Accounts Payable Help
Accounts Payable handles all your payables
record keeping and reporting needs, regardless
of the size and complexity of your
business. More...

Getting Started
About Setting Up Vendor Records
About Recurring Payables
About Payment Entry
About Processing Invoices, Credit Notes, Debit Notes, and Interest
About Batch Processing in Accounts Payable
About Accounts Payable Reports

Using A/P Screens
Vendor Reports
Vendors
Periodic Processing
Setup Reports
Setup
Transactions Reports
Transactions

How-To Articles
Setting Up Accounts Payable
Adding, Modifying, or Deleting a Vendor
Entering an Invoice
Entering a Cash Invoice or Miscellaneous Payment
Prepaying a Vendor
Entering and Applying a Payment
Processing Recurring Payables
Adjusting a Posted Transaction
Applying Payment Controls
Printing Letters and Labels
Printing the Overdue Payables Report
Printing the Aged Payables Report
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What's New in Accounts Payable 2014
Accounts Payable 2014 includes the following new features and
improvements:
US tax forms updated. The 1099 and 1096 forms have been
updated to meet the following changed IRS specifications for 2013:
The alignment and positioning of some information has been
changed so that it prints in the correct place on these forms.
The 1099-MISC form now includes the following boxes:
11 Foreign tax paid
12 Foreign country or U.S. possession

Upgrading from an Earlier Version?
If you are upgrading from version 6.0, see Changes in Accounts
Payable 2012.
If you are upgrading from version 5.6, see Changes in Accounts
Payable 6.0.
If you are upgrading from version 5.5, see Changes in Accounts
Payable 5.6.
If you are upgrading from version 5.4, see Changes in Accounts
Payable 5.5.
If you are upgrading from version 5.3, see Changes in Accounts
Payable 5.4.
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Getting Started
Find help, documentation, tips, and resources to get Accounts Payable
up and running quickly and easily.
Support and Resources
Finding Help and Documentation
Data Entry Tools and Shortcuts
Working with Detail Entry Tables
Keyboard Shortcuts for Detail Tables
Accounts Payable Menu Commands
Setting Finder Criteria
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Support and Resources
Use the links below to find instructions, software training, one-on-one
support, technical specifications, or other resources to get Sage 300 ERP
working smoothly for your business.
Your Sage Business Partner is also an excellent resource to consult
when you have questions about Sage 300 ERP.

How can we help you?
I'm setting up Sage 300 ERP and need information or assistance
I'm looking for instructions to complete a task in Sage 300 ERP
I think something is broken, or I'm getting error messages
I’m looking for downloads, updates, or technical specifications
I want to become a more skilled user of Sage 300 ERP
I want to share knowledge with other Sage 300 ERP users
I want to contact a Sage 300 ERP representative

Related Topics
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Finding Help and Documentation
You can find information about setting up and using Sage 300 ERP in the
Sage 300 ERP Learning Center and in the product documentation
included with this release.
Note: For technical support, visit Customer Support or contact your
Sage business partner.

The Sage 300 ERP Learning Center
The Learning Center is where you'll find documentation for new product
features and modules in the Sage 300 ERP Portal. It features articles and
information about the portal, shortcuts, snapshots, and Inquiry.
You view the Learning Center in one of the following ways:
Open the Sage 300 ERP Portal, and on the welcome bar at the top of
the screen, click Help > Learning Center.
On the tab menu for any portal tab, click Help.

Context-Sensitive Help
Sage 300 ERP features context-sensitive help that you can use to quickly
open and view articles and information directly from Sage 300 ERP
screens.
In the Sage 300 ERP Portal, click Help on the tab menu to view
help for the current screen.
On the Sage 300 ERP Desktop, press F1 to view help for the current
screen.

Product Documentation
Sage 300 ERP includes guides in printable PDF format, including the
Installation and Administration Guide, Upgrade Guide, and other
documentation related to installation and setup.
These guides are available in the Docs folder on the Sage 300 ERP
server, and online in the Sage Customer Portal.
To view the guides in the Docs folder:
On the Windows taskbar, click Start > Programs > Sage 300 ERP >
Documentation.
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Data Entry Tools and Shortcuts
Use these tools and shortcuts to speed up data entry in Sage 300 ERP.
Note: We are updating the visual design of Sage 300 ERP. Some
screens, but not all, include redesigned buttons, as shown below.

Tool

Data Entry Tools and Shortcuts
Shortcut
Description
Key

Drilldown

n/a

The Drilldown button appears beside some
data entry fields and in some column headings in
transaction detail entry tables. Click it to view
details of the record or transaction in the
corresponding field. More...

Finder

F5

The Finder appears in some data entry fields,
and in some table headings in transaction entry
screens. Click it when you want to look up
records you can select for a field. More...
Tip: For additional instructions on using the
Finder to select records, press F1 when the
Finder screen appears.

Go

F7

The Go button appears on screens where you
must enter information (such as filter criteria)
before viewing records that match the
information you enter. More...

Navigation n/a

Click the Previous and Next buttons to navigate
through a list of existing records, or click the First
and Last buttons to navigate to the first and last
records. More...

New

n/a

Click the New button or select New from a
menu to begin creating a new record.

Zoom

F9

Click the Zoom button or press the F9 key to
view or enter supplementary information for a
transaction detail or for a field. More...
After viewing or editing the information in the
detail screen, you can press F9 to close the
screen.

Add/Save n/a

Click this button to save the displayed record,
account, batch, or transaction.
If you have just entered a new record, the Add
button appears instead of Save.

Cancel

n/a

Use this command to cancel the changes you
have made and to return the record to the way it
was when you selected it.

Close

n/a

Click the Close button to close the current
screen.
If you are editing a record, the program asks you
whether you want to save your changes or
cancel them.

Delete

n/a

Use this command to delete the displayed
record, account, batch, or transaction. If you
cannot delete a record, you see a warning
message that explains why you cannot delete it.
You can delete a batch at any time (using the
Batch List screen for the type of batch), but you
cannot reuse the batch number.

Related Topics
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Working with Detail Entry Tables
The first tab of each transaction entry screen in Sage 300 ERP contains
a detail entry table that shows the document details in tabular format.
In most cases, you can enter all the necessary details for a document
right on the table.
Tip: If there are more columns than can be displayed at one time, you
can use the horizontal scroll bar at the bottom of a list to view the
additional columns. You can also rearrange the order of columns, or
change column widths, consistent with how you enter data.
You can also view and edit all the fields for a single detail on a separate
Detail Items/Taxes screen. To view this screen, select a detail line and
click the Item/Tax button below the table, or press F9.
Note: You use the Detail Items/Taxes screen to view or change tax
information for a detail. Detail tax fields do not appear in the detail table.
To add details using the detail table, do one of the following:
If a blank line is highlighted, tab to the Item Number field, then either
type the item number or select it from the Finder. Enter the remaining
information for the detail.
To start a new line, press Insert or tab through the end of the last line
on the table.
If you want to insert a new line in a specific location, highlight the line
above the location, and then press Insert.
Note: A detail line is saved as you enter it on the detail entry table.
To edit details using the detail table:
Select the line you want to edit, and then enter your changes on that
line.

Note: For information about using your keyboard to move within a detail
table, see Keyboard Shortcuts for Detail Tables
To delete details using the detail table:
1. Select the line you want to delete.
2. Press the Delete key on your keyboard.
3. If you see a message asking you to confirm the deletion, click Yes.
To edit item information or detail tax information using the Detail
Items/Taxes screen:
1. Select the detail on the table, and then either click the Item/Tax
button, or press F9.
2. Edit the item information and/or change the Tax Class or Tax
Included options for the detail.

Related Topics
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Keyboard Shortcuts for Detail Tables
Use the following keyboard shortcuts to navigate in detail tables.
Key
Ins/Insert

Del/Delete

Menu
Command

Action

New

Insert a blank row to add a new
record.

Delete

Remove the selected row.

Up or Down Arrow

Go up or down one row.

Left or Right Arrow

Go left or right one column.

Pg Up

Go to the top row in view.

Pg Dn

Go to the bottom row in view.

Home

First

Go to the first row in a list.

End

Last

Go to the last row in a list.

Tab or Enter;

Go to the next or previous column
in a list.

Shift+Tab or
Shift+Enter

Related Topics
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Menu Commands
The following commands appear on the File, Settings (when available),
and Help menus on Sage 300 ERP screens.
Note: Menu names and commands may differ by screen.

File Menu
Command
Close

File Menu Commands
Description
Closes the current
screen.

Customize Lets you hide or
display fields for
users by UI Profile
ID.

Notes

You can also press Alt+F4 to close a
screen.
Click File > Customize to hide fields
on an open screen for users assigned
to a UI Profile ID for that screen.
When these fields are hidden, data
that would normally appear in these
fields cannot be printed.
For more information, see the help for
the UI Profile Maintenance screen in
the System Manager help.

Export

Import

Exports data
records to other
Sage 300 ERP
databases and nonSage 300 ERP
programs.

Click File > Export to export data.

Imports data
records from other
databases and from
non-Sage 300 ERP
programs.

Click File > Import to import data.

For example, you could export
purchase statistics for use in
spreadsheet or database software.
Note: You cannot export serial or lot
numbers for kit components.

For example, you could use a
spreadsheet to enter current
requisitions or purchase orders when
setting up your system, and then
import the transactions later.
Note: You cannot import serial or lot

numbers for kit components.
Print

Prints the current
report, list, or
screen.

On screens with a corresponding
report, click File > Print to open the
report screen, which you use to select
report options (if applicable) before
printing the report.

Print
Setup

Selects a printer
and sets printing
options.

Click File > Print Setup to set up
your printer. You can select the
default printer or select another from
the list of installed printers.
For more information about print
options, refer to your operating
system documentation.

Save

Saves the entries or If you have just entered a new record,
Add appears instead of Save.
changes you have
made to the current
screen.

Settings Menu
Command

Settings Menu Commands
Description
Notes

Auto Clear

Creates a new entry Use the Auto Clear option to
automatically when streamline data entry in transaction
you post a
entry screens.
transaction.
If Auto Clear is turned on, all
fields are cleared each time
you post a transaction,
allowing you to immediately
begin entering another
transaction.
If Auto Clear is turned off,
transaction information
remains on the screen after
you post it. Click the New
button to begin entering
another transaction.

Quick Mode

If you select Quick
Mode, when you
start a new entry or
detail, fields from
the previous
transaction or detail
are copied to the
new transaction or
detail, so you don’t
have to re-enter
them.

This command is available for
Invoice Entry. When you click
Quick Mode on the Settings menu,
a separate screen appears that
lets you select Quick Mode
settings:
To copy header fields to new
transactions in the batch you
are working on, select Quick
Mode For Entries, and then
specify the entry fields you
want to copy.
To copy detail fields to new

details in the transaction you
are working on, select Quick
Mode For Lines, and then
specify the detail fields you
want to copy.
Clear Saved
Settings

Restores default
This command is available for
settings for a report. forms and for some reports.

Save
Settings as
Defaults

Saves the current
report settings as
personal defaults.

This command is available for
forms and for some reports.

Help Menu
Command

Help Menu Commands
Description

About

Displays version and copyright information for the current
screen and program.

Contents

Opens Help.

Using Help Opens Help to an introductory topic on how to use Help.

Related Topics
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Setting Finder Criteria
To help you search quickly through a long list of records, you can use
criteria to restrict the records that are displayed in the Finder and when
you use the navigation buttons.
However, at other times, if the Finder uses criteria, it might not display all
the records you expect to see.
To check or remove the criteria:
1. Click the Finder .
2. Click the Set Criteria button.
3. On the screen that appears, click the Clear button.
For instructions on setting criteria, click the Help button when the Set
Criteria screen appears.

Related Topics
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Setting Up Accounts Payable
Use Accounts Payable Setup screens to set up records and options that
determine how Accounts Payable:
Processes transactions.
Interacts with General Ledger and other Sage 300 ERP modules.
Steps for Setting Up Accounts Payable
Using a Self-Assessed Tax
Accounts Payable Security Authorizations
Accounts Payable Options
Integration with General Ledger
Setting Up and Maintaining Processing Records
Customizable Formats for Accounts Payable Forms
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Setting Up Accounts Payable
After you activate Accounts Payable, follow the steps in this topic to set
up a new Accounts Payable ledger.
Before you start
Step 1: Select options and add setup records
1. Use the A/P Options screen and the A/P G/L Integration screen to
specify how your Accounts Payable system will operate.
2. Design coding schemes for your Accounts Payable records. For
more information, see About Designing Accounts Payable Coding
Schemes.
3. Add records and print setup reports. For more information, see:
Adding 1099 / CPRS Codes
Adding or Modifying an Account Set
Adding or Modifying a Distribution Code
Adding or Modifying Distribution Sets
Adding or Modifying E-mail Messages
Adding or Modifying an Optional Field (if you use them)
Adding or Modifying a Payment Code
Adding Payment Selection Codes
Adding or Modifying a Terms Code
Step 2: Add vendor records
For more information, see:
Adding, Modifying, or Deleting a Vendor Group
Adding, Modifying, or Deleting a Vendor
Adding, Modifying, or Deleting a Remit-to Location for a Vendor
(optional)
Setting Up a Recurring Payable for a Vendor

Printing the Vendors List
Printing the Vendor Group List
Printing the Remit-To Locations Report (optional)
Step 3: Transfer your accounting data to Accounts Payable
For more information, see:
1. About Entering Current and Historical Transactions
2. About Batch Processing in Accounts Payable
3. Printing Batch Listings and Printing Posting Journals
Step 4: Design formats for your preprinted forms
Design and test formats for printing checks, advices, letters, and labels,
or adapt the sample formats to print on your own forms. For more
information, see Customizable Formats for Printed Accounts Payable
Forms
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Using a Self-Assessed Tax
A self-assessed tax is one that you must pay, even though the vendor
does not collect it. These taxes commonly arise when you order goods
from another state or province, but you are still subject to local sales
taxes.
Accounts Payable does not have a self-assessing tax type, but you can
use the program to calculate self-assessing taxes and distribute them to
expense and tax payable accounts. The trick is to create two tax
authorities.
To create a self-assessed tax for use in Accounts Payable:
1. In Tax Services:
Use the Tax Authorities screen to create two new tax authorities:
Authority 1 is the tax expense. This tax can be distributed with the
invoice amount or expensed separately to a tax expense account.
Authority 2 is the tax payable. Specify that this tax is expensed
separately to the tax payable account.
Use the Tax Classes screen to create Purchases tax classes for
vendors and items for both tax authorities.
Use the Tax Rates screens to define tax rates for purchases for
each of the authorities:
For authority 1, specify the tax rate as you would for any other
tax.
For authority 2, specify a negative tax rate of the same amount
that you specified for authority 1.
Note: The two taxes will cancel each other, and not add to the
value of the invoice.
Use the Tax Groups screen to add both taxes to the tax group you
want to use for purchases that involve self-assessed taxes.

For more detailed information about setting up tax authorities, tax
classes, and tax groups, see the help for Tax Services.
2. In Accounts Payable, specify the self-assessing tax group when you
add an invoice.
Note:
Make sure that you are using the same tax class for both taxes.
If you are not calculating tax, enter a positive tax amount for
authority 1 and a corresponding negative amount for authority 2
on the Vendor Taxes tab.
If you are calculating tax, set the two taxes to "No" in the Tax
Included field.

Related Topics
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Accounts Payable Security Authorizations
If security is turned on for your Sage 300 ERP system, the system
administrator must assign users security authorization for Accounts
Payable screens.
For information on turning on security, setting up security groups, and
assigning authorizations, refer to the System Manager help.
Note: To change the print destination for forms and reports, you must
have Change Print Destination security authorization for Administrative
Services.
To view records and to print reports in Accounts Payable, you must
belong to a security group with Common Inquiry authorization. However,
Common Inquiry authorization by itself does not let you edit any Accounts
Payable records.
To edit records or perform processing tasks, the system administrator
must grant the group access to additional tasks from the following list:
Security
Authorization
Common
Inquiry

Accounts Payable Security Authorizations
Description

View records and print reports for Vendor Groups,
Vendors, and Remit-to Locations.
View setup records and print setup reports.
Common Inquiry is automatically assigned with any
other type of authorization, except:
Import Processing
Export Processing
Transaction Optional Fields
Set Ready To Post (for any type of batch)
Check Printing

Setup
Maintenance

Update and print setup choices and records using the
A/P Options, Account Sets, 1099/CPRS Codes,
Distribution Codes, Distribution Sets, Terms,
G/L Integration, Payment Codes, E-mail Messages, and
Optional Fields screens.

Control
Payments

Process payment controls using the Control Payments
screen.

Vendor
Maintenance

Update records for Vendor Groups, Vendors, Remit To
Locations, and 1099/CPRS Amounts (if the Allow Edit of
1099/CPRS Amounts option is selected on the
A/P Options screen).
Add or delete optional fields for vendor groups, vendors,
and remit-to locations.

Vendor
Analysis

View vendor information in Vendor Activity.
Use the 1099 Electronic Filing screen.
Print Vendor Transactions, Aged Payables, Aged Cash
Requirements, Aged Retainage, 1099/CPRS Amounts,
and Letters/Labels.

Invoice Batch
Inquiry

View and print transactions in the Invoice Batch List and
Invoice Entry screens.
View and print recurring payables records.
View records in the 1099/CPRS Amounts screens.
View invoice records in the Vendor Activity screen.
Print transaction reports for invoices from the Batch
Listing, Batch Status, Posting Journals and Posting
Errors, and transaction entry screens.
Use the 1099 Electronic Filing screen.

Invoice Batch
Entry

The same rights as Invoice Batch Inquiry, plus:
Create, edit, and delete transactions using the
Invoice Batch List and Invoice Entry screens.
Create, edit, and delete records using the Recurring
Payables setup screen, and create batches of
recurring payable invoices using the Create
Recurring Payable Batch screen.
Create batches of retainage documents using the
Create Retainage Batch screen.
If you also have Payment Entry authorization, enter
prepayments in Invoice Entry.
If you also have Set Invoice Batch Ready To Post
authorization, set batches ready to post on the Invoice
Batch List screen.

Invoice Batch
Posting

The same rights as Invoice Batch Inquiry, plus:
Post invoice batches using the Invoice Batch List
and Post Batches screens.
Send transactions to the General Ledger
automatically, if the Create G/L Batches During
Posting option is selected on the A/P Options
screen.
If you also have Set Invoice Batch Ready To Post
authorization, set batches ready to post on the Invoice
Batch List screen.

Set Invoice
Batch Ready
To Post
Payment
Batch Inquiry

If you also have Invoice Batch Entry or Invoice Batch
Posting authorization, set invoice batches ready to post
on the Invoice Batch List screen.
View and print transactions using the Payment Batch
List, Payment Entry, Payment Inquiry, and Check
Register screens.

View payment records on the Vendor Activity screen.
Print transaction reports for payments using the Batch
Listing, Batch Status, Posting Journals, Posting Errors,
and G/L Transactions screens.
Use the 1099 Electronic Filing screen.
Payment
Batch Entry

The same rights as Payment Batch Inquiry, plus:
Create, edit, and delete transactions using the
Payment Batch List and Payment Entry screens.
Create payment batches automatically using the
Create Payment Batch screen.
Create, edit, and delete payment selection codes.
Print transaction reports for payments using the Batch
Listing, Batch Status, Check Register, and
G/L Transactions screens.
If you also have Set Payment Batch Ready To Post
authorization, set batches ready to post on the Payment
Batch List screen.

Payment
The same rights as Payment Inquiry, plus post payment
Batch Posting batches using the Payment Batch List and Post Batches
screens.
Send payment transactions to the general ledger
automatically, if the Create G/L Batches During Posting
option is selected on the A/P Options screen.
If you also have Set Payment Batch Ready To Post
authorization, set batches ready to post on the Payment
Batch List screen.
Note: You cannot set a payment batch Ready To Post if
it contains unprinted checks. You require Check Printing
authorization to print the checks.

Check
Printing

Print checks using the Payment Entry and the Payment
Batch List screens.
Note: You also require Payment Inquiry, Payment Entry,
or Payment Posting authorization to print checks.

Set Payment
Batch Ready
To Post
Adjustment
Batch Inquiry

If you also have Payment Batch Entry or Payment Batch
Posting authorization, set payment batches ready to
post.
View transactions and print reports using the
Adjustment Batch List and Adjustment Entry screens.
Print transaction reports for adjustments using the Batch
Listing, Batch Status, Posting Journals, Posting Errors,
and G/L Transactions screens.
Use the 1099 Electronic Filing screen.

Adjustment
Batch Entry

The same rights as Adjustment Batch Inquiry, plus
create, edit, and delete transactions in the Adjustment
Batch List and Adjustment Entry screens.
If you also have Set Adjustment Batch Ready To Post
authorization, set batches ready to post on the
Adjustment Batch List.

Adjustment
The same rights as Adjustment Batch Inquiry, plus post
Batch Posting adjustment batches using the Adjustment Batch List and
Post Batches screens.
Send transactions to the General Ledger automatically,
if the Create G/L Batches During Posting option is
selected on the A/P Options screen.
Use the 1099 Electronic Filing screen.
If you also have Set Adjustment Batch Ready To Post

authorization, set batches ready to post on the
Adjustment Batch List screen.
Set
Adjustment
Batch Ready
To Post

If you also have Adjustment Batch Entry or Adjustment
Batch Posting authorization, set adjustment batches
ready to post on the Adjustment Batch List screen.

Transaction
View vendor information on the Vendor Activity screen
History Inquiry and the inquiry screens.
Use the 1099 Electronic Filing screen.
Transaction
Optional
Fields

Add or delete optional fields on the Invoice Entry,
Payment Entry, Adjustment Entry screens, and other
Accounts Payable screens that create transactions
automatically.

Clear History / Do periodic processing using the Clear History, Clear
Records /
Statistics, and Delete Inactive Records screens.
Stats
View and print vendor and setup records.
Period End
Maintenance

Do periodic processing using the Create G/L Batch and
Revaluation screens.
Print revaluation transactions using the Posting Journals
and G/L Transactions screens.

Year End
Maintenance

Do periodic processing using the Year End screen.

Import
Processing

Import records using the File menu.
Note: You also require update authorization for the
types of records you want to import. For example, to
import vendor records, you need both Import
Processing and Vendor Maintenance authorizations.

Export

Processing

Export setup, vendor, and transaction records, using the
File menu.
You also require Inquiry authorization for the types of
records you want to export. For example, to export
payment records, you need both Export Processing and
Payment Inquiry authorization.

Aged
Payables
Snapshot

View and configure the Aged Payables snapshot in the
Sage 300 ERP portal.

Days
Payables
Outstanding
Snapshot

View and configure the Days Payables Outstanding
snapshot in the Sage 300 ERP portal.

Vendor
Developer
Inquiry

This authorization supports the Inquiry feature in the
Sage 300 ERP portal.
Developers of third-party programs, including macros,
need to incorporate this resource in their security
structures.

Sage 300
ERP Inquiry

Query Accounts Payable data in the portal.
If you also have Export Processing authorization for
Accounts Payable, print or export the results of these
queries.
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Accounts Payable Options
The options you select on the A/P Options screen determine how your
Accounts Payable system operates and the types of data that it stores
and displays. You can change most of these options after setup, as
needed.
About Selecting Accounts Payable Options
About Prepayment Numbering Options
About Displaying Open Documents in Payment Entry
Selecting Options for Accounts Payable
Using Multicurrency Accounting in Accounts Payable
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Accounts Payable Options

About Selecting Accounts Payable Options
Once you have activated Accounts Payable, your first task is to use
Accounts Payable's Options screen to choose the options you want to
use with your Accounts Payable system.
You also use the G/L Integration screen to specify how and when to
produce transactions for General Ledger.
The options you choose determine how your Accounts Payable system
will operate, and the types of data that will be stored and displayed. You
can also use the screens after setup to review your entries and change
most of them, if necessary.

Related Topics
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About Assigning Document Numbers to
Prepayments
Accounts Payable assigns a unique number to each prepayment
document you add to a payment batch.
The number is a combination of a prefix that identifies the transaction
type, and a number that is assigned sequentially by Accounts Payable,
starting with the number you specify.
You enter the prefix and next number to assign to prepayment
documents on the Numbering tab of the A/P Options screen.
You may be able to continue using your current numbering scheme. At
any time, you can also specify a different prefix and next number on the
A/P Options screen for Accounts Payable to assign. (However, you
cannot make a change that would create duplicate document numbers.)
Check number sequences and the next check number are set in Bank
Services. Invoices use the numbers assigned by the vendor.

Prefix and Next Number
You can use up to six characters for the prefix, and up to nine digits for
the document number.
If you do not enter a prefix and document number, Accounts Payable
automatically assigns 1 as the first document number and uses "PP" as
the prefix for all prepayment documents.

Sequence Number
When you add a prepayment in the Payment Entry screen, Accounts
Payable automatically assigns a document number, using the prefix and
next number you specified on the A/P Options screen. If you use the
assigned number, the Next Number box is updated on the A/P Options
screen.
Document numbers can go as high as 999999999, then they are
automatically reset to 1.

Changing the Next Document Number
If you want to change the next number to assign on the A/P Options
screen to a lower number, you may want to also change the prefix, to
prevent Accounts Payable from assigning the same document number
twice. You cannot post two documents with identical document prefixes
and numbers.

Related Topics
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Documents in Payment Entry

About Displaying Open Documents in Payment
Entry
You can control the order in which open documents (such as invoices
that are not yet paid, or credit notes that have not been applied) appear
in selection lists when you are applying payments in the Payment Entry
screen. This option lets you display the documents in the order that is
easiest for you to use.
Accounts Payable displays open documents by document number unless
you choose another order. To change the order at any time, use the
Default Order Of Open Documents option on the Transactions tab on the
A/P Options screen.
You can choose to display open documents for each vendor account by:
Document number. This choice lists open documents, such as
invoices, credit notes, and debit notes, by their document numbers,
beginning with the lowest document number for each transaction
type.
If you use this option, you should consider prefixing vendor invoices,
credit notes, and debit notes so Accounts Payable will list documents
in the order you prefer.
The following prefixes would list invoices first, followed by interest
invoices, credit notes, debit notes, and adjustments:
IN (invoice)
INT (interest invoice)
NCR (credit note)
NDR (debit note)
XADJ (adjustment)
PO number. This choice groups open (unpaid or unapplied)
documents (invoices, credit notes, and debit notes) by their purchase
order numbers. Documents issued from the lowest purchase order
number are displayed first.

Due date. This choice lists open invoices, credit notes, and debit
notes by their due dates, beginning with the document with the oldest
(earliest) due date.
Order number. This choice groups open documents by their sales
order numbers. Documents entered with the lowest sales order
number are listed first.
Document date. This choice lists open documents by the document
dates entered with them, beginning with the oldest date.
Current Balance. This choice lists open documents by their
outstanding balances, beginning with the smallest amount.

Related Topics
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Accounts Payable

Selecting Options for Accounts Payable
You use the A/P Options screen to select processing, transaction, and
numbers options and enter general information about your Accounts
Payable ledger.
Note: You use the G/L Integration screen to select options that control
how Accounts Payable interacts with General Ledger, including when
and how to process General Ledger transactions.
Before you start
To set processing options for Accounts Payable:
1. Open Accounts Payable > A/P Setup > Options.
2. Click the tab that contains the options you want to change.
3. Make your changes.
4. Click Save to keep your changes.
Note: You cannot save most changes to the A/P Options screen if
any other Accounts Payable screens are open.
5. Click Close when you are finished or to leave the screen without
changing any information.
After selecting options for Accounts Payable
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Setting Up Accounts Payable to Use
Multicurrency Accounting
Accounts Payable lets you process invoices and payments in any
currencies your vendors use.
Note: You require a license for Sage 300 ERP Multicurrency to use
multicurrency features.
Before you start
To set up a multicurrency Accounts Payable ledger:
1. On the Processing tab of the A/P Options screen, select the
Multicurrency option for Accounts Payable.
Note: Once you turn on the Multicurrency option, you cannot turn
it off again.
2. Use the A/P Account Sets screen to add at least one account set for
each currency you want to use in Accounts Payable.
For each account set, enter the currency code and the numbers of
your exchange gain and loss general ledger accounts.
3. When you create vendor groups and vendor records, select the
account set and the rate type for each record.
The vendor's account set determines the vendor's currency. The
vendor group account set is only a default when adding vendor
records. You can override it.
Note: Invoices are always issued in the vendor currency, although
payment can be in any currency.
4. If you post transactions to add year-to-date figures, enter them in the
appropriate currencies.
5. If you enter statistics for previous years and periods, you must enter

amounts in both the functional and vendor currencies. Accounts
Payable cannot calculate equivalent amounts from statistics you
enter yourself.
After setting up a multicurrency Accounts Payable ledger
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Integration with General Ledger
You select options on the A/P G/L Integration screen to:
Control how Accounts Payable interacts with General Ledger.
Specify the types of information to send with the transactions you
send to General Ledger from Accounts Payable.
About Using Accounts Payable with General Ledger
Selecting General Ledger Integration Options for Accounts
Payable

Home > Setting Up Accounts Payable > Integration with General Ledger > About Using
Accounts Payable with General Ledger

About Using Accounts Payable with Sage 300
ERP General Ledger
If you use Sage 300 ERP General Ledger, Accounts Payable creates
batches of general ledger transactions in General Ledger and displays
and validates General Ledger account numbers in Accounts Payable.
The G/L Transactions report and the summary at the end of each
Accounts Payable posting journal list the general ledger accounts that will
be debited and credited with payables transactions when you post the
Accounts Payable batch of general ledger entries in General Ledger.
You use the G/L Integration screen to specify the type of reference and
description to include with each General Ledger transaction.
Until you clear the transactions using the A/P Clear History screen, you
can drill down from the General Ledger Transaction History screen to
view originating transactions in Accounts Payable and Order Entry (if you
use it).

General Ledger Accounts Used in Accounts
Payable
Accounts Payable uses the following general ledger accounts: Payables
Control, Bank, Purchase Discounts, Prepayment, and the accounts you
assign to distribution codes or enter with transactions.

Multicurrency Ledgers
If you use multicurrency accounting, Accounts Payable also uses
General Ledger's unrealized and realized exchange gain and loss
accounts.
If your Sage 300 ERP General Ledger system is at another location,
Accounts Payable creates its general ledger transactions in a batch that
you can import into General Ledger.
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Selecting General Ledger Integration Options for
Accounts Payable
You use the A/P G/L Integration screen to select options that govern how
Accounts Payable interacts with General Ledger, including when and how
to create G/L batches and the type of information to send to General
Ledger with posted transactions.
Before you start
To change G/L integration options:
1. Open Accounts Payable > A/P Setup > G/L Integration.
2. Use the Integration tab to change options that determine how and
when to process general ledger batches.
3. Use the Transactions tab to change the information that is included
with general ledger transactions. More...
4. When you are satisfied with your choices for G/L integration, click
Save, and then click Close.
After selecting G/L Integration options
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Setting Up and Maintaining Processing Records
Before you can add vendor records to Accounts Payable, you must set
up the records that you will assign to vendors:
1099/CPRS codes
Account sets
Distribution codes
Distribution sets (optional)
E-mail messages (optional)
Optional fields (if you use Sage 300 ERP Transaction Analysis and
Optional Field Creator)
Payment codes
Payment selection codes
Recurring Payables
Terms
About Designing Accounts Payable Coding Schemes
About Importing Setup and Vendor Records
1099 / CPRS Codes
Account Sets
Distribution Codes
Distribution Sets
E-mail Messages
Optional Fields
Payment Codes
Payment Selection Codes

Terms Codes
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About Designing Accounts Payable Coding
Schemes
Before you can use Accounts Payable, you must add codes to identify
the account sets, distribution codes, vendors, and other records you will
add to your system. You should take the time to design sensible coding
schemes for each type of code you require, before you start assigning
codes to records.
If you already have a system for these codes, you may be able to
continue with the same system. To check whether each code type allows
for the number and type of characters you use in your current system,
review the following list:
Codes Used in Accounts Payable
Code Name
Maximum Number of Characters
Account set code

6 digits and letters

1099/CPRS code

6 digits and letters

Distribution code

6 digits and letters

Distribution set

6 digits and letters

Payment selection code 6 digits and letters
Recurring Payable code 15 characters
Remit-to location code

6 characters

Terms code

6 digits and letters

Vendor group code

3 digits and letters

Vendor number

12 characters

If you are designing new codes, you should assign codes that make it
easy to identify each record type and that list records in the order you
want them to appear on reports and in Finder windows.
Each code is a unique set of letters, symbols, and digits. For example,

each of the following could be a valid vendor number:
123
123A
AB1234
A1
A01
To simplify codes, we recommend that you:
Use the same number of characters in all codes of the same record
type.
Where permitted, define codes of at least three characters to allow
for future expansion.
Use a numbering system that is significant for your business, such as
a geographical region or division or vertical market.
If possible, use only numbers (not letters or symbols), for consistency
of sorting.

Sorting Order of Codes
Accounts Payable sorts codes on screens and reports in a specific order,
which you should take into consideration when designing codes.
The program reads codes from left to right, and uses the following
sequence to put them in order:
[Blank] ! " # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? @ A B C D E
FGHIJKLMNOPQRSTUVWXYZ[\]^_`abcdefghijkl
mnopqrstuvwxyz{|}~
The codes listed in the introduction to this discussion would be sorted by
the program into the following order:
123
123A
A1
A01
AB1234
You should use the same number of characters in all your codes, to avoid
number sequences such as:
100
10000
19
2
2000
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About Importing and Setup and Vendor Records
If you presently have a computerized accounts payable system, you may
be able to transfer vendor records directly into Sage 300 ERP Accounts
Payable by importing them.
You can also export records from another Sage 300 ERP Accounts
Payable database, edit them in a spreadsheet or other program to
change codes, amounts, and other information, then import them into the
new Accounts Payable system you are setting up.
Accounts Payable records you can import and export include:
Account sets
1099/CPRS codes (although these are set up by Accounts Payable)
Distribution codes
Distribution sets
E-mail messages
Payment codes
Remit-to locations
Terms codes
Vendor groups
Vendors
Payment selection codes
Example: You could export vendor records to a spreadsheet to analyze
their statistics. You could also export all vendor records with the same
account set to a spreadsheet, change their tax group, then import them
back into Accounts Payable.
Accounts Payable can create export files in several formats, including
Microsoft Excel, Microsoft Access, Comma Separated Values and
Continuous ASCII file formats, dBase 5, ODBC, and XML formats. You
select the format to use when you export the data.
You can export data to different types of file, including:

Microsoft Excel
Microsoft Access
Comma Separated Values and Continuous ASCII
dBase 5
ODBC
XML
You can also create files to be imported by Accounts Payable in any of
the above programs or formats.
For more information about importing and exporting records, see the
System Manager Help.
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1099 / CPRS Codes
1099/CPRS expense class codes identify different categories of
1099/CPRS payments and establish how you print 1099/CPRS forms for
different vendors. You must assign a 1099/CPRS code in the Vendors
screen to each vendor you mark as subject to 1099/CPRS reporting.
About 1099 CPRS Codes
List of 1099 / CPRS Codes
Adding 1099/CPRS Codes
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About 1099 / CPRS Codes
You use the A/P 1099/CPRS Codes screen to add codes to assign to
vendors that are subject to 1099/CPRS reporting. You must enter a
1099/CPRS code in the Vendors screen for each vendor you mark as
subject to 1099/CPRS reporting.
1099/CPRS expense class codes correspond to the various box numbers
on a standard 1099 or CPRS form. In other words, they identify different
categories of 1099/CPRS payments. You specify the default 1099/CPRS
code for each vendor in the vendor records, but you can specify a
different code for each invoice, if necessary.
Note: Generally, you should assign code 3, Other Income, for vendors
subject to CPRS reporting in Canada.
The Minimum To Report amount that you enter for a 1099/CPRS code is
used when you print 1099 forms or file 1099s electronically.
Accounts Payable sets up most 1099/CPRS codes when you activate a
new database. You should have to add or edit codes only if the existing
code structure changes.
1099/CPRS vendor amounts are accumulated by code and by period.
Each time you enter an invoice, you can specify the 1099/CPRS code to
which the invoice applies. Accounts Payable prints each code amount in
the appropriate box on the 1099/CPRS form.
Note: Although 1099/CPRS codes and amounts are entered with
vendor invoices, Accounts Payable accumulates the 1099/CPRS
statistics each time you post payments for the vendor.

Editing 1099/CPRS Codes
You can change the description and Inactive status only. You cannot
change the 1099/CPRS code.
However, assigning Inactive status does not affect the accumulation of
1099/CPRS information at posting.

Deleting 1099/CPRS Codes
Deleting codes does not remove any information from your ledger
(except the code definition). However, you should not delete 1099/CPRS
codes if you are required to print 1099/CPRS forms. If you accidentally
delete a code, just add it again.
If you delete a 1099/CPRS code, you can no longer assign it to vendor
records—nor can you update a vendor record which has that code
assigned.

Non-Standard Codes
Only standard 1099-MISC codes are printed on the stock 1099/CPRS
Amounts report.
If you add any non-standard 1099/CPRS codes, you must modify the
1099/CPRS Amounts report screen to print the non-standard codes.
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List of 1099 / CPRS Codes
Accounts Payable creates the following 1099 / CPRS codes:
1099/CPRS CODES
Minimum
1099/CPRS
To
Code
Report
1
2

Description

600 Rent
10 Royalties

3

600 Other income

4

zero Federal income tax withheld

5

zero Fishing boat proceeds

6

600 Medical and health care payments

7

600 Non-employee compensation

8
9

10 Substitute payments in lieu of dividends or
interest
5,000 Direct Sales

10

600 Crop insurance proceeds

11

zero Foreign tax paid

13

zero Excess golden parachute payments

14

600 Gross proceeds paid to an attorney

15A

600 Section 409A Deferrals

15B

zero Section 409A Income

16

zero State income tax withheld

Note: Accounts Payable does not create a code for box 12 on the 1099
form, which is used to specify a vendor's country. However, when you
print the form, the country specified for the vendor is entered

automatically in box 12.
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Adding 1099 / CPRS Codes
1099 forms are used in the United States to report the amount of
purchases from your US vendors.
The Contract Payment Reporting System (CPRS) is a Canadian tax
reporting system designed for reporting payments made to Canadian
construction subcontractors.
Before you start
To add a 1099/CPRS code:
1. Open Accounts Payable > A/P Setup > 1099/CPRS Codes.
2. Add the 1099/CPRS codes you need, entering for each:
1099/CPRS Code. Type the number of the box on the form that
contains the 1099/CPRS code.
Description. Type a description of the 1099/CPRS code.
Minimum To Report. Enter the lowest amount you are required to
report for each code. Only vendors with a total 1099 amount equal
to or greater than this amount are included in the electronic 1099
file or on printed 1099‐MISC forms.
3. Click the Add button.
4. Repeat steps 2 to 3 for each code you want to add.
After adding 1099/CPRS codes
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Account Sets
An account set is a group of general ledger account numbers, including
the payables control account, to which vendors' transactions are
distributed.
You must create at least one account set before you can add vendor
records.
About Account Sets
Adding or Modifying an Account Set
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About Account Sets
An account set is a group of general ledger account numbers, including
the payables control account, to which vendors' transactions are
distributed.
You must create at least one account set before you can add vendor
records.
If you use multicurrency accounting, you must add at least one account
set for each currency used by your vendors. The account set you assign
to a vendor must use the vendor's currency.
In multicurrency ledgers:
Specify the currency used by vendors assigned to each account set.
For account sets that do not use the functional currency, enter
account numbers for unrealized exchange gains and losses, and
realized exchange gains and losses.
For account sets that do not use the functional currency, specify an
account for exchange rounding differences.

Multicurrency Account Sets
If you use multicurrency accounting, you assign a currency code to each
account set to identify the currency used by the vendors you will assign
to the set. Once you save (add) an account set, you cannot change its
currency.
Multicurrency account sets that do not use the functional currency also
include the accounts to which you post gains and losses that result when
you revalue Accounts Payable transactions at new exchange rates:
Unrealized Exchange Gain (available only if you use the Realized
and Unrealized Gain/Loss accounting method)
Unrealized Exchange Loss (available only if you use the Realized
and Unrealized Gain/Loss accounting method)
Exchange Gain

Exchange Loss
Exchange Rounding
These general ledger accounts must allow the account set's currency.
The general ledger accounts you assign to multicurrency account sets
depend on the type of currency information you require in your general
ledger. For example, you might use a separate Payables Control account
for each currency, but use the same numbers for the rest of the accounts
in all your account sets.
If you use the same account number for all the unrealized and realized
exchange gains and losses accounts, the balance in that account in your
general ledger will be the net exchange gain or loss on Payables
transactions.

Editing Account Sets
You can change everything in most records except the identifying code.
To change the code, you first add a record with the code you want to use,
then delete the record with the code you do not want.
If you use multicurrency accounting, you cannot change the currency
code assigned to an account set.

Deleting Account Sets
You can delete account sets only when they are not assigned to vendors
or vendor groups.
If you want to delete a code that is assigned to a vendor group or vendor
record, you must first assign a different account set to the vendor record,
then delete the unwanted code.
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Adding or Modifying an Account Set
You use the A/P Account Sets screen to create groups of general ledger
account numbers that you can use to categorize vendor transactions
when they are posted in general ledger.
You must create at least one account set before you can add vendor
records.
Before you start
To add a new account set:
1. Open Accounts Payable > A/P Setup > Account Sets.
2. On the screen that appears, enter information in the following fields:
Account Set Code. Type a code, up to six characters, to identify
the account set.
Description. Type a description of the account set.
Currency Code. If this is a multicurrency account set, type the
currency code, or use the Finder to select it.
Note: You cannot change the currency code after you add the set.
General Ledger Accounts. Type or select the general ledger
account numbers that make up the set. If you use Sage 300 ERP
General Ledger, you can select the account numbers from the
Finder.
In a multicurrency account set that does not use the functional
currency, you must also enter the currency code and account
numbers for the exchange gain, exchange loss, and exchange
rounding accounts.
3. When finished, click the Add button.
To edit an account set:

1. Open Accounts Payable > A/P Setup > Account Sets.
2. Select the account set you want to change.
3. Make your changes.
Note: If you use multicurrency accounting, you cannot change the
currency code assigned to an account set.
4. Click Save.
To delete a terms code:
1. Open Accounts Payable > A/P Setup > Account Sets.
2. Select the account set you want to delete.
3. Click Delete.
If a message appears asking you to confirm the deletion, click Yes.
After adding, editing, or deleting account sets
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Distribution Codes
A distribution code is a name for a single general ledger account.
Distribution codes provide an easy way to specify account numbers when
you distribute purchases, because you can make them shorter—and
easier to remember—than the general ledger account numbers.
About Distribution Codes
Adding or Modifying a Distribution Code
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About Distribution Codes
A distribution code is a name for a single general ledger account.
Distribution codes provide an easy way to specify account numbers when
you distribute purchases, because you can make them shorter—and
easier to remember—than the general ledger account numbers.
Accounts Payable lets you distribute transactions by distribution set (a
group of distribution codes), by distribution code, or by general ledger
account number. You select a default distribution method for each vendor
in the vendor records.
Once you define distribution codes, you can group them in distribution
sets, to provide sets of default distributions for assignment to vendors.

Posting Transactions with Distribution Codes
When you post invoice and adjustment batches, Accounts Payable
creates general ledger transactions for the accounts represented by
distribution codes, and lists the information on the posting journals.

Effects of Changes
You can change the description and the general ledger account number
assigned to a distribution code, but you cannot change the distribution
code.
If you change the general ledger account assigned to a distribution code,
the new general ledger account is used only in transactions you add after
making the change. Existing transactions will be posted to the original
general ledger account, unless you edit the transactions to enter the new
account number.
If you change the general ledger account assigned to a distribution code,
the new account number is automatically entered in any distribution set
records that use the distribution code.
Making a distribution code inactive has the following consequences:
You cannot select an inactive distribution code as the default code
when adding a new vendor group or vendor record.
You cannot update a vendor group or vendor record that uses an
inactive distribution code.
You cannot assign the inactive distribution code to items, or use it
when you add an invoice. (But you can print and post the invoice if
you made the distribution code inactive after you entered the
invoice.)
You cannot add or save changes to a distribution set that includes an
inactive distribution code.

Deleting Distribution Codes
Deleting codes does not remove any information from your ledger
(except the code definition). If you accidentally delete a code, just add it
again.
Note: Accounts Payable does not stop you from deleting a code which
is part of a distribution set, or a code which is assigned to a vendor
record. However, if you delete a distribution code, that code will be
rejected when you try to distribute an invoice using the code (even if
you are using the code in a distribution set).
Deleting a code after adding an invoice (but before posting it) has no
effect on posting. However, you will have to change the code if you edit
the invoice, because you cannot save changes to an invoice that uses a
deleted distribution code.
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Adding or Modifying a Distribution Code
You use the Distribution Codes screen to add distribution codes. For
each record you enter a unique code, up to six characters, a description
(name) for the code, and the general ledger account number that the
code represents.
You can define as many distribution codes as you need to represent the
various general ledger accounts to which you distribute purchases.
Before you start
To add a distribution code:
1. Open Accounts Payable > A/P Setup > Distribution Codes.
2. On the screen that appears, enter information in the following fields:
Distribution Code. Type a code, up to six characters, to identify
the distribution code.
Description. Type a description of the distribution code.
G/L Account. Enter the general ledger account number to which
amounts posted with the distribution code are distributed. If you use
Sage 300 ERP General Ledger, you can select the general ledger
account number from the Finder.
Discountable. Select this option if you want invoice, credit note,
debit note, and recurring payable details that use this distribution
code to be discountable by default. (You can change the
Discountable status when you enter a detail.)
3. When finished, click Add.
To edit a distribution code:
1. Open Accounts Payable > A/P Setup > Distribution Codes.
2. Select the distribution code you want to change.
3. Make your changes.

4. Click Save.
To delete a distribution code:
1. Open Accounts Payable > A/P Setup > Distribution Codes.
2. Select the distribution code you want to delete.
3. Click Delete.
If a message appears asking you to confirm the deletion, click Yes.
After adding, editing, or deleting distribution codes
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Distribution Sets
Distribution sets are groups of distribution codes or accounts.
For example, if you typically distribute invoices from vendors to three
different accounts, you can define three distribution codes, then define
one distribution set that includes the three codes. You then assign the
distribution set to vendor accounts.
About Distribution Sets
Adding, Editing, or Deleting Distribution Sets
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About Distribution Sets
You can define as many distribution sets as you need to represent the
various combinations of general ledger accounts to which you post
invoice data.
For each distribution set, you enter a unique code, up to six characters, a
description (name) for the code, the method for distributing the amounts
(Manual, Spread Evenly, Fixed Percentage, or Fixed Amount) and the list
of distribution codes (or General Ledger accounts) in the set.
Accounts Payable also lets you enter particular General Ledger
accounts, as well as distribution codes, in distribution sets.
You do not have to add distribution sets, but it is more efficient to enter a
single distribution set rather than several distribution codes or accounts
when you add a transaction.

Editing a Distribution Set
You can change the description, the distribution method, the list of
distribution codes, and the accounts in a distribution set, but you cannot
change the code that identifies the distribution set.
If you want to reuse the description and discount status from an existing
distribution code, add the distribution code to the distribution set. Then
clear the Dist. Code field, and enter the G/L account you want to use.
(You cannot change the account for a line to which a distribution code is
assigned.)

Effects of Changes
If you make a distribution set inactive:
You cannot select the inactive distribution set as the default set when
adding a new vendor group or vendor record.
You cannot save changes to a vendor group or vendor record that is
assigned the inactive distribution set.
You cannot use the inactive distribution set when you add an invoice.
(But you can print and post transactions that include the distribution
set if you made it inactive after you entered the transaction.)
If you change the accounts for a distribution code, Accounts Payable
immediately updates the distribution sets that use the those codes when
you save the changes.

Deleting Distribution Sets
Deleting sets does not remove any information from your ledger (except
the set definition). If you accidentally delete a set, just add it again.
You cannot delete a distribution set if it is assigned to a vendor record.
You must assign a different distribution set to the vendor first.
Deleting a set after adding an invoice (but before posting it) has no effect
on posting. However, you will have to change to a valid set if you edit the
invoice.

Related Topics

Home > Setting Up Accounts Payable > Setting Up and Maintaining Processing Records >
Distribution Sets > Adding, Editing, or Deleting Distribution Sets

Adding or Modifying Distribution Sets
You use the Distribution Sets screen to add distribution sets.
Before you start
To add a distribution set:
1. Open Accounts Payable > A/P Setup > Distribution Sets.
2. For each distribution set, enter the following information:
Distribution Set.Enter a code to identify the distribution set, using up
to six characters.
Description.Type a description of the distribution set.
Distribution Method. Select the method by which to apportion an
invoice amount among the accounts in the distribution set:
Spread Evenly. This method divides the invoice amount evenly
among all the distribution codes in the distribution set. You can then
edit the result.
Fixed Percentage. This method lets you specify the percentage of
the total invoice amount to allocate to each distribution code. You
can specify a negative percentage or a percentage more than
100%. You can also edit the results of this distribution method.
Manual. This method provides no amount allocation; it just enters
the distribution codes and lets you enter the amounts of the
distribution.
Fixed Amount. This method distributes a specific amount to each
distribution code in the distribution set. You must specify a currency
code to use this method, and you can select the distribution code
only for vendors that use this currency. You can edit the result.
Note: The setting you select determines the default invoice
distribution, which you can override at invoice entry.
Distribution Code.Type the distribution code you want to add to the

distribution set or select the code from the Finder. Once you enter the
code, Accounts Payable displays the code description and general
ledger account number so you can verify them.
If you are adding to an existing list of codes, press the Insert key to
start a new line.
Distribution Amount. If you selected Fixed Amount as the
distribution method, enter the amount to allocate to the distribution
code.
Distribution Percent. If you selected Fixed Percentage as the
distribution method, enter the percentage of the document total to
distribute to each distribution code you add to a set.
You can use negative percentages and percentages greater than 100
percent, providing the total is 100 percent.Accounts Payable warns
you if the percentages you enter for a distribution set do not add up
to 100 percent, but lets you add or save the record.
Use this type of distribution set when you need to enter additional
general ledger account distributions with invoices, but do not want to
include the extra accounts in the distribution set.
3. When finished, click the Add button.
4. Repeat steps 2 and 3 for each distribution set you want to add.
To edit a distribution set
1. Open Accounts Payable > A/P Setup > Distribution Sets.
2. Enter the code for the distribution set, or select it from the Finder.
3. Make the changes you need.
Tip:
To reuse the description and Discountable status from an existing
distribution code:
a. Insert the code in the distribution set, as usual.
b. Clear the code by double-clicking the Dist. Code field, then

pressing the Delete key.
c. In the G/L Account field, enter the General Ledger account you
want to use.
4. Click Save to record the changes.
To delete a distribution set
1. Open Accounts Payable > A/P Setup > Distribution Sets.
2. Enter the code for the distribution set, or select it from the Finder.
3. Click Delete.
If a message appears asking you to confirm the deletion, click Yes.
After adding distribution sets
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E-mail Messages
You use the A/P E-mail Messages screen to create standard messages
to send with e-mailed statements, letters, and invoices.
About E-mail Messages
Substitute Variables for Use in E-mail Messages
Adding E-mail Messages
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About E-mail Messages
You use the E-mail Messages screen to create standard messages to
send with e-mailed letters.
You can use variables (field names) from your company database to
include vendor- or company-specific information on the messages.
You identify each e-mail message with a unique 16-character Message
ID code. When you select Vendor as the Delivery Method on the
Letters/Labels screen, you can select message codes for the message
you want to send with e-mailed letters.

Variables for E-mail Messages
If you use variable names from your company database in the subject
line or in the body of e-mail messages that you set up for use with letters,
the program substitutes (or “merges”) vendor- or company-specific
information in the e-mailed messages.
For a list of the variables you can use with e-mail messages, see E-mail
Message Variables.
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E-mail Message Variables
A variable is a field name from your company database that can be
replaced with specific terms or values from your company records.
You can use variables in the subject line and body of e-mail messages
you create to send with letters to vendors. Accounts Payable substitutes
vendor- or company-specific information when you specify an e-mail
delivery method and code when printing letters.
Example: In an e-mail message to a company where the specified
vendor contact is Mr. Carl Jenner, the line "Dear
$VENDOR_CONTACT" is replaced with "Dear Mr. Carl Jenner" when
the message is sent.
You can use the following Accounts Payable variables in all e-mail
messages.
Common E-mail Message Variables
Value to Insert
E-mail Message Variable
Company contact

$COMPANY_CONTACT

Company name

$COMPANY_NAME

Company fax number

$COMPANY_FAX

Company telephone number $COMPANY_PHONE
Vendor ID

$VENDOR_ID

Vendor contact

$COMPANY_CONTACT

Vendor name

$VENDOR_NAME
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Adding or Modifying E-mail Messages
You use the E-mail Messages screen to create standard messages to
send with letters that you e-mail to your vendors.
Before you start
To create a message that you can use with letters that you e-mail to
vendors:
1. Open Accounts Payable > A/P Setup > E-mail Messages.
2. In the Message ID field, type a code to identify the message, using
up to 16 characters.
3. In the Description field, type a description for the message, using up
to 60 characters.
4. In the E-mail Subjectfield, type the subject line to use for e-mailed
messages that use this message ID.
5. Enter the body of the message in the text box.
Note: You can use field names, preceded by a dollar sign to insert
vendor- or company-specific information in the subject line and
body of messages.
6. Click Add when you are satisfied with your message.
To modify an e-mail message:
1. Open Accounts Payable > A/P Setup > E-mail Messages.
2. In the Message ID field, type the message ID, or use the Finder or
the navigation buttons to select the code for the message you want to
change.
3. Make your changes.
4. Click Save.
To delete an e-mail message:

1. Open Accounts Payable > A/P Setup > E-mail Messages.
2. In the Message ID field, select the code for the message you want to
delete.
3. With the message displayed, click Delete.
After adding, editing, or deleting e-mail messages
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Optional Fields
Optional fields are available if you purchased and activated Sage 300
ERP Transaction Analysis and Optional Field Creator.
Accounts Payable optional fields let you customize your Accounts
Payable system by letting you store an unlimited amount of additional
information with vendor records and transaction details.
About Accounts Payable Optional Fields
Adding or Modifying an Optional Field
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About Accounts Payable Optional Fields
Note: Optional fields are available if you use Sage Transaction Analysis
and Optional Field Creator.
You can customize your Accounts Payable system by using optional
fields to store additional information that you want to keep with vendor
records and transaction details.
Optional fields also provide an additional means of analyzing vendors
and transactions in Accounts Payable. You can include optional field
information when you print lists of vendors, vendor groups, remit-to
locations, and recurring payables. In addition, you can select aging
reports and reports of vendor transactions by optional fields.
If you use exactly the same optional fields in Accounts Payable and
General Ledger, General Ledger will retain the optional field information
sent with transactions that you generate in Accounts Payable.
You can use an unlimited number of optional fields in Accounts Payable.
However, you must first define optional fields for your Sage 300 ERP
system using the Optional Fields screen in Common Services. For more
information about setting up optional fields in Common Services, see the
System Manager help.
Once you have set up optional fields for your Sage 300 ERP system, you
use the A/P Options screen in the A/P Setup folder to define optional
fields for use with the following Accounts Payable records and
transactions:
Vendors and vendor groups
Remit-to locations
Invoices (including interest and recurring payable invoices)
Invoice details
Adjustments
Payments
Revaluation

You can then assign the optional fields to particular setup records
(vendor, vendor group, remit-to location, and recurring payable records)
in Accounts Payable.
You can also assign optional fields that you set up for use in transaction
entry screens to particular transactions (adjustments, invoices,
payments) and invoice details.
Note: The Recurring Payables setup screen uses the same optional
fields you assign to Invoice Entry.

Validating Optional Field Entries
Optional fields may use validation, which limits the values that can be
entered in the fields:
If the optional field is validated, you must specify a value that is
defined for the optional field in Common Services.
Note: If the optional field allows blanks, you can leave the value
field blank.
If the optional field is not validated, you can enter any value that is
consistent with the type of field (such as yes/no, text, number, date,
or amount), providing the value you enter does not exceed the length
permitted for the field. You can also leave the field blank.
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Adding or Modifying an Optional Field
Note: Optional fields are available if you use Sage Transaction Analysis
and Optional Field Creator.
Optional Fields let you store custom information with records and
transactions. You can define an unlimited number of optional fields for
each type of Accounts Payable record or transaction, providing the
optional fields are set up in Common Services for use in your system.
You can change the default value and Auto Insert status for an optional
field at any time. If the field is validated, you must select a value that is
defined for the optional field in Common Services.
Any change you make to an optional field affects only records or
transactions added after you make the change.
Before you start
To set up an optional field for use in Accounts Payable:
1. Open Accounts Payable > A/P Setup > Optional Fields.
2. In the Optional Fields For field, select the type of record or
transaction for which you are defining the optional field. More...
3. Use the Finder to select the optional field code or codes you want
to use for the selected type. The program displays the description for
the optional field you select.
Note: If you want to retain Accounts Payable optional field
information when you create batches for General Ledger, you must
use the same optional fields for transactions in Accounts Payable
as you use in General Ledger.
4. If you want to specify a default value for the optional field:
a. Double-click in the Value Set column to set the field to “Yes” for a
selected optional field.

b. In the Default Value field, enter or select the value that the
program will display as the default for the optional field. More...
When you specify a value from Common Services, the program
displays the description for the value.
5. To indicate that the optional field must be used in the records and
transactions for which it is created, double click the Required field.
During data entry, if an optional field is required and does not have a
default value, you must fill in the field before you can proceed.
6. To display the optional field and its default value when you set up
new records or enter transactions on the screen for which you are
defining the optional field, select Yes in the Auto Insert field.
7. Click the Settings button, if it is available, to specify additional
settings for the optional field.
A separate screen appears, listing all the groups of accounts that are
affected when you post transactions of the type for which you are
defining the optional field. Use the screen to specify:
The account groups for which values pass to General Ledger when
you post transactions that include the optional field.
Whether Accounts Payable passes optional field information for job
related transactions to Project and Job Costing, if you use Sage
300 ERP Project and Job Costing.
Note: If the optional fields in the posted transactions match the
optional fields defined for billings in Project and Job Costing, the
optional field information is sent to that program.
8. Click Add (or Save).
To edit an optional field:
1. Open Accounts Payable > A/P Setup > Optional Fields.
2. In the Optional Fields For field, select the type of record or
transaction for which you are defining the optional field.

3. Make the changes you need on the table.
4. Use the Settings button to select the type of General Ledger
accounts to which optional field information can be passed, or to
indicate whether optional field information can be passed to Project
and Job Costing.
5. Click Save to record the changes.
To delete an optional field:
1. Open Accounts Payable > A/P Setup > Optional Fields.
2. In the Optional Fields For field, select the type of record or
transaction for which you want to delete an optional field.
3. On the table, select (highlight) the optional field that you want to
remove.
4. Click the Delete button, or press the Delete key on your keyboard.
If a message appears asking you to confirm the deletion, click Yes.
After adding, editing, or deleting optional fields
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Payment Codes
You can enter all types of payments in Accounts Payable, including cash,
checks, credit cards, and the other ways that you pay vendors, or that
vendors refund payments to you. Accounts Payable uses the payment
code you enter during payment entry to add information automatically
about the type of payment.
Your Accounts Payable system must contain at least one payment code
before you can add payment transactions.
About Payment Codes
Adding or Modifying a Payment Code
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Payment Codes > About Payment Codes

About Payment Codes
You can enter all types of payments in Accounts Payable, including cash,
checks, credit cards, and the other ways you pay your vendors.
You use the A/P Payment Codes screen to create codes that identify
each type of payment you make. During payment entry, you simply enter
the code, and Accounts Payable adds the information about the type of
payment.
Tip: Consider batching payments by payment code.
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Adding or Modifying a Payment Code
Before you start
To add a payment code:
1. Open Accounts Payable > A/P Setup > Payment Codes.
2. In the Payment Code field, type an identifying code, using up to six
characters, and then press the Tab key.
3. Type a description for the payment code, such as the name of the
credit card.
4. For the payment type, select Cash, Check, Credit Card, or Other.
5. Click Add.
To edit a payment code:
1. Open Accounts Payable > A/P Setup > Payment Codes.
2. Select the payment code you want to change.
3. Make your changes.
4. Click Save.
To delete a payment code:
1. Open Accounts Payable > A/P Setup > Payment Codes.
2. Select the payment code you want to delete.
3. Click Delete.
If a message appears asking you to confirm the deletion, click Yes.
After adding, editing, or deleting payment codes
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Payment Selection Codes
When you create an automatic payment batch with Accounts Payable,
you specify a payment selection code for the batch, which contains
criteria for selecting vendors and invoices to pay.
About Payment Selection Codes
Adding Payment Selection Codes
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About Payment Selection Codes
When you create an automatic payment batch with Accounts Payable,
you specify a payment selection code for the batch, which contains
criteria for selecting vendors and invoices to pay.
Payment selection codes are identified by codes of up to six characters
(letters and digits). The rest of the selection record defines the criteria for
selecting—or excluding—vendor invoices for payment.
Payment selection codes define the following elements:
The bank on which the checks are drawn.
How you select invoices (by due date, discount date, or due date and
discount date).
Whether you pay all documents or forced documents only.
The range of vendor groups.
The range of vendors.
The range of account sets.
The range of check amounts (for example, so you could pay all the
small outstanding amounts first).
Vendors you want to exclude from the payment selection.
The bank currency (multicurrency ledgers only.
The vendor currency (multicurrency ledgers only).
Exchange rates between the bank currency and functional currency
and between the vendor currency and functional currency (if you
have a multicurrency ledger).
You create payment selection codes using the Payment Selection Codes
screen.
You cannot use the Create Payment Batch screen to generate checks
unless you have defined at least one payment selection code.
You can change the payment selection criteria after you enter the
payment selection code in the Create Payment Batch screen. So, if your
payment selection needs are fairly simple (for example, if you use only

one bank and have a small number of vendors), you may define only one
code and modify it if you are generating a special check run.
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Adding Payment Selection Codes
You must create at least one payment selection code if you want
Accounts Payable to generate payments for invoices automatically.
Note: You do not have to create payment selection codes if you intend
to enter all your payments individually to a batch using the Payment
Entry screen.
Before you start
To add payment selection codes:
1. Open Accounts Payable > A/P Setup > Payment Selection
Codes.
2. In the Selection Code field, enter or select a code to identify the
payment selection criteria (such as “ALL” if you are defining only
one).
3. In the next field, type a description for the code.
4. Complete the Select tab as follows:
Pay From Bank. Select the bank on which you are writing the
checks.
Select Vendors With This Bank Code Only. This option restricts
the payment selection to vendors that specify this bank in their
vendor records.
If you have a multicurrency ledger, you also select the bank
currency and the vendor currency.
All checks in a batch must be:
Drawn on the same bank.
In the same check currency.
For vendors with the same source currency.
Bank Currency. This is the check currency. You can only use one

in a batch.
Rate Type (Bank). If the bank currency is different from your
functional currency, you can enter or select the exchange rate type
you want to use. (You can override this rate when you create a
payment batch.)
Vendor Currency. All the vendors must use the same source
currency. However, you do not have to specify the currency in the
selection criteria record; you can select it when yo generate
payments.
Rate Type (Vendor). If the vendor currency is different from your
functional currency, you can enter or select the exchange rate type
for converting vendor currency to functional currency.
Apply Method. Specify how to apply partial payments to invoices
that use different contracts, projects, and categories. More...
Note: The apply method affects only job‑related invoices for which
the applied amount is less than the current balance.
5. Fill in the Criteria tab as follows:
Select Documents By. Specify how to select documents for
payment. More...
Pay All Selected Documents / Only Forced Documents. Specify
whether to pay all documents in the selection, or only transactions
that have a Forced status. (You use the Control Payments screen
to place invoices on hold or force their payment.)
Vendor Selection Range. Specify the range of vendor groups,
vendor numbers, account sets, vendor (check) amounts, payment
codes, and (if you use optional fields) a vendor optional field from
which you want to choose documents for payment.
Specifying a range of vendor amounts lets you maintain different
procedures for smaller checks.
Note: You can select a vendor optional field only if you use Sage
Transaction Analysis and Optional Field Creator and you have
defined optional fields for vendors. If you specify an optional field,

additional fields appear, letting you specify a range of values for
the field. If you do not want to use an optional field as a criterion,
accept None, the default setting for this field.
6. On the Exclusion tab, list any vendors that you want to exclude from
the payment run.
7. If you use Sage Transaction Analysis and Optional Field Creator and
you want to assign optional fields to this payment selection code,
click the Optional Fields tab.
Any optional fields set up for automatic insertion on payments appear
on the table, along with their default values.
You can accept, change, or delete these entries. You can also add
any other optional fields that are defined for payments.
Note: If you delete an automatically inserted optional field, the
program reinserts the optional field with its default value when you
create a batch using the payment selection code.
8. When ready, click the Add button.
9. Repeat the preceding steps for each payment selection code you
want to add.
After adding payment selection codes
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Terms
You use the A/P Terms screen to define all the terms Accounts Payable
uses to determine invoice due dates, set the rates and eligibility periods
of discounts for early payment, and calculate discount bases.
You assign a terms code to each vendor record to set the default terms
that appear when you enter invoices for the vendor.
You must define at least one set of terms before you can add vendor
records.
About Terms Codes
Adding or Modifying a Terms Code
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About Terms Codes
You must add at least one terms code before you can enter Accounts
Payable transactions.
For each terms code you:
Define the payment terms by which your vendors calculate invoice
due dates.
Specify the method used to calculate discount periods and discount
amounts on invoices from vendors who offer discounts for early
payment.

Installment Payments
A set of terms can be as simple as a due date and discount date and
rate, or they can include payment schedules to allow for installment
(timed) payments.
When you enter invoices for a multiple payment schedule, Accounts
Payable automatically calculates the schedule, but you can change
schedule amounts or due dates for each invoice. For example, you can
specify that the first payment is not due for a year from the invoice date.

Setting Up Installment Terms
You use the Multiple Payment Schedule option to set up a terms code
that allows installment payments. You can define installment periods that
vary in length, and use different methods to calculate due dates and
discounts. You can also set up as many installment periods for a terms
code as you need.

Calculating Discounts Before or After Tax
If you pay tax on purchases, you can specify whether to include tax in the
document total that Accounts Payable uses to calculate discount
amounts

Using Standard Due Dates

Standard due dates are similar to "day of the month due," except they do
not restrict you to a single due date. For example, you can use standard
due dates to assign invoices to the 15th or 30th of each month.
If your vendor uses standard due dates, you can create a terms code
table to calculate a due date for each of up to four ranges of days on
which invoices were issued.
For example, your table could specify that invoices entered between the
1st and 15th of each month are due on the 30th of the month, and that
invoices entered between the 15th and the end of the month are due on
the 15th of the next month.
You define standard due dates with a table that lets you specify a due
date for each of up to four ranges of days on which invoices were issued.
You can also specify due dates that are one or more months later.
When you use due date tables, you can either define discount periods in
the same way as for other terms options, or you can enter a table of
standard discount periods.

Assigning Terms to Vendor Records
You assign a terms code to each vendor record to set the default terms
that appear when you enter transactions for the vendor. You can choose
different terms for the vendor during transaction entry without changing
the standard terms assigned in the vendor record.

Using Terms with Transactions
When entering transactions, you enter a terms code with each invoice,
and Accounts Payable automatically does all the required calculations.

Editing Terms Codes
You can change all the information in a terms code record except the
terms code.

Effects of Changes
If you make a terms code inactive:

You cannot select an inactive terms code as the default code when
adding a new vendor group or vendor record.
You cannot update a vendor group or vendor record that uses an
inactive terms code.
You cannot use the inactive terms code when you add an invoice.
(But you can print and post invoices you entered with the terms code
before you made the code inactive.)
Other changes you make to terms codes have no effect on existing,
unposted documents that use the codes. If you want to use changes
such as new discount percentages on existing unposted invoices, you
must edit the invoices to enter the new information for the terms code.

Deleting Terms Codes
Deleting payment terms does not remove any information from your
ledger (except the terms definition). If you accidentally delete a payment
terms code, you can just add it again.
Deleting a payment term after adding an invoice (but before posting it)
has no effect on posting. However, you must specify a different code if
you edit the invoice (because you cannot save changes to the invoice if
the terms code is invalid).
Accounts Payable prevents you from deleting a terms code that is
assigned to a vendor record.
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Adding or Modifying a Terms Code
You use the A/P Terms screen to set up codes for your vendors' payment
terms.
You assign a terms code to each vendor record to set the default terms
that appear when you enter transactions for the vendor. However, you
can specify different terms during transaction entry.
Changes you make to terms codes have no effect on existing, unposted
documents that use the codes. You must edit invoice batches to register
changes such as new discount percentages and dates.
Note: You must add at least one terms code before you can enter
Accounts Payable transactions.
Before you start
To add a terms record:
1. Open Accounts Payable > A/P Setup > Terms.
2. In the Terms Code field, enter the identifying code.
3. Press the Tab key, and then type a description for the terms code.
4. For the Calculate Base For Discount With Tax option, specify
whether to include tax amounts in the invoice totals on which
discount amounts are calculated. More...
5. If you want to allow payment by installments with this code, select the
Multiple Payment Schedule option. Then select the due date type
and enter information for each payment.
6. In the Due Date Type field, select the method by which you calculate
invoice due dates. More...
7. In the Discount Type field, select the method you use to calculate
the last day on which your vendors let you take a discount for prompt
payment. If your vendors do not offer discounts, ignore the discount
fields and columns. More...
8. Click Add.

To edit a terms code:
1. Open Accounts Payable > A/P Setup > Terms.
2. Use the Finder or the navigation buttons for the Terms Code field to
select the terms code you want to change, or type the code in the
field.
3. Make your changes.
4. Click Save.
To delete a terms code:
1. Open Accounts Payable > A/P Setup > Terms.
2. Use the Finder or the navigation buttons for the Terms Code field to
select the terms code you want to delete, or type the code in the field.
3. Click Delete.
If a message appears asking you to confirm the deletion, click Yes.
After adding, editing, or deleting terms codes
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Customizable Formats for Printed Accounts
Payable Forms
Accounts Payable includes sample checks and payment advices, letters,
labels, and 1099/1096 and T5018 (CPRS) reports. You may be able to
use these sample formats "as is," or adapt them to print on the forms you
use.
Before entering or processing transactions, you should set up and test
the formats you want to use for printing these forms.
You use Crystal Reports to design or edit formats for printing Accounts
Payable reports and forms. (Crystal Reports is available separately.)
Accounts Payable includes Crystal (.RPT) versions of the following
printed forms:
File Name
AP1099

Forms Included with Accounts Payable
Description
Sample 1099 format for laser printers.
Only standard 1099-MISC codes are printed on the
stock report.
Important! This format was valid at the time this
program was released. If the form changes, you can
update the report format using Crystal Reports.

AP1096

Sample 1096 format for laser printers.
Important! This format was valid at the time this
program was released. If the form changes, you can
update the report format using Crystal Reports.

APCHECK

Advice-only form for laser printers.

APCHK01

Advice-check-advice form for laser printers.

APCHK01A

Similar to APCHK01. The check portion is ANSIcompliant.
For more information, see About Clearing Checks
Electronically.

APCHK02

Advice and check.

APCHK03

Check-advice-advice.

APCHK11

Check-advice-advice for 11-inch check forms.

APCHK11A

Similar to APCHK11. The check portion is ANSIcompliant.
For more information, see About Clearing Checks
Electronically.

APCHK14

Check-advice-check-advice for 14-inch forms.

APCPRS

Sample T5018 (CPRS) format for laser printers.
Important! This format was valid at the time this
program was released. If the form changes, you can
update the report format using Crystal Reports.

APLBL01

Sample labels, approximately 6.5 cm by 2.5 cm, which
are designed to fit a tab of 30 labels arranged in 3
columns

APLETT01

Sample letter.

Modifying Reports
For information about how to customize forms, see the online document
Customizing Printed Forms with SAP Crystal.
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About Clearing Checks Electronically
The American National Standards Institute standard facilitates the
conversion of checks to electronic images so that they can be cleared
electronically. You can print ANSI-compliant refund checks for the US and
Canada.
The ANSI format has a slightly different layout from other printed forms,
as follows:
The date is printed in one of the formats DDMMYYYY, MMDDYYYY,
YYYYMMDD, depending on your windows setup.
The currency code and currency symbol (for example, $) is printed
before the check amount, depending on the currency setup in
Common Services.
The text version of the amount prints "Dollars."
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Setting Up and Maintaining Vendor Records
After setting up processing records, such as the account sets, terms
codes, payment codes, and distribution codes that you assign to vendor
records, you can add vendor records to Accounts Payable.
Use the screens in the A/R Vendors folder to add the following types of
records for vendors:
Vendor groups
Vendors
Remit-to locations
Recurring payables
Vendor Groups
Vendors
Remit-To Locations
Recurring Payables
Inquiring on Vendors
About Entering Current and Historical Transactions
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Vendor Groups
You use vendor groups to classify your vendor records into groups that
share similar characteristics, such as geographical location.
You must define at least one vendor group before you can add vendor
records.
About Setting Up Vendor Groups
Adding, Modifying, or Deleting a Vendor Group
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About Vendor Groups
You use vendor groups to classify your vendor records into groups that
share similar characteristics. You define vendor groups adding vendor
records.
Vendor groups let you:
Set default entries to speed up the task of adding vendor records.
Select accounts for payment. (The vendor group is one of the
selection criteria.)
Select vendors on reports. (Vendor transactions, aged payables,
aged cash requirements, letters, and labels can all be printed for a
range of vendor groups.)

About Setting Up Vendor Groups
You must define at least one vendor group, and you may define multiple
vendor groups.
You use the Vendor Groups screen to define the vendor groups you
need.
To define a vendor group, you must:
Assign a unique code, up to three characters, to identify the group.
Select the account set, terms code, and bank code to use as the
default selections for the vendor records you will add to the group.
Specify the method for distributing transactions to general ledger
accounts. You can distribute invoices by distribution set, distribution
code, or general ledger account.
Specify a default code for the distribution method. For example, if you
select G/L Account, you must specify the default general ledger
account to which you want to distribute amounts.
If you have a multicurrency ledger, specify the default rate type for
vendors in the group.
Choose whether to check for duplicate invoices with the same vendor
and amount or same vendor and date.
Choose whether to generate separate payments for each invoice, or
pay several invoices with a single check.
Set default entries for vendor optional fields.
Select the default tax group for vendors in the vendor group. You
must also enter a tax class for each tax authority in the group, and
indicate whether tax is usually included in the invoice details.
Specify whether the vendors in this group are subject to 1099/CPRS
reporting. (You can override this choice for individual vendors.)
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About Editing Vendor Groups
You can change most of the information in a vendor group record, with
the following restrictions:
You cannot change the vendor group code.
In a multicurrency ledger, you cannot change the account set to one
that uses a different currency.
You can edit vendor group statistics only if the Allow Edit Of
Statistics option is selected on the A/P Options screen. For more
information, see A/P Options Screen.
Most changes you make to a vendor group affect only the vendor records
you add to the group after making the changes. The only exception is if
you set the status of the group to Inactive. If you assign Inactive status to
the group, you cannot:
Add new vendors to the group.
Change any of the vendor records assigned to the group (except to
change their vendor group).
Tip: If you need to make the same change to a number of vendor
groups, use Sage 300 ERP's macro facility. For more information, see
the System Manager Help.

Optional Fields
If you use Sage 300 ERP Transaction Analysis and Optional Field
Creator, you can use the Optional Fields screen to define vendor optional
fields, marking for automatic insertion the ones you want to use as
defaults when you add new vendor group records. For more information,
see A/P Optional Fields Screen.
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Adding, Modifying, or Deleting a Vendor Group
You use the A/P Vendor Groups screen to add records for vendor groups
to Accounts Payable. You must add at least one vendor group record
before you can add vendor records.
You can change the information in a vendor group record at any time,
with some restrictions. More...
Note: Most of the changes you make to a vendor group record have an
effect only on new vendor records you create and add to the group,
later.
To add a vendor group record:
1. Open Accounts Payable > A/P Vendors > Vendor Groups.
2. In the Group Code field, do one of the following:
To create a completely new vendor group record, click the New
button.
To create a vendor group record based on an existing vendor group
record, enter the code for an existing vendor group, and then press
Tab.
3. In the Group Code field, enter a code for the new vendor group.
4. Complete the fields on the vendor group record.
5. Click Add.
To edit or view an existing vendor group record:
1. Open Accounts Payable > A/P Vendors > Vendor Groups.
2. In the Group Code field, specify the vendor group record you want to
edit.
3. Make the changes you need in the record.
4. Click Save.

To delete a vendor group record:
1. Open Accounts Payable > A/P Vendors > Vendor Groups.
2. In the Group Code field, specify the vendor group record you want to
delete.
3. Click Delete.
4. If a message appears asking you to confirm that you want to delete
the record, click Yes.
After modifying a vendor group record
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Vendors
You must add vendor records before you can enter and process
transactions in Accounts Payable.
About Setting Up Vendor Records
Adding, Modifying, or Deleting a Vendor Record

Home > Setting Up and Maintaining Vendor Records > Vendors > About Setting Up Vendor
Records

About Setting Up Vendor Records
Adding vendor records to Accounts Payable involves transferring your
existing vendor information to Sage 300 ERP and selecting options that
let you process payables more effectively.
You use the A/P Vendors screen to enter most of your vendor
information, including:
The vendor number (the code you use to identify the account).
Whether the account is on hold.
An optional "short name," (an abbreviation or acronym that
represents the vendor).
The vendor's name, address, Web site, e-mail address (one for the
vendor and one for your contact), and phone numbers.
The date on which you started to do business with the vendor.
Comments you want to store with the vendor record or want to print
on correspondence with the vendor, display during transaction entry,
or keep for other purposes.
Additional information your company wants to include in the optional
fields created on the A/P Options screen for your vendor records, if
you purchased the separate Optional Fields package from Sage 300
ERP.
Tip: If you have a large number of one-time vendors, you should add a
"miscellaneous vendor" record, so you can process payments using
Create Payment Batch and keep statistical data for this class of vendor.
Make sure that you select the option Generate Separate Payments For
Each Invoice for the miscellaneous vendor (on the Processing tab of the
Vendors screen).

Vendor Numbers
For each vendor record, you assign a unique vendor number, using up to
12 characters, including letters, numbers, and symbols.
If your current system for assigning vendor numbers makes sense in
Sage 300 ERP, you may want to transfer your present system. However,
we recommend that you take the time now to evaluate your current
system, because the best time to switch systems is when you already
have to recreate all your vendor records.
If you do not have an established system for assigning vendor numbers,
you should develop a system before you add any vendor records to
Accounts Payable.
Your numbering system should let you organize the records as you
require, such as alphabetically, by region, and for reporting purposes.
The system should also allow for expansion as your business grows.

Processing Options
You identify the ways in which you process transactions for each vendor,
specifying the following information:
The account set, which determines the general ledger accounts to
which the vendor's transactions are distributed. Each set includes
accounts for payables control, purchase discounts, and prepayments.
If you use multicurrency accounting, the account set also includes
unrealized and realized exchange gain and loss accounts.
The default payment terms used to calculate the due date, discount
period, and discount amount for vendor invoices.
The bank code and credit limit associated with the vendor.
The vendor bank code is the bank account on which you usually write
checks to pay the vendor.
The method for distributing invoice amounts to general ledger
accounts.
You may distribute amounts by distribution code, distribution sets, or
by general ledger account code.
How you check for duplicate vendor invoices.
Whether you pay each invoice separately or cover several invoices
with a single payment.
Tax information for vendor invoices, and whether the vendor is
subject to 1099 (for US vendors) or CPRS (for Canadian vendors)
reporting.
The tax group for the vendor determines the taxing authorities and
tax class for each authority to which you would pay tax on an invoice.
This information tells Accounts Payable how to calculate tax amounts
on the vendor's invoices.
If you use multicurrency accounting, the rate type for converting
source currencies to their functional-currency equivalents.
In addition to the information you can enter for each vendor in the

Vendors screen, Accounts Payable automatically adds the statistics it
collects from all transactions posted to each vendor account
Note: If you select the Allow Edit Of Statistics option on the
A/P Options screen, you can enter statistical figures when you are
setting up a new Accounts Payable system, and revise them as needed.
You can define additional remit-to addresses on the A/P Remit-To
Locations Screen. For more information, see Adding, Modifying, or
Deleting a Remit-to Location for a Vendor.
If you regularly pay the vendor for the same order, such as monthly rent,
you can create recurring payable records, using the Recurring Payables
Setup screen. For more information, see About Recurring Payables.

Short Names
You can enter a code or "short name" of up to ten characters for each of
your vendors. Short names are a means by which you can list vendors in
alphabetical order (or any other order) on reports, and still include the full
vendor name in the vendor record, because Accounts Payable can sort
records by short name first.
Example:
You have four vendors. When listed alphabetically, their names appear
in this order:
A. Craig & Son
Bashaw Bulldozing
Mr. Stephen Kershaw
The Garden Restaurant
You can assign short names to these vendors to change the order in
which they are listed:
Vendor name

Short name

Bashaw Bulldozing

BASHAW

A. Craig & Son

CRAIG

The Garden Restaurant GARDEN
Mr. Stephen Kershaw

KERSHAW

You can print short names on vendor statements. You might then want to
use them for a purpose that is unrelated to vendor names.
You may have designed your vendor numbers so that they list vendors in
alphabetical order or in another order that meets your requirements. In
that case, you might choose not to use short names at all.

Inactive and On Hold Account Statuses
You can change the status of a vendor account to either of the following:
Inactive. You can set a vendor record inactive prior to deleting it, to
ensure that no further transactions are processed for the account.
Note: You cannot set a vendor record inactive if there are any
unposted transactions for the vendor.
On Hold. If you place a vendor account on hold, you cannot enter
payments or prepayments for the vendor, or otherwise decrease the
balance in the vendor account, using the Create Payment Batch
screen. However, you can still create invoices for the vendor. You can
also pay the vendor using the Payment Entry screen.

Tax Information
Whether you are charged taxes on purchases or are tax exempt, you
enter all the necessary tax information in the vendor record. Accounts
Payable can then automatically calculate all the applicable taxes so you
can verify the invoices you receive from vendors.
To specify tax information in the Vendors screen, you first select the tax
group that includes the taxing authorities and tables that apply in the
vendor's geographical area. (You set up tax groups in the Tax Services
screens in Common Services.)
You then select the taxing authorities that tax sales to the vendor and the
tax class that indicates the type of sales on which the vendor is charged
tax by each authority.
If the vendor has a tax-exemption number or a registration number, such
as for the Canadian Goods and Services Tax (GST), you also enter it.
You can also include the number in the information you print on invoices
and statements.

Vendor Statistics
Accounts Payable keeps period and activity statistics for vendors, and
displays them in the Vendors screen. For more information, see About
Vendor and Vendor Group Statistics.

Reporting Tax Amounts in Statistics
The totals kept for invoices, credit notes, and debit notes can include or
exclude tax amounts posted with the document. You can also see, but
not change, the outstanding balance, open document count, current
prepayment amount, and number of prepayments for the account.

Vendor Optional Fields
If you use Transaction Analysis and Optional Fields Creator, you can
assign optional fields to store additional information you want to keep
with vendor records.
You use the Optional Fields tab in the vendor record to assign optional
fields to particular vendors.
Optional fields that are marked for automatic insertion in vendor records
appear on the tab, along with their default values. You can accept the
optional fields that are displayed as defaults, or you can delete them.
You can also assign any additional optional fields that are defined in
Accounts Payable for vendors and vendor groups. The program assigns
default values to the optional fields, as follows:
For optional fields that match those used by the vendor group, values
from the vendor group record appear as defaults.
If no default entry is specified for an optional field in the vendor group
record, the program uses the value specified in the optional fields
record.
You can accept or change the default entries. However, if the optional
field is validated, you must use a value that is defined for the optional
field in Common Services.

Retainage Options for Vendors
If you use retainage accounting in your Accounts Payable system, you
should also specify default settings for each vendor, including the
retainage percentage, retention period, and retainage terms.
When you add a new vendor, Accounts Payable displays on the Invoicing
tab of the new vendor record the default retainage percentage, retention
period, and retainage terms you specified on the A/P Options screen, but
you can change these settings for individual vendors.
When you enter an invoice, credit note, or debit note for a vendor,
Accounts Payable uses the settings from the vendor record as defaults.

Processing Vendor Comments
You can enter any number of comments in vendor records, using up to
2,509 characters for each comment.
Tip: To view an entire comment on a separate screen (rather than
having to scroll to see it), double-click in the Comment column.
When you enter a comment, you can also enter a follow-up date when
you want to check on the comment, as well as an expiration date when
you want to delete the comment. Once the expiration date is reached,
Accounts Payable automatically deletes the comment when you use the
A/P Clear History screen to clear comments for the vendor number.

About Importing Vendor Records
You can import vendor records into Accounts Payable from non-Sage
300 ERP programs, instead of entering them in the Vendors screen. For
more information, see About Importing and Setup and Vendor Records
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About Vendor Comments
On the A/P Vendors screen, you can enter comments in vendor records.
You can add any number of comments to a vendor record. Each
comment can be up to 2,500 characters long. You can also specify
follow-up and expiration dates for each comment.
You can enter a comment directly on the comment table on the Comment
tab, or you can double-click in the Comment column to open a separate
screen that lets you see the entire comment without having to scroll.

Clearing Comments
To make sure that comments are kept current, you assign a number of
days for which you will retain each one, then, when you enter a comment,
Accounts Payable adds this number of days to the comment date, and
calculates an expiration date.
When you use the Vendor Comments option on the A/P Clear History
screen, comments that have been kept past the expiration date are
deleted, saving you from having to delete each comment individually from
the vendor records.
Note: To specify the default number of days to keep comments, use the
Number of Days to Keep Comments option on the Processing tab of
the A/P Options screen.

Printing Comments
You can print comments on the Vendors report. When you choose
comments, the program lets you specify the range of follow-up dates for
which you want the comments printed.
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About Editing Vendor Records
Use the Vendors screen to edit vendor records in Accounts Payable. You
can change most of the information in a vendor record at any time, with
the following restrictions:
You cannot save changes to a vendor record if the vendor's group is
inactive.
You cannot assign a vendor to a vendor group that has an Inactive
status.
You can select Inactive status for a vendor record only if the account
has a zero balance and no outstanding transactions.
You cannot post transactions to any vendor records that are inactive.
You cannot directly change a vendor number. However, if you
accidentally add an incorrect vendor number, you can create a new
record with the correct number, then delete the incorrect record.
You can also create a new record and delete the old one if the vendor
record has a zero balance, and you have deleted paid transactions.
However, you must still edit the vendor statistics in the new record if
you want to keep statistical data, and you must transfer the
appropriate vendor group statistics if the new vendor number is
assigned to a different group.
In multicurrency ledgers, you can change the vendor group, account
set, and tax group assigned to a vendor, but only to another vendor
group, account set, or tax group that uses the same currency.
Tip: If you need to keep more than one address for a vendor, use the
Remit-To Locations screen to add any additional addresses you require.
Tip: If you need to make the same change to a number of vendor
records, use Sage 300 ERP's macro facility. For more information, see
the System Manager Help. For example, you can use a macro to
change the default entries in optional fields.

Changing the Vendor Group or Account Set
We do not recommend that you change the vendor group or account set
assigned to a vendor record to which you have posted transactions.
If you do change the vendor group, be aware that the default choices for
the new vendor group replace existing choices in the vendor record,
although you can edit the vendor record to change the new selections.
You may also need to correct statistics for the affected vendor groups.
You can edit statistics only if you have selected the Allow Edit Of
Statistics option on the A/P Options screen.
If you are changing the vendor's account set, check the vendor's account
balances.
If the vendor account has outstanding amounts, you will need to transfer
the control account balances to the new control accounts in the General
Ledger after updating the vendor record with the new account set code;
otherwise, you will have old balances that are never reconciled.
If you move vendors from one payables control account to another, check
the unpaid balance of the vendor account. You will have to transfer that
balance from the original control account to the new account.

Optional Fields
If you use Sage 300 ERP Transaction Analysis and Optional Field
Creator, you can use the Optional Fields screen to define vendor optional
fields, marking for automatic insertion the ones you want to use as
defaults when you add new vendor records. For more information, see
A/P Optional Fields Screen.
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Adding, Modifying, or Deleting a Vendor
You use the A/P Vendors screen to add records for your vendors to
Accounts Payable. You must add vendor records before you can enter
and process transactions in Accounts Payable.
You can change the information in a vendor record at any time, with
some restrictions. More...
We recommend that you do not change the vendor group or account set
assigned to a vendor record to which you have posted transactions.
More...
Before you start
To add a vendor record:
1. Open Accounts Payable > A/P Vendors > Vendors.
2. In the Vendor Number field, do one of the following:
To create a completely new vendor record, click the New button.
To create a vendor record based on an existing vendor record,
enter the code for an existing vendor, and then press Tab.
3. In the Vendor Number field, enter a code for the new vendor.
4. Complete the fields on the vendor record.
5. Click Add.
To edit or view an existing vendor record:
1. Open Accounts Payable > A/P Vendors > Vendors.
2. In the Vendor Number field, specify the vendor record you want to
edit.
3. Make the changes you need in the record.
Note:

If you change the vendor group:
Defaults for the new vendor group will be applied to the vendor
record.
Statistical comparisons between fiscal periods or between vendor
groups will be invalidated (unless you update the vendor group
statistics).
4. Click Save.
To delete a vendor record:
1. Open Accounts Payable > A/P Vendors > Vendors.
2. In the Vendor Number field, specify the vendor record you want to
delete.
3. Click Delete.
4. If a message appears asking you to confirm that you want to delete
the record, click Yes.
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Remit-To Locations
You use the A/P Remit-To Locations screen to add records for the
addresses to which you send payments and other correspondence to
vendors.
Then, you can use the remit-to location codes on Accounts Payable
invoices, and, if you also use Sage 300 ERP Order Entry, on orders,
shipments, and invoices you process in that program.
About Remit-to Locations
Adding a remit-to location for a vendor
Looking up remit-to locations for a vendor
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About Remit-to Locations
Remit-to locations are the addresses to which vendors want you to send
payments. The remit-to address may be different from the address in the
vendor record, for example, if the vendor address is just for ordering.
You use the Remit-To Locations screen to add remit-to addresses for
your vendors.

Primary Remit-To Locations
If you mark a remit-to location as the primary remit-to location (an option
in the Remit-To Locations screen), Accounts Payable will use this
location as the default address on invoices and on vendor checks.
Accounts Payable can keep an almost unlimited number of remit-to
addresses for your vendors, and you can choose the remit-to location to
use when you are entering payments.
For each remit-to location, you can:
Specify whether it is the primary location.
Set the location to active or inactive.
Specify the check language.
Enter a remit-to address.
Provide default entries for the vendor optional fields.
Note: If you use the remit-to location, these entries override the
optional field entries from the vendor record.

Specifying Remit-To Locations
When you add a remit-to location in the Remit-To Locations screen, you
assign a code that identifies the location. You then use the code to select
the location during invoice or payment entry.

Customizing Remit-To Address Information
If you use optional fields, you can use the Optional Fields screen to add
extra fields to the Optional Fields tab of the Remit-To Locations screen.
For more information, see A/P Optional Fields Screen.
If you set any remit-to location optional fields for automatic insertion, they
appear on the tab, along with their default values.
You can accept or change the optional field values. If an optional field
requires validation, you can select only a value that is assigned to the
optional field in Common Services or, if the optional field allows it, you
can leave the default value field blank.
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Adding, Modifying, or Deleting a Remit-to
Location for a Vendor
You use the A/P Remit-To Locations screens to add remit-to location
records for your vendors to Accounts Payable.
You can change the information in a remit-to location record at any time,
with some restrictions. More...
Before you start
To add a remit-to location:
1. Open Accounts Payable > A/P Vendors > Remit-To Locations.
2. In the Vendor No. field, enter the vendor number.
Remit-to locations for the specified vendor are displayed in the table.
3. Click New.
A screen appears allowing you to specify information for the new
remit-to location.
4. In the Remit-To Location field, enter a unique code to identify the
remit-to location. Also, in the field to the right, enter a description of
the remit-to location.
5. Fill out the fields on each tab.
6. Click Add.
To edit an existing remit-to location:
1. Open Accounts Payable > A/P Vendors > Remit-To Locations.
2. In the Vendor No. field, enter the vendor number.
Remit-to locations for the specified vendor are displayed in the table.
3. Select a remit-to location in the table, and then click Open.
A screen appears allowing you to edit information for the specified
remit-to location.

Tip: You can also edit other remit-to locations on this screen. To do
so, enter the code for another remit-to location in the Remit-To
Location field.
4. Make your changes.
Notes:
If you make a remit-to location inactive:
You can no longer use it when adding an invoice.
Ensure that the Primary Remit-To option is not selected.
You cannot make a remit-to location inactive if it is used on any
unposted documents.
5. Click Save.
To delete a remit-to location:
1. Open Accounts Payable > A/P Vendors > Remit-To Locations.
2. In the Vendor No. field, enter the vendor number.
Remit-to locations for the specified vendor are displayed in the table.
3. Select a remit-to location in the table, and then click Delete.
Note: You cannot delete a remit-to location if it is used on any
unposted documents.
4. If a message appears asking you to confirm the deletion, click Yes.
After adding or modifying a remit-to location
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Looking Up Remit-to Locations for a Vendor
You can use the A/P Remit-To Locations screen to view the remit-to
locations that are defined for a vendor.
To view remit-to locations for a vendor:
1. Open Accounts Payable > A/P Vendors > Remit-To Locations.
2. In the Vendor No. field, enter the vendor number.
Remit-to locations for the specified vendor are displayed in the table.
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Recurring Payables
Use the A/P Recurring Payables setup screen to create templates for
standard invoices you receive from your vendors at regular intervals,
such as charges for monthly rent.
Then, you can process the recurring payables periodically, using the
A/P Create Recurring Payable Batch screen, or, if you attached
schedules that use reminders you can process the payables directly from
the Reminder List.
About Recurring Payables
Setting Up a Recurring Payable for a Vendor
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About Recurring Payables
If you have vendors who issue standard invoices at regular intervals,
such as rent, standing orders, or services that vary little from period to
period, you can set up records for the payables using the Recurring
Payables screen.
You can also attach schedules with reminders to alert specific or all Sage
300 ERP users to process the recurring transactions when they are due.
You use the Create Recurring Payables Batch screen to create an
invoice batch automatically when the payables are due. If a recurring
payable record uses a schedule with a reminder attached, you can also
process the payable right from the Reminder List. For more information
about creating schedules and using the Reminder List, see the System
Manager help.

Specifying When to Invoice Recurring Payables
You can set up a recurring payable to be processed indefinitely, or you
can specify a limit for the payable. You can also assign a schedule to
each recurring payable, then generate an invoice for it at the frequency
determined by the schedule.

Specifying Limits for a Recurring Payable
To limit the number of times you can process an invoice for a recurring
payable, you enter a start date and, by choosing Specific Date as the
Expiration Type, you can enter an expiration date for the payable. No
invoice is created for the payable prior to its start date or after its
expiration date.
You can also specify a maximum amount that can be invoiced for a
payable. No invoices are created that would cause the total amount
invoiced to exceed this maximum for a recurring payable.

Assigning Payment Terms to Recurring
Payables
You enter a terms code for each recurring payable. The code determines
the due date for recurring payable invoices, as well as the discount
percentage and period.
Note: Once you generate an invoice, you can change the due date,
discount percentage, and period on the Invoice Entry screen. For more
information, see A/P Invoice Entry Screen.

Adding General Ledger and Tax Information
You can distribute each detail of a recurring payable to a different
distribution code or general ledger payable account, and you can specify
whether or not taxes are calculated automatically.
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Setting Up a Recurring Payable for a Vendor
You can set up recurring payable records for recurring payments you
make to a vendor.
Before you start
To create a recurring payable:
1. Open Accounts Payable > A/P Vendors > Recurring Payables.
2. Click the New button beside the Recurring Payable Code field,
and then enter the recurring payable code you want to use with the
new payable.
Note: You can use the same recurring payable code for different
vendors.
3. Enter a description for the recurring payable.
4. In the Vendor Number field, enter the number of the vendor you will
pay periodically using this recurring payable.
5. On the Invoice tab, enter:
a. A start date for the payable.
b. An expiration type and related information for the expiration type
you specify.
c. Header information for the document.
6. On the Detail tab, enter details for the recurring payable, as you
would for an invoice. More...
7. Check or change tax information for the document on the Tax/Totals
tab.
8. Click Add (or Save, if you are updating an existing recurring payable
record).
After creating a recurring payable
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Inquiring on Vendors
Use the A/P Vendor Activity screen to view the following information for a
selected vendor:
Activity statistics.
Aging information.
Document history, including payments and exchange gains and
losses for a selected document.
Payment history.
Use the A/P 1099/CPRS Inquiry screen to look up the history of
1099/CPRS payments made to vendors that are subject to 1099/CPRS
reporting.
Tip: You can also use 1099/CPRS Inquiry screen to add, modify or
delete 1099 or CPR amounts (if your Accounts Payable systems allows
editing of these amounts).
About Vendor and Vendor Group Statistics
Looking Up Account Activity for a Vendor
Looking Up Vendor Payment Information
Looking Up 1099 or CPRS Vendor Amounts
Adding, Modifying, or Deleting a 1099 or CPRS Vendor
Amount
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About Vendor and Vendor Group Statistics
Statistics are automatically accumulated for vendors and vendor groups,
and automatically updated when you post invoice batches.

Period Statistics
For each vendor and vendor group, Accounts Payable stores the total
amount and number of:
Invoices.
Payments.
Discounts taken.
Discounts lost.
Credit notes.
Debit notes.
Adjustments.
Total paid invoices.
Period statistics are reported by the period specified on the A/P Options
screen, for as long as you keep transaction details.
Statistics are accumulated into the year and period derived from the
document date. Even if you change the year and period to which you
post the transaction, the statistics will still go to the period specified by
the full document date.
Use the Vendors and Vendor Groups screens to enter, edit, and review
statistics. For more information, see A/P Vendors Screen and A/P Vendor
Groups Screen.

Activity Statistics
Activity statistics kept for each vendor include the current outstanding
balance, year-to-date amounts, amount and date of the vendor's highest
balance and largest invoice in the current and previous years, as well as
the amount and date of the last invoice, payment, credit note, debit note,
adjustment, and discount posted to the account.
Each vendor record also shows the total amount of the invoices paid in
the current year, the number of checks, the average payment, and the
total and average number of days it took to pay the invoices. Activity
statistics for the previous year are cleared at year end.
No activity statistics are kept for vendor groups.

Options for Keeping Statistics
On the A/P Options screen, you can set the following options for vendor
and vendor group statistics:
Allow Edit Of Statistics. Specify whether or not statistics can be
manually edited.
Include Tax In Statistics. Specify whether or not to include tax
amounts in statistical totals.
Accumulate By. Specify whether to accumulate statistics by
calendar year or fiscal year.
Period Type. Specify the length of period by which to accumulate
and report statistics.
For more information about these options, see A/P Options Screen.

Changing the Method of Reporting Statistics
If you change the type of year and period (by which Accounts Payable
reports all three types of statistics), such changes will distort the figures
in past periods.
For example, if you update statistics quarterly for nine months, then
change to monthly updating, the totals for the first three quarters become
the totals for the first three months. The result is overstated totals in each
of the first three months, and zeros in the following six months.
If you need to change the type of year or period by which Accounts
Payable reports statistics, you should either do so after running Year
End, or edit the statistics for the earlier periods in the year to correct
distortions.
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Looking Up Vendor Activity
On the A/P Vendor Activity screen, you can look up information about
account activity for vendors, including:
Summary account information.
Specific payments or transaction documents.
To look up information about vendor activity:
1. Open Accounts Payable > A/P Vendors > Vendor Activity.
2. In the Vendor No. field, specify a vendor number.
On the Activity tab, summary account information is displayed for
the specified vendor, including the effects of the most recently posted
transactions.
Note: If you use multicurrency accounting, you can specify in the
Amounts In field whether to display amounts in the vendor
currency or the functional currency.
3. Look up payments or transactions:
a. On the Payments tab or the Transactions tab, specify search
criteria.
b. Click the Go button or press F7.
Payments or transaction documents matching the specified criteria
are displayed for the specified vendor.

Related Topics

Home > Setting Up and Maintaining Vendor Records > Inquiring on Vendors > Looking Up
Vendor Payment Information

Looking Up Vendor Payment Information
You use the A/P Payment Inquiry screen to look up payments.
To look up payments:
1. Open Accounts Payable > A/P Transactions > Payment Inquiry.
The A/P Payment Inquiry screen displays all payments as the default
list.
2. Select criteria to limit the list of payments:
A range of bank codes to list payments that were processed using
one of the bank codes that fall within the given range.
A range of vendor numbers to view payments only for the vendors
in the specified range.
Note: To include miscellaneous payments you must use blanks in
the vendor number range.
A Payment status to include only payments that are outstanding,
cleared, or returned, or you can display all payments that meet the
other specified criteria.
A transaction type to include only Prepayment or Payment
transaction types, or you can display all payments that meet the
other specified criteria.
A range of payment dates to include only payments that were
posted within the specified date range.
A range of years and periods to include only payments that were
posted within the specified year and period range.
A range of payment numbers to limit the list to the specified range
of payment numbers.
3. Click the Go

button.

Payments that meet the specified criteria are displayed.

Notes:
To view a payment in the Payment Entry screen, select the
payment on the list, and then click Document.
To view details of the payment (including, in a multicurrency
system, any gains or losses on settlement of a document) in a
separate Payment Information screen, select the payment, and
then click Open.
To print the Payment Inquiry report, click Print.
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Looking Up 1099 or CPRS Vendor Amounts
You use the A/P 1099/CPRS Inquiry screen to look up 1099 or CPRS
amounts.
To look up 1099 or CPRS amounts stored in your Accounts Payable
system:
1. Open Accounts Payable > A/P Vendors > 1099/CPRS Inquiry.
2. Specify search criteria.
3. Click the Go button.
Amounts matching the specified criteria are displayed for each month
of the year, including the last payment date in each month, the
number of payments, and the total amount paid.
After looking up 1099/CPRS amounts
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Adding, Modifying, or Deleting a 1099 or CPRS
Vendor Amount
You use the A/P 1099/CPRS Inquiry screen to look up 1099 or CPRS
amounts. You can also use this screen to:
Add new amounts.
Change or delete amounts you look up.
Before you start
To add, edit, or delete a 1099 or CPRS amount for a vendor:
1. Open Accounts Payable > A/P Vendors > 1099/CPRS Inquiry.
2. Specify search criteria.
3. Click the Go button.
Amounts matching the specified criteria are displayed for each month
of the year, including the last payment date in each month, the
number of payments, and the total amount paid.
4. Do one of the following:
To add an amount, click the first blank line on the table or press
Insert, and then enter information in the field in the line.
To change an amount, double-click the Amount field, and then
enter the correct 1099 or CPRS amount.
To delete an amount, select the line for the amount, and then press
Delete.
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About Entering Current and Historical
Transactions
Accounts Payable can display statistical information for vendor accounts,
and vendor groups for the current year and for all the previous years for
which you retain the data. You add the historical information you need
during setup. Accounts Payable then automatically updates the statistical
information every time you post transactions.
To properly set up your Accounts Payable system, you must enter and
post the current-year opening balances in your vendor accounts. If you
set up partway through a fiscal year, you must also enter and post figures
for the current year, up to the present date, and all outstanding
transactions. If you want to display and print reports of previous-year
data, you must enter those figures during setup as well.
Note: You should delete all general ledger batches created from posting
historical transactions. If you post these to your general ledger, you will
be duplicating posted transactions.

Entering Outstanding Invoice Balances in
Vendor Accounts
You create the opening balances in your vendor accounts by entering
them as invoices using the Invoice Entry screen, then posting them.
The opening balance invoice should use the first date of the current fiscal
year as the transaction (document) date. You can also import the figures
from a spreadsheet or other non-Sage 300 ERP program.

Entering Current-Year Transactions
When you set up an Accounts Payable system part way through a fiscal
year, you must enter the transaction data for the current year-to-date.
You can use any of the following method to add current-year
transactions:
Enter data directly in Accounts Payable.
Import data, then post it using one of the following methods:
Post all the current-year transactions, one at a time, period by
period.
This provides full detail for current-year transactions.
Post all the transactions for the current period, and the net changes
in each vendor's invoice and payment totals for each of the earlier
periods in the current year.
This provides full detail for current-period transactions, and creates
accurate balances for previous periods in the current year.
Post the net changes in each vendor's invoice and payment totals
for each of the periods in the current year.
This produces accurate balances for each account in each period
of the current year, but does not provide transaction detail for the
audit trail reports.
Post the net change between the opening and current balances for
each vendor account.
This is the quickest method of entering the data, but it does not
provide transaction detail for audit trail reports.

Entering Statistics for Previous Years
If you need to add purchase history for previous years to a new Accounts
Payable system, you can add it quickly, or import it, using the Vendors
and Vendor Groups screens.
You enter statistics by the periods and years specified for the options to
keep the data.
For each vendor and vendor group, you can enter the amount and
number of:
Invoices
Payments
Discounts taken
Discounts lost
Credit notes
Debit notes
Adjustments
Paid invoices
You can also enter the:
Amount and date of the high and low balance for the current year and
previous year
Largest invoice for the current year and previous year
Amount and date of the last:
Invoice
Payment
Credit note
Debit note
Adjustment
Discount
Total invoice amount paid, number of checks, average payment, days

to pay, and average days to pay.
You can review the figures in the Vendors and Vendor Groups screens,
and you can print them using the Statistics option in the Setup reports for
each type of data.
If you do not need historical data right away, you do not have to add it
when you set up an Accounts Payable system. The figures are updated
automatically each time you post transactions.

Related Topics
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Entering and Posting Accounts
Payable Transactions
Use Accounts Payable transaction entry screens to record, edit, post,
and inquire on the following types of transactions:
Invoices, debit notes, credit notes
Payments
Adjustments
About Batch Processing in Accounts Payable
Invoices, Debit Notes, and Credit Notes
Payments
Adjustments
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About Batch Processing in Accounts Payable
Batches are groups of transactions that share the same batch number
and batch date. Each transaction has its own entry number, vendor
number, date, and details.
Accounts Payable operates on a batch system. This means that you:
1. Enter the three main types of transactions—invoices, payments, and
adjustments—into batches.
2. List the batches to check for errors.
3. Post the batches to record the transactions in vendor accounts and
distribute the amounts to general ledger accounts.
4. Print the posting journals and G/L Transactions report as part of your
audit trail records of batches.
The batch system for processing transactions provides great flexibility at
the batch-entry stage, and tight auditing control during and after posting.
For details, see the following topics:
About Creating Accounts Payable Batches
Journal Entries Generated by Accounts Payable
About Listing Batches
About Posting Batches
About Printing Posting Journals and the G/L Transactions Report
About Tracking Batches

About Batch Types
There are three types of transaction batches in Accounts Payable:
Invoice batches. Invoice batches contain invoices, debit notes, credit
notes, and interest invoices. In multicurrency ledgers, each invoice batch
can contain documents in different currencies.
Payment batches. Payment batches contain payments, prepayments,
miscellaneous payments, and transactions that apply previously posted
payments and credit notes to documents in vendor accounts. You can
also enter adjustments to specific documents in payment batches if you
use the Allow Adjustments In Payment Batch option.
In multicurrency ledgers, all payments in a single payment batch must be
in the same currency, and the currency must be accepted by the bank
code assigned to the batch.
Adjustment batches. Adjustment batches contain corrections to posted
transactions. In multicurrency ledgers, a single adjustment batch can
contain transactions in different currencies.

Assigning and Using Batch Numbers and Entry
Numbers
To keep a clear and accurate audit trail, Accounts Payable automatically
assigns a number to each batch and to each entry (transaction) you add
to a batch, starting with 1. You must use the assigned batch and entry
numbers.
A separate numbering sequence is used for each type of batch (invoice,
payment, and adjustment).
The batch and entry numbers are a permanent part of each transaction
record, and they appear with the transactions on Accounts Payable
reports, such as posting journals and the Vendor Transactions report.
You can use batch and entry numbers to trace the progress of
transactions through the Accounts Payable system and, if you use the
numbers as the descriptions or references for G/L transactions, into your
general ledger (unless you consolidate the transactions during posting in
Accounts Payable).

Number of Open Batches Permitted at One Time
You can have an almost unlimited number of batches open at once,
depending on available disk space. The ability to use several open
batches means you can group transactions by data entry person,
currency, date, location, or any other criteria you find useful.

System-Generated Payment Batches
You can have only one open payment batch that has been created using
the A/P Create Payment Batch screen, although you can have other
payment batches that you imported or created with the Payment Entry
screen.

Force Listing of Batches
If you use the Force Listing Of Batches option, you must print batch
listings for each batch you want to post. You must also print a new listing
for each batch you edit.
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About Creating Accounts Payable Batches
You use the A/P Invoice Entry screen, the A/P Payment Entry screen,
and the A/P Adjustment Entry screen to create batches and enter
transactions directly into them.
In addition, Accounts Payable automatically creates batches when you:
Use the Create Payment Batch screen to create a batch of payment
transactions for currently due invoices.
Note: You must create at least one payment selection code before
you can use the Create Payment Batch screen to create a payment
batch.
Post transactions that contain errors. Accounts Payable posts errorfree transactions only, and creates a new batch that contains all the
transactions it could not post.
Use the Create G/L Batch screen or post Accounts Payable batches.
Depending on whether you defer general ledger batch creation or
not, Accounts Payable creates batches of general ledger transactions
arising from the invoices, payments, and adjustments you post to
vendor accounts.
Import Accounts Payable batches from Sage 300 ERP programs at
another location or from non-Sage 300 ERP products.

Multicurrency Ledgers
If you have a multicurrency ledger, you must create a new payment batch
for each currency you want to process. All transactions in the same
payment batch must be in the same currency. You can enter a mix of
currencies in invoice and adjustment batches.
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About Locked Fiscal Periods
In Sage 300 ERP, fiscal periods are locked separately for each
transaction-oriented Sage 300 ERP program.
The system checks the status of a fiscal period for Accounts Payable
when you enter certain dates in Accounts Payable transactions. It also
checks the status of the fiscal period for Bank Services when you print a
check.
If the period is locked for Accounts Payable, you receive a warning, an
error message, or no message, depending on the setting for the Locked
Fiscal Period option on the Company Profile’s Options tab, as follows:
If the period is locked for Bank Services and the Locked Fiscal
Period option is set to Error, you receive an error message when
you add a receipt or print a refund check. (Otherwise, no warning or
error appears.)
Important! Generally, you should lock a period for Accounts
Receivable, Bank Services, and Accounts Payable at the same
time, to avoid this situation.
If a fiscal period is locked for General Ledger but not for Accounts
Payable, you can create batches for General Ledger during posting
or using the A/P Create G/L Batch screen (depending on Accounts
Payable's G/L Integration settings). When you try to post transactions
to a locked period in General Ledger, however, the transactions will
be placed in an error batch.
Important! You should create and post General Ledger batches for
outstanding Accounts Payable transactions before locking a period
for General Ledger.
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About Accounts Payable Batches Created by
Intercompany Transactions
If you use Intercompany Transactions (ICT), the Accounts Payable
component in ICT lets you enter invoices, debit notes, credit notes, and
interest charges for related companies.
Posting an ICT A/P batch creates an Accounts Payable batch in the
originating company's Accounts Payable ledger (for posting invoices,
debit notes, credit notes, and interest to vendor accounts), and it creates
an ICT G/L batch in the ICT company.
Note: For online help specifically about ICT features, you must open an
ICT screen, and then press F1 on your keyboard. You can do this only if
you have installed ICT and activated it for an ICT company.
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About Editing and Deleting Batches and
Transactions
You can edit transactions or delete open batches according to your
selection for the following options:
Allow Edit Of System Generated Batches.
Allow Edit Of Imported Batches.
Allow Edit of External Batches.
Note: System generated batches are payment batches created using
the A/P Create Payment Batch screen.

Editing Batches
You can always change most batch header information, regardless of the
restrictions you may place on batch editing. For example, you can always
change dates and descriptions of all open batches, whether you created
them in Accounts Payable or imported them from another ledger.
You can add a new vendor or a new remit-to location during invoice entry
or when editing an invoice.
You cannot change the bank code in payment batches once you add the
first transaction.

Editing Imported Batches
If you need to correct an imported batch, you should delete the batch
from Accounts Payable and make the corrections to it in the program
where you created the batch. This procedure ensures that the batch you
post in Accounts Payable contains exactly the same information as the
batch in the source program.
To prevent editing of imported batches in Accounts Payable, make sure
that you do not select the Allow Edit Of Imported Batches option on the
A/P Options screen.

Editing Transactions
The status of a batch must be Open or Printed to edit the transactions.
(Printed status means that the batch listing has been printed).
If the batch has a Ready To Post status, you must turn off the Ready To
Post selection before you can edit transactions.
If you allow editing of batches, you can always delete unposted
transactions. You can also change any transactions in an open batch
except payment transactions for which you have printed checks.
If you have printed the check for a transaction, you cannot edit it. You can
delete the transaction to void the check.

Deleting Entries and Batches
When you delete a batch or an entry in a batch, you cannot reuse its
number. Deleted batches and entries are reported on the batch listing
and posting journal for the batch. Deleted batches are also reported on
the Batch Status report.
If you delete a payment transaction for which you printed a check, you
will void the check.
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About Posting Batches
Posting accomplishes the following tasks:
Updates vendor accounts with the transaction information entered in
batches, and updates vendor and vendor group statistics.
Updates 1099/CPRS information for vendors who are subject to
1099/CPRS reporting (with tax information from invoices and
payment totals from payments).
Creates general ledger transaction information for the G/L accounts
affected by the transactions.
Posting creates G/L batches for the transactions if the Create
G/L Transactions During Posting option is selected on the
A/P Options screen. If you do not use the option, the G/L transaction
information is stored for later addition to a G/L batch.
Creates transactions to realize gains or losses due to changes in
exchange rates for payments that settled invoice transactions. These
transactions affect the General Ledger only.
Updates bank services with payment amounts and check numbers, if
you printed and posted checks.
Creates a posting journal for each group of batches posted at the
same time.
Updates the posting sequence numbers for each type of batch listed
on the Numbering tab of the A/P Options screen.
If you create General Ledger transactions during posting, updates the
sequence numbers for the General Ledger batches on the Integration
tab of the Integration screen.
Updates the status of each batch that was posted.

Preparing to Post Batches
You take the following steps to post batches:
1. Print listings of the batches you want to post.
If you use the Force Listing Of Batches option, you must print batch
listings for each batch you want to post. You must also print a new
listing for each batch you edit.
2. Select the Ready To Post option for each batch you want to post.

Posting Invoices and Adjustments
You can post invoices and adjustments in the following ways:
Post individual batches from the Invoice Batch List screen or
Adjustment Batch List screen.
Post one or more batches in a range using the Post Batches screen.
For more information, see Post Batches Screen.

Posting Payment Batches and Printing Checks
You post payment batches using the Print/Post button on the Payment
Batch List screen.
Print/Post is a two-stage process:
1. Accounts Payable prints any checks in the batch that have not been
printed using the Payment Entry screen, and,if the print run was
successful, posts the check information to Bank Services.
2. Once the check data has been posted to Bank Services (when you
leave the Print Checks screen), the program proceeds to the
payment-posting stage.
If all checks in the batch have been printed or if the payment batch
did not contain any checks for printing, Print/Post skips the printing
step, and proceeds directly to post the payment information to vendor
accounts.
Payment posting applies all payment information to vendor accounts,
and creates a Payment Posting Journal and a Check Register, which
are the audit trail reports of the checks that were produced to pay
vendors.

Posting Errors
If errors are found in a batch during posting, the incorrect transactions
are not posted. Instead, they are placed in a new batch that uses the next
available batch number.
The details of the incorrect transactions are printed in an error report
which you print separately from the posting journal. If checks were
printed for any of the incorrect entries, the word "Printed" appears with
the transaction on the error report.

Posting Sequence Numbers
Accounts Payable assigns a posting sequence number to each
transaction during posting. The same sequence number is assigned to all
transactions that are posted together. Posting sequence numbers provide
another way to trace posted transactions back to source documents.
Each time you post batches, Accounts Payable increases the posting
sequence number by 1, and updates the posting sequence numbers that
are displayed on the A/P Options screen. You can look up the current
posting sequence numbers on the A/P Options screen to be sure you
have up-to-date copies of posting journals and G/L Transactions reports.
Accounts Payable uses a separate numbering sequence for each type of
batch (invoice, payment, and adjustment).

Posted Batches Are Automatically Deleted
When you post a batch, its contents are transferred to the vendor
accounts and you can no longer edit the transactions.
You must enter adjustments or apply debit or credit notes to change any
transactions you have already posted.

Delete Imported Batch Source Files After Posting
When you import and post a batch, the original file you imported still
exists in the program where you created it. Imported batches are deleted
automatically only from Accounts Payable.
You should also delete the batch file from the program where you created
it, to avoid accidentally importing the batch twice.

If You Do Not Use Sage 300 ERP General Ledger
If you do not use Sage 300 ERP General Ledger—or if your Sage 300
ERP General Ledger system is at another location—Accounts Payable
creates its general ledger transactions in a file called APGLTRAN.CSV,
which can be imported by a remote site Sage 300 ERP General Ledger,
or transferred to another general ledger that you use. The file is in a
Comma Separated Values (CSV) format.
All general ledger transactions are placed in the same CSV file. Each
time Accounts Payable creates transactions it will ask you whether you
want to add to the file, or replace it.
You should always add to the CSV file using the Append option when
you create G/L transactions. If you overwrite the file, you will destroy all
transactions that are already in the file.
When you are ready to transfer the batch to your general ledger, copy the
file to the computer or directory where your general ledger is located, and
delete the original CSV file. Then make a backup copy of the CSV file.
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About Tracking Batches
To check on current batches, print their batch listings or print the
A/P Batch Status report for the type of batches you want to review.
To display batch information on your screen, print the reports using
Preview as the print destination, or look up the batches using the
A/P Invoice Batch List, A/P Payment Batch List, and A/P Adjustment
Batch List screens.

Batch Statuses
Batches are categorized by:
Status. Statuses include Open, Deleted, Ready To Post, Printed,
Post In Progress, Posted, Check Creation In Progress (payment
batches).
Type. These are the methods by which the batches were entered in
Accounts Payable, including Entered, Imported, Generated (error
batches), or System (system generated payment batches).

Clearing Batch Status Information
You can remove information about posted and deleted batches from the
A/P Batch Status report if you select the option to clear deleted and
posted batches on the A/P Clear History screen.
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About Listing Batches
Once you have entered all transactions in a batch, you should print the
batch listing and compare it to your source documents to be sure all
transactions were entered correctly.
If you find mistakes, edit the batch to correct the errors, then reprint and
check the batch listing before posting the batch.

Using the Force Listing Of Batches Option
To make sure listings are printed for each batch before you post it, select
the Force Listing Of Batches option on the A/P Options screen. The
option also prevents you from posting batches you edited but did not
relist.
To print a listing for a batch you are working on, use the File > Print
command on the batch entry screen.
To print listings for a range of batches, use the Batch Listings icon in the
A/P Transaction Reports folder.
File the reports as part of your audit trail.
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Listing Payment Batches
You use the A/P Payment Batch List screen to work with payment batch
listings.
To list batches:
1. Open Accounts Payable > A/P Transactions > Payment Batch
List.
2. In the Batch Number field, enter the number of a payment batch.
Note: You cannot view a batch if you have cleared it using the
Clear Deleted And Posted Batches option (on the A/P Clear
History screen).
Tip: To limit the display to batches that are open or ready to post,
clear the Show Posted And Deleted Batches option.
Note:
You can also print the following reports from the A/P Payment Batch List
screen:
Batch Status. To print this report, click Print Batch Status on the
File menu.
Posting Errors. To print this report, double-click in the Number Of
Errors column for the error batch.
Posting Journal. To print this report, click in the Posting
Sequence Number column.

Related Topics

Home > Entering and Posting Transactions > About Batch Processing in Accounts Payable >
About Tracking Batches > About Printing Posting Journals and the G/L Transactions Report

About Printing Posting Journals and the G/L
Transactions Report
Each time you post batches, Accounts Payable creates a journal of the
entries from the batches you posted together. These posting journals are
an essential part of your audit trail, because they provide a record of all
posted details and of the related general ledger distributions.
You should keep your audit trail of posted transactions up to date by
printing and filing each posting journal as it is created.
You should also print the G/L Transactions report as part of your periodend procedures. You are required to print these reports only once, before
you close the year. (You cannot use the A/P Year End screen until you
have printed all outstanding posting journals and created the general
ledger transaction batch.)
If you carefully maintain and identify source documents, and print and file
all batch listings, posting journals, and other audit trail reports, you will be
able to trace any transaction from source to general ledger entry.
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Journal Entries Generated by Accounts Payable
When you post transactions, journal entries are created in general ledger.
The journal entries that are created vary depending on transaction type.
The following sections include information about the journal entries
associated with Accounts Payable transactions:
Invoices
Credit Notes
Debit Notes
Payments
Prepayments
Miscellaneous Payments
Adjustments
Exchange Gains and Losses

Invoices
On the G/L Transactions report, invoices are assigned source code APIN; interest invoices are assigned the source code AP-IT.
Posted invoice transactions debit the general ledger inventory account or
expense account you specify with each invoice detail (either directly or
using a distribution code) and credit the vendor's Payables Control
account.
Journal Entries for Invoices
G/L Account
Inventory (or Expense)

Debit Credit
X

Retainage Control

X

Payables Control

X

The entry for a retainage invoice is:
Journal Entries for Retainage Invoices
G/L Account
Retainage Control
Payables Control

Debit Credit
X
X

Credit Notes
Credit notes are assigned source code AP-CR on the G/L Transactions
report.
Credit note transactions credit the general ledger account (the inventory
account in this example) and debit (decrease) the vendor's Payables
Control account.
Journal Entries for Credit Notes
G/L Account

Debit Credit

Payables Control

X

Retainage Control

X

Inventory (or Expense)

X

Debit Notes
Debit notes are assigned source code AP-DB on the G/L Transactions
report.
Debit note transactions debit the general ledger account represented by
the distribution code (inventory in this example) and credit (increase) the
vendor's Payables Control account.
Journal Entries for Debit Notes
G/L Account
Inventory
Retainage Control
Payables Control

Debit Credit
X
X
X

Payments
Payments are assigned source code AP-PY on the G/L Transactions
report.
Payments debit the vendor's Payables Control account, credit the Bank
account specified for the payment batch, and credit the Payment
Discounts account (if a discount is taken). Discounts are assigned the
source code AP-ED (for earned discount).
Journal Entries for Payments
G/L Account
Payables Control
Bank
Payment Discounts

Debit Credit
X
X
X

Prepayments
Prepayments are assigned source code AP-PI on the G/L Transactions
report.
Prepayments debit the Prepayment account and credit the Bank account
for the payment batch. When you apply the prepayment later, Accounts
Payable will credit the prepayment account and debit the expense or
asset account that you specify.
Journal Entries for Prepayments
G/L Account
Prepayments
Bank

Debit Credit
X
X

Miscellaneous Payments
Miscellaneous Payments are assigned source code AP-PY on the G/L
Transactions report.
Miscellaneous cash payments debit the general ledger account you
specify on the Payment Detail tab of the Payment Entry screen and credit
the Bank account for the payment batch.
Journal Entries for Miscellaneous Payments
G/L Account
Debit Credit
Misc. Expense
Bank

X
X

Adjustments
Adjustments are assigned source code AP-AD on the G/L Transactions
report.
An adjustment entered as a positive number credits the vendor account
(increases the payables balance) and debits the general ledger account
you specify when you enter the adjustment.
For example, the following adjustment was entered as a positive
adjustment to the inventory account:
Journal Entries for Credit Notes
G/L Account
Inventory
Payables Control

Debit Credit
X
X

An adjustment entered as a negative amount debits the vendor account
and credits the general ledger account you specify when you enter the
adjustment.

Exchange Gains and Losses
On the G/L Transactions report, exchange gains or losses are assigned
source code AP‑GL (for "gain/loss").
In a multicurrency system, exchange gains or losses result when you
revalue or settle an invoice using an exchange rate that is different from
the rate currently used by the invoice.

During Revaluation
Accounts Payable creates entries for General Ledger when you revalue
an invoice in a source (non-functional) currency at an exchange rate that
is different from the rate currently used by the invoice.
The following transaction registers a loss, because changes in the
exchange rate have increased the value of the vendor invoice:
Journal Entries for Exchange Losses During Revaluation
G/L Account
Debit Credit
Exchange (or Realized) loss

X

Payables Control

X

If you use the Realized and Unrealized Gain/Loss accounting method for
your company, exchange gains and losses are considered unrealized
until the document is paid. Revaluation sends unrealized gain and loss
transactions to General Ledger as reversing transactions (meaning they
are automatically reversed at the beginning of the next fiscal period).
The following entry shows how the unrealized loss is reversed:
Journal Entries to Reverse Unrealized Loss
G/L Account
Debit Credit
Payables Control
Exchange (or Realized) loss

X
X

When you print the Vendor Transactions report for the period in which
you post the reversing revaluation transaction, both transactions appear

for the vendor. Their net effect on the account balance is zero.
If you use the Recognized Gain/Loss accounting method, revaluation
exchange gains and losses are not reversed.

Arising on Settlement
This type of exchange gain or loss arises when you settle an invoice
using an exchange rate that is different from the rate currently used by
the invoice.
If posting changes the value of an invoice (for example, through partial
payment, full payment, or credit note), Accounts Payable calculates the
gain or loss for the portion of the invoice that was changed by the
posting, and creates gain or loss transactions for the general ledger
accounts.
The following transaction registers a gain, because the exchange rate on
settling reduced the value of the vendor invoice:
Journal Entries Exchange Losses Arising on Settlement
G/L Account
Debit Credit
Payables Control

X

Exchange (or Realized) gain

X

Note: Credit notes and debit notes do not affect gains or losses if they
are issued at the exchange rate of the original invoice. However, they
do generate gains or losses if they are issued at a different rate.

Related Topics

Home > Entering and Posting Transactions > Invoices, Credit Notes, and Debit Notes

Invoices, Credit Notes, and Debit Notes
These topics describe how to:
Create invoice batches.
Enter vendor invoices, credit notes, and debit notes using the A/P
Invoice Entry screen.
Calculate tax.
Edit exchange rate information.
Assign multiple payment schedules to invoices.
Enter prepayments with invoices.
About Processing Invoices, Credit Notes, Debit Notes, and
Interest
About Interest Invoices
About Distributing Invoice, Credit Note, and Debit Note
Amounts
About Applying Credit Notes and Debit Notes
About Calculating Early Payment Discounts
About Calculating Tax
About Processing Advance Credits for the Return of Goods
About Entering Multicurrency Invoices, Credit Notes, and
Debit Notes
About Entering Optional Fields on Invoices
Working with Invoice Batches
Entering an Invoice
Entering a Debit Note or a Credit Note

Deleting a Document
Posting an Invoice Batch
Posting a Range of Batches

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Processing Invoices, Credit Notes, Debit Notes, and Interest

About Processing Invoices, Credit Notes, Debit
Notes, and Interest
You can use the A/P Invoice Entry screen to create new batches for
invoices, credit notes, debit notes, and interest charges.
You use the A/P Invoice Entry screen to add these documents to invoice
batches. You can add all four document types to a single batch, or use
separate batches for each type.
You can also add retainage invoices, retainage debit notes, and
retainage credit notes manually, if you do not want to use the A/P Create
Retainage Batch screen to generate these documents automatically.

Information Entered with Documents on the
Invoice Entry Screen
For each invoice, debit note, credit note, or interest invoice you enter on
the A/P Invoice screen, you enter:
Header information for the document (transaction).
Header information includes the vendor number, document type and
date, remit-to address, tax group, payment terms, and other data that
are the same for the entire document.
Tax information.
Detail information to distribute the document and tax amounts to
general ledger accounts.
With each document, you can also enter:
Payment amounts, dates, and discount information for payment
schedules (installment payments).
Information in optional fields, if you use Sage 300 ERP Transaction
Analysis and Optional Field Creator and you have set up optional
fields for use with invoices.

Quick Mode
You can use Invoice Entry’s Quick Mode setting to save time during data
entry. When you use this setting, Accounts Payable copies selected fields
from the previous transaction or detail to the new transaction or detail, so
you do not have to re‐enter them. For more information, see Menu
Commands.

Multicurrency Ledgers
If you use multicurrency accounting, the vendor's currency code and the
exchange rate appear on the Document tab when you enter the vendor
number. You enter all amounts in the vendor's currency, which you
cannot change.

Tip: Batches in multicurrency ledgers can contain documents in more
than one currency. However, you may want to group documents into
separate batches by the vendor’s source currency.
If the vendor does not use the functional currency, a Rates tab appears.
You use the Rates tab to change the exchange rate, rate type, and rate
date for an invoice, if necessary.
When you enter a credit note or debit note for a specific invoice, the
original exchange rate used for the invoice appears on the Rates tab.
Note: If you need to change the tax group for a multicurrency vendor,
you must select another tax group that also uses the vendor's currency.

Editing Unposted Invoices, Credit Notes, and
Debit Notes
You can change or correct open invoice batches, including error batches
created during posting.
If you want to edit batches that were created by other Sage 300 ERP
programs or non-Sage 300 ERP programs, you must select the Allow
Edit Of Imported Batches option on the A/P Options screen.

Job‑related Invoices, Credit Notes, and Debit
Notes
If you use Sage 300 ERP Project and Job Costing, you can enter
invoices, debit notes, and credit notes that update projects in that
program when you post the documents in Accounts Payable.
When you enter a job‑related document, you must:
Select the Project and Job Costing option.
Identify the contract, project, and category for each detail you enter.
Note: Invoice details can either be job‑related or not job‑related—you
cannot enter an invoice with both types of details.
When you post job‑related invoices, Accounts Payable:
Updates the project in Sage 300 ERP.
Creates journal entries to update the Work-In-Progress and Payables
Control accounts in General Ledger.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Interest Invoices

About Interest Invoices
You enter an interest charge on the Invoice Entry screen just as you
would a debit note, except that the program does not let you enter or
distribute taxes.

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Distributing Invoice, Credit Note, and Debit Note Amounts

About Distributing Invoice, Credit Note, and
Debit Note Amounts
For most invoices you need to distribute two amounts:
The amount of the invoice net of taxes.
The tax amount.
You distribute both of these amounts after you enter the document total
on the Document tab and tax information on the Taxes tab of the Invoice
Entry screen.

Including Tax in the Distribution Amount
If you select Tax Included for a tax authority and Calculate for the Tax
Amount field on the Taxes tab, you distribute the invoice total—the details
plus the tax that is included in the total on your vendor invoice.
If all the taxes are listed separately, you distribute the amount of the
invoice net of tax, then calculate tax on the invoice.
If you select Distribute or Enter as the tax entry method, you always
enter the tax amounts on the Taxes tab, then distribute the net-of-tax
amount (the rest of the invoice) on the Document tab.
For instructions on distributing tax amounts, see the following topics:
Manually Entering and Distributing Tax Amounts
Calculating Included Taxes Automatically
Calculating Excluded Taxes Automatically

Multicurrency Ledgers
You distribute all invoice and tax amounts in the vendor's currency.
Accounts Payable calculates the functional-currency equivalent to the
invoice amount using exchange rates maintained in the Currency screens
in Common Services.
You can change the exchange rate, rate type, and rate date for an
invoice, using the Rate Information tab in the Invoice Entry screen, but

you cannot change the vendor currency.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Distributing Invoice, Credit Note, and Debit Note Amounts > About Billing Types

About Billing Types
Billing types are used for job‑related documents, where you manage the
job using Sage 300 ERP Project and Job Costing.
The billing type indicates to Project and Job Costing whether to bill the
cost of a distribution line to the customer. You can change the billing type
for a distribution if the project is billable and uses an Item invoice type,
depending on the project style and accounting method.
Note: Only time and materials projects and fixed price projects that use
an Item invoice type in Project and Job Costing can use item invoices.
You cannot change the billing type for cost plus projects or fixed price
projects that use a Summary invoice type in Project and Job Costing.
If a project is no charge or non-billable (regardless of the project type,
project style, or accounting method), the program sets the billing type
consistent with the project, and you cannot change it.
On a basic project:
For time and materials projects and for fixed price projects that use a
billings and costs or accrual-basis accounting method and an item
invoice type:
If both the specified project and category are billable, the detail is
billable by default, but you can change the billing type.
If the project is billable, but the specified category is no charge or
non-billable, the detail is also no charge or non-billable, consistent
with the category, and you cannot change the billing type.
For fixed price projects that use a summary invoice type and an
accounting method of:
Project percentage complete or completed project, if the project is
billable, the detail is also billable.:
Billings and costs or accrual-basis:

If both the specified project and category are billable, the detail is
billable.
If the project is billable but the category is not, the detail is nonbillable or no charge, consistent with the category, and you
cannot change it.
On a standard project:
For time and materials projects and for fixed price projects that use a
billings and costs or accrual-basis accounting method and an item
invoice type:
If both the project and the specified resource are billable, the detail
is billable by default. You can change the billing type for the detail.
If the project is billable, but the specified resource is no charge or
non-billable, the program sets the detail No Charge or Non-billable,
consistent with the resource.
For fixed price projects that use a summary invoice type and an
accounting method of:
Project percentage complete or completed project, if the project is
billable, the detail is also billable.
Billings and costs or accrual-basis:
If both the specified project and resource are billable, the detail is
also billable. You cannot change the billing type.
If the project is billable but the specified resource is not, the detail
is also non-billable or no charge (consistent with the resource),
and you cannot change it.
For cost plus projects, the program sets the billing type, as follows:
For cost plus projects that use a completed project, total cost
percentage complete, labor hours percentage complete accounting
method, if the project is billable, the detail is automatically billable.
For cost plus projects that use a category percentage complete,

billings and costs, or accrual-basis accounting method:
If both the project and category are billable, the detail is
automatically billable.
If the project is billable, but the specified category is no charge or
non-billable, the detail is automatically no charge or non-billable,
consistent with the category.
Note: The Billing Type field is always blank for cost plus projects, and
you cannot change it.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Applying Credit Notes and Debit Notes

About Applying Credit Notes and Debit Notes
When you enter credit notes and debit notes using the A/P Invoice Entry
screen, you can also specify the number of the document to which the
note applies.
If the note applies to several invoices or is issued on account (for
example, as a purchase volume rebate), you do not enter an invoice
number here. You apply the credit note or "pay" the debit note later, using
the A/P Payment Entry screen.
Note: Discounts are not applied to credit notes or debit notes.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Calculating Early Payment Discounts

About Calculating Early Payment Discounts
If your vendors offer discounts for early invoice payment, you should
define a terms code for each of the methods used to calculate discount
amounts and discount periods.
Accounts Payable uses the terms code you specify with an invoice to
calculate the discount period and amount for the document.
If the terms code includes multiple payments, Accounts Payable sets up
a payment schedule that includes separate discount information for each
payment.
You can also specify whether the invoice discount applies to a particular
detail, or not. To indicate that a detail is not subject to the invoice
discount, you simply clear the Discountable option for the detail on the
Detail Items/Taxes screen, or select No for the option on the detail-entry
table.
You can change the discount date, discount base, amount, and discount
rate at any time until you post the invoice.
Note: You must enter a discount date before you can enter an amount
or a rate.
The discount date determines whether a discount is available when you
enter a payment in the A/P Payment Entry screen. If a discount is
available, Accounts Payable displays the available discount amount and
the invoice total net of the discount when you apply payments to the
invoice.
Note: Discounts do not apply to credit notes and debit notes.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Calculating Early Payment Discounts > About Assigning Multiple Payment Schedules to
Invoices

About Assigning Multiple Payment Schedules to
Invoices
To enter invoices that will be paid by a series of payments, you use a
terms code that includes a multiple payment schedule. For example, the
terms code might require six payments over a specified period to pay a
single invoice.
Based on the information entered for the terms code, Accounts Payable
creates a payment schedule that divides the invoice total into the
specified number of payments, each with its own due date, payment
amount, and discount period.
Payment information appears on the Terms tab on the A/P Invoice Entry
screen. You can change the payment schedule after you have distributed
the invoice amounts.
You reference payments by payment number when you apply checks to
multiple payment invoices. This feature makes it easy to track the
payments for each invoice.
Note: You can include payment schedules on batch listings by selecting
the Show Schedules option on the Batch Listing screen.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Calculating Tax

About Calculating Tax
Account Payable gets all its tax rates and tax account information from
Tax Services, which is part of Sage 300 ERP's Common Services.
Accounts Payable provides three methods for entering tax amounts and
tax bases on invoices, credit notes, and debit notes:
You can let the program calculate all taxes for you.
You can enter all taxes manually for the document and its distribution
lines.
You can enter total tax amounts for the document, and then prorate
and allocate the total amounts to distribution lines.
Whether you let the program calculate taxes or you enter them manually,
Accounts Payable sends all the appropriate tax information to Tax
Services for tax reporting purposes.

Specifying a Tax Entry Method for a Document
on the Invoice Entry Screen
You specify how taxes are calculated for a document on the Taxes tab of
the Invoice Entry screen. In the Tax Amount and the Tax Base fields,
you can select:
Enter. If you select this method, you enter total tax amounts and/or
tax bases on the Taxes tab manually, and enter tax amounts for each
detail on the Detail Accounts/Taxes screen using the information from
the invoice.
If you want, you can distribute amounts automatically to the invoice
details using the Distribute Taxes button. You can edit the detail
taxes, later, on the Detail Accounts/Taxes screen.
Note: Clicking the Calculate Taxes button overrides all manually
entered taxes—the total amounts on the Taxes tab as well as the
detail taxes.
Distribute. If you select this method, you enter the total tax amounts
and/or tax bases on the Taxes tab manually, using the information
from the invoice.
You use the Distribute Taxes button to allocate to invoice the total
tax amounts you enter manually.
Note: You cannot edit taxes on the Detail Accounts/Taxes screen if
you choose this method.
Calculate. If you select this method, you let the program calculate
and distribute taxes when you add the invoice or distribute the
invoice amount.
The only way to change the amounts calculated for a document is by
changing one of the following:
The tax group
The tax classes

If you choose Calculate for the tax amount and Distribute or Enter for
the tax base, the program uses the tax base to calculate tax amounts
automatically.
The main reasons for having the program calculate tax are:
To check the tax amount that appears on the invoice.
To track a tax which is hidden in the invoice total.
Note: Accounts Payable automatically uses the default tax entry
method specified on the Transactions tab on the A/P Options screen.
You can change the method for individual invoices.
Tips:
If you want Accounts Payable to calculate all tax amounts for an
invoice, select Calculate for the Tax Amount, Tax Base, and Tax
Reporting options on the Taxes tab. You can change the tax calculations
as follows:
To change the vendor’s tax class for the invoice, use the Taxes tab
on the Invoice Entry screen.
To change the tax group for the invoice, use the Taxes tab.
To change the tax class for a detail, select the detail, and then click
the Account/Tax button or press the F9 key. Edit the detail tax class
on the Detail Accounts/Taxes screen.
Change the tax rates in Tax Services.
If you want to enter tax amounts manually:
Select Enter for the Tax Amount and the Tax Base options on the
Taxes tab on the Invoice Entry screen, and then enter tax amounts
for each authority. You can then prorate and distribute the tax
amounts to invoice details.
Select Enter for the Tax Reporting option if you want to enter tax
reporting information manually for the invoice and its details.
Accounts Payable does not calculate any tax for the invoice unless you

click the Calculate Taxes button on the Taxes tab.

Tax Groups and Tax Authorities
The tax group you select for an invoice determines which tax authorities
appear on the Taxes tab and the tax class for each tax authority. The only
way to change the list of tax authorities is by changing the tax group.
For an overview of tax groups, see About Tax Groups.

Tax Classes
The tax class usually determines whether goods are taxable.
You can change the tax classes for each tax authority on the Taxes tab.
If you select Calculate as the tax entry method, you can also change the
tax classes for individual distribution lines using the Detail
Accounts/Taxes screen.
Tip: Whatever method you choose, you can always override manually
entered amounts by clicking the Calculate Taxes button.

Tax Included Amounts
The Tax Included field on the Taxes tab determines whether distribution
amounts are net of taxes or include taxes.
Note: You can change the Tax Included setting only if the tax authority
permits it.

Tax on Retainage
You can report taxes on retainage amounts when you post an original
invoice or when specified by a tax authority. Accounts Payable respects
the option specified for each tax authority.
This feature meets the reporting requirements for GST and VAT, for which
tax is reported separately on the amount payable on the original invoice,
and then on the amount of the retainage when the retainage is due.

Tax Reporting in Multicurrency Ledgers
In a multicurrency system, if you assign to the invoice a tax group that
uses a different currency than the vendor, Tax Reporting fields appear.
Tax reporting amounts are required in some jurisdictions, such as
Singapore.
You can let Accounts Payable automatically calculate all taxes in source
currency, functional currency, and the tax reporting currency.
You can also change the rate type, rate date, and exchange rate for the
tax reporting currency, and let Accounts Payable calculate the Tax
Reporting amounts for each authority.

Distributing Document Taxes
When Accounts Payable distributes tax amounts to invoice details, it:
Checks the Taxes tab to see which taxes apply to the vendor and the
tax entry method.
If Calculate is not selected, Accounts Payable uses the tax
amounts entered on the Taxes tab.
If Calculate is selected, Accounts Payable checks the Tax
Included settings, then calculates the total tax amount for the
distributions listed on the Document tab.
Allocates entered or calculated taxes in the same proportion as you
distributed the rest of the invoice amount.
Removes any proportion of the tax that is recoverable from the tax
distribution amount, and assigns it to the tax recoverable account.
You define tax authorities and specify whether taxes are recoverable
using the screens in the Tax Services folder.
Removes any tax that is separately expensed from the tax
distribution amount and assigns it to the tax expense account.
You specify whether taxes are expensed separately in Tax Services.
Tax Services performs the tax calculations when you click the Distribute
Taxes button on the Taxes tab.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Calculating Tax > About Tax Groups

About Tax Groups
Tax groups specify the authorities that tax the goods you purchase from
vendors, and determine the specific classification for a tax, such as which
rate is applied or whether you are tax-exempt.
You assign a tax group to each vendor record with other tax information,
such as tax numbers and whether tax is usually included in invoice
amounts. This information appears by default when you enter an invoice
from the vendor.
If you need to change tax rates or amounts for a document, you can
assign a different tax group or you can change the tax class or tax
included settings, as follows:
On the A/P Invoice Entry screen, you change the settings on the
Taxes tab.
On the A/P Recurring Payables screen, you change the settings on
the Tax/Totals tab.
If you are calculating tax automatically for a document, you can change
the tax settings for individual distribution lines on the Detail
Accounts/Taxes screen.
To open the Detail Accounts/Taxes screen, on the Invoice Entry
Document tab, select (highlight) the distribution line on the table, and
then click the Account/Tax button or press the F9 key.
Note: To change tax rates for a tax authority, you use the Tax Services
screens in Common Services.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Calculating Tax > About Distributing Self-Assessed Taxes

About Distributing Self-Assessed Taxes
A self-assessed tax is one that you must pay, even though it is not
collected by the vendor. These taxes commonly arise when you order
goods from another state or province, but are still subject to local sales
taxes.
Accounts Payable does not have a self-assessing tax type, but you can
use the program to calculate self-assessing taxes and distribute them to
expense and tax payable accounts. The trick is to create two tax
authorities, one for the tax expense, and one for the tax payable.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Calculating Tax > About Changing the Tax Class for a Single Invoice Distribution

About Changing the Tax Class for a Single
Invoice Distribution
You can change the tax class (tax status) for single invoice distributions
by highlighting the invoice distribution line, pressing F9 or clicking the
Accounts/Taxes button, and then selecting a different tax class.
Important! You must specify the tax class before you distribute taxes.
If you know the tax amounts for each distribution, you can also enter the
taxes manually for each line.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Calculating Tax > About Changing the Tax Class for a Single Invoice Distribution > Editing
Taxes on an Invoice, Debit Note, or Credit Note

Editing Taxes on an Invoice, Debit Note, or
Credit Note
Accounts Payable can calculate all tax amounts on invoices, debit notes,
or credit notes, or you can enter the taxes manually.
Before you start
To change tax amounts for a document:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Display the batch and the invoice you want to edit, as usual.
3. Click the Taxes tab.
a. If you need to change the tax group for the document, select a
different tax group in the Tax Group field.
Note: In a multicurrency ledger, if the new tax group does not use
the vendor's currency, Tax Reporting fields appear.
b. In the Tax Amount field and/or the Tax Base field, specify the tax
entry method. More...
Note:
If you select Calculate or Distribute as the tax entry method, you
cannot directly edit tax amounts for distribution lines, although
you can change tax classes.
You can use the Calculate Tax button to calculate the tax for the
document.
You can use the Distribute Taxes button to prorate the total tax
amounts for individual document details.
If you enter tax reporting amounts manually, you can use the
Derive Rates button to calculate the implicit exchange rate for
the tax reporting currency.

c. If you selected Distribute for the tax entry method, enter the total
tax for each tax authority manually, and then click Distribute Taxes
to allocate tax amounts to the distribution lines.
d. If you selected Enter for the tax entry method:
i. Enter the total tax for each tax authority on the Taxes tab.
ii. Enter the tax amounts for each distribution line that appears on
the Document tab. More...

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Calculating Tax > About Changing the Tax Class for a Single Invoice Distribution > Changing
the Tax Class or Tax Included Setting for a Distribution Line

Changing the Tax Class or Tax Included Setting
for a Distribution Line
If you do not select Enter as the tax entry method for an invoice, debit
note, or credit note, you can change the tax allocation for a distribution
line only by changing the tax class or the Tax Included status for the
distribution line before you calculate and distribute taxes for the
document.
Before you start
To change the detail tax class or tax-included setting for a
distribution line:
1. If you have not already displayed the invoice, debit note, or credit
note in the A/P Invoice Entry screen:
a. Open Accounts Payable > A/P Transactions > Invoice Entry.
b. Select the invoice, debit note, or credit note.
2. On the detail table, highlight the distribution line for which you need
to change the tax settings.
3. Click the Account/Tax button, and then press the F9 key or press
Alt+U to display the Accounts/Taxes screen.
4. Change the Detail Tax Class or the Tax Included setting.
Important! You can change the Tax Included setting only if the tax
authority permits.
5. Click Save.
Note: If you changed the detail tax class to a non-taxable class,
when you calculate tax, the total tax amount is reduced and is
prorated over all other distribution lines based on their percentages
of the total amount.
6. Click Close to return to the A/P Invoice Entry screen.

After changing the tax settings for a distribution line

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Processing Advance Credits for the Return of Goods

About Processing Advance Credits for the
Return of Goods
Accounts Payable lets you record an advance credit for goods that you
have returned to a vendor, but the vendor has not yet received and has
not yet issued a credit.
When you pay the invoice, you reduce your payment by the agreed
amount , at the same time recording the advance credit for the returned
goods.
The advance credit offsets the full amount of the invoice. However,
because the vendor has not received either a payment or the goods, it
preserves the outstanding balance for the unpaid portion of the invoice.
When the vendor issues the real credit note, you enter it in Invoice Entry,
offsetting the advance credit in the vendor account.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Entering Multicurrency Invoices, Credit Notes, and Debit Notes

About Entering Multicurrency Invoices, Credit
Notes, and Debit Notes
You enter multicurrency transactions in the same way as functionalcurrency transactions. The only extra consideration arises if you need to
change exchange rates or assign a different tax group to the transaction.
The currency for an invoice, credit note, or debit note is displayed along
with the current exchange rate when you enter a vendor number.
To change exchange-rate information for a document, use the Rates tab
that appears for multicurrency transactions. You can change the rate
type, rate date, and exchange rate for the document.
You can change the tax group for a document only to another tax group
that also uses the vendor's currency.
When you post multicurrency transactions, Accounts Payable converts
the amounts to the functional currency, using the exchange rate
information entered with the transaction.

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Entering Optional Fields on Invoices

About Entering Optional Fields on Invoices
If you use Sage 300 ERP Transaction Analysis and Optional Field
Creator and you have set up system-wide optional fields, you can define
optional fields for the A/P Invoice Entry screen.
You define optional fields for invoices and invoice details using the A/P
Optional Fields Screen in the A/P Setup folder. For more information, see
A/P Optional Fields Screen.
When you enter a new invoice, debit note, or credit note, Accounts
Payable displays any invoice optional fields that are marked for automatic
insertion, along with their default values.
The Optional Fields check box on the Invoice Entry screen shows
whether a selected document uses optional fields.
Note: The program sets this indicator. You cannot select or clear it. If
you delete all the optional fields associated with the document, the
program resets the Optional Fields indicator.

Assigning Optional Fields to Documents
You can view or change the optional fields assigned to an invoice, debit
note, or credit note, as follows:
To view or assign optional fields to a document, you use the Optional
Fields tab on the Invoice Entry screen. More...
To view or assign optional fields for a document detail, you use a
separate Optional Fields screen. Select the detail on the table, and
then click the Optional Fields column heading, or press Shift+F9.
(You can also display the detail on the Detail Accounts/Taxes screen,
and then click the Optional Fields Zoom button.) More...
You can change the value that appears for an optional field, as follows:
If the optional field is validated, you must specify a value that you
have defined for the optional field in Common Services. You can
leave the value blank only if the optional field allows blanks.
If the optional field is not validated, you can either select an value
that you defined for the optional field in Common Services, or you
can enter any value that is consistent with the type of optional field
and that does not exceed the length specified for the field.

Optional Fields for job‑related Details
On a job‑related invoice, if the detail optional fields are identical to the
optional fields used for the contract project in Project and Job Costing,
Accounts Payable uses the optional field values from the project as
default values for the details.
If an optional field you assign to an invoice detail is not used in the
contract project, the default value from the optional field record appears.
If the optional fields match the optional fields defined for Project and Job
Costing billings, the optional field information is passed to Project and
Job Costing when you post the invoice.

Optional Fields for Retainage Document Details
On retainage documents, the optional fields and values specified on the
original documents are used as defaults for the related retainage
invoices, retainage credit notes, and retainage debit notes, whether you
enter the retainage documents manually or create them using Create
Retainage Batch.

Updating General Ledger
Accounts Payable transfers optional field information to General Ledger
when you create transactions for General Ledger if:
You specified in the optional field setup record that optional field
information will be passed to the General Ledger account.
You defined the same optional fields for invoices and invoice details
as you defined for transaction details in the General Ledger account
record.
The General Ledger accounts can include:
Payables Control
Recoverable Tax
Expense Tax
Purchase Discount
Prepayment
Retainage
Realized Exchange Gain
Realized Exchange Loss
Rounding

Related Topics

Home > Entering and Posting Transactions > Invoices, Debit Notes, and Credit Notes > About
Entering Optional Fields on Invoices > About Using Optional Fields on Job-Related Invoices,
Debit Notes, and Credit Notes

About Using Optional Fields on job‑related
Invoices, Debit Notes, and Credit Notes
On job‑related invoices, debit notes, and credit notes, if the optional fields
for the document details match the optional fields used in Project and Job
Costing, the values from the contract appear as defaults, as follows:
For time and materials projects:
For basic contracts, values from matching optional fields used by
the project category appear.
For standard contracts, values from matching optional fields used
by the project resource appear.
For fixed price projects that use a Completed Project or Project
Percentage Complete accounting method, values from matching
optional fields used by the project appear.
For fixed price projects that use a Billings and Costs or Accrual-Basis
accounting method, values from matching optional fields used by the
project category appear.
For cost plus project that use a Completed Project, Total Cost
Percentage Complete, or Labor Hours Percentage Complete
accounting method, values from matching optional fields used by the
project appear.
For cost plus project that use a Billings and Costs, Accrual-Basis, or
Category Percentage Complete accounting method, values from
matching optional fields used by the project category appear.
If the invoice detail optional fields do not match those used in Project and
Job Costing, the values from the optional field setup records appear.
You can change the values, as follows:
If the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional field
allows a blank, you can leave the value blank.

If the optional field is not validated, you can select a defined value, or
you can enter any value that is consistent with the type of field,
providing your entry does not exceed the length specified for the
optional field.
The optional field information will be passed to Project and Job Costing
when you post job‑related invoices if:
You selected the Project and Job Costing Billings setting for the
optional field in the optional field setup record.
The invoice details optional fields match the optional fields defined for
Project and Job Costing billings.
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Working with Invoice Batches
The A/P Payment Batch List screen lets you work with payment batches
in a number of ways:
It provides an overview of all payment batches (entered, imported,
generated, external, ready to post, and, if you choose to show them,
deleted and posted).
It shows the status of each batch, as well as batch totals and
numbers of entries.
It provides batch maintenance functions that you use to set batches
Ready To Post, and to post and delete selected batches.
Note: You must set batches Ready To Post before you can post
them using the Post Batches screen.
It provides links to several transaction report screens.
It provides a point of entry to the A/P Payment Entry screen. You can
select and open existing batches, and create new batches, with the
click of a button.
It lets you print all the checks in a batch before you post the
payments.
Note: You can view only posted batch that you have not have cleared
using the A/P Clear History screen.
To view a list of existing payment batches:
1. Open Accounts Payable > A/P Transactions > Payment Batch
List.
2. To start the display with a specific batch number, type the number or
select it from the Finder.
Tip: To limit the list to batches that are open or ready to post, clear
the Show Posted And Deleted Batches option.

3. To edit or view an existing invoice batch in the Payment Entry screen,
double-click it on the table, or select it, and then click Open.
Note: You cannot work with posted or deleted batches.
To create a new payment batch:
1. Open Accounts Payable > A/P Transactions > Payment Batch
List.
2. Click the New button.
Accounts Payable displays the new batch in the A/P Payment Entry
screen.
For more detailed information, see Creating a New Invoice Batch.
To set a batch Ready To Post:
1. Open Accounts Payable > A/P Transactions > Payment Batch
List.
2. Select (highlight it) the open batch on the list, then double-click in the
Ready To Post field.
Note: You cannot edit a batch for which you have selected the
Ready To Post option.
After setting a batch Ready To Post, you can print the checks in the batch
and then post the batch using the Print/Post button.
To delete an invoice batch:
1. Open Accounts Payable > A/P Transactions > Payment Batch
List.
2. Select (highlight it) the batch on the list, and then click Delete.
3. When prompted, click Yes to confirm the deletion.
To print reports from the Payment Batch List screen:

1. Open Accounts Payable > A/P Transactions > Payment Batch
List.
To print the Batch Status report, click File > Print Batch Status
Report.
To print the Batch Listing report, click File > Print Batch Status
Report.
To print the posting errors report, double-click in the Number Of
Errors column for the error batch.
To print the invoice posting journal, double-click in the Posting
Sequence column for the batch.
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Creating a New Invoice Batch
Because Accounts Payable operates on a batch system, you must create
batch files to contain invoices, debit notes, credit notes, and interest
invoices before you enter these transactions.
You then post batches of transactions to update vendor accounts and
general ledger accounts, rather than posting transactions one at a time.
Before you start
To create an invoice batch:
1. Open Accounts Payable > A/P Transactions > Invoice Batch List.
2. On the Invoice Batch List screen, click the New button to open the
A/P Invoice Entry screen.
3. Enter a batch date and a description.
Tip: You can also create batches directly in the Invoice Entry screen
by clicking the New button beside the Batch Number field.
After creating an invoice batch
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Deleting an Invoice Batch
When you delete an invoice batch, all transactions in the batch are
deleted and the batch is listed as Deleted on the Batch Status report.
You cannot reuse the batch number.
To remove the data for the deleted batch from Accounts Payable, select
the Clear Deleted And Posted Batches option when you clear history
using the A/P Clear History screen.
To delete an invoice batch:
1. Open Accounts Payable > A/P Transactions > Invoice Batch List.
2. Select (highlight it) the batch on the list, and then click Delete.
3. When prompted, click Yes to confirm the deletion.
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Entering an Invoice
You use the Invoice Entry screen to add invoices and interest invoices to
invoice batches.
For an overview of invoice entry, see About Processing Invoices, Credit
Notes, Debit Notes, and Interest.
For an overview of tax calculation on invoices, see About Calculating Tax.
Important! If you use Sage 300 ERP Project and Job Costing, note that
a document can either be job‐related or not. You cannot mix job‐related
and non‐job‐related details on the same document.
Before you start
To add an invoice:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Select an existing batch using the Batch Number field, or create a
new batch. More...
3. Click the New button beside the Entry Number field to start a new
document, and then enter a description for the entry.
4. Enter header information for the document on the Document tab.
More...
5. Enter distribution details in the detail entry table. More...
To check or change the general ledger accounts and tax information
for a detail, click the Account/Tax button. (Click Close to return to
the Invoice Entry screen.)
For more information, see Editing Taxes on an Invoice, Debit Note, or
Credit Note.
6. Check to be sure you have distributed all document amounts before
you calculate tax for the document.
After distributing taxes, you should have distributed all document

amounts, and the Undistributed Amount field should show zeros.
More...
7. To check or change taxes for the document , click the Taxes tab.
Click the Distribute Taxes button to allocate tax to each of the
distributions in the list. The amounts are displayed in the Allocated
Tax column.
You can edit the tax amount that was allocated to each distribution
detail if you select Enter as the tax entry method on the Taxes tab.
For more information, see Editing Taxes on an Invoice, Debit Note, or
Credit Note.
8. On an invoice from which retainage will be deducted, use the
Retainage tab to specify terms for the retainage document.
Note: In a multicurrency ledger, you also specify which rate to use
when you process the retainage.
9. Use the Terms tab to enter Payment terms for the invoice.
10. If you use invoice optional fields, use the Optional Fields tab to view
or edit the optional fields assigned to this invoice.
11. If the document does not use the functional currency and you need to
edit the exchange rate, rate date, or rate type, use the Rates tab to
adjust them.
For more information, see Editing Exchange Rate Information on an
Invoice
12. Click Add to add this document to the batch.
13. If you need to enter a prepayment for the invoice,click Prepay to add
it now.
For more information, see Entering a Prepayment with an Invoice.
After adding an invoice, debit note, or credit note
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About Document Headers
Certain information, such as the vendor number, document number, and
document type, is the same for all details on a single invoice, credit note,
or debit note. This is the header information for the document and you
enter it on the Document tab on the A/P Invoice Entry screen.
Header information for invoices, credit notes, and debit notes includes:
Entry Number. This is a sequence number that Accounts Payable
assigns. It indicates the order in which a document was added to a
batch. Entry numbers let you select documents for editing and
identify documents on Accounts Payable reports.
Vendor Number. This number identifies the vendor, sets the default
tax group and payment terms (for invoices), and specifies the
currency of the document in multicurrency systems.
Remit To Address. You can use this field to specify the address to
which the payment should be sent.
1099/CPRS Code and Amount.
Document Type. You can select Invoice, Credit Note, Debit Note, or
Interest Charge.
Apply To. If you are entering a credit note, debit note, or interest
charge, identify the invoice to which the document applies.
Document Number. The vendor assigns this number. You can use
each document number only once.
Document Date. This is the date from which the document is aged
on reports. You can choose whether to age credit notes and debit
notes by document date or treat them as current transactions.
Invoices are always aged by due date.
Fiscal Year and Period. The fiscal calendar defined for the company
in Common Services identifies the period to which the document will
be posted.
Document Description. You enter a description that will appear on
the Invoice Batch Listing and the Invoice Posting Journal.
Tax Group. The tax group determines the tax authorities and tax

classes that apply to goods you buy from the vendor. It is also used
to calculate tax amounts for the document.
Purchase Order Number. Optional field. You can sort documents by
purchase order number in Finders and for payment application, and
you can use the number as the reference or description in G/L
transaction batches.
Sales Order Number. You can sort documents by sales order
number in Finders and for payment application, and you can use the
number as the reference or description in G/L transaction batches.
Terms Code. This field appears for invoices only. If the terms code is
for a multiple payment schedule, Accounts Payable adds an
additional Schedule tab to the screen. Otherwise, the code sets the
information in the Due Date, Discount Date, Discount %, and
Discount Amount fields.

Changing Document Header Information
After you save an invoice, you can change most of the header
information, including the following:
Document date
Description
Payment terms and discount information
Purchase order number
Sales order number
Remit-to location
Tax group
You cannot change the following header information:
Vendor number
Document type
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Calculating Excluded Taxes Automatically
You can choose to have Accounts Payable automatically calculate and
distribute taxes that should be listed separately on the invoice.
To calculate excluded taxes automatically:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Select an invoice, or enter a new one, as usual.
Before proceeding to the next step, make sure that on the Document
tab, you have:
Entered the total amount of the document in the Document Total
field.
Subtracted the excluded tax amount from the document total, and
distributed the difference using a distribution set or entering
distribution lines manually.
3. On the Taxes tab:
Select Calculate as the tax entry method for both the Tax Amount
field and the Tax Base field.
Check the tax classes. If they are not correct, use the Finder to
select the correct classes for each authority.
Double-click in the Tax Included column, or press the Spacebar, to
select No for each tax that should be listed separately on the
invoice.
Click Distribute Taxes.
Note: Because detail taxes are calculated automatically, you
cannot change the allocated tax directly for detail lines on the
Document tab. However, you can change the tax class or Tax
Included setting for an individual line, as described in step 2.
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Calculating Included Taxes Automatically
You can choose to have Accounts Payable automatically calculate and
distribute taxes that are included in the invoice totals.
To calculate included taxes automatically:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Select an existing invoice, or enter a new one, as usual.
Before proceeding to the next step, make sure that on the Document
tab you have:
Entered the total amount of the document in the Document Total
field.
Distributed the total document amount, either using a distribution
set or entering distribution lines manually. Accounts Payable
calculates the portion of each distribution that is tax.
Important! If some taxes are not included in the invoice total,
subtract these tax amounts from the document total, and then
distribute the net amount.
If you need to change the tax settings for a single distribution, do it
before you calculate tax, as follows:
Select (highlight) the distribution line.
Press the F9 key to display the Detail Accounts/Taxes screen.
Change the Tax Class or the Tax Included setting, as required.
Click OK.
3. On the Taxes tab:
Select Calculate as the tax entry method in the Tax Amount field.
Check the tax classes. If they are not correct, use the Finder to
select the correct classes for each tax authority.

Double-click in the Tax Included column, or press the Spacebar, to
select Yes for each tax that should be included in the invoice total,
and not listed separately on the invoice.
Note: You can change the Tax Included setting only if the tax
authority allows taxes to be included in invoice totals.
Click Distribute Taxes.
The Vendor Tax Class and Tax Included settings on this tab are the
default settings for all distribution lines on the Document tab.
Note: Because detail taxes are calculated automatically, you
cannot change the allocated tax directly for detail lines on the
Document tab. However, you can change the tax class or Tax
Included setting for an individual line, as described in step 2.
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Manually Entering and Distributing Tax Amounts
You can enter and distribute taxes manually on invoices, debit notes, and
credit notes if you do not select Calculate as the tax entry method.
To enter and distribute tax amounts manually:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Display an existing transaction, or create a new invoice, debit note, or
credit note, as usual. More...
3. On the Taxes tab, enter taxes for the document, as follows:
a. In the Tax Amount and/or the Tax Base field, select Enter or
Distribute as the tax entry method.
Important! You can enter or edit detail taxes only if you select
Enter as the tax entry method on this tab.
b. If you selected Enter or Distribute in the Tax Amount field, enter the
amount of each tax from the vendor's invoice.
c. If you selected Enter or Distribute in the Tax Base field, enter the
amount of each tax base.
d. Check the tax classes. If they are incorrect, use the Finder to select
the correct classes.
e. Click Distribute Taxes to allocate tax amounts proportionally to
each distribution line on the document.
4. If you selected Enter as the tax entry method, you can edit the
amount of each tax allocation, as necessary.
a. On the Document tab, select the distribution line, then click the
Account/Tax button. Make the changes in the Detail
Accounts/Taxes screen that appears.
b. Click the Taxes tab to check tax amounts for the document and
compare the totals on the screen with the totals on the source
document.

5. Click Add or Save.
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Editing Exchange Rate Information on an
Invoice
You can change the exchange rate for a document if the vendor uses a
different currency than your functional currency.
To enter exchange rate information:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Display the invoice you want to edit, or add a new invoice as usual.
3. Click the Rates tab.
Note: The Rates tab appears only in multicurrency ledgers if the
vendor does not use the functional currency.
4. In the Rate Type field, enter the code for the rate type to use to
convert the source currency to your functional currency.
5. In the Rate Date field, enter the date to use for selecting the
exchange rate.
6. If the correct exchange rate does not appear in the Exchange Rate
field, enter it, and then press the Tab key to record the rate.
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Entering a Prepayment with an Invoice
You can add one prepayment with each invoice you enter in an invoice
batch.
Note: Although you enter the prepayment through the Invoice Entry
screen, you actually add it to a payment batch.
Before you start
To add a prepayment with an invoice:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Select the open batch that contains the invoice you are prepaying, or
to which you want to add the invoice.
3. Select the existing invoice that you are prepaying.
If the invoice does not yet exist, enter the invoice information, and
then click Add or Save.
4. Click Prepay.
The Prepayments screen appears.
5. In the Batch Number field, type the number of the payment batch to
which to add the prepayment, or use the Finder to select the batch.
To create a new payment batch, click the New button beside the
Batch Number field, then enter a description and a date for the batch.
6. Fill in the remaining fields in the screen, as you would for any
prepament.
7. Click the Add button to add the prepayment.
Note: You can add only one prepayment per invoice.
Tip: To cancel a prepayment before you have processed it, click
Close without first clicking Add, then click Yes at the message that
appears.

8. Click Close.
After adding a prepayment with an invoice
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Editing Optional Fields for an Invoice Detail
Optional fields that are set up for automatic insertion with invoice details
appear as defaults when you add invoice details. You can edit or delete
the fields that appear automatically, and add any optional fields that are
set up for use with invoice details.
Before you start
To change the optional fields for a document detail:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Display the invoice that you want to edit, or enter a new invoice, as
usual.
3. On the detail table, select the detail you want to change, and then
click the Optional Fields column heading.
Tip: You can also select the detail, then press Shift+F9.
An Optional Fields screen appears, displaying any optional fields
assigned to the invoice detail.
4. On the Optional Fields screen:
Add or delete optional fields for the detail, as required. You can add
any optional fields that are defined for invoice details.
If necessary, edit the default values that appear.
Note:
If the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional
field allows blanks, you can leave the value field blank.
If the optional field is not validated, you can select a predefined
value, or you can enter any value that is consistent with the type
of field (amount, text, yes or no, and so on), providing your entry
does not exceed the length permitted for the field.
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Entering a job‑related Invoice
You can enter invoices in Accounts Payable that will update jobs that you
manage using Project and Job Costing.
Important! Invoices can be either job‑related or not job‑related . You
cannot enter a mixed invoice.
Tip: To prevent the program from inserting a default distribution line,
select None as the Distribute By option in the vendor record. If you do
not select this option, you must delete the default distribution line from
each invoice before you can enter a job‑related invoice.
Before you start
To enter a job‑related invoice:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Enter the vendor number and other header information, as usual.
3. Select the Job Related option.
Note: If the option is dimmed, delete the default distribution line
from the detail table.
Additional fields appear that have the Level 1, Level 2, and Level 3
names specified on the PJC Options screen. Accounts Payable uses
the default names, Contract, Project, and Category (and their
plurals), respectively, unless Project and Job Costing specifies
different names.
4. In the detail table, for each detail:
a. Specify the contract, project, category, and resource in the
associated field.
Depending on the project type, Accounts Payable may display the
default billing type, billing rate, A/R item number, unit of measure,

General Ledger account, and unit cost from the contract.
b. Update the billing type, billing rate, A/R item number, unit of
measure, General Ledger account, and unit cost, if required.
c. In the Quantity field, enter the quantity of the resource for which
your vendor is billing.
You enter quantities in the unit of measure specified for the detail.
d. If you use optional fields, enter the codes for the optional fields to
use for the detail.
The optional fields used for the project, category,or resource in
Project and Job Costing appear as defaults, but you can change
them.
5. Complete the rest of the tabs and fields as you would for any other
invoice, credit note, or debit note.
Note: On the Optional Fields tab, Accounts Payable displays
optional fields used for the contract in Project and Job Costing, but
you can change them.
6. Click Add when you are finished.
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Invoicing a Recurring Payable Manually
Use this procedure if you accidentally delete a recurring payable invoice,
or if you need to create an additional invoice for some other reason.
To create an invoice for a recurring payable:
1. Open Accounts Payable > A/P Vendors > Recurring Payables.
2. In the Recurring Payable Code field, select the code for the type of
payable.
3. In the Vendor Number field, select the vendor whose invoice you
want to create.
4. Click Create Invoice.
5. Fill in the fields on the Create Invoice screen that appears.
Specify the date for the invoice, as follows:
Select Next Scheduled to create an invoice using the next
scheduled date.
Select Other if you want to use a different date (for example, to
reproduce an invoice that you accidentally deleted).
If you select Other, specify the invoice date in the date field that
becomes available.
Specify whether to create a new batch for the invoice or add the
invoice to an existing invoice batch.
If you select Add To An Existing Batch, enter the batch number in
the next field (or use the Finder to select the number).
6. Click Process to create the invoice.
7. Click Close.
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Entering a Debit Note or a Credit Note
You use the Invoice Entry screen to add debit notes and credit notes to
invoice batches.
For an overview of invoice entry, see About Processing Invoices, Credit
Notes, Debit Notes, and Interest.
Before you start
To add a debit note or a credit note:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Select an existing batch using the Batch Number field, or create a
new batch. More...
3. Click the New button beside the Entry Number field to start a new
document, and then enter a description for the entry.
4. Enter header information for the document on the Document tab.
More...
5. Enter distribution details in the detail entry table. More...
To check or change the general ledger accounts and tax information
for a detail, click the Account/Tax button. (Click Close to return to
the Invoice Entry screen.)
For more information, see Editing Taxes on an Invoice, Debit Note, or
Credit Note.
6. To check or change tax information for the document, click the Taxes
tab.
For more information, see Editing Taxes on an Invoice, Debit Note, or
Credit Note
7. On a document from which retainage will be deducted, use the
Retainage tab to specify terms for the retainage document. In a
multicurrency ledger, you also specify the type of rate to use when
you process the retainage.

8. If you use invoice optional fields, click the Optional Fields tab to view
or edit the optional fields assigned to this invoice.
9. If the document does not use the functional currency and you need to
check or adjust exchange rate information, use the Rates tab.
For more information, see Editing Exchange Rate Information on an
Invoice.
10. Click Add to add this document to the batch.
11. Click Save.
After adding a debit note or credit note
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Deleting an Invoice, Debit Note, or Credit Note
You can delete invoices, credit notes, and debit notes from batches that
you have not yet posted.
Deleted documents are reported on the batch listing and posting journal
for the batch.
When you delete a document in a batch, you cannot reuse its entry
number.
To delete an invoice, credit note, or debit note:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Display the batch and the invoice you want to delete.
3. Click Delete.
4. If a message appears asking you to confirm the deletion, click Yes.
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Posting an Invoice Batch
You use the Invoice Batch List screen to post a single invoice batch.
You can post a range of invoice batches using the Post Batches screen.
For more information , see Posting a Range of Batches.
Before you start
To post a single invoice batch:
1. Open Accounts Payable > A/P Transactions > Invoice Batch List.
2. Select (highlight) the batch you want to post on the list.
3. Click Post.
Note: If the Ready To Post option is not selected for the batch, a
message appears asking whether you want to select the option and
post the batch. Click Yes.
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Posting a Range of Batches
You use the A/P Post Batches screen to post a range of invoice batches
to vendor accounts.
You can post all batches that are marked Ready To Post, or you can
specify a range of batches that are marked Ready To Post.
Before you start
To post a range of batches:
1. Open Accounts Payable > A/P Transactions > Post Batches.
2. Select the type of batch to post: Invoice, Payment, or Adjustment.
Note: You can post only one type of batch at a time.
3. Select the All Batches option to post all the batches of the chosen
type, or select Range and then specify the range numbers for the
batches you want to post.
You can post a single batch, a range of batches, or all ready-to-post
batches of the chosen type.
4. Click Post.
After posting batches
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Payments
You can enter payments in the following ways:
Use the Payment Entry screen to create new payment batches
manually, enter payments one at a time, and print single checks for
those payments.
You can also issue checks or other payments manually, and then use
the Payment Entry screen to record the checks.
Use the Create Payment Batch screen to create batches of checks
automatically.
Once you generate payment entries, you can list them, edit them
using the Payment Entry screen, print the checks, and post the
transactions to vendor accounts.
Note: You can change the information that appears on, and the layout
of, printed checks and advices. For more information, see the
documentation that comes with Crystal Reports.
About Payment Entry
Working with Payment Batches
Creating a Payment Batch Automatically
About Controlling Payments
Entering and Applying a Payment
About Entering Cash Invoices
Entering an Advance Credit for Goods You Return

Home > Entering and Posting Transactions > Payments > About Payment Entry

About Payment Entry
You use the A/P Payment Entry screen to:
Create new batches of payments.
Enter payment information for checks you have already issued or for
checks you want to print using Accounts Payable.
Apply existing documents, such as prepayments, to invoices.
Apply payments and partial payments to job‑related invoices.
Edit system-generated payment batches.
Print checks.
Enter adjustments to invoices you are paying in the Payment Entry
screen, instead of using the Adjustment Entry screen.

Types of Payment Transactions
In most cases, a payment transaction is the information that Accounts
Payable needs to print one check for a vendor and update the vendor
account with the check information.
You can enter four types of transactions using the Payment Entry screen:
Payment. Records a check, cash, or other type of payment of
outstanding transactions.
Prepayment. Records a check or other type of payment to prepay an
invoice.
Apply Document. Lets you apply one posted document against
another, such as a prepayment against an invoice.
Miscellaneous Payment. Lets you enter an invoice at the same time
as you enter the payment for an Accounts Payable vendors or for a
one-time vendor.
For each type of transaction (except Apply Document transactions), you
can print checks immediately after entry, or you can print them when you
post the payment batch.
For more information about payment types, see About Payment Types.

Restrictions on Batch Entries
The main restrictions on the entries in a single payment batch are these:
All checks in the batch must use the same bank account. (You
specify the bank when you create the payment batch.)
All checks in the batch must be in the same currency and use the
same rate of exchange between the bank currency and the functional
(home) currency (if they are different).
As with the bank, you specify the batch currency and rate when you
create the batch. (You can change the bank rate later, but not the
check currency.)
The currency you specify for a payment batch is the check currency,
not the currency of the vendors paid in the batch.
Accounts Payable lets you pay vendors in any currency you choose.
For example, you can have a functional currency of Canadian dollars,
but create a payment batch using US dollars to pay vendors in
Mexico (whose source currency is the peso).

Information Entered with Payments
For each payment batch, you enter:
Batch Number (supplied by the program).
Batch Date.
Batch Description (optional).
Bank Code.
Currency (of the payment batch in multicurrency ledgers).
Rate Date (date for establishing the rate of exchange between the
payment currency and the functional currency if you have a
multicurrency ledger).
Rate Type (such as spot rate, average rate, or weekly rate).
Bank Rate (set by the rate date and type, or overridden by the user).
You enter the following general information for payments on the Payment
Entry screen:
Entry number (select only if editing; otherwise, Accounts Payable
supplies the number).
Transaction Type (Payment, Prepayment, Apply Document, or
Miscellaneous Payment).
Description.
Vendor (do not enter for one-time vendors).
Remit To (a primary remit-to location code will appear by default if the
vendor has one; enter the payee name for miscellaneous payments).
Check Date (or Apply Date if applying a document).
Fiscal Year and Period (to which transaction posted).
Print Check (select if you want program to print it).
Check Number (if a payment or prepayment, you must enter a
number if not printing the check from Accounts Payable).
Check Language (unless you are applying a document).
Apply Method (for job‑related payments).

Optional Fields (if you use Transaction Analysis and Optional Field
Creator).
You also enter the following payment details:
Document(s) to which you are applying the transaction. How you do
this depends on the type of transaction:
For Payment-type transactions, you select documents using one of
two selection modes (Select mode or Direct mode).
For Prepayment-type transactions, you specify a document
number, purchase order number, or sales order number.
If you are applying a payment or credit note you entered before,
select the payment or credit note and the document to which it
applies.
For miscellaneous payments, you enter the distribution accounts.
Check amount. How you do this depends on the type of transaction:
For Payment-type transactions, you enter the total applied to
documents.
For Prepayment-type transactions, you enter a single amount.
For Miscellaneous Payment-type transactions, you enter the total of
all distributions.
Activation date for prepayments—usually the date you expect the
invoice.
Note: A prepayment is not considered a credit to the vendor's
account until the activation date. So, if you generate payments
using Create Payment Batch before the activation date, the
prepayment does not offset vendor invoices or debit notes.

Exchange Rates
If either the bank currency or the vendor currency differs from the
functional currency, you enter exchange rate information for
multicurrency payments on a separate Rate Override screen.

Click the Rates button to display the Rate Override screen.
There are two sets of rate information:
Bank Rate. This is the rate of exchange between the check currency
and the functional currency.
Vendor Rate. This is the rate of exchange between the vendor's
source currency and the functional currency.
You can also override the check amount if the bank currency differs from
the vendor's. This will, in turn, change the exchange rate.
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About Payment Types
In most cases, a payment transaction is the information that Accounts
Payable needs to print one check for a vendor and update the vendor
account with the check information.
However, the Payment Entry screen lets you enter four types of
transactions:
Payment. Records a check, cash, or other type of payment of
outstanding transactions. You can print the check from Payment
Entry or enter the number of a previously written check.
The program displays the vendor's outstanding transactions
(invoices, debit notes, and interest charges), and you select the
transactions you want to partially or fully pay.
Prepayment. Records a check or other type of payment to prepay an
invoice. You can print the check from Payment Entry or enter the
number of a previously written check.
Prepayments pay for a purchase before you have been invoiced for
it. When you receive the invoice, you enter it using the Invoice Entry
screen, and post it. The prepayment will then be applied against the
invoice.
Apply Document. Lets you apply a posted prepayment or credit note
to an invoice, debit note, or interest charge.
Miscellaneous Payment. Lets you enter an invoice at the same time
as you enter the payment for an Accounts Payable vendors or for a
one-time vendor for which you have not set up a vendor record.
You enter the details of the purchase in the detail entry table in the
same way as you enter an invoice. The distributions debit the general
ledger accounts you specify and credit the bank account.
Tip: If you have a large number of one-time vendors, you should
add a "miscellaneous vendor" record, so you can process payments
using Create Payment Batch and keep statistical data for this class
of vendor. Make sure that you select the option Generate Separate

Payments For Each Invoice for the miscellaneous vendor (on the
Processing tab of the Vendors screen).
If you are entering a payment for a one-time vendor, for whom you do
not create a vendor record, Accounts Payable does not create an
invoice when you post the payment.
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About Payment Limits
The A/P Control Payments screen lets you set a maximum that you can
pay for an invoice when using the Create Payment Batch screen to
generate a payment batch.
Accounts Payable applies the payment limit in Payment Entry and when
creating payment batches, as follows:
For Payment and Apply Document transactions you enter in Payment
Entry, if you apply an invoice for which a payment limit exists,
Accounts Payable displays a reduced applied amount that observes
the payment limit. It also warns you that a payment limit exists for the
invoice. You can enter a larger amount, if you want to override the
payment limit.
For Prepayment transactions in Payment Entry, when a payment limit
is applied depends on whether you are matching the prepayment to a
PO number, order number, or document number:
If you select Document Number in the Apply By field, Accounts
Payable reduces the amount consistent with the payment limit,
warns you about the payment limit, and lets you edit the applied
amount, as for Payment and Apply Document transactions.
If you select PO Number or Order Number in the Apply By field, you
do not receive a warning when you apply an amount.
The specified PO number or order number can be billed using more
than one invoice, and each invoice can have its own payment limit.
Therefore, when you post the prepayment, Accounts Payable
applies the payment limits of all invoices that use the PO or order
number, and reduces each payment, as necessary.
When generating a batch of payments using the Create Payment
Batch screen, Accounts Payable pays the invoice only up to the
amount permitted by the payment limit.
If a payment limit causes an invoice to be only partially paid,
Accounts Payable uses zero as the discount taken, even if a discount

is available, deferring the discount until the invoice is fully paid.
If you want to override the payment amount or the discount amount
calculated by Accounts Payable, you can edit the payment batch in
Payment Entry, provided you selected the option to allow edit of
system batches (on the A/P Options screen).
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About Multicurrency Payments
If you use multicurrency accounting, all payments in a payment batch are
in the currency you specify for the payment batch.

Exchange Rates are Maintained in Common
Services
The default bank rate for each transaction is set in the batch header.
Click the Zoom button beside the Currency field to view exchange rate
information for the batch.
When you create the batch, the default rate for the batch comes from
Common Services, and is based on the rate type and the session date.
The vendor exchange rate for payments, prepayments, or miscellaneous
payments also comes from Common Services, and is based on the rate
type and session date.

"Apply Document" Exchange Rates
If you are applying a document, you cannot change any rates, because
the document you are applying has already been entered and posted
with a rate.

If the Batch is in the Functional Currency
The Check Amount you enter in the Payment Detail screen is in the
functional currency.
The Applied Amount or Prepayment Amount shown on the Payment
Detail table is in the vendor currency.
The exchange rates are for converting the bank currency or the vendor
currency to your functional currency. If either of these currencies is the
functional currency, the rate for that currency will be 1.0000000.
Note: If you use the Rate Override screen to change the exchange rate,
you will change the amount in the Check Amount field, which shows the
amount in the vendor currency in this screen.
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About Posting a Payment to a Future Year
If you are near the end of your fiscal year and want to create a post-dated
check, you must post to a future year.
To do so, make sure the Create GL Transactions By option is set to
Creating a New Batch on the A/P G/L Integration screen.
If Create GL Transactions By option is set to Creating and Posting a
New Batch, the system tries to post to the current fiscal year, not a future
one, and an error message appears.
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About Reversing Posted Checks
You do not reverse posted checks in Accounts Payable. You must use
the Reverse Transactions screen in Bank Services to reverse a posted
check.
When you post the reversal in Bank Services, you can choose whether to
reinstate the associated invoice in Accounts Payable, if the invoice
information still exists. However, you cannot reinstate an invoice if the
vendor has no record in Accounts Payable (for example, if you reverse a
miscellaneous payment to a one-time vendor).
Note: If your Sage 300 ERP system uses security, you must have
authorization to use the Reverse Transactions screen in Bank Services.
For more information about reversing a posted check, see the Bank
Services help.
If you have not yet posted the payment, see Voiding a Printed Check.
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About Entering Optional Fields on Payments
If you use Sage 300 ERP Transaction Analysis and Optional Field
Creator and you have set up system-wide optional fields, you can define
optional fields for the Payment Entry screen. You can then assign these
optional fields to all types of payment transactions: payments,
prepayments, and unapplied cash, apply document, and miscellaneous
payment transactions.
You define payment optional fields using the A/P Optional Fields Screen
in the A/P Setup folder. For more information, see A/P Optional Fields
Screen.
When you enter a new payment, Accounts Payable displays any
payment optional fields that are marked for automatic insertion, along
with their default values.
The Optional Fields check box on the Payment Entry screen shows
whether a selected payment uses optional fields.
Note: The program sets this indicator. You cannot select or clear the
check box. If you delete all the optional fields associated with the
payment, the program resets the Optional Fields indicator.

Assigning Optional Fields to Particular
Payments
To view the optional fields that are assigned to a selected payment, click
the Zoom button beside the Optional Fields check box. The Optional
Fields screen appears, where you can change the values for optional
fields that appear as defaults, or delete them. You can also add any other
optional fields that you have defined for payments.
If exactly the same optional fields are defined for vendors and for
payments, the optional field values from the vendor record are used as
defaults when you enter a new payment.
You can change the default value that appears for an optional field, as
follows:
If the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional field
allows a blank, you can leave the value blank.
If the optional field is not validated, you can select a defined value, or
you can enter any value that is consistent with the type of field,
providing your entry does not exceed the length specified for the
optional field.

Updating General Ledger
When you post a payment that contains optional field information, the
optional field information specified for the payment is passed to General
Ledger and is included in the journal entry if:
You specified in the optional field setup record that optional field
information will be passed to the General Ledger account.
You defined the same optional fields for payments as you defined for
transaction details in the General Ledger account record.
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About Printing Checks
You can print vendor checks in one of the following ways:
From the Payment Entry screen, when you enter a payment for a
vendor. More...
From the Payment Batch List screen, for all the checks in a selected
payment batch. You also post the payment batch to vendor accounts
after printing the checks. More...
Once the check data has been posted, you cannot reprint the checks or
advices.
For step-by-step instructions for printing checks, see
Printing a Single Check When You Pay a Vendor
Printing Checks for a Batch of Payments. (This is the most common
way of printing checks.)

Print Formats for Checks
Sage 300 ERP Accounts Payable comes with several sample formats for
checks with attached advice slips. You can use the sample formats or
change them to suit your company's requirements (for example, to adapt
the formats if you use separate pre-printed check and advice forms)
using Crystal Reports.
For a list of the sample check-printing formats that come with Accounts
Payable, see Customizable Formats for Printed Accounts Payable
Forms.
For instructions on printing checks, see Printing Checks for a Batch of
Payments or Printing a Single Check When You Pay a Vendor.

Canceling the Printing and Posting Process
Accounts Payable does not post to vendor accounts until you confirm
that:
Checks (and advices, if printed separately) were correctly printed.
Accounts Payable can post the batch.
If the checks were not printed properly (and you cannot reprint them at
this time), you can cancel the print run as follows:
1. Answering No when the program asks whether the checks were
printed properly.
2. Setting the check status to Not Printed.
3. Clicking the Close button on the Print Checks screen.
You then have the option to void all checks that were printed.
If you void checks, the check numbers will be marked as void in Bank
Services, and a subsequent printing will issue all new check
numbers.
If you do not void checks, you will be able to specify which checks
you want reprinted the next time you choose Print/Post for this batch.
The status for the batch will be set to Check Creation In Progress,
and you will have to complete check printing in future before posting
can proceed.

Void and Reversed Checks
You cannot reprint a check once the check information has been posted
to Bank Services. However, if you delete the payment from the payment
batch after you print the check, Accounts Payable changes the status of
the check to Void in Bank Services.
You can delete payments (void checks) until you post the batch. Deleted
checks do not appear on the Accounts Payable Check Register.
If you need to put a stop-payment on a check for which you have posted
the payment to vendor accounts, you can reverse the check using the

Reconcile Statements screen in Bank Services. Accounts Payable will
reverse the payment application associated with the check when you do
the reversal.
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About Clearing Checks Electronically
The American National Standards Institute standard facilitates the
conversion of checks to electronic images so that they can be cleared
electronically. Accounts Payable lets you print ANSI-compliant checks for
the US and Canada.
The ANSI format has a slightly different layout from the other forms, as
follows:
The date is printed in one of the formats DDMMYYYY, MMDDYYYY,
YYYYMMDD, depending on your windows setup.
The currency code and currency symbol (for example, $) is printed
before the check amount, depending on the currency setup in
Common Services.
The text version of the amount prints "Dollars".
The following Accounts Payable check formats are ANSI-compliant:
APCHK01A
APCHK11A
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About Reprinting Checks
The simple rule is that you cannot reprint checks if you accept them as
correctly printed and then close the Print Checks screen.
If your checks are not printed correctly and you need to reprint them, you
must click No when Accounts Payable asks you whether the checks were
printed correctly, and then change the check status to Not Printed on the
Print Checks screen.
After you reject printed checks, you can reprint them immediately, or you
can reprint them later. If you decide to reprint the checks later, you can
choose whether to void all printed checks when you close the Print
Checks screen.
If you were printing checks using the Print/Post button on the Payment
Batch List screen, Accounts Payable does not proceed with posting.

Reprinting Checks Immediately
If you want to reprint checks that do not print correctly:
1. When asked if the checks printed correctly, click No to reject the
checks.
2. On the Print Checks screen:
a. Double-click in the Check Status column for each check to set its
status to Not Printed.
b. Click the Reprint button on the Print Checks screen to reprint the
checks.

Voiding Printed Checks
If you cannot reprint checks immediately and you want to edit the batch
later (for example, if you are entering and printing single checks from the
Payment Entry screen), you should void the check when you close the
Print Checks screen.
If you do not void the checks, Accounts Payable sets the batch status to
Check Creation In Progress, preventing you from opening or editing this
batch unless you reset the batch status.
For instructions on voiding checks during a check run, see Voiding
Printed Checks During a Check Run.

Previously Printed Checks Are Assigned “Void” Status
Accounts Payable assigns check numbers to checks just before printing
them.
If you did not cancel the previous check run, the program must void the
old check numbers and issue new ones when you reprint checks.
Accounts Payable:
Reprints the checks using a new series of check numbers beginning
with the Next Check Number specified in the Print Checks screen.
Voids the check numbers it used earlier.
Asks whether the new checks printed correctly.
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Working with Payment Batches
You use the following screens to work with payment batches:
Payment Batch List. You use this screen to create new payment
batches to which you add individual payment transactions, later,
using the Payment Entry screen. You also use this screen to view the
status of all payment batches, to set payment batches Ready To
Post, to print checks, to post batches, and to print batch listings,
batch status reports, posting journals, and posting error reports.
Payment Entry You use this screen to create a new payment batch,
and to enter and edit payments, print individual payment checks, and
adjust specific open documents.
Create Payment Batch. You use this screen to create a batch of
vendor payments automatically.
Control Payments. You use this screen to review and change the
status of transactions. You can put holds on invoices and force
payments.
You can also create a payment batch when you add a prepayment with
an invoice you are entering using the Invoice Entry screen.
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About Creating Payment Batches Automatically
You use the A/P Create Payment Batch screen to create batches of
payment entries automatically to pay all or a selection of your due
accounts.
Important! You must create a separate payment batch for each bank
account on which you want to write checks.
Once you create a batch of payments, you can edit them using the A/P
Payment Entry screen—if the Allow Edit Of System Generated
Batches option is selected on the A/P Options screen.

Preparing to Create a Payment Batch
Before you create a payment batch, you should:
Post all outstanding batches.
Post invoice batches to update vendor accounts with any new
charges, credit notes, and debit notes.
Post adjustment batches to ensure that vendor records are correct.
Post payment batches. Accounts Payable will scan all open batches
for pending payments, but problems can arise when you work on
several payment batches simultaneously.
For example, the payments listed on the Pre-Check Register will not
match the generated payment batch if you continue to enter
payments manually.
Choose Generate Separate Payments For Each Invoice in the
vendor records of any vendors who require separate invoice
payment.
Use the Control Payments screen to set maximum amounts or to
hold payments on individual invoices.
Place vendor records on hold if you want to block payments.
Edit the payment selection criteria on the Create Payment Batch
screen to exclude individual vendors from the check run.
Print the Pre-Check Register and review it before you generate the
payment batch.

The Pre-Check Register
The Pre-Check Register lists the details and totals of checks that the
program will produce, using the criteria you specify in the Create
Payment Batch screen.
After reviewing the Pre-Check Register, you may decide not to pay
certain transactions, or you may want to force payment on certain
transactions, or pay only a portion of a transaction.

If you use the Control Payments screen to add payment restrictions,
reprint the Pre-Check Register to check their effects.

Payment Criteria and Payment Selection Codes
The Create Payment Batch screen selects vendors for payment
according to criteria you specify, and creates a payment batch that you
can later edit with the Payment Entry screen.
You define the criteria for selecting payments by first defining at least one
payment selection code with the Payment Selection Codes screen. You
then select the code you want to use when you create a payment batch,
and modify the criteria, if necessary. More...

On Hold Transactions
Some transactions do not appear on the Pre-Check Register unless you
assign them a Forced status on the Control Payments screen. These
transactions include:
Transactions that are being withheld, either because the associated
vendors are on hold or because the transactions have been placed
on hold in the Control Payments screen.
Prepayments with activation dates later than the check date.
Note: The Pre-Check Register lists transactions that have a Forced
status only if the amounts of the checks that would include the forced
payments are within the minimum and maximum check amounts
specified for the check run.
The Pre-Check Register can also include all payables that were
bypassed in the check run. Bypassed transactions include transactions
placed on hold in the Control Payments screen, transactions being
withheld from payment because the vendors have been placed on hold in
the Vendors screen, and Forced transactions for amounts outside the
specified range of check amounts.

Check Language
The language for printing the check amount in text is taken from the

vendor record or primary remit-to record for each vendor. If you need to
specify a different language for individual checks, you will have to edit the
payment entries after you create the batch.
Note: The check language applies only to the textual amount printed on
each check. All other text on the check or advice comes from the check
report screen

Unposted Payment Batches
Create Payment Batch scans the payment entries in all unposted batches
to make sure that outstanding invoices are not paid twice.

Payment Controls
Create Payment Batch also checks to see whether any payment controls
have been placed on vendors or invoices using the Control Payments
screen.

Multicurrency Ledgers
All payment entries in a batch are in the same currency and are drawn
from the same bank.
All vendors being paid must have the same source currency; however,
payments do not have to match the vendor's currency. For example, you
can create a batch of checks in US dollars to pay vendors whose source
currency is the drachma.

Discounts
If you take discounts, you must specify a range of discount dates on the
Vendor and Date Selection Criteria tab of the Create Payment Batch
screen. Accounts Payable will review all documents with a discount date
within the range you specify (that meet other criteria), and take discounts
if they are available as of the batch date you specify on the Bank and
Currency Selection Criteria tab of the screen.

Optional Fields

If you use optional fields, an Optional Fields tab is available. Initially, the
tab displays any payment optional fields that you set up for automatic
insertion, along with their default entries. You can accept or change the
inserted optional field entries, or you can delete the optional fields. You
can also assign different payment optional fields to the batch.
When you generate payment entries, Accounts Payable assigns optional
fields to the payment entries, as follows, using the values specified on the
Optional Fields tab:
All payment optional fields that are set up for automatic insertion.
More...
Any additional optional fields you specified for the payment batch on
the Optional Fields tab.

Printing Checks for a Generated Batch
After creating a payment batch, you should:
Print the batch listing before you print checks. You can edit payments
and delete transactions before you print checks. Once you print
checks, you cannot edit the transactions, but you can delete them.
Print the checks and payment advices together or separately using
the Print/Post button in the Payment Batch List screen. Once you
indicate that the printed checks are acceptable, the checks are
posted to the vendor accounts.
If the checks are not acceptable, you can reprint them as often as
necessary. They will not be posted until you indicate that they are
acceptable.
For information about printing checks for a batch, see Printing
Checks for a Batch of Payments.
Print the Check Register. The Check Register provides a list of all
valid checks issued by the check printing program.
Note: Normally, you print the Check Register immediately after you
have printed and posted checks and advices.
You will likely do check runs on a regular basis—semi-monthly, for
example, or as often as necessary to maintain a consistent cash flow.
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Adding a Payment Batch
You add payments in batches.
Before you start
To create a new payment batch:
1.
2.
3.
4.

Open Accounts Payable > A/P Transactions > Payment Entry.
Click the New button beside the Batch Number field.
Enter a description for the batch.
In the Batch Date field, enter a date for the new batch.
Note: By default, the session date appears in this field.

5. In the Bank field, enter or select a bank code.
Note: Each batch can use only one bank code because the batch is
for a single check stock. If you have a multicurrency ledger, you
must also select a bank code that accepts the currency you want to
use in the batch.
6. If you have a multicurrency ledger, select the currency for the batch.
Note: You can pay vendors in any currency, but all the payments in
a batch are in the same currency. You must use a separate batch
for each currency.
Tip: To check the currency information for the batch, click the Zoom
button beside the Batch Number field to display the Batch Information
screen. On this screen, you can view and edit the default rate type, rate
date, and exchange rate that will be used for the individual entries in the
batch.
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Deleting a Payment Batch
On the Payment Batch List screen, you can delete batches.
To delete a batch:
1. Open Accounts Payable > A/P Transactions > Payment Batch
List.
2. In the Batch Number field, enter the number of the batch to be
deleted.
3. Click Delete.
All transactions in the batch will be deleted and the batch will be
listed as deleted on the Batch Status report. You cannot reuse the
batch number.
Note: To clear the data for the deleted batch from Accounts Payable,
select the Clear Deleted And Posted Batches option when you print
the Batch Status report to a printer or file.
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About Printing Payment Batch Listings
You print batch listings from the A/P Batch Listing Report. To print
payment batch listings, you can open this report in the following ways:
Open Accounts Payable > A/P Transaction Reports > Batch
Listing.
From the Payment Batch List screen:
a. Open Accounts Payable > A/P Transactions > Payment Batch
List.
b. In the Batch Number field, enter a batch number.
c. Click Print.
From the Payment Entry screen:
a. Open Accounts Payable > A/P Transactions > Payment Entry.
b. In the Batch Number field, enter a batch number.
c. On the File menu, click Print Batch Listing Report.
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Creating a Payment Batch Automatically
You use the A/P Create Payment Batch screen to create batches of
payments to pay vendor invoices that are due or have a discount
available for early payment.
Before you start
To create a payment batch:
1. Open Accounts Payable > A/P Transactions > Create Payment
Batch.
2. In the Selection Code field, enter a payment selection code.
Tip: After you specify a selection code, the Selection Code field is
no longer editable. To make the field editable again so you can
change the selection code, click Clear. Alternatively, if the Selection
Code field does not appear, you can edit all the fields in the Create
Payment Batch screen to select the records you want.
3. Fill in the fields on the Select tab.
For help on the fields on this and other tabs on the Create Payment
Batch screen, see A/P Create Payment Batch Screen.
4. Fill in the fields on the Criteria tab.
Note: Transactions must meet all selection criteria on this tab and
on the Select tab to be considered for payment.
5. If you want to exclude specific vendors who match all other selection
criteria from this payment run, add them to the list on the Exclusion
tab.
6. In multicurrency ledgers, if the bank or vendor currency is not the
functional currency and you need to change the exchange rate
information for the checks, use the Rates tab to adjust them. More...
7. Check all your criteria to make sure these are the vendors for which
you want to generate checks.

8. If you use optional fields, check the Optional Field tab to ensure that
any payment optional fields assigned to the batch are correct. Edit
the optional fields or add different ones, as necessary.
9. Make sure your printer is turned on and ready, and then click
Register to print the payment register.
10. Review the register and make whatever changes are necessary for
your check run.
Note: You can leave the Create Payment Batch screen at any time.
The program retains all the criteria you specified to ensure that the
generated checks match the Pre-Check Register.
11. When you are ready to create the payment batch, click Generate.
After creating a payment batch
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Excluding Vendors from Payment Selection
When creating a payment batch, you might need to exclude from the
selection process certain vendors that otherwise meet the payment
selection criteria. (For example, if you want to withhold payment from a
vendor until you settle a dispute over the quality of goods you received.)
You can use the Exclusion tab on the Create Payment Batch screen to
exclude a vendor from a single payment run, or you can exclude the
vendor indefinitely using the Exclusion tab on the Payment Selection
Codes screen. More...
Before you start
To exclude a vendor from a payment run:
1. Open Accounts Payable > A/P Transactions > Create Payment
Batch.
2. In the Selection Code field, enter a payment selection code.
Tip: After you specify a selection code, the Selection Code field is
no longer editable. To make the field editable again so you can
change the selection code, click Clear. Alternatively, if the Selection
Code field does not appear, you can edit all the fields in the Create
Payment Batch screen to select the records you want.
3. Fill in the fields on the Select tab, as usual.
For help on the fields on this and other tabs on the Create Payment
Batch screen, see A/P Create Payment Batch Screen.
4. Fill in the fields on the Criteria tab, as usual.
5. To exclude specific vendors who match all other selection criteria
from this payment run, add them on the Exclusion tab:
a. In the Vendor Exclusion List table, press Insert to add a new line.
b. Enter the vendor number or select it using the Finder .
Note: You must add a separate line for each vendor you want to

exclude.
6. To remove a vendor from the exclusion list, select a line on the
Vendor Exclusion List table, and then press Delete.
7. If you use optional fields, check the Optional Field tab to ensure that
any payment optional fields assigned to the batch are correct.
8. Make sure your printer is turned on and ready, and then click
Register to print the payment register.
9. Review the register and make whatever changes are necessary for
your check run.
Note: You can leave the Create Payment Batch screen at any time.
Accounts Payable retains all the criteria you specified to ensure that
the generated checks match the payment register.
10. When you are ready to create the payment batch, click Generate.
After creating a payment batch
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About Controlling Payments
When you use A/P Create Payment Batch to create a batch of checks,
you can control which checks are generated in three ways:
By using payment selection codes to apply predefined criteria to
select documents for payment.
Payment selection codes provide default settings for the Create
Payment Batch screen. These settings cover such things as the
payment bank and bank currency, the range of vendors, and a
vendor exclusion list.
By imposing payment controls, either holding or forcing payment, for
individual vendors and invoices.
By placing a vendor on hold. You cannot enter any payments for a
vendor who is on hold.

Using Payment Selection Criteria
Payment selection codes specify how Accounts Payable should select
vendor invoices for payment. You can create as many payment selection
codes as you want using the A/P Payment Selection Codes screen. For
example, you might have separate selection codes for processing US,
Canadian, and Mexican payments.
When you create a payment batch, you specify a payment selection code
that provides default criteria for creating the batch. You can override
these criteria when you create the batch.

Placing Invoices On Hold Using the Control
Payments Screen
You use the A/P Control Payments screen to control payments for a
specific vendor, document, and payment (for multiple payment
schedules).
You can also change the status or clear any invoice payment limits of
groups of transactions for a vendor or for a range of vendors.
Normally, you use the Control Payments screen after printing the PreCheck Register and reviewing the current payables to select the
transactions you want to pay.

Documents On Hold
Putting a transaction on hold means it will not be paid until you remove
the hold.
Important! Placing invoices on hold using the Control Payments screen
prevent you from generating payments using the Create Payment Batch
screen. It does not prevent you from entering checks using the
Payment Entry screen.

Forcing Payments
Forcing payment of a document means that a payment will definitely be
generated the next time you create a payment batch, provided the vendor
and the check amount are within the ranges of vendors and check
amounts specified for the batch.
Note: We recommend that you set holds and force payments to control
non-payment and payment of individual transactions, rather than trying
to achieve the same effect by changing due dates or discount dates.
For information about applying payment controls to a single document,
see About Applying Payments Controls to a Single Document.

For information about controlling payments for a range of documents, see
About Applying Payment Controls for a Range of Vendors.
For instructions on using the Control Payments screen, see Applying
Payment Controls.

Setting a Vendor On Hold
You can place an individual vendor on hold in the vendor record so that
no transactions for that vendor are paid.
Important! This restriction applies only to the Create Payment Batch
process. You cannot force a payment for an On Hold vendor using the
Control Payments screen. However, you can make payments to an On
Hold vendor manually, using the A/P Payment Entry screen.
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About Applying Payments Controls to a Single
Document
You use the Single Document tab of the Control Payments screen to
apply payment controls for a selected vendor and document. You can:
Set or change a payment limit for an invoice.
Change the due date, discount date, and discount percent or
discount amount for a selected invoice.
Change the activation date for a selected prepayment.
Place a document on hold.
Force payment of the document.
Cancel a previous control status.
To control payments for a range of documents, see About Applying
Payment Controls for a Range of Vendors.
For an overview of the Control Payments screen, see A/P Control
Payments Screen.
For complete instructions on using the Control Payments screen, see
Applying Payment Controls.

Date and Discount Changes are Permanent
Changes to the due date, discount date, discount percent, and discount
amount are permanent changes to the document.
You would make these changes after renegotiating terms or if the original
document was incorrect.

Normal Status
You use Normal status to clear documents of any Forced or On Hold
status you applied previously.

Forced Documents
Invoices and debit notes that are assigned a Forced status are paid in the
next check run, unless:
The payment amount of the check is outside the minimum and
maximum amounts specified for the check run.
The vendor bank does not match the batch bank, and you selected
the vendor record option to Select Vendors With This Bank Code
Only.
The vendor currency does not match the vendor currency for the
batch.
There is a pending payment in an open batch for the same
document.

Documents On Hold
Documents assigned an On Hold status are not paid in a system check
run until the On Hold status is removed.
On Hold documents are not applied during posting:
When you post invoice batches, Accounts Payable does not apply
any matching prepayments if either the prepayment or the invoice
has an On Hold status.
In addition, it does not apply credit notes or debit notes if either the
credit (or debit) note or the specified Apply-To document is on hold.
When you post payment batches, prepayments are not applied to
matching invoices if the invoice has an On Hold status.
Note: You can also place the vendor on hold using the Vendors screen.
To apply a prepayment, debit note, or credit note to a document you have
put on hold, you first remove the On Hold status using the Control
Payments screen, and then use an Apply Document transaction in
Payment Entry to apply the prepayment, debit note, or credit note.

Prepayment Activation
Bringing forward or delaying the activation date of a prepayment affects
payments because the A/P Create Payment Batch screen does not take
prepayments into account unless they are activated.

Payment Limit
You can use the Payment Limit field to set a maximum amount that can
be paid for a selected document when you generate payments using the
A/P Create Payment Batch screen.
You can enter a greater payment if you pay the document using the A/P
Payment Entry screen.
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About Applying Payment Controls for a Range
of Vendors
You can use the Control Payments screen to change the status or to
clear any invoice payment limits of groups of transactions for a vendor or
for a range of vendors.
You use the Range Of Documents tab to change the status of a range of
invoices, debit notes, credit notes, and prepayments for a range of
vendors. For example, use Range Of Documents to hold all invoices for
one vendor or for a vendor group. You can also clear all payment limits
for invoices in a specified range.
For information about applying payment controls to a single document,
see About Applying Payments Controls to a Single Document.
For an overview of the Control Payments screen, see A/P Control
Payments Screen.
For instructions on using the Control Payments screen, see Applying
Payment Controls.

Date and Discount Changes are Permanent
Changes to the due date, discount date, discount percent, and discount
amount are permanent changes to the document.
You would make these changes after renegotiating terms or if the original
document was incorrect.

Normal Status
You use Normal status to clear documents of any Forced or On Hold
status you applied previously.

Forced Documents
Invoices and debit notes that are assigned a Forced status are paid in the
next check run, unless:
The payment amount of the check is outside the minimum and
maximum amounts specified for the check run.
The vendor bank does not match the batch bank, and you selected
the vendor record option to Select Vendors With This Bank Code
Only.
The vendor currency does not match the vendor currency for the
batch.
There is a pending payment in an open batch for the same
document.

Documents On Hold
Documents assigned an On Hold status are not paid in a system check
run until the On Hold status is removed.
On Hold documents are not applied during posting:
When you post invoice batches, Accounts Payable does not apply
any matching prepayments if either the prepayment or the invoice
has an On Hold status.
In addition, it does not apply credit notes or debit notes if either the
credit (or debit) note or the specified Apply-To document is on hold.
When you post payment batches, prepayments are not applied to
matching invoices if the invoice has an On Hold status.
Note: You can also place the vendor on hold using the Vendors screen.
To apply a prepayment, debit note, or credit note to a document you have
put on hold, you first remove the On Hold status using the Control
Payments screen, and then use an Apply Document transaction in
Payment Entry to apply the prepayment, debit note, or credit note.

Payment Limits
You can use the Clear Payment Limit field to clear any payment limits set
for documents in the range of documents you specified.
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Applying Payment Controls
You use the A/P Control Payments screen to specify payment controls
for a single document or for ranges of transactions and vendors. More...
Important! Placing invoices on hold using the Control Payments screen
prevents you from generating payments using the Create Payment
Batch screen. It does not prevent you from entering checks using the
Payment Entry screen.
Before you start
To control payments in system-generated batches:
1. Open Accounts Payable > A/P Transactions > Control Payments.
2. To apply controls to a single document:
a. On the Single Document tab, fill in the following fields to select the
document you want to change:
Vendor Number
Document Number (invoice, credit note, debit note, or
prepayment)
Payment Number (will be "1" unless the document has a multiple
payment schedule)
b. Click the Go button or Press F7 to display information for the
document so that you can change it. The fields you can change
are:
Due Date
Discount Date
Discount Percent
Discount Amount
Document Status (Normal, Forced, or On Hold)
Activation Date for prepayments (the date after which the

prepayment is considered when calculating the amount due for
payment)
3. To apply controls to a range of documents or a range of vendors:
a. On the Range of Documents tab, fill in the following ranges:
Vendor Group
Vendor Number
Document Number (since different vendors use different
numbering systems, this option may be useful only if you are
selecting invoices from a single vendor)
b. Select the document types for which you want to change the
status.
c. Select the Document Status that you want applied.
4. Click Process.
After applying payment controls
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Entering and Applying a Payment
You use the A/P Payment Entry screen to enter and apply vendor
payments.
You can also use the Payment Entry screen to print a single check for a
vendors when you enter a payment, but if you want to enter and print
checks for a large number of vendors, use the A/P Create Payment
Batch screen.
To add a vendor payment:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Select an existing payment batch using the Batch Number field, or
create a new batch. More...
3. Click the New button beside the Entry Number field to start a new
document, and then enter a description for the entry.
If you are applying an existing payment, type the payment number in
the field, or use the Finder or navigation buttons to select the
payment.
4. Enter a description for the payment, such as Payment of Inv 7764.
5. if you are recording a check you issued to a vendor, or you are
entering a vendor check you want to print, select Payment as the
transaction type.
6. In the Vendor Number field, type or select the code that identifies
the vendor.
7. Fill in general, or header, information for the payment. More...
For more information, see A/P Payment Entry Screen.
8. If you know the numbers of the documents to which you are applying
the invoice, or there is a large number of documents for this vendor,
select the Select Mode option. Otherwise, clear this option. Then:
If you are using select mode:

i. Select the type of documents you want to display (All, Invoice, or
Debit Note).
ii. Select the order by which to list documents (Document Number,
PO Number, Due Date, Order Number, Document Date, or
Balance Due).
iii. Enter the starting number, date, or balance, depending on the
choice you made for ordering documents.
Tip: Press F5 to use a Finder to select from available options.
iv. Click the Go button, or press F7.
v. For each document to which you want to apply the payment,
select Yes in the Apply column.
vi. In the Applied Amount field, enter the amount to apply.
Notes:
By default, the entire amount is applied, and the full discount
is taken. However, you can post the transaction without fully
applying the prepayment or credit note, leaving some to be
applied at a later date.
You cannot apply more than the total amount of the payment.
vii. If an early-payment discount applies to the invoice, enter the
amount in the Discount Taken column.
Note: You can enter a discount taken that exceeds the discount
specified on the original invoice.
If you are not using select mode:
i. In the Document Number field, enter the document number.
ii. In the Payment Number field, enter "1", or enter the number of
the payment if the document has a multiple payment schedule.
iii. In the Applied Amount field, enter the amount to apply.
iv. If you are entering a partial payment for a job‑related document,

choose an apply method for the payment, and edit the distribution
for the payment, if necessary.
v. If there is a discount amount, enter it in the Discount Amount
field.
9. If you need to adjust an invoice or other document, click the Adjust
button to open the Miscellaneous Adjustment Entry screen, then:
a. Enter a reference and description for the adjustment.
b. Select the line number you want to edit on the document you are
adjusting. The program displays the distribution code and general
ledger account used in the original transaction, but you can change
them.
c. Type the amount of each adjustment detail.
d. Click Save, then click Close to return to the Payment Entry screen.
Note: The Adjust button is available only if the Allow Adjustments
In Payment Batch option is selected on the A/P Options screen.
10. If the document you are paying is job‑related , and you are only
paying part of the invoice, select an apply method, and apply the
partial payment manually. More...
11. In a multicurrency ledger, if the bank or vendor does not use the
functional currency and you need to change the exchange rate
information for the payment, click the Rates button, then for each
type of rate (bank and vendor), enter:
The rate type code.
The exchange rate. If the bank currency or the vendor matches the
functional currency, the rate for that currency is 1.0000000.
Note: The Rates button appears only if the vendor does not use
your functional currency.
The check will be in the bank currency.
12. When finished, click Add or Save.

After entering and applying payments
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About Entering Prepayments Using the Payment
Entry Screen
Use the Payment Entry screen to:
Specify the amount of the prepayment.
Specify the number of the document to which you want the
prepayment applied. You can identify the unposted document by its
invoice number, PO number, or sales order number.
You can post the invoice or the prepayment first. Accounts Payable
matches up prepayments when you post payment batches and when you
post invoice batches. If the prepayment correctly references the invoice
number, PO number, or sales order number of an invoice, it is applied to
the invoice no matter which document is posted first.
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Prepaying a Vendor
When you enter a prepayment, you can specify the document number,
purchase order number, or sales order number to which the prepayment
applies. Accounts Payable will use this number to match the posted
prepayment to the invoice when it is posted.
Note: It is not necessary to supply a matching document number when
you enter a prepayment.
You can also add a prepayment at the same time as you enter an
invoice. For more information, see A/P Invoice Entry Screen.
If Accounts Payable cannot match the invoice to the prepayment when
the invoice is posted, you use an Apply Document transaction type to
match them.
Prepayments have a payment activation date—which is the date on
which Accounts Payable considers the payment to be credited to the
vendor account. Prepayments are not used to calculate amounts due to
vendors when you use the Create Payment Batch screen until their
activation dates.
For multicurrency prepayments:
All checks in a batch are issued in the bank currency.
You enter the amount of a prepayment in the vendor's currency—
even if the vendor's currency is different from the bank currency.
If the bank or vendor does not use the functional currency, you can
use the Rate Override screen to change the exchange rate
information for the prepayment, and to see the conversion from the
vendor currency to the bank currency. For more information, see A/P
Rate Override Screen.
To add a prepayment that you will apply later:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. In the Batch Number field, enter the batch number for an existing

batch, or click the New button to create a new batch.
3. Click the New button beside the Entry Number field, and in the
field to the right, enter a description for the payment, such as
"Prepayment of PO 5664."
4. In the Transaction Type field, select Prepayment to record an
advance to a vendor account.
5. Fill in the remaining fields on the Payment Entry screen. For more
information, see A/P Payment Entry Screen.
6. If the prepayment is job‑related :
a. Select the Job Related option.
b. Click Jobs.
The Project and Job Costing Apply Details screen appears.
c. Distribute amounts to the contracts, projects, categories, and
resources for which you are making payment. For more
information, see A/P Project and Job Costing Apply Details Screen.
7. Click Add or Save.
Note: When you click Add, Accounts Payable assigns a
prepayment number to the prepayment. The number uses the prefix
and next sequence number specified on the Numbering tab of the
A/P Options screen.
After adding a prepayment
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Applying a Payment
You use the Payment Entry detail table to apply payments to specific
outstanding documents. You can apply a payment at the same time that
you enter it, or at a later time.
Once you have applied the payment, you can save the transactions and
print the check, if you want.
Before you start
To apply a payment to an invoice:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. In the Batch Number field, enter a batch number.
3. In the Entry Number field, enter the number of the payment you
want to apply.
4. If you know the numbers of the documents to which you are applying
the invoice, or there is a large number of documents for this vendor,
select the Select Mode option. Otherwise, clear this option. Then:
If you are using select mode:
i. Select the type of documents you want to display (All, Invoice, or
Debit Note).
ii. Select the order by which to list documents (Document Number,
PO Number, Due Date, Order Number, Document Date, or
Balance Due).
iii. Enter the starting number, date, or balance, depending on the
choice you made for ordering documents.
Tip: Press F5 to use a Finder to select from available options.
iv. Click the Go button, or press F7.
v. For each document to which you want to apply the payment,
select Yes in the Apply column.
vi. In the Applied Amount field, enter the amount to apply.

Notes:
By default, the entire amount is applied, and the full discount
is taken. However, you can post the transaction without fully
applying the prepayment or credit note, leaving some to be
applied at a later date.
You cannot apply more than the total amount of the payment.
vii. If an early-payment discount applies to the invoice, enter the
amount in the Discount Taken column.
Note: You can enter a discount taken that exceeds the discount
specified on the original invoice.
If you are not using select mode:
i. In the Document Number field, enter the document number.
ii. In the Payment Number field, enter "1", or enter the number of
the payment if the document has a multiple payment schedule.
iii. In the Applied Amount field, enter the amount to apply.
iv. If you are entering a partial payment for a job‑related document,
choose an apply method for the payment, and edit the distribution
for the payment, if necessary.
v. If there is a discount amount, enter it in the Discount Amount
field.
5. Click Add or Save to add and apply the payment.
After applying a vendor payment to an invoice
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Displaying an Existing Payment to Apply or Edit
You can display an existing payment to:
Apply the payment to the vendor account.
Edit amounts you previously applied for this payment.
Enter the distribution details for a miscellaneous payment.
To display a payment:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. In the Batch Number field, enter the batch that contains the payment
you want to apply or edit.
Note: To view header information for a payment batch, click the
Zoom button beside the Batch Number field. For more
information, A/P Batch Information Screen (Payment Entry).
3. In the Entry field, enter the payment entry number.
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Applying Prepayments and Credit Notes Using
the Payment Entry Screen
Use the Payment Entry detail table to:
Apply new payments to outstanding transactions.
Apply previously posted prepayments and credit notes.
Change unposted payment applications.
Enter adjustments to invoices, credit notes, or debit notes (if you use
the Allow Adjustments In Payment Batch option).
View the history of applications to a document.
To apply a prepayment or credit note:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Enter the Document number of the prepayment or credit note you
want to apply.
Accounts Payable will display the amount that you can apply in the
Unapplied Amount field.
3. If you use optional fields and you want to view or edit any payment
optional fields automatically assigned to this transaction, click the
Zoom button beside the Optional Fields option.
The Optional Fields screen appears, letting you edit or delete the
optional fields assigned to this transaction. You an also assign
different payment optional fields.
4. If you know the numbers of the documents to which you are applying
the invoice, or there is a large number of documents for this vendor,
select the Select Mode option. Otherwise, clear this option. Then:
If you are using select mode:
i. Select the type of documents you want to display (All, Invoice, or
Debit Note).
ii. Select the order by which to list documents (Document Number,

PO Number, Due Date, Order Number, Document Date, or
Balance Due).
iii. Enter the starting number, date, or balance, depending on the
choice you made for ordering documents.
Tip: Press F5 to use a Finder to select from available options.
iv. Click the Go button, or press F7.
v. For each document to which you want to apply the payment,
select Yes in the Apply column.
vi. In the Applied Amount field, enter the amount to apply.
Notes:
By default, the entire amount is applied, and the full discount
is taken. However, you can post the transaction without fully
applying the prepayment or credit note, leaving some to be
applied at a later date.
You cannot apply more than the total amount of the payment.
vii. If an early-payment discount applies to the invoice, enter the
amount in the Discount Taken column.
Note: You can enter a discount taken that exceeds the discount
specified on the original invoice.
If you are not using select mode:
i. In the Document Number field, enter the document number.
ii. In the Payment Number field, enter "1", or enter the number of
the payment if the document has a multiple payment schedule.
iii. In the Applied Amount field, enter the amount to apply.
iv. If you are entering a partial payment for a job‑related document,
choose an apply method for the payment, and edit the distribution
for the payment, if necessary.
v. If there is a discount amount, enter it in the Discount Amount

field.
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Applying a Posted Prepayment or a Credit Note
You can apply a poster prepayment.
Before you start
To apply a prepayment or credit note to an invoice or a debit note:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. In the Batch Number field, enter the batch number for an existing
batch, or click the New button to create a new batch.
3. Click the New button to the right of the Entry Number field, and
then enter a description for the transaction, such as "Apply
Prepayment to Inv 7764."
4. In the Transaction Type field, select Apply Document.
5. Fill in the remaining fields on the Payment Entry screen. For more
information, see A/P Payment Entry Screen.
6. If you know the numbers of the documents to which you are applying
the invoice, or there is a large number of documents for this vendor,
select the Select Mode option. Otherwise, clear this option. Then:
If you are using select mode:
i. Select the type of documents you want to display (All, Invoice, or
Debit Note).
ii. Select the order by which to list documents (Document Number,
PO Number, Due Date, Order Number, Document Date, or
Balance Due).
iii. Enter the starting number, date, or balance, depending on the
choice you made for ordering documents.
Tip: Press F5 to use a Finder to select from available options.
iv. Click the Go button, or press F7.
v. For each document to which you want to apply the payment,
select Yes in the Apply column.

vi. In the Applied Amount field, enter the amount to apply.
Notes:
By default, the entire amount is applied, and the full discount
is taken. However, you can post the transaction without fully
applying the prepayment or credit note, leaving some to be
applied at a later date.
You cannot apply more than the total amount of the payment.
vii. If an early-payment discount applies to the invoice, enter the
amount in the Discount Taken column.
Note: You can enter a discount taken that exceeds the discount
specified on the original invoice.
If you are not using select mode:
i. In the Document Number field, enter the document number.
ii. In the Payment Number field, enter "1", or enter the number of
the payment if the document has a multiple payment schedule.
iii. In the Applied Amount field, enter the amount to apply.
iv. If you are entering a partial payment for a job‑related document,
choose an apply method for the payment, and edit the distribution
for the payment, if necessary.
v. If there is a discount amount, enter it in the Discount Amount
field.
7. If you are issuing a payment that is not in your functional currency,
click Rates to check or edit the exchange rate used for this payment.
8. If you need to adjust a document you are paying:
a. Click Adjust.
The Miscellaneous Adjustment Entry screen appears.
Note: This button is available only if the Allow Adjustments In

Payment Batch option is selected on the A/P Options screen.
b. Enter a reference and description for the adjustment.
c. Enter the distribution code or general ledger account number for
each adjustment detail.
d. Enter the amount of each adjustment detail.
e. Click Save.
f. Click Close to return to the Payment Entry screen.
9. Click Add or Save to apply the prepayment or credit note.
After applying a prepayment or credit note to an invoice or a debit note
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Applying a Payment or Credit Note to a
job‑related Invoice
You can distribute payment amounts to invoices.
Before you start
To apply amounts to details for different contracts, projects,
categories, and resources:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Display the payment, prepayment, or credit note.
3. On the detail table, for the job‑related invoice you are paying, select
Yes in the Apply column.
4. Click Jobs.
The Project and Job Costing Apply Details screen appears.
5. Enter the amount to apply to the selected invoice.
6. In the Apply Method field, specify one of the following methods to
apply the amount to contracts, projects, categories, and projects that
appear on the invoice:
Top Down. Select this method to apply an amount automatically to
invoice details beginning with the first detail (contract-projectcategory-resource) on an invoice until the amount is fully applied.
If you are using this method to allocate a payment to an invoice that
uses a multiple payment schedule, you may have to adjust the
allocations manually.
Note that discounts, if any, are applied to the last line only. If you
wish to allocate discounts proportionately, you should select the
Prorate By Amount option.
Prorate By Amount. Select this method to apply a payment
amount proportionately to all invoice details, depending on the
relative amounts of the details.

7. Select any details that are not being paid at this time, and then click
Clear to remove the details from the distribution.
8. Click Close to return to the Payment Entry screen.
9. Click Add or Save.
Tip:
If you accidentally delete a line, or if you use the Clear button to remove
all the lines, you can use the Apply Line Number Finder to select a
particular detail for payment. More...

Related Topics

Home > Entering and Posting Transactions > Payments > Entering and Applying a Payment >
Applying a Payment > Partially Paying a Job-Related Document

Partially Paying a job‑related Document
You use the A/P Payment Entry screen to apply partial payments to
invoices.
To apply partial payments to job‑related invoices:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Enter payment header details as usual, including the vendor number,
transaction date, year, and period.
3. Select an apply method to use as the default for the current payment
entry. For more information, see A/P Payment Entry Screen.
4. Select the job‑related invoice you want to pay in one of the following
ways:
Select the Select Mode option, click the Go button to display the
unpaid invoices for the selected vendor, and then select Yes in the
apply column for the invoice.
Clear the Select Mode option, and then enter the invoice number in
the document field in the detail table.
5. Enter the amount of your payment in the Applied Amount column
for the selected invoice, then navigate out of the field.
6. If the Applied Amount is less than the current balance and you want
to select particular details to which to apply the partial payment or to
use a different apply method for this invoice:
a. Click Jobs to open the Project and Job Costing Apply Details
screen.
b. Select the apply method to use to allocate the partial payment to
invoice details.
c. Click the Go button to display the invoice details.
d. Select any details that are not being paid at this time, then click
Clear.
e. Make sure the amounts allocated to invoice details are correct.

Notes:
If you do not use an apply method to allocate amounts to the
details, or you want to change the allocated amounts, you can
manually enter or change the amounts that you are paying for
invoice details.
To add or save the invoice, the Unapplied Amount must be zero,
meaning that the sum of the amounts applied to the details is
the same as the total applied to the invoice. For example, you
might need to adjust the amounts for an invoice that uses a
multiple payment schedule.
f. Click Close to return to the Payment Entry screen.
g. Click Save.
7. Click Add.

Related Topics

Home > Entering and Posting Transactions > Payments > Entering and Applying a Payment >
Applying a Payment > Writing Off Small Differences During Payment Entry

Writing Off Small Differences During Payment
Entry
You can adjust a document only if you have applied a payment to it by
entering a Payment transaction.
Before you start
To adjust a document during payment entry:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Create a new Payment or Apply Document transaction, or select one
for editing.
3. On the detail table, select Yes in the Apply column for the document
you want to adjus, and then, in the Applied Amount column, enter
the amount you are paying or applying to the document.
4. With the apply-to document selected, click Adjust.
The Miscellaneous Adjustment Entry screen appears.
5. Enter a reference and description for the adjustment, and then, for
each adjustment detail:
a. In the Adjust Line Number field, use the Finder to select the
document detail you want to adjust.
b. Enter a distribution code or general ledger account number for the
adjustment detail.
c. Enter the adjustment amount for the detail.
6. When finished, click Close to return to the Payment Entry screen.
7. Click Add or Save.
8. Do one of the following:
If you have issued a manual check:
i. Zero the check number, and then select the Print Check option.
ii. Adjust the invoice to which the payment is applied, and then save
the payment.

iii. Edit the payment again after saving the changes, this time
clearing the Print Check option and entering the check number.
If you have not issued a manual check:
i.
ii.
iii.
iv.

Select the Print Check option.
Apply the transaction.
Save the transaction.
Highlight the invoice you want to adjust, click Adjust, enter the
adjustment details, and save the adjustment.
v. Edit the payment once again to clear the Print Check option and
enter the number of the check you issued.

Related Topics
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Viewing Document History when Applying a
Payment or a Credit Note
You can view information about what has previously been applied to a
document, including:
Transaction type
Check/document number
Transaction date
Applied amount
Transaction description
Vendor number and name
Note: These instructions assume you are working with the payment or
credit note in the Payment Entry screen.
Before you start
To view the history of an invoice, credit note, or debit note while
applying a payment or credit note:
1. On the Payment Entry screen, select a document in the detail table.
2. In the Apply field, select Yes (double-click in the Apply field to
change the selection from No to Yes, or from Yes to No).
3. Click History.
The Document History screen appears, providing information about
each document that was previously applied to the selected invoice,
credit note, or debit note.
Note: You cannot change any of the information on this screen.
4. Click Close to return to the Payment Entry screen.

Related Topics

Home > Entering and Posting Transactions > Payments > Entering and Applying a Payment >
Changing Optional Fields

Changing Optional Fields
If you use exactly the same optional fields in vendor records and on
payments, the program assigns the optional field values used in the
vendor record to the payment.
You can accept or delete the optional fields that appear as defaults, and
you can add other optional fields that you have set up for payment
documents. You can also change the optional field values used in the
entry.
To check or to change the optional fields and values for a payment:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Click the Zoom button beside the Optional Fields option.
The Optional Fields screen appears, displaying any optional fields
that are marked for automatic insertion on new payments.
3. On the Optional Fields screen, add or delete optional fields for the
payment document.
You can add any optional fields that are defined for invoice details.
You can also change the default values that appear, as follows:
If the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional
field allows blanks, you can leave the value field blank.
If the optional field is not validated, you can select a predefined
value, or you can enter any value that is consistent with the type of
field (for example, amount, text, yes or no), providing your entry
does not exceed the length permitted for the field.

Related Topics

Home > Entering and Posting Transactions > Payments > Entering and Applying a Payment >
Voiding a Printed Check

Voiding a Printed Check
If you made a mistake when writing a check, then printed the check
before realizing the error, you can void the check through Bank Services
or from the A/P Payment Entry screen.
To void a printed check from the Payment Entry screen:
1.
2.
3.
4.
5.

Open Accounts Payable > A/P Transactions > Payment Entry.
Display the batch and the entry.
On the detail table, select a check to void.
Click Void Check.
When prompted, click Yes.

Related Topics

Home > Entering and Posting Transactions > Payments > About Entering Cash Invoices

About Entering Cash Invoices
The Payment Entry screen lets you enter invoices at the same time as
you enter payments for existing vendors as well as for one-time vendors.
In some programs, this is called a "cash invoice."
To enter an invoice when you add a payment, you must select Misc.
Payment as the transaction type. Accounts Payable then displays a
detail-entry table where you can enter general ledger account
distributions for the payment, as you would to add an invoice using the
Invoice Entry screen.
The distributions debit the general ledger accounts you specify and credit
the bank account you chose for the batch.
When you post the miscellaneous payment, Accounts Payable creates
an invoice transaction as well as a payment transaction. The entries are
combined on the same posting journal.
Note:
Invoices created for a miscellaneous payment do not include:
Retainage.
Optional fields.
Terms. (The invoice is paid immediately.)

One-Time Vendor or Accounts Payable Vendor
If you are entering a miscellaneous payment for an existing vendor, you
must enter the invoice number and the vendor number. When you add
the entry, Accounts Payable creates an invoice document that uses this
number.
Note: To enter a cash invoice for a one-time vendor, you must leave the
Vendor Number field blank. You enter the payee name and address in
the screen that opens when you click the Zoom button beside the
Remit-To field.

job‑related Miscellaneous Payments
Payment Entry also lets you enter job‑related details for miscellaneous
payments. To display the necessary job‑related fields, select the Job
Related option on the Payment Entry screen before you enter any details.

Calculating Tax for Miscellaneous Payments
Accounts Payable calculates tax and updates tax services for
miscellaneous payments, as it does for invoices you enter using the
Invoice Entry screen.
The program displays tax information from the vendor record as defaults,
which you can change for a miscellaneous payment, as follows:
To change the tax group or other tax information for the document,
you use the A/P Document Taxes Screen. (You can use a tax group
that is from the one specified in the vendor record.) For more
information, see A/P Document Taxes Screen.
To change tax information for the invoice details, you use the
separate A/P Detail Accounts/Taxes Screen (Miscellaneous
Payments) to enter the details and detail tax information. For more
information, see A/P Detail Accounts/Taxes Screen (Miscellaneous
Payments).

Related Topics
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Entering a Cash Invoice or Miscellaneous
Payment
You enter a miscellaneous payment to issue a check to a person or
company for which no vendor record exists in Accounts Payable. For
example, you could enter a miscellaneous payment to record a purchase
from a one-time vendor.
You can also enter a miscellaneous payment for an existing Accounts
Payable vendor and create an invoice at the same time, so you do not
have to enter the invoice separately in the Invoice Entry screen. This type
of payment is known as a a "cash invoice."
Note: Accounts Payable does not create an invoice when you post a
payment for a one-time vendor, for whom you do not create a vendor
record.
To add a cash invoice or cash payment:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Select an existing payment batch using the Batch Number field, or
create a new batch. More...
3. Click the New button beside the Entry Number field to start a new
document, and then enter a description for the payment (such as
Payment for camera).
4. Select Misc. Payment as the transaction type.
5. If the payment is for an existing vendor, enter the vendor number in
the Vendor Number field, or use the Finder to select the vendor.
6. Fill in general, or header, information for the payment. More...
For more information, see A/P Payment Entry Screen.
7. Enter distribution details for the payment, as you would for an
invoice. More...
8. To check or change the taxes calculated for the document (including
the tax reporting amount), or to change the tax group for the

document, click the Taxes button.
9. To check the taxes calculated for a distribution detail, or to enter them
manually, select the detail, then click the Account/Tax button.
To find out about entering taxes manually, see Editing Taxes on an
Invoice, Debit Note, or Credit Note.
10. In a multicurrency ledger, if the bank or vendor does not use the
functional currency and you need to change the exchange rate
information for the payment, click the Rates button, then for each
type of rate (bank and vendor), enter:
The rate type code.
The exchange rate. If the bank currency or the vendor matches the
functional currency, the rate for that currency is 1.0000000.
Note: The Rates button appears only if the vendor does not use
your functional currency.
The check will be in the bank currency.
11. When finished, click Add or Save.
After entering and distributing the payment

Related Topics
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Distributing Miscellaneous Payment Details
The Payment Entry screen lets you distribute a miscellaneous payment
to general ledger accounts.
Once you have distributed the payment, you can save the transaction
and print the check.
To distribute a miscellaneous payment:
1. For each account to which you want to distribute this payment:
Enter the distribution code or the general ledger account number.
Enter the amount.
Note: You can enter a negative amount on a detail line. However,
the document total cannot be a negative amount.
Optionally enter a reference and description.
2. Specify distribution details. More...
3. On the Rates tab, assign an exchange rate for the miscellaneous
payment.
Note: This tab appears only in multicurrency systems.
4. Click Add.

Related Topics

Home > Entering and Posting Transactions > Payments > Entering an Advance Credit for
Goods You Return

Entering an Advance Credit for Goods You
Return
You can record an advance credit for goods you have returned.
Before you start
To process an advance credit:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Display the payment entry.
3. Click the Zoom button beside the Advance Credit field.
The Advance Credit screen appears.
4. For each claim for which you are recording a credit, press Insert to
create a detail line, and then complete the following detail fields:
Document Number. Enter a number to identify the debit document
that the system will produce for the advance credit.
The number should help you to match this document with the credit
note, when it arrives. For example, if your vendor has given you an
RMA number, you could use that for the document number (say
RMA-00001).
Reference. Enter a meaningful reference number to identify the
specific document that will be credited, typically, an invoice number.
Description. Enter a description for the debit note, such as a
description of the goods you are returning and the reason.
Claim Amount. Enter the amount the vendor is crediting you for
the return of the goods.
Note: The Advance Credit field displays the total amount of
advance credits entered.
5. Click Close to return to the Payment Entry screen, where you apply
the Payment (including the advance credit), as usual.

6. Click Save.
After adding an advance credit

Related Topics

Home > Entering and Posting Transactions > Adjustments

Adjustments
In Accounts Payable, you can:
Enter adjustments individually using the A/P Adjustment Entry
screen.
Adjust specific documents in the A/P Payment Entry screen, if the
Allow Adjustments In Payment Batches option is selected on the
A/P Options screen.
About Processing Adjustments
Adjusting a Posted Transaction
About Entering Optional Fields on Adjustment Transactions

Home > Entering and Posting Transactions > Adjustments > About Processing Adjustments

About Processing Adjustments
Accounts Payable provides several convenient methods by which you
adjust transactions and account balances.
In Accounts Payable, you enter adjustments individually in one of the
following ways:
By entering an adjustment transaction using the A/P Adjustment
Entry screen, specifying the document number to adjust and the
general ledger account to debit or credit.
When you add an adjustment, Accounts Payable automatically
assigns a document number, beginning with 1.
By adjusting specific documents using the Payment Entry screens,
provided the Allow Adjustments In Payment Batches option is
selected on the A/P Options screen.
By entering a debit note or a credit note using the A/P Invoice Entry
screen. You use this method to adjust documents that have been
completed and cleared from Accounts Payable, or to enter a general
adjustment to an account balance.
Vendor statistics include the total amount and number of adjustments
entered for the period, and the amount and date of the last adjustment
transaction entered.

Updating Bank Services
Important! If you make any adjustments that affect a bank account, you
must make a second adjustment in Bank Services.
Accounts Payable does not send adjustment information to Bank
Services.

Related Topics

Home > Entering and Posting Transactions > Adjustments > About Processing Adjustments
Creating or Modifying an Adjustment Batch

Creating or Modifying an Adjustment Batch
You use the A/P Adjustment Entry screen to create and modify batches of
adjustments.
To create an adjustment batch:
1. Open Accounts Payable > A/P Transactions > Adjustment Entry.
Note: You can also open the Adjustment Entry screen by clicking
New on the Adjustment Batch List screen.
2. Click the New button beside the Batch Number field.
3. Enter a description and a date for the batch.
4. Enter adjustments. For more information, see Adjusting a Posted
Transaction.
To edit an existing adjustment batch:
1. Open Accounts Payable > A/P Transactions > Adjustment Entry.
Note: You can also open the Adjustment Entry screen by clicking
New on the Adjustment Batch List screen.
2. In the Batch Number field, enter a batch number.
3. Make the changes you need to adjustments in the batch.
Note: To view and edit header information for the batch, click the
Zoom button beside the Batch Number field.
4. Click Save.
After creating or modifying an adjustment batch

Related Topics
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Opening an Existing Adjustment Batch

Opening an Existing Adjustment Batch
You can view or open existing adjustment batches.
To open an existing adjustment batch:
1. Open Accounts Payable > A/P Transactions > Adjustment Batch
List.
2. If there are a large number of adjustment batches, enter a batch
number in the Batch Number field.
Tip: To show only batches that are open or ready to post, clear the
Show Posted And Deleted Batches option.
3. Click Open.

Related Topics

Home > Entering and Posting Transactions > Adjustments > About Processing Adjustments
Deleting an Adjustment Batch

Deleting Adjustments
You can delete individual adjustments, or whole adjustment batches.
To delete an individual adjustment entry:
1.
2.
3.
4.
5.

Open Accounts Payable > A/P Transactions > Adjustment Entry.
In the Batch Number field, enter a batch number.
Select an adjustment entry.
Click Delete.
If a message appears asking you to confirm the deletion, click Yes.

To delete an adjustment batch:
1. Open Accounts Payable > A/P Transactions > Adjustment Batch
List.
2. In the Batch Number field, enter a batch number.
3. Click Delete.
4. If a message appears asking you to confirm the deletion, click Yes.
All transactions in the batch will be deleted and the batch will be
listed as deleted on the Batch Status report. You cannot reuse the
batch number.
Note: To clear the data for the deleted batch from Accounts
Payable, select the option Clear Deleted And Posted Batches from
the A/P Clear History screen.

Related Topics
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Posting an Adjustment Batch

Posting an Adjustment Batch
You can post adjustment batches individually from the A/P Adjustment
Batch List screen.
To post a range of batches, use the A/P Post Batches screen. For more
information, see Posting a Range of Batches.
Before you start
To post an adjustment batch:
1. Open Accounts Payable > A/P Transactions > Adjustment Batch
List.
2. Select the batch you want to post.
3. In the Ready To Post field for the selected batch, specify Yes.
4. Click Post.

Related Topics
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Adjusting a Posted Transaction
If you need to change the amount for a posted transaction, you do so by
entering an adjustment. You can also make changes to an existing
adjustment, and then save your changes.
To add an adjustment:
1. Open Accounts Payable > A/P Transactions > Adjustment Entry.
2. Select or create the adjustment batch to use.
3. To assign the entry number, click the New button beside the Entry
Number field.
4. Enter an optional description for the entry, then enter the adjustment
date, the posting date, the vendor number, an optional reference and
reference description, the document number to adjust, and the
payment number (if the adjusted document includes a payment
schedule).
5. Use the Finder for the Adjust Line Number field to select a detail for
adjustment.
6. Include for each detail:
The distribution code or the general ledger account number.
The amount. (Enter a positive amount to reduce the balance of an
invoice or debit note, or a negative amount to increase the balance
of these documents.)
If the adjustment is for a job‑related document, the contract,
project, and category to adjust in Project and Job Costing.
7. If you use retainage accounting, adjust retainage as necessary. For
more information, see About Processing Retainage in Accounts
Payable.
8. Click Add.
Note: This button changes to Save. If you make changes to the
adjustment after you have added it, click Save to record your

changes.

Related Topics
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About Entering Optional Fields on Adjustment
Transactions
If you use Sage 300 ERP Transaction Analysis and Optional Field
Creator and you have set up system-wide optional fields, you can define
optional fields for the Adjustment Entry screen.
You define adjustment optional fields using the A/P Optional Fields
Screen in the A/P Setup folder. For more information, see A/P Optional
Fields Screen.
When you enter a new adjustment transaction, Accounts Payable
displays any optional fields that are marked for automatic insertion in
adjustments, along with their default values.
The Optional Fields check box on the Adjustment Entry screen shows
whether a selected adjustment uses optional fields.
Note: The program sets this indicator. You cannot select or clear the
check box. If you delete all the optional fields associated with the
adjustment, the program resets the Optional Fields indicator.

Assigning Optional Fields to Particular
Adjustments
To view the optional fields that are used on a selected adjustment, click
the Zoom button beside the Optional Fields check box. The Optional
Fields screen appears, where you can change the values for optional
fields that appear as defaults, or delete them. You can also add any other
optional fields that you have defined for adjustments.
Accounts Payable assigns default values to adjustment optional fields as
follows:
If the optional fields used on the original document are the same as
the adjustment optional fields, the values from the original document
appear.
If the vendor and adjustment optional fields are the same, the
program displays the values from the vendor record. However, if the
optional field is also used on the original document, the value from
the original document is used.
If an adjustment optional field is not used either on the original
document or in the vendor record, the program uses the default value
specified in the optional field setup record.
You can change the default value that appears for an optional field, as
follows:
If the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional field
allows a blank, you can leave the value blank.
If the optional field is not validated, you can select a defined value, or
you can enter any value that is consistent with the type of field,
providing your entry does not exceed the length specified for the
optional field.

Updating General Ledger
When you post an adjustment that includes optional fields, the optional

field information specified for the adjustment is included in the journal
entry passed to General Ledger if:
You specified in the optional field setup record that optional field
information will be passed to the General Ledger account.
You defined the same optional fields for adjustments as you defined
for transaction details in the General Ledger account record.

Related Topics

Home > Periodic Processing in Accounts Payable

Periodic Processing in Accounts Payable
Use Accounts Payable Periodic Processing screens to perform tasks that
are part of your regular period-end procedures, such as clearing history,
creating general ledger batches, and deleting inactive records.
Periodic Processing Procedures
About Creating General Ledger Transactions
About Checking Data Integrity
About Processing Recurring Payables
About Processing Retainage in Accounts Payable
About Deleting Inactive Records
Clearing Obsolete Data from Accounts Payable
Clearing Statistics
Filing 1099 Reports Electronically
Filing a T5018 (CPRS) Information Return Electronically
About Revaluing Multicurrency Transactions
About Year End Processing in Accounts Payable

Home > Period-End Procedures > Periodic Processing Procedures

Periodic Processing Procedures
There are several Accounts Payable screens you can use to complete
the types of processing you do at specified intervals, such as at month
end or period end, and to remove obsolete data and records.
This section outlines periodic procedures you might follow, and tells you
how to use Accounts Payable to accomplish the tasks.
1. Update Accounts Payable records, such as entering changes of
address, making corrections, and selecting the Inactive option for
records you plan to delete.
Use the icons in the A/P Vendors and A/P Setup folders to revise
these records.
2. Post transactions that apply to the period, and then print and file the
posting journals.
Use the Invoice Entry, Payment Entry, and Adjustment Entry icons in
the A/P Transactions folder.
3. Print the Vendor Transactions and Aged Payables reports to identify
amounts that should be paid, or that require other action.
Use the Vendor Transactions and Aged Payables icons in the
A/P Transaction Reports folder to print the reports.
4. Use the Create Recurring Payable Batch icon in the A/P Periodic
Processing folder to generate invoices for the recurring payables you
have set up.
5. Create and post batches of adjustments, such as transactions to
correct errors found when you reconcile bank statements.
Use the Adjustment Entry icon in the A/P Adjustments folder.
6. If you have a multicurrency ledger, you may need to update
exchange rates in Common Services and revalue multicurrency
transactions and balances periodically, to reflect changes in
exchange rates.
Use the Revaluation icon in the A/P Periodic Processing folder.

7. Print the G/L Transactions report, and then create any outstanding
general ledger transactions.
Use the G/L Transactions icon in the A/P Transaction Reports folder
to print the report, and the Create G/L Batch icon in the A/P Periodic
Processing folder to create transactions.
Process the batches in Sage 300 ERP General Ledger, if you use it,
or post them manually to your other general ledger.
8. Clear the paid transactions, vendor comments, and statistics that you
no longer need, and delete records that you classed as inactive and
prepared for deletion.
Use the Clear History, Clear Statistics, and Delete Inactive Records
icons, respectively, in the A/P Periodic Processing folder to clear this
information.
9. Use the 1099 Electronic Filing icons in the A/P Periodic Processing
folder to file 1099s electronically, if you are required to file 1099
forms. (If you do not file electronically, you choose the 1099/CPRS
Amounts screen from the Vendor Reports folder to print out the
forms.)

Related Topics
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About Creating General Ledger Transactions
When you post invoice batches, Accounts Payable creates transactions
for the inventory or expense accounts to which the invoices are
distributed and creates balancing transactions for the general ledger
payables control accounts.
If you want to automatically create general ledger transaction batches
each time you post Accounts Payable transactions, select the option to
Create G/L Transactions During Posting (on the A/P Options screen).
To create general ledger batches only when you want to, select Create
G/L Transactions On Request Using Create G/L Batch Icon.
Note: If you use the Create G/L Batch screen, you must create the
transactions before using the Year End screen to do year-end
processing.

Reporting G/L Transactions
The G/L Transactions report and the summary at the end of each
Accounts Payable posting journal lists the general ledger accounts that
will be debited and credited with payables transactions when you post the
batch of general ledger entries in General Ledger.
On the A/P Options screen, you choose the type of reference and
description that is included with each General Ledger transaction.
Note: You must print the G/L Transactions report before clearing
posting journals (using the A/P Clear History screen), as this option
deletes data for the G/L Transactions report.

G/L Accounts
Accounts Payable uses the following general ledger accounts: Payables
Control, Purchase Discounts, Prepayments, and the accounts you assign
to distribution codes or enter with transactions.
If you use multicurrency accounting, Accounts Payable also uses
General Ledger's unrealized and realized exchange gain and loss
accounts.
If you do not use Sage 300 ERP General Ledger—or if your Sage 300
ERP General Ledger system is at another location—Accounts Payable
creates its general ledger transactions in a file called APGLTRAN.CSV,
which can be imported by a remote site Sage 300 ERP General Ledger,
or transferred to another general ledger that you use. The file is in
Comma Separated Values format, and is created in the same directory as
your company database.
Note: All general ledger transactions are placed in the same CSV file,
and each time Accounts Payable creates transactions, it appends them
to the CSV file.

Multicurrency Ledgers
If you use multicurrency accounting, you use the Create G/L Batch
screen to produce general ledger batches containing revaluation
transactions that you created with the Revaluation screen.
Revaluation transactions revalue all outstanding multicurrency Accounts
Payable documents at new exchange rates. Because revaluation
transactions are for unrealized amounts, they are posted to the General
Ledger system as reversing transactions, which means that General
Ledger simultaneously posts reversing transactions to the first day of the
next fiscal period.
Note: Revaluation transactions created by Accounts Payable are set as
automatically reversing transactions. If they were posted to Sage 300
ERP General Ledger, they would be reversed at the beginning of the
next fiscal period.
If you are posting them to a different general ledger, you must also
reverse these transactions in the next fiscal period.

Related Topics
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Creating Batches of Transactions for General
Ledger
If Accounts Payable does not create general ledger batches during
posting, you use the Create G/L Batch screen to produce batches of
general ledger transactions from the batches posted in Accounts
Payable. In a multicurrency system, you also use this screen to produce
general ledger batches for transactions created during revaluation.
More...
Note: If you try to post a G/L batch to a period that is locked for General
Ledger, the transactions will be placed in an error batch. Therefore, be
sure to create and post General Ledger batches for outstanding
Accounts Receivable transactions before locking a period for General
Ledger.
Before you start
To create G/L batches:
1. Open Accounts Payable > A/P Periodic Processing > Create G/L
Batch.
2. Select the types of posted batches from which to create transactions
(invoices, payments, adjustment, revaluation).
3. Select the posting sequence number through which to create
transactions for each batch type.
4. Click Process.
If you use Sage 300 ERP General Ledger, Accounts Payable either
adds the new transactions to existing General Ledger batches or
creates new batches, depending on your choice for the Create G/L
Batches By option on the G/L Integration screen.
If you do not use Sage 300 ERP General Ledger, you see a message
asking whether to append transactions to an existing batch file or to
overwrite the file.

After creating a G/L batch

Related Topics
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About Checking Data Integrity
You should check data integrity and back up your data whenever you add
records that would be time-consuming to enter a second time or perform
other tasks that change your Accounts Payable data.
Important!
You should always check data integrity:
Before posting batches
After importing data

Related Topics
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About Processing Recurring Payables
If you regularly pay for such costs as rent, standing orders, or services
that vary little from period to period, you can automatically create invoices
for all or a selection of the payables and vendors at once.
The ability to create separate recurring payable batches saves you from
having to enter an invoice for each recurring payable and vendor
manually. It also provides a specific audit trail for the recurring payables
by assigning them a separate batch type (Recurring).

Preparing Recurring Payable Records
You use the Recurring Payables screen to add records for the recurring
payables you use and to assign them to vendors.

Specifying When to Process Recurring Payables
You can create payables you intend to apply indefinitely, or you can set
them up to stop once you have paid a maximum amount or reached a
certain date, or once you have processed a specified number of invoices.
You schedule the recurring payable for processing at regular intervals,
and you can also have System Manager remind specific or all Sage 300
ERP users to create invoices for the recurring payables. For more
information about creating schedules and using reminders, see the
System Manager help.

Entering Details for Recurring Payable Invoices
You add distributions to recurring payable records, similar to invoice
entry.
You can have Accounts Payable calculate taxes when you create a
recurring payable batch, or you can enter the taxes manually.

Other Information You Can Enter with Recurring Payables
If you need to send your payment to a different address than the one in
the vendor record, you can include a remit-to location with each payable.
The remit-to location is used on the invoice when you create a recurring
payable batch.

Creating Recurring Payable Batches
When the recurring payables are due, you use the Create Recurring
Payable Batch screen to create a batch of invoices.
If the recurring payable record uses a schedule that includes a reminder,
you can also process the recurring payable right from the Reminder List
in Common Services.
You can create a recurring payable batch by vendor number, vendor
group, or recurring payable code.
Accounts Payable creates invoices for the amounts specified in the
selected recurring payable records.
When you process a recurring payable batch, Accounts Payable checks
to ensure that the invoice total (including taxes) will not cause the amount
invoiced to date to exceed the maximum amount specified in the
recurring payable record. If the maximum amount will be exceeded,
Accounts Payable does not create the invoice, and does not update the
Last Invoiced date field for the recurring payable.
If a recurring payable batch with the same batch date exists when you
process a recurring payable batch, the new transactions are added to
that batch.
You can edit the recurring payable batches, print listings for them, and
post them in the same way you process other types of batches.

Manually Invoicing a Recurring Payable
If you accidentally delete a recurring payable invoice, or if you need to
create an additional recurring payable invoice for another reason,
Accounts Payable lets you create an invoice manually. For more
information, see Invoicing a Recurring Payable Manually.

Assigning Document Numbers to Recurring
Payable Invoices
When you create a recurring payable batch, Accounts Payable
automatically assigns a document number to each invoice. The
document numbers use the prefix and start with the next number
assigned for recurring payables on the Numbering tab of the A/P Options
screen.

Reusing Deleted Recurring Payable Invoice Numbers
If you delete a batch of recurring payable invoices before posting them,
Accounts Payable does not automatically reset the next invoice number
for recurring payables on the A/P Options screen. To prevent gaps in
your audit trail of recurring payable invoice numbers, you should change
back to the number assigned to the first invoice in the deleted batch.

Reporting Recurring Payable Invoices
Invoices for recurring payables are shown as transaction type IN on all
listings and reports in Accounts Payable, and the batch type is Recurring.
The G/L Transactions report assigns AP-IN as the source code for
recurring payable invoices.
When you post a batch of recurring payables, the program adds the
recurring payable amounts to vendor period-to-date and year-to-date
invoice totals. It also updates the Last Invoiced date and Last Invoice
Amount fields in the recurring payable record.

Posting Recurring Payable Batches
When you post a recurring payable batch, Accounts Payable creates a
posting journal for the transactions and updates the following records:
Vendors. Adds the amount and number of new recurring payables to
the totals for the period in the vendor’s account. Also enters the
amount and document date of the last recurring payable that was
posted for the vendor.
Vendor Groups. Adds the total amount of the recurring payables
invoiced to vendors in the group and the number of recurring-payable
invoices created for the group to the group statistics. Use the Vendor
Groups screen to view this information.

Creating General Ledger Transactions
When you post recurring payable batches, Accounts Payable creates
transactions for the payable accounts specified for each detail line on a
recurring payable invoice, and for the affected accounts in the vendor’s
account set. Posting also creates balancing transactions for the
corresponding payable control accounts. Print the posting journal for the
recurring payable batch or the G/L Transactions report to view this
information.
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Processing Recurring Payables
You use the Create Recurring Payable Batch screen to create batches of
recurring invoices.
Tip: If recurring payable records include reminders to to users, you can
also create recurring payable batches from the Reminder List in
Common Services.
Before you start
To process recurring payables:
1. Open Accounts Payable > A/P Periodic Processing > Create
Recurring Payable Batch.
2. Type the run date.
3. Specify whether to create invoices by recurring payable code, vendor
number, or vendor group.
4. Specify the ranges for the selected record type.
5. Use the Method field to specify whether to create a new batch, add
the invoices to an existing batch, or use the default method to
determine whether to create a new batch or add the invoices to an
existing batch.
6. Click Process.
After generating a batch of invoices
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About Processing Retainage in Accounts
Payable
Accounts Payable lets you account for retainage (or a holdback) that
occurs when your vendor withholds a percentage of an invoiced amount,
usually by mutual agreement or according to a statute (such as a
Builders Lien Act).
There are two steps in processing retainage:
1. First, you post an invoice, debit note, or credit note that specifies a
holdback (retainage) for the document.
2. Later, you post a separate retainage invoice, debit note, or credit note
to invoice the outstanding retainage amount.

Entering Original Documents with Retainage
An invoice, debit note, or credit note from which retainage is taken is
called an original document in Sage 300 ERP.
You enter the invoice, debit note, or credit note using the Invoice Entry
screen, as usual. To indicate that retainage applies to the document,
however, you select the Retainage option.
Note: The Retainage option appears only if you selected the Retainage
Accounting option for your Accounts Payable system.
Accounts Payable then displays the retainage percentage, retention
period, retainage rate, and the retainage terms from the vendor record.
Unless the document is job‑related, you can change these retainage
factors for a particular document, as follows:
Retainage Amount. To calculate the retainage amount, Accounts
Payable multiples the document amount (or the document total, if you
include taxes in retainage) by the retainage percentage. You can
enter a new retainage amount, if necessary. When you enter an
amount to replace a calculated amount, Accounts Payable
recalculates the retainage percentage.
The retainage amount is subtracted from the document amount (or
the document total) to calculate the amount due.
Retainage Due Date. Accounts Payable calculates the retainage due
date (the date the outstanding retainage is due for invoicing) by
adding the number of days in the retention period to the original
document date. You can enter a different due date, if you want.
Retainage Percentage. Accounts Payable uses the retainage
percentage to calculate the retainage amount.
You can enter a different retainage percentage in the Retainage
Percentage (%) field. When you enter a new percentage, Accounts
Payable recalculates the retainage amount.
Retainage Rate. You use this field to specify the method Accounts

Payable uses to determine the exchange rate for the retainage
document when you eventually process it. You can choose one of the
following:
Use Original Document Exchange Rate. Uses the same rate as
the document you are processing.
Use Current Exchange Rate. Uses the rate in effect when you
process the retainage document to clear the outstanding retainage.
Retainage Terms. You can use different terms for retainage
documents (used to process invoices for outstanding retainage) than
you used for the original document from which the retainage was
taken.
Accounts Payable displays the code specified for retainage terms in
the vendor record, but you can change the retainage terms for a
document.
Retention Period. Accounts Payable uses the retention period to
calculate the due date for the retainage document. When you change
the retention period, Accounts Payable recalculates the retainage
due date, and vice versa.

Apply Document Transactions
When you apply original debit notes or credit notes that include retainage
in Invoice Entry, or when you apply credit notes in Payment Entry, only
the original document balances are affected.Outstanding retainage
amounts remain with original documents until you post retainage
documents or adjustments to clear the outstanding retainage.

Job‑related Retainage
If the document is job‑related, you enter the retainage exchange rate and
the retainage terms at the document level. However, because
outstanding retainage amounts are tracked separately for each
job‑related detail, you enter a separate due date, retention period, and
retainage amount or retainage percentage for each detail on a job‑related
document.

Taxes on Retainage
Tax on retainage is processed according to the Report Tax option
selected on the A/P Options screen. The option provides the following
alternatives:
At Time Of Original Document. If you select this option, Accounts
Payable calculates and reports (posts) tax on retainage when you
post an original document that includes retainage.
As Per Tax Authority. If you select this option, Accounts Payable
calculates tax when you post an original document, but reports
(posts) the tax as required by each tax authority. The tax reporting
requirements for each tax authority are specified by the Report Tax
On Retainage Document option, in Tax Services. The tax authority
can specify No Reporting, At Time Of Retainage Document, or At
Time Of Original Document.
Some tax authorities require that you report tax when you post a
retainage document; others let you report tax when you post an
original document to which retainage applies.
If the tax authority reports tax At Time Of Original Document, the tax
amount is calculated and the tax tracking reports are updated
immediately when you post original documents.
If the tax authority reports tax At Time Of Retainage Document, the
tax amount is calculated when you post the original document, but it
is not reported until you post the retainage document.
To report tax, Accounts Payable posts tax amounts to a tax liability
account and updates the tax tracking reports. The timing of the tax
liability on retainage documents depends on the tax authority.

Posting Original Invoices, Debit Notes, and
Credit Notes
When you post the original retainage document, Accounts Payable
deducts the retainage from the document total, and posts the amount to
the retainage control account.
For example, if you enter an invoice for $10,000 with 10% retainage, an
invoice is posted for $9,000 with retainage outstanding of $1,000.
The retainage amount remains in the control account until you invoice it
in accordance with:
The retention period or retainage due date specified for the invoice.
The number of days in advance specified on the A/P Options screen
for generating retainage documents.

Adjusting Original Documents
Adjustment Entry lets you adjust retainage related to posted invoices,
debit notes, and credit notes, as follows:
To change the retainage amount for an original document, you use
the detail-entry table to adjust each detail or to add a new detail that
includes retainage. Enter the amount by which to adjust retainage in
the retainage debit or retainage credit fields on the table.
You can also add retainage to a document that did not include
retainage. You enter the retainage due date, as well as the retainage
amount, for each detail on the detail-entry table. You also enter
retainage terms and the retainage exchange rate for the document, if
you are adding retainage to a document for the first time.
You specify retainage terms and the retainage exchange rate option
for the whole document on the Retainage tab.
Note: If retainage was included on the original document, Accounts
Payable uses the retainage exchange rate setting from the original
document.
If you add a new detail to which retainage applies, the retainage
document detail inherits the Discountable status from the distribution
code used in the adjustment detail.
If you don't use a distribution code in the adjustment detail, the
retainage detail is discountable by default.
You can change both the retainage amount and add or change
document details. Accounts Payable then creates two entries: one for
the detail adjustment, and the other for the retainage adjustment.It
does not create a compound entry.
When you post the adjustment, Accounts Payable adjusts the
outstanding retainage account.
Note that Accounts Payable does not calculate any retainage on
adjustment transactions. You must enter the retainage manually, whether

you are adding it for the first time, or adjusting existing retainage debits or
credits.

Invoicing Outstanding Retainage
You invoice for outstanding retainage amounts, or holdbacks, either
manually, using the Invoice Entry screen, or automatically, using the
Create Retainage Batch screen. If you have posted debit notes and credit
notes to which retainage applied, you also create retainage debit notes
and credit notes using the Invoice Entry screen and the Create Retainage
Batch screen.

Invoicing Retainage Manually
Normally, you would use the Create Retainage Batch screen to invoice
periodically for retainage. However, Accounts Payable also lets you
process outstanding retainage manually.
To invoice manually for outstanding retainage, or to manually process a
credit note or debit note to clear an outstanding retainage amount, you
use the Invoice Entry screen.
You enter information for the retainage invoice, credit note, or debit note,
as usual. To invoice for retainage, you must:
Select Summary as the detail type. (Retainage documents are
summary documents.)
Select Retainage Invoice, Retainage Credit Note, or Retainage Debit
note as the document type, consistent with the original retainage
document for which you are now processing outstanding retainage.
(These options are not available if you selected Item as the detail
type.)
Because outstanding retainage remains associated with the original
retainage document, you must use a retainage invoice if the original
document was an invoice, a retainage debit note if the original document
was a credit note, and a retainage debit note if the original document was
a debit note.
Use the Original Document field to specify the original retainage
document for which you are invoicing the outstanding retainage.

When you post the retainage documents (invoices, credit notes, or debit
notes), Accounts Payable transfers outstanding retainage amounts from
the retainage control account to the payables control account.

Viewing Retainage Information
You can view retainage information on the:
Vendor Activity screen. To review the relationships between
retainage documents, you can use the Transactions tab on the
Vendor Activity screen.
Select a retainage transaction, then click the:
Document button to open the document in the transaction entry
screen.
Open button to display information for the retainage document in
the separate Document Information screen.
The Document Information screen shows:
The original retainage amount and retainage due date.
The outstanding retainage amount (in the Retainage Amount
field), if any.
The retainage documents used to clear the outstanding retainage
amount for the original document, if you have processed any (on
the Item Activity table).
Vendors screen. The Outstanding Retainage field on the Activity tab
of the Vendors screen displays the amount of retainage outstanding
for a selected vendor.
Aged Retainage report. For more information, see Printing the Aged
Retainage Report.

Revaluing Outstanding Retainage Amounts
If you use multicurrency, when you run Revaluation, Accounts Payable
also revalues amounts outstanding in the retainage control account.
For revalued outstanding retainage, Accounts Payable creates general
ledger entries to adjust the retainage control account rather than the
payables control account.
If your Sage 300 ERP system uses the Realized and Unrealized
Gain/Loss the accounting method to revalue multicurrency documents,
Accounts Payable also creates reversing entries for the next period. (You
set the revaluation accounting method in the Company Profile, in
Common Services.)
The Revaluation Posting Journal includes a separate section for
retainage after the current revaluation for each vendor.
If you include job‑related details on the posting journal, a retainage
section appears on the Summary page after the current job details.
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Processing Outstanding Retainage
Use the A/P Create Retainage Batch screen periodically to process
outstanding retainage automatically for the vendors, document numbers,
or vendor groups you select.
Notes:
You can also process individual invoices for outstanding retainage
using the Invoice Entry screen.
Accounts Payable can remind you and other users to process
retainage transactions when they are due. If you assign a schedule
that uses a reminder on the Retainage tab of the A/P Options
screen, you can process retainage directly from the Reminder List
in Common Services.
Taxes are calculated only on original documents. They do not
appear for retainage documents.
Before you start
To create a batch of retainage documents:
1. Open Accounts Payable > A/P Periodic Processing > Create
Retainage Batch.
2. Specify the Run Date for this retainage batch.
3. Specify the types of original retainage documents for which you are
now processing outstanding retainage.
4. Choose the type of record by which to select outstanding retainage
for processing, then enter the range of records from which to select
outstanding retainage.
5. In the Number Of Days In Advance field, specify the number of
days in advance of the retainage due date that retainage documents
can be created.
6. Click Process to create the batch.

Accounts Payable generates the required retainage invoices,
retainage debit notes, and retainage credit notes, and updates the
Last Invoiced field on the Retainage tab of the A/P Options screen.
7. When finished, click Close.
After generating a retainage batch
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About Deleting Inactive Records
You use the Delete Inactive Records screen to remove obsolete vendor,
vendor group, remit‐to location, and recurring payable records from
Accounts Payable.
You can remove records only if they currently have an inactive status and
were set to inactive within the range of dates you specify.
If you do not want to use the same range of dates for deleting all types of
records, you can delete each type of record separately.

Deleting Vendor Records
To identify inactive vendor records, print the Vendors report, selecting
one or more of the Address, Profile, or Comment options. The report
shows which vendor records are inactive (on the first line for each
vendor), and when the status was changed.
When you delete vendor records, you also delete vendor statistics and
comments.

Deleting Vendor Groups
You cannot delete a vendor group to which vendors are assigned. To
determine whether any vendors are assigned to a group, print the Vendor
Groups report, selecting the Group Members option.
Note: When you delete a vendor group, you also delete the vendor
group statistics.

Deleting Remit-to Locations
Before you delete inactive remit-to locations, make sure there are no
unposted transactions that use them. (You cannot edit and save a
transaction with an inactive or deleted remit-to location; however, you can
post such transactions without errors.)
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Removing Inactive Records from Accounts
Payable
You use the A/P Delete Inactive Records screen to remove obsolete
vendor, vendor group, remit‐to location, and recurring payable records
from Accounts Payable. This screen removes records only if they
currently have an Inactive status and were set to Inactive within the range
of dates you specify.
Before you start
To delete inactive records:
1. Open Accounts Payable > A/P Periodic Processing > Delete
Inactive Records.
2.
3.
4.
5.

Select the types of records you want to delete.
Specify the ranges for each type of record.
Type the range of dates for which to delete records.
Click Process.

After deleting inactive records
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Clearing Obsolete Data from Accounts Payable
You use the A/P Clear History screen to remove the following types of
data from Accounts Payable:
Fully paid documents.
Vendor comments.
1099/CPRS amounts.
Printed posting journals.
Posting errors.
Deleted and posted batches.
Important! After you clear posted batches, you can no longer drill
down from General Ledger to the Accounts Payable transactions
that they contained. Also, you can no longer reprint invoices.
Before you start
To clear obsolete data:
1. Open Accounts Payable > A/P Periodic Processing > Clear
History.
2.
3.
4.
5.

Select the types of records you wish to clear.
Specify the ranges for each type of record.
Type the dates or fiscal year and period for which to clear.
Click Process.
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Clearing Statistics
You use the A/P Clear Statistics screen to remove obsolete vendor period
statistics and vendor group period statistics data from your Accounts
Payable system.
Note: To clear activity statistics, you use the A/P Year End screen. For
more information, see Starting a New Fiscal Year.
Before you start
To clear statistics:
1. Open Accounts Payable > A/P Periodic Processing > Clear
Statistics.
2.
3.
4.
5.

Select the types of records you want to clear.
Select the range of vendors for which you want to clear statistics.
Type the fiscal year and period for which to clear.
Click Process.

After clearing statistics
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Filing 1099 Reports Electronically
You can create an electronic file to submit 1099 forms through the IRS
FIRE (Filing Information Returns Electronically) System using a modem
or by mailing them on magnetic tape or diskettes.
Before you start
To create an electronic file for your 1099 forms:
1. Open Accounts Payable > A/P Periodic Processing > 1099
Electronic Filing.
2. Complete the header, transmitter, and payer fields according to IRS
requirements.
3. Click Generate to produce the electronic file.
4. Follow the instructions on FIRE system.
Important! Be sure to record the name that the IRS assigns to your
file. You will need the name if you are required to submit a
replacement file.
5. When you have finished, click Close.
After filing electronically
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Filing a T5018 (CPRS) Information Return
Electronically
If your company operates in Canada and your primary source of business
income is construction, you must report amounts paid or credited for
construction services to the Canada Revenue Agency (CRA) by filing a
T5018 information return, which consists of a T5018 Summary and
related T5018 slips.
You use the A/P T5018 (CPRS) Electronic Filing screen to create your
T5018 information return in the required XML format. You can then
submit the generated file to the CRA through their website or on
electronic media acceptable to the CRA (DVD, CD, or diskette).
Important! If you file more than 50 T5018 slips for a calendar year, you
must use CRA's Internet File Transfer application to file original or
amended T5018 returns.
Before you start
To create an electronic file for your T5018 information return:
1. Open Accounts Payable > A/P Periodic Processing > T5018
(CPRS) Electronic Filing.
2. Complete the header, transmitter, and payer fields according to
Canada Revenue Agency (CRA) requirements.
Important! You must complete both the Transmitter Information
and Payer Information sections, even if the transmitter and payer
are the same company.
3. Click Process to produce the electronic file.
4. Make a note of the name and location of the generated output file.
5. When you have finished, close the T5018 (CPRS) Electronic Filing
screen.
After creating an electronic file
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About Revaluing Multicurrency Transactions
When exchange rates fluctuate, you may need to revalue outstanding
documents denominated in other currencies to reflect their present value
in your own (functional) currency at a particular time, for example, at
financial statement dates. When you revalue a transaction, Accounts
Payable recalculates its functional equivalent value at a new exchange
rate.
Some accounting standard-setting bodies require that you take gains or
losses due to fluctuating exchange rates into income (recognized) in the
period in which they occur.
In Sage 300 ERP, exchange gains and losses are treated as permanent
or temporary, depending on the exchange Gain/Loss Accounting Method
specified for your Sage 300 ERP system (in the company profile):
Recognized Gain or Loss. If you use this accounting method,
revaluation transactions are considered permanent. In this
accounting treatment, they are recognized immediately when you
post them, and they are not reversed in the next period.
Realized and Unrealized Gain/Loss. If you use this accounting
method, revaluation transactions are considered temporary, or
unrealized, gains and losses. Therefore, they are posted to General
Ledger as reversing transactions, meaning that General Ledger
simultaneously posts reversing transactions to the first day of the
next fiscal period following the revalued period. In this way,
revaluation has no permanent effect on the general ledger.
Under this method, realized exchange gains or losses are calculated
only when you post payments to pay invoices and debit notes, or
when you post credit notes to pay down invoices.
Note: Rounding differences may occur during revaluation. These
exchange differences are automatically posted to the exchange
rounding account when payments are posted.
You do not post revaluation batches in Accounts Payable. If you do not

have Sage 300 ERP General Ledger in your company database,
Accounts Payable creates an export batch for your general ledger. If you
import a revaluation batch into another general ledger, make sure that the
revaluation transactions are reversed in the next fiscal period.

Revaluing Periods that Contain Backdated
Documents
Sage 300 ERP lets you post a multicurrency document that predates the
last revaluation for the document currency, and it lets you apply the
backdated document. An exchange gain or loss can arise.
The accounting method you use to record exchange gains and losses in
your Sage 300 ERP system determines how the revaluation process
handles backdated documents:
Realized and Unrealized Gain/Loss. If you use this accounting
method, you can revalue the backdated document by running the
Revaluation program again for the period to which you posted the
document (process a backdated revaluation). For this accounting
method, if you rerun revaluation for a period that contains a
backdated document, you must also rerun all subsequent
revaluations.
Recognized Gain or Loss. If you use this accounting method, you
can let the program automatically correct any exchange gains or
losses for backdated documents and the documents to which they
are applied.
To automatically correct these exchange gains or losses, enter or
accept a date in the Earliest Backdated Activity Date field on the
Revaluation screen.
You can also choose to ignore the backdated document, for example,
if it is not material or if you posted it to a period that does not coincide
with the end of a reporting period. If you do not want the program to
revalue backdated documents and activity when you perform a
backdated revaluation, leave the Earliest Backdated Activity Date
field blank on the Revaluation screen.
The program adjusts exchange gains and losses for backdated
documents and documents affected by backdated activity as of the
balance sheet dates:
If the current revaluation date is on or after the last revaluation date

and there is a backdated document (or a document affected by
backdated activity), the program revalues the document and
creates adjustments as of the current revaluation date. (The
Earliest Backdated Activity Date field does not appear.)
If the current revaluation date predates the last revaluation date
and you are revaluing a backdated document or a document
affected by backdated activity, Revaluation:
Creates entries to recognize exchange gains or losses for
backdated documents as of each revaluation date from the
earliest backdated activity date to the last revaluation date.
Ignores any backdated documents with posting dates before the
Earliest Backdated Activity Date.
If the revaluation occurs between the document date and
settlement date, and the revaluation rate is different from the
current rate for the settlement document, Revaluation creates
adjustments to:
Update the document’s functional balance (including discount and
retainage balances) for the revalued period.
Correct any exchange gains and losses recognized at the time of
settlement for the period from the revaluation date to the
settlement date.

Revaluing Documents with a Multiple Payment
Schedule
If you use the Recognized Gain/Loss accounting method, when you
revalue a document that uses a multiple payment schedule, Revaluation
revalues each portion of the invoice that is due and applies the sum of
the net gains (or losses) to the document.

Revaluing Outstanding Retainage
If you use multicurrency, when you run Revaluation, the program also
revalues amounts outstanding in the retainage control account.
For revalued outstanding retainage, the program creates general ledger
entries to adjust the retainage control account rather than the payables
control account.
If your Sage 300 ERP system uses the Realized and Unrealized
Gain/Loss accounting method to revalue multicurrency documents, the
program also creates reversing entries for the next period. (You set the
revaluation accounting method in the Company Profile, in Common
Services.)
The Revaluation Posting Journal includes a separate section for
retainage, following the current revaluation of documents for each
vendor.
If you include job‑related details on the posting journal, a retainage
section appears on the Summary page after the current job details.

Unrealized Gains and Losses
If your Sage 300 ERP system uses the Realized and Unrealized
Gain/Loss method to revalue multicurrency amounts, Accounts Payable
calculates unrealized exchange gains or losses as follows:
Source amount x Revaluation rate
Less:
Functional amount
Equals
Unrealized gain (loss)
The revaluation transaction is reported on the Vendor Transactions report
for the vendor as type GL.
When you post the revaluation batch in General Ledger, the program also
posts a reversing entry to the first day of the next fiscal period:
When you print the Vendor Transactions report for the period in which
you post the reversing revaluation transaction, both transactions appear
for the vendor. Their net effect on the account balance is zero.
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About Exchange Gains and Losses on
Settlement
When you apply multicurrency payments, credit notes, debit notes, or
adjustments to another document, if the exchange rate used for the
applied document is different from the current rate of the apply to
document, Accounts Payable recognizes an exchange gain or loss, as
follows:
Source amount x current rate of applied document
Less:
Source amount x current rate of apply-to document
Equals
Exchange gain (loss) or realized exchange gain (loss)
Note: If you use the Realized and Unrealized Exchange Gain/Loss
method to record exchange gains and losses, any gains or losses
arising from differences in exchange rates at the time of settlement are
called “realized” gains or losses.
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Revaluing Transactions in Other Currencies
When exchange rates fluctuate, you may need to revalue outstanding
documents denominated in other currencies to reflect their present value
in your own (functional) currency at a particular time, for example, at
financial statement dates.
You use the A/P Revaluation screen to revalue transactions.
Before you start
To revalue transactions:
1. Open Accounts Payable > A/P Periodic Processing >
Revaluation.
2. Indicate whether to do a provisional revaluation or an actual
revaluation. More...
3. For each currency you want to revalue, use one line on the table to
enter the following information:
Currency. Type the currency code for which you want to specify
revaluation options, or choose it from the Finder. The revaluation
process selects only transactions that are in the specified currency.
Note: You cannot specify the same currency code more than once
for a single revaluation. If you want to revalue different ranges of
records for the same currency code, you must revalue each range
separately.
Revaluation date. Type the date of the end of the period you want
to revalue (normally, the end of a reporting period).
The revaluation process selects open transactions with posting
dates that are on or before the date you specify.
Earliest backdated activity date. This field is available only if you
use the Recognized Gain/Loss accounting method for your Sage
300 ERP system. It identifies the earliest backdated document to
revalue, if there is a backdated transaction in the period you are

revaluing.
Rate type. Type the rate type for selecting the currency table, or
select a rate type from the Finder.
The revaluation process selects transactions only from specified
vendor accounts that use the selected currency.
Rate date. Type the date to use to select the exchange rate at
which to revalue transactions for the specified currency code.
Exchange rate. Type the rate at which to revalue transactions for
the specified currency code.
4. To change the optional fields and values for a particular line or to
delete optional fields, either double-click in the Optional Fields
column for the line or select the line, then click the Optional Fields
column heading. More....
5. Optionally, do a test run before performing the final step:
a. Select the Provisional Revaluation option, if you did not select it
earlier.
b. Click Process.
c. Print the Provisional Revaluation posting journal to list the
transactions that would be created for the exchange gain and loss
general ledger accounts.
d. Make any necessary changes to your selections and to currency
rates.
6. When you are satisfied with the results of the provisional revaluation,
clear the Provisional Revaluation option, and then click Process to
create the revaluation transactions.
After creating a revaluation batch
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About Year End Processing in Accounts Payable
At the end of each fiscal year, use the Year End screen to transfer
current-year activity statistics for vendor groups and vendors to the
previous year, in preparation for a new year. You may also want to follow
the same procedures you use at the end of each period.
The Year End function performs the following tasks:
If you select the Reset All Batch Numbers option, Year End resets
the next batch number to 1 for all batch types, and deletes all
information for posted and deleted batches, so they no longer appear
on the Batch Status report.
Note: After resetting batch numbers, you can no longer view
transactions from the General Ledger Transactions screen.
Inserts the Average Days To Pay total from the year you are closing
into the Average Days To Pay field for the previous year and into the
Total Days To Pay field for the new year in vendor records.
Clears activity statistics, if you select the Clear Activity Statistics
option. This step moves year-to-date vendor activity statistics to lastyear activity statistics, and sets year-to-date totals for the new year to
zero. It also sets the largest invoice this year and the largest balance
this year to zero.
Resets to 0 (zero) the Total Days To Pay on the Statistics tab of the
Vendors and Vendor Groups screens, and resets the Total Invoices
Paid and Number Of Checks on the Statistics tab of the Vendors
screen (if you select both the Clear Activity Statistics option and
the Clear Invoices Paid And Days to Pay Counter option).
If you select the Clear Total Recurring Payable Amount option,
clears the total amount accumulated for each recurring payable, so
that you can resume processing the payables in the new year.
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Starting a New Fiscal Year
Starting a new fiscal year requires that you close the current year,
transferring current-year activity statistics for vendor groups and vendors
to the previous year.
Note: You can use the Year End screen at any time of year if you just
need to reset batch numbers or clear recurring-payable amounts.
However, you must first complete all the steps listed in the “Before You
Start” section.
Before you start
To start a new fiscal year:
1. Open Accounts Payable > A/P Periodic Processing > Year End.
2. Select the options you want to include in year-end processing.
More...
Note: We recommend that you clear activity statistics and the Total
Invoices Paid and Total Days To Pay totals only at the end of your
fiscal year.
3. Click Process.
4. When finished, click Close.
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Importing and Exporting Accounts Payable Data
You can import and export a variety of Accounts Payable records and
transactions in a number of common formats.
Exporting Accounts Payable Information
Importing Information into Accounts Payable
Displaying a List of Fields You Can Import and Export
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Exporting Accounts Payable Information
To export Accounts Payable information:
1. Open the screen that displays the kind of data that you want to
export. (You can export setup records, vendor records, and
transactions.)
2. If necessary, use the screen to create or select the records you want
to export.
For example, to export an invoice batch, create the batch in the A/P
Invoice Entry screen, or select an existing batch.
3. Click File > Export.
4. If the File Import/Export Selection screen appears, select the type of
data to export, and then click OK.
Example: When you export vendor records, you use the File
Import/Export Selection screen to specify Vendor, Statistics, or
Comments.
5. On the Export screen that appears (depending on the type of records
you are exporting):
a. In the Type field, specify the format in which to save the exported
data.
b. In the File field, specify the name and location for the export file,
and then press Tab.
c. Select the type of information to export. You can also:
Click Load Script to choose a template that specifies the
information you want to export.
Click Set Criteria to limit the range of records to export using
criteria.
Click File > Display Export Fields to view a list of fields you can
export.

6. If you frequently export information with these specifications, click
Save Template to create an export template that you can use the
next time you export this data.
7. When ready, click OK to begin exporting.
If you specified a folder and file that do not yet exist, Accounts
Payable asks whether to create them.
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Importing Information into Accounts Payable
Before you start
To import account information or transactions:
1. Open the Accounts Payable screen that contains the data you want
to import.
For example, to import vendor accounts, open the Vendors screen.
To import invoices, open the A/P Invoice Entry screen.
2. Click File > Import.
3. If the File Import/Export Selection screen appears, select the type of
data to import, and then click OK.
Example: When you import vendor records, you use the File
Import/Export Selection screen to specify Vendor, Statistics, or
Comments.
4. On the Import screen that appears:
a. In the Type field, specify the format of the data you are importing.
b. Specify whether to insert new records, update existing records, or
insert and update records.
c. In the File field, specify the name and location of the import file,
and then press Tab.
d. If you previously created an import template that matches the
information you want to import, click Load Script, and then select
the template file.
Otherwise, select the type of information to export.
Tip: You can click File > Display Import Fields to view a list of
fields you can import.
e. Select any other options that appear.

5. Optionally, click Save Script to save your choices as a template for
the next time you import these records.
6. Click OK to begin importing.
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Displaying a List of Fields You Can Import and
Export
You can display and print lists of the fields you can import or export for
most Sage 300 ERP records, including transaction batches. The report
also indicates key fields.
To display a list of the fields you can import and export:
1. Open the record or transaction entry screen for the type of record or
transaction you want to import or export.
2. For transaction fields, display an existing batch using the Batch
Number field.
3. Click File > Import or Export.
4. If a File Import/Export Selection screen appears (for example, if you
clicked Import or Export on the Vendors screen), select the type of
record to import or export, and then click OK.
5. On the screen that appears, click File > Display Import Fields or
Display Export Fields to display the name, type, and length of each
field in the record that you can import or export.

Home > Printing Accounts Payable Reports

Printing Accounts Payable Reports
Use Accounts Payable reports screens to print reports of Accounts
Payable vendors, setup records, and transactions.
Setup reports list the information entered to define your Accounts
Payable system.
Vendor reports list information about your vendors and vendor
groups, including lists and statistical reports for vendors and vendor
groups, as well as letters, and labels that you print for your vendors.
Transaction reports provide you with transaction listings and status
information, and reports that you can use to interpret, analyze, and
summarize your data.
If you have a multicurrency ledger, some of these reports can also
include source and functional-currency (home-currency) information.
Accounts Payable provides numerous sorting and selecting options on a
full range of reports, journals, and lists.
About Reporting Accounts Payable Data
About Print Destinations
Printing Tips
Setup Reports
Transaction Reports
Vendor Reports
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About Accounts Payable Reports
You can use Accounts Payable to produce a wide variety of reports which
provide you with up-to-date information and a source of backup
information in case your Accounts Payable data is damaged.
This section briefly describes the reports you can produce in Accounts
Payable.

Printing Reports
You can print reports in the following ways:
Directly to a printer, to obtain permanent copies of the information.
To your screen, for quick review.
To a file for printing later, importing into another program, or
transferring to external storage.
To an RTF file, which you can send as an e-mail attachment.
Note: If you are using Seagate Info server software, you can print a
report at a specific time and date and define the publishing format and
destination.
Using a laser printer, you can print all Accounts Payable reports on 8½"
by 11" or A4-sized paper.
On dot matrix printers all Accounts Payable reports are 132 characters
(columns) wide.

Setup Reports
From the A/P Setup Reports folder, you can produce reports showing the
information entered to define each of the records you create when setting
up or updating your Accounts Payable system.
Any time you add, delete, or change any of these records, you should
print and file the corresponding reports, to keep your printed records up
to date.

Vendor Reports
From the A/P Vendor Reports folder, you can produce reports showing
the information entered for your vendor records, including the lists and
statistical reports for vendors and vendor groups. Reports you can print
for your vendors also include the 1099/CPRS Amounts and Remit-To
reports.
Whenever you change any of these records, you should print and file the
corresponding reports, to keep your printed records up to date.

Transaction Reports
From the A/P Transaction Reports folder, you can produce a complete
range of reports of your Accounts Payable transactions.
Many of these reports are important for maintaining your Accounts
Payable audit trail, including the batch listings, posting journals, error
reports, batch status reports, and the G/L Transactions report. You should
regularly print these reports, check them carefully, and file them in a
secure place.
Note: You must print the G/L Transactions report before you clear
posting journals.
Accounts Payable also provides three important reports that you can use
to interpret, analyze, and summarize your data:
Aged Cash Requirements. This report highlights the cash amounts
that will be required to meet obligations as they become due,
including the amount needed to pay invoices that are overdue,
current, and due in each of four future periods you define. Use the
report for cash flow analysis and projections.
You can print the report in detailed form, listing all outstanding
documents for each vendor, or summary form, printing one line for
each vendor number, including the overdue and current balances and
the balances in each aging period.
Aged Payables. This report groups outstanding transactions into a
current period and four aging periods by document date or due date.
Use the report to analyze your payables.
You can print the report in detailed form, listing all outstanding
documents for each vendor, or in summary form, printing one line for
each vendor number, including the current balance and the balance
in each aging period.
Vendor Transactions. This report serves as an audit trail of posted
transactions in your vendor accounts, within the range of dates you
specify. Use the report to obtain an overview of your vendor accounts

in any period for which you have Accounts Payable data.
You can report the details of any combination of invoices, debit notes,
credit notes, and prepayments. You can also choose to include zero
balances and applied details, and print a total for each transaction
type.
If you use multicurrency accounting, you can also print the report in
functional currency or in the vendors’ currencies.
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About Print Destinations
There are several ways to print reports in Sage 300 ERP, depending on
your needs. Before you print, you can select a print destination to:
Print directly from the program to the printer, to obtain permanent
copies of the information.
Print the information on your screen, for quick review.
Print to a file so that you can print the report later, import it into
another program, or transfer it to other electronic media.
Print to e-mail to send a report to an electronic mail recipient.
Note: To change the print destination for screens and reports, you must
have Change Print Destination security authorization for Administrative
Services.
You select print destinations from the File menu on the Sage 300 ERP
desktop.
For more information, see Selecting a Print Destination.
Important! When you print to any destination, the report’s status is
updated to Printed.
Tips:
If you use Preview as your print destination, you can print or export the
report from the preview screen in the following ways:
To print the report on your printer, click the printer icon on the
SAP Crystal Reports® menu bar.
To export the report to a file, click the export
icon on the SAP
Crystal Reports® menu bar. (You can select Crystal Reports, PDF,
Excel, RTF, or CSV as the export format.)
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Selecting a Print Destination
You can print Sage 300 ERP reports to a printer, to the screen, to a file,
or as an attachment to an e-mail message.
Note: You must be assigned to a security group that has authorization
to change the print destination, or the only destination available will be a
physical printer.
To set the Sage 300 ERP print destination to Printer:
Note: These instructions assume that you have set up printers in
Microsoft Windows.
1. On the Sage 300 ERP Desktop menu, click File > Print Destination.
2. Select Printer, and then click OK.
When you next print from Sage 300 ERP, the report will be sent to the
Windows default printer.
Tip: If you want to confirm the destination printer, page size, and
orientation each time you print a report, on the Desktop, click View >
Preferences, and then select Confirm on print.
To print to the screen (display reports on your monitor):
1. On the Sage 300 ERP Desktop menu, click File > Print Destination.
2. Click Preview.
Note: For Web-based clients, the Preview screen appears first when
you click the Print button.
Tip: You can print a report displayed in the Preview window by clicking
the Print Report button.
To print to a file:

1. On the Sage 300 ERP Desktop menu, click File > Print Destination.
2. Click File.
When you next print from Sage 300 ERP, you are prompted for an export
format and a destination.
If you select Disk file as the destination, browse to the location
where you want to save the file, accept the file name or type the
name you want to use, and then click Save.
If you select Application as the destination, Sage 300 ERP opens
the associated application, and displays the report in that application.
You can then save the file to a location using the file name you want.
If you select Microsoft Mail as the destination, Sage 300 ERP opens
your e‑mail client so that you can send the report as an attachment to
recipients you specify.
Note: You can enter the name of a non-existent file or directory to be
created by the system when you print. When you print to a file, the
report is assigned a unique name, for example, CS1000.TXT.
To print reports as attachments to e-mail messages:
1. On the Sage 300 ERP Desktop menu, click File > Print Destination.
2. Select E-mail to create a file that can be attached to an e-mail.
3. Select either Adobe Acrobat (PDF) or Rich Text Format (RTF) as
the file format for the e-mail attachment. More...
4. Click OK.
When you print using an e-mail destination Sage 300 ERP creates a PDF
or RTF version of the report, opens your default e-mail program, and
attaches the report file to a new e-mail message. More...
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Selecting a Printer for Reports
When your print destination is Printer, Sage 300 ERP prints reports to the
Windows default printer, unless you have assigned a specific printer to a
report.
The ability to assign different printers to different reports at print time
means that you are not limited to printing to the default printer. For
example, you can use a different printer to print item labels than you use
to print inventory worksheets.
To assign a specific report to a specific printer:
1. Open the report screen that you want to assign to a printer.
2. On the report screen, click File > Print Setup.
The program displays the Windows default printer, but you can
change the printer for a specific report.
3. Select the Specific Printer option, and then select from the list the
printer to use for this report.
The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
4. Select a paper source if you want to use a particular paper tray or
paper stock for this report.
5. Click OK to close the Print Setup screen.
To clear the assigned printer for a specific report:
1. On the Sage 300 ERP desktop, select (highlight) the icon for the
report.
2. On the Desktop Object menu, click Restore Defaults, or right-click
the report icon, and then click Restore Defaults on the list that
appears.
3. In the Restore Defaults dialog box, select the Print Settings option,
then click OK.

The print setup for that report is reverted to the desktop default.
To have the program prompt you to specify a printer and print
options each time you print:
On the Sage 300 ERP Desktop View menu, click Preferences > Confirm
On Print.
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Printing Tips
You can select a print destination for a report that is different from the
default print destination, and you can save personalized settings for
printing certain reports in Accounts Payable.
Report Printing Options
Saving Default Report Settings
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Report Printing Options
You can print Sage 300 ERP data in a variety of reports to view key
information. Printed reports also serve as a source of backup information
in case your data is damaged on your computer.
Sage 300 ERP provides four destinations for printing reports. You can:
Print directly to a printer, (to laser printers on 8.5" x 11" paper, or to
dot matrix printers) to obtain permanent copies of the information.
Display the information on your screen, for a quick review.
Print to a file that you can save, print later, or import into another
program.
Print to an e-mail to send to another user or office.
For instructions on specifying the print destination for Sage 300 ERP
reports, see Selecting a Print Destination.
If you print reports to a physical printer, you can also specify a particular
printer to use for printing a report. For instructions, see Selecting a
Printer for Reports.
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Saving Default Report Settings
Sage 300 ERP lets you save report settings as defaults for printing
certain Accounts Payable reports, including Aged Payables, Aged Cash
Requirements, Aged Retainage, Vendors, and Vendor Transactions
reports, as well as Letters and Labels.
To save current settings as defaults:
1. Open the Accounts Payable report screen for which you want to save
printing settings.
2. Select the default settings to use whenever you print this report.
3. On the menu, click Settings > Save Settings As Defaults.
To clear saved settings:
1. Open the Accounts Payable report screen for which you want to reset
printing settings.
2. On the menu, click Settings > Clear Saved Settings.
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Printing Setup Reports
Use the screens in the A/P Setup Reports folder to print reports of:
The options you selected, data you entered, and records you added
to set up your Accounts Payable system.
Records you revised.
Vendor and vendor group statistics.
1099/CPRS Codes Report
Account Sets Report
Distribution Codes Report
Distribution Sets Report
E-mail Messages Report
G/L Integration Report
Optional Fields Report
Options Report
Payment Codes Report
Payment Selection Codes Report
Terms Codes Report
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Printing the 1099/CPRS Codes Report
The 1099/CPRS Codes report lists the code and description for each
1099/CPRS code entered in your Accounts Payable system.
For information on the contents of this report, see A/P 1099/CPRS Codes
Report Screen.

When to Print
Print CPRS reports at the end of each calendar year, after you have
entered all transactions for the calendar year.
To print the report:
1. Open Accounts Payable > A/P Setup Reports > 1099/CPRS
Codes.
2. Specify the range of 1099/CPRS codes to include in the report. The
default range includes all 1099/CPRS codes.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the Account Sets Report
This report lists the account sets defined for your Accounts Payable
system. Print the report when you add, change, or delete account sets.
For information on the contents of this report, see A/P Account Sets
Report Screen.

When to Print
Print the report when you add, change, or delete account sets.
To print the Account Sets report
1. Open Accounts Payable > A/P Setup Reports > Account Sets.
2. Select the range of account sets to include in the report. The default
range includes all account sets.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the Distribution Codes Report
The Distribution Codes report lists the descriptions and numbers of the
general ledger accounts used in the distribution codes in your Accounts
Payable system.
For information on the contents of this report, see A/P Distribution Codes
Report Screen.

When to Print
Print the report when you add, change, or delete distribution codes.
To print the Distribution Codes report
1. Open Accounts Payable > A/P Setup Reports > Distribution
Codes.
2. Select a range of distribution codes. The default range includes all
distribution codes.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the Distribution Sets Report
The Distribution Sets report lists the distribution methods and distribution
codes specified for the distribution sets you use to allocate purchase
amounts in your Accounts Payable system.
For information on the contents of this report, see A/P Distribution Sets
Report Screen.

When to Print
Print the report when you add, change, or delete distribution sets.
To print the Distribution Sets report:
1. Open Accounts Payable > A/P Setup Reports > Distribution
Sets.
2. Select a range of distribution sets to include. The default range
includes all distribution sets.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the E-mail Messages Report
The E-mail Messages report lists all the messages you created to send to
vendors with e-mailed letters.
For more information on the contents of this report, see A/R E-mail
Messages Report Screen.

When to Print
Print the report when you add, change, or delete e-mail messages.

When to Print
To print the E-mail messages report:
1. Open Accounts Payable > A/P Setup Reports > E‑mail
Messages.
2. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the G/L Integration Report
The G/L Integration report lists the options and other information entered
on the G/L Integration screen that determine how your Accounts Payable
system interacts with General Ledger.
For more information on the contents of this report, see A/P G/L
Integration Report Screen.

When to Print
Print the report when you change the G/L Integration options for
Accounts Payable.
Before you start
To print the G/L Integration report:
1. Open Accounts Payable > A/P Setup Reports > G/L Integration.
2. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the Optional Fields Report
You print the Optional Fields report whenever you need a listing of all the
optional fields set up for Accounts Payable.
For information on the contents of this report, see A/P Optional Fields
Report Screen.

When to Print
Print the report when you add, change, or delete optional field records.
To print the Optional Fields report:
1. Open Accounts Payable > A/P Setup Reports > Optional Fields.
2. Select Show Settings if you want to list the G/L accounts associated
with transaction detail optional fields.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the A/P Options Report
The Options report lists the options selected and other information
entered on the A/P Options screen to specify how your Accounts Payable
system operates.
For information on the contents of this report, see A/P Options Report
Screen.

When to Print
Print the report when you change option selections.
To print the report:
1. Open Accounts Payable > A/P Setup Reports > Options.
2. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the Payment Codes Report
The Payment Codes report lists the codes, descriptions, and methods of
payment used in your Accounts Payable system.
For information on the contents of this report, see A/P Payment Codes
Report Screen.

When to Print
Print the report when you add, change, or delete payment codes.
To print the report:
1. Open Accounts Payable > A/P Setup Reports > Payment Codes.
2. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the Payment Selection Codes Report
The Payment Selection Codes report lists the bank and currency codes,
selection criteria, and exclusion criteria defined for the payment selection
codes used to create payment batches in your Accounts Payable system.
For more information on the contents of this report, see A/P Payment
Selection Codes Report Screen.

When to Print
Print the report when you add, change, or delete payment selection
codes.
To print the Payment Selection Codes report:
1. Open Accounts Payable > A/P Setup Reports >
Payment Selection Codes.
2. Specify the range of payment selection codes to include on the
report. The default range includes all payment selection codes.
3. Select the Optional Fields check box if you want to include optional
fields associated with each payment selection code.
4. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
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Printing the Terms Report
The Terms report lists the information entered to define each terms code,
including multiple payment schedules and due date and discount date
tables, when used.
For information on the contents of this report, see A/P Terms Report
Screen.

When to Print
Print the report when you add, change, or delete terms codes.
To print the Terms report:
1. Open Accounts Payable > A/P Setup Reports > Terms.
2. Select the range of terms codes that you want to print.
3. Select Include Multiple Payment Schedules if you want to print
schedules for terms codes that use them.
4. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Printing Transactions Reports

Printing Transactions Reports
Use the screens in the A/P Transaction Reports folder to print a variety of
transaction reports to maintain your audit trail and to analyze Accounts
Payable data.
Aged Cash Requirements Report
Aged Payables Report
Aged Retainage Report
Printing Batch Listings
Batch Status Report
Check Register
Checks
G/L Transactions Report
Overdue Payables Report
Posting Errors Report
Posting Journals
Pre-Check Payment Register
Revaluation Posting Journal
Vendor Transactions Report

Home > Printing Reports > Transaction Reports > Aged Cash Requirements Report

Printing the Aged Cash Requirements Report
The Aged Cash Requirements report highlights the cash amounts that
will be required to meet obligations as they become due, including the
amount needed to pay invoices that are overdue, current, and due in
each of four future periods you define. Use the report for cash flow
analysis and projections.
For information on the contents of this report, see A/P Aged Cash
Requirements Report Screen.

When to Print
Print the Aged Cash Requirements report when you need a listing of the
amounts owed and when they are due, to assist you with cash-flow
management, short-term planning, and budgeting.
To print the Aged Cash Requirements report:
1. Open Accounts Payable > A/P Transaction Reports > Aged Cash
Requirements.
2. Select from the following report options:
Age By. You can age outstanding documents or balances by their
due dates or document dates.
Age As Of. Specify the date on which to report the payables.
Accounts Payable uses this date to assign transactions to aging
periods.
For example, if you print the report aged by due date, the program
assigns each transaction to an aging period by calculating the
number of days between its due date and the Age As Of date.
Cutoff By. The report includes only transactions that have a
document date that is on or before the cutoff date you specify.
More...
Print Transactions In. Indicate whether to print a summary or
detailed report, and whether to print the detailed version of the
report with transactions ordered by document date (Detail by Date)
or by document number (Detail by Document).
Sort Transactions by Transaction Type. Select this option if you
want sort transactions by document type for each vendor on the
report.
Use Aging Periods. The aging periods defined on the A/P Options
screen appear as defaults, but you can assign different periods for
this report.
The aging periods are used to group transactions by the future

dates at which they will become due, rather than by the amount of
time they are overdue. All overdue amounts appear in the Overdue
column on the report.
Select Vendors By. Specify up to four criteria to select the vendor
accounts to list on the report. More...
If you do not specify selection criteria, the report includes all vendor
records.
Sort Vendors By. Specify up to four sort orders by which to
organize records on the report. More...
If you do not specify sorting criteria, the report orders the records
by vendor number.
Title. If you want to include a title for each sorted group, select the
Title check box for each group of records you are sorting by.
Total. If you want to include subtotals for each sorted group, select
the Total check box for the groups of records you are sorting by.
[Include] Contact/Phone/Credit. Select this option if you want to
list the vendor's contact person and phone number and your credit
limit for the vendor.
[Include] Space For Comments. Select this option if you want to
leave blank space at the end of each vendor record for your notes.
[Include] Vendors/Transactions on Hold. Choose this option to
include vendors that you have placed on hold in the Vendors
screen, and transactions that you have placed on hold in the
Control Payments folder.
[Include] All Available Discounts. Select this option if you want the
program to calculate amounts owing by taking advantage of all
available discounts.
Select Transaction Types. Select the types of transactions to
include on the report. You can include any or all of the transaction
types listed.
Note: If you clear the Adjustments check box, adjustments can
still appear as applied details on the documents that payment was
applied to. If you select the Adjustments check box, adjustments

can appear as both applied details and regular documents.
[Show] Applied Details. Select this option if you want to include all
the documents such as payments and credit notes that were
applied to each reported invoice. If you do not select this option, the
report shows only the balance owing for each outstanding
document.
[Show] Fully Paid Transactions. Select this option if you want to
list documents that are fully paid, but not yet cleared from Accounts
Payable.
[Show] Aged Retainage. Select this option if you want to include
retainage documents with taxes on the report.
This option is not available if you are aging documents by
document date.
Print Amounts In. Use this option to select the currency for the
report. You can list transaction amounts in the vendor currency or
the functional currency.
If you list transactions in the functional currency, and you have
performed a revaluation, the report shows the new functional
amounts.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Transaction Reports > Aged Payables Report

Printing the Aged Payables Report
The Aged Payables report groups outstanding transactions into a current
period and four aging periods by document date or due date. Use the
report to analyze your payables.
For information on the contents of this report, see A/P Aged Payables
Report Screen.

When to Print
Print the Aged Payables report when you need a listing of the status of
your payables on a given date, such as at the end of a fiscal year or
period.
To print the Aged Payables report:
1. Open Accounts Payable > A/P Transaction Reports > Aged
Payables.
2. In the Report Type field, select Aged Payables By Due Date or
Aged Payables By Document Date to age balances or documents.
3. In the Age As Of field, specify the date on which to report the
payables.
Accounts Payable uses this date to assign transactions to aging
periods. For example, if you print the report aged by due date, the
program assigns each transaction to an aging period by calculating
the number of days between its due date and the Age As Of date.
4. In the Cutoff By field, specify the type of date by which to evaluate
transactions for inclusion on the report, and then, in the Cutoff Date
field, specify the latest date a transaction can have to be included on
the report. (The report includes only transactions that have a date
that is on or before this date.) More...
5. Select from the following options:
Print Transactions In. Indicate whether to print a summary or
detailed report, and whether to print the detailed version of the
report by document date (Detail by Date) or by document number
(Detail by Document).
Sort Transactions by Transaction Type. Select this option if you
want to sort transactions by document type for each vendor on the
report.
Use Aging Periods. The aging periods defined on the A/P Options
screen appear, but you can assign different periods for this report.

Select Vendors By. Specify up to four criteria to select the vendor
accounts to list on the report. More...
Sort Vendors By. Specify up to four orders by which to sort
records for the report. More...
If you do not specify sorting criteria, the report orders the records
by vendor number.
Show Group Title. If you want to include a title for each sorted
group, select the Title check box for each group of records you are
sorting by.
Show Group Subtotal. If you want to include subtotals for each
sorted group, select the Show Group Subtotal option for groups of
records you are sorting by.
[Include] Contact/Phone/Credit. Select this option if you want to
list the vendor's contact person and phone number, and your credit
limit for the vendor.
[Include] Space for Comments. Select this option to leave blank
space at the end of each vendor record for your notes.
[Include] Vendors With A Zero Balance. Select this option to
include vendors with zero balances.
[Include] Vendors/Transactions on Hold. Select this option to
include vendors that are placed on hold in the Vendors screen, and
transactions that you have placed on hold in the Control Payments
screen.
Select Transaction Types. Select the types of transactions to
include on the report. You can include any or all of the transaction
types listed.
Note: If you clear the Adjustments check box, adjustments can
still appear as applied details on the documents that payment was
applied to. If you select the Adjustments check box, adjustments
can appear as both applied details and regular documents.
Applied Details. Select this option to include all the documents
such as payments and credit notes that were applied to each
reported invoice. If you do not select this option, the report shows

only the balance owing for each outstanding document.
[Show] Fully Paid Transactions. Select this option to list
documents that are fully paid, but not yet cleared from Accounts
Payable.
[Show] Aged Retainage. Select this option to include retainage
documents with taxes on the report.
This option is not available if you are aging documents by
document date.
Print Amounts In. Use this option to select the currency for the
report. You can list transaction amounts in the vendor currency or
the functional currency.
Note: If you list transactions in the functional currency, and you
have performed a revaluation, the report shows the new functional
amounts.
6. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Transaction Reports > Aged Retainage Report

Printing the Aged Retainage Report
The Aged Retainage report groups outstanding retainage amounts by
due date into a current period and four aging periods.
For information on the contents of this report, see A/P Aged Retainage
Report Screen.

When to Print
Print the report when you need to review retainage that is due to vendors,
such as at the end of a fiscal year or period.
To print the report:
1. Open Accounts Payable > A/P Transaction Reports > Aged
Retainage.
2. In the Report Type field, specify a type as follows:
Select Aged Retainage By Due Date to print a report that shows
all outstanding retainage amounts that are due for each aging
period, including Future and Current.
Outstanding retainage amounts are grouped according to the dates
on which they become due.
Note: For job‑related documents, if one of the document details
becomes due in a future period, the outstanding retainage amount
for that detail appears in the Future period.
Select Future Retainage By Due Date to print a report that shows
outstanding retainage amounts that will become due in future aging
periods, beginning with the Age As Of date.
Outstanding retainage amounts are grouped according to the future
dates at which they will become due.
Select Overdue Retainage By Due Date to print a report that
shows only outstanding retainage amounts that became overdue in
each aging period.
Overdue outstanding retainage amounts are grouped according to
the dates on which they became due.
3. Select the remaining report options as follows:
Age As Of. Specify the date on which to report the retainage. The
program uses this date to assign retainage to an aging period by

calculating the number of days between its due date and the date
entered in the Age As Of field.
Cutoff By. The report includes only those transactions or balances
that have a due date before or on the cutoff date you specify.
More...
Print Transactions In. Indicate whether to print a summary or a
detailed report, and whether to print the detailed version of the
report by document date (Detail By Document Date), by due date
(Detail By Retainage Due Date), or by document number (Detail By
Document).
Use Aging Periods. Accounts Payable uses aging periods to
group outstanding retainage amounts.
The aging periods defined on the A/P Options screen appear as
defaults, but you can assign different periods for this report.
Select Vendors By. Specify up to four criteria to select the vendor
accounts to list on the report. More...
If you do not specify selection criteria, the report includes amounts
for all vendors that use the account type you select.
Sort Vendors By. You can choose up to four orders by which to list
(sort) records for the report. If you do not specify sorting criteria, the
report orders the records by vendor number.
Title. If you want to include a title for each sorted group, select this
option for each group of records you are sorting by.
Total. If you want to include subtotals for each sorted group, select
the this option for each group of records you are sorting by.
Include Taxes. Select this option to include tax information on the
report.
Print Amounts In. Use this option to select the currency for the
report. You can list transaction amounts in the vendor currency or
the functional currency.
If you list transactions in the functional currency, and you have
performed a revaluation, the report shows the new functional

amounts.
4. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Transaction Reports > Printing Batch Listings

Printing Batch Listings
A batch listing is the printed record of the transactions in a batch.
You can print batch listings for invoice, payment, and adjustment batches
that have been entered, imported, generated, or posted.
Note:
You cannot print batch listings for deleted or posted batches.
The invoice batch listing includes debit notes and credit notes, as
well as interest invoices.
Printing batch listings is optional, unless the Force Listing Of All
Batches option is selected on the A/P Options screen.
For information on the contents of this report, see A/P Batch Listing
Screen.

When to Print
You should print batch listings for your audit trail records after entering,
importing, generating, or editing a batch, at any time before the batch is
posted.
Important! When you print to any print destination, including Preview,
Accounts Payable changes the batch print status to Printed. Be sure to
print the batch listing to a printer or a file before posting, even if the
Force Listing Of Batches option is selected on the A/P Options
screen.
To print batch listings:
1. Open Accounts Payable > A/P Transaction Reports > Batch
Listing.
Tip:
You can also open the Batch Listing screen by:
Clicking the Print button on the Batch List screen.
Clicking File > Print Batch Listing Report on any transaction
entry screen.
2. Select the type of batch for which you are printing listings (invoice,
Payment, or Adjustment).
Note: You do not print payment or adjustment batch listings for an
Intercompany Transactions company.
3. Use the From and ToBatch Number fields to specify the range of
batch numbers to include in the batch listing.
4. Use the From and ToBatch Date fields to specify the range of batch
creation dates.
The default range includes all batches from the beginning of the

current fiscal year to the session date.
5. Select any optional information you want to include, as follows:
.Reprint Previously Printed Batches.
Show Comments.
Show Schedules. Select this option to include multiple payment
schedules on invoice batch listings.
Show Tax Details. Select this option to include tax details on
invoice batch listings.
Show Adjustment Details. Select this option to include details of
adjustments posted with payments and an adjustment summary.
Note: This option appears only for payment batch listings, and it is
not available for an Intercompany Transactions company.
Show Job Details. Select this option to include the contract,
project, category, resource, applied amount, and discount taken for
each job‑related detail, and to print a summary by contract.
Note: This option appears only if you use Sage 300 ERP and Job
Costing, and it is not available for an Intercompany Transactions
company.
Show Optional Fields. Select this option to include optional field
information included with transactions.
Note: This option appears only if you use Sage 300 ERP
Transaction Analysis and Optional Field Creator.
6. Select the types of batches to print. You can choose:
Entered. These are batches created in Accounts Payable.
Imported. These are batches transferred to Accounts Payable
using the File > Import (batch) command on transaction entry
screens. More...
Generated. These are batches created in Accounts Payable, such

as transactions that were rejected during posting.
Recurring. If you are printing invoice batches, you can also print
listings of the batches created using the Create Recurring Payable
Batch screen.
Note: This option is not available for an Intercompany
Transactions company.
External. These are batches that you create in other Sage 300
ERP programs, then send to Accounts Payable (for example,
invoice batches that you generate in Purchase Orders).
System. These are payment batches created using the Create
Payment Batch screen.
Note: This option is not available for an Intercompany
Transactions company.
Retainage. These are batches that you create to clear outstanding
retainage.
Note: This option appears only if you use retainage accounting,
and it is not available for an Intercompany Transactions company.
7. Select the statuses of batches to print. You can choose:
Open. These are unlisted batches, or edited batches that have not
been relisted.
Ready To Post. These are completed batches that have been
marked Ready To Post.
Posted. These are batches that have been posted.
8. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.

If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
After printing batch listings

Related Topics

Home > Printing Reports > Transaction Reports > Batch Status Report

Printing the Batch Status Report
The Batch Status report describes all unposted invoice, payment, or
adjustment batches, and posted or deleted batches for which the
information has not yet been cleared from Accounts Payable. It is a
valuable management tool for tracking batches, particularly when several
operators are entering batches on a multi-user system.
For information on the contents of this report, see A/P Batch Status
Report Screen.

When to Print
Print the report when you need batch information, and before clearing
batch status information (details of posted and deleted batches).
Tip: You clear information about printed posting journals and deleted
and posted batches using the A/P Clear History screen.
To print the Batch Status report:
1. Open Accounts Payable > A/P Transaction Reports > Batch
Status.
2. Select the batch type for which you want to print the report (invoice,
Payment, or Adjustment).
Note: You do not print payment or adjustment batch listings for an
Intercompany Transactions company.
3. Use the From and ToBatch Number fields to specify the range of
batch numbers to include in the report.
4. Use the From and ToBatch Date fields to specify the range of batch
creation dates.
The default range includes all batches from the beginning of the
current fiscal year to the session date.
5. Select the types of batches to print. You can choose:
Entered. These are batches created in Accounts Payable.
Imported. These are batches transferred to Accounts Payable
using the File > Import (batch) command on transaction entry
screens. More...
Generated. These are batches created in Accounts Payable, such
as transactions that were rejected during posting.
Recurring. If you are printing invoice batches, you can also print
listings of the batches created using the Create Recurring Payable

Batch screen.
Note: This option is not available for an Intercompany
Transactions company.
External. These are batches that you create in other Sage 300
ERP programs, then send to Accounts Payable (for example,
invoice batches that you generate in Purchase Orders).
System. These are payment batches created using the Create
Payment Batch screen.
Note: This option is not available for an Intercompany
Transactions company.
Retainage. These are batches that you create to clear outstanding
retainage.
Note: This option appears only if you use retainage accounting,
and it is not available for an Intercompany Transactions company.
6. Select the statuses of batches to print. You must select at least one
of the following statuses:
Open. These are unlisted batches, or edited batches that have not
been relisted.
Deleted.You can select this option to include deleted batches that
you have not yet cleared from Accounts Payable.
Ready To Post. These are completed batches that have been
marked Ready To Post.
Posted. These are batches that have been posted.
Post In Progress. These are batches for which posting has begun.
You cannot edit or print the batch.
Check Creation In Progress. When you print the report for
payment batches, you can select this status.
7. Click Print.
If you are printing to a printer, the Print window appears. Confirm

your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Transaction Reports > Check Register

Printing a Check Register
The Create Payment Batch screen provides a Pre-Check Register that
lets you preview the payment transactions that will be created using the
current selection criteria when you generate a payment batch.
Important! You should always print a Pre-Check Register, so you do
not get unexpected results when you generate the batch.
The Check Register report lists details of checks that are produced and
posted to vendor accounts during a check run. It can also list a summary
of the general ledger distributions that result.
Checks that are used for alignment or leading, as well as checks that are
voided before posting, are not included on this report because they do
not result in the creation of general ledger distributions or changes to
vendor account balances. These checks are listed on the Check Status
report in Bank Services.
For more information on the contents of this report, see A/P Check
Register Screen.

When to Print
Print the report after posting a check run, as part of your audit trail of
payments made during the check run.
To print a check register:
1. Open Accounts Payable > A/P Transaction Reports > Check
Register.
2. Select a range of posting sequences.
3. Indicate whether to print a summary of the general ledger
transactions created for the payments.
4. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
After printing a check register

Related Topics

Home > Printing Reports > Transaction Reports > Printing a Single Check When You Pay a
Vendor

Printing a Single Check When You Pay a Vendor
You can print a check for a payment or a prepayment when you enter the
transaction using the A/P Payment Entry screen or the A/P Invoice Entry
screen.
You can also print all the checks in a payment batch together using the
A/P Payment Batch List screen. For instructions on printing checks for
batches, see Printing Checks for a Batch of Payments.
You can print checks and advices on different types of check stock,
including forms that include an advice slip listing the details of the
payment. For information about the check and advice formats that come
with Accounts Payable, see About Printing Checks.
You can print checks while other users are printing checks, provided the
check runs are for different payment batches.
Notes:
You cannot reprint a check after the check information has been
posted to Bank Services.
If you delete a payment from the payment batch after you print the
check, Accounts Payable changes the status of the check to Void in
Bank Services.
You can delete payments (void checks) until you post the batch.
Deleted checks do not appear on the Accounts Payable Check
Register.

When to Print
Use the A/P Payment Entry screen or the A/P Invoice Entry screen to
print a check for a payment or a prepayment when you enter the payment
or prepayment.
Before you start
To print a check for a prepayment you enter using the Invoice Entry
screen:
1. Open Accounts Payable > A/P Transactions > Invoice Entry.
2. Display the invoice that you are prepaying, or add the invoice, as
usual.
Note: If you are entering a new invoice, you must click Add after
entering all the invoice information
3. Click Prepay.
4. On the Prepayments screen, select the payment batch and the
payment, or enter a new payment, as usual.
Note: If you are entering a new prepayment, you must click Add
after entering all the payment information
5. Make sure that the Print Check option is selected for the payment.
6. Click Print Check to display the Print Checks screen.
7. Continue at step 5 of the following instructions for printing a check
from the Payment Entry screen.
To print a check for a payment or a prepayment when you enter it on
the Payment Entry screen:
1. Open Accounts Payable > A/P Transactions > Payment Entry.
2. Display the payment for which you want to print a check, or enter a
new payment, as usual.

3. Make sure that the Print Check option is selected for the payment.
4. Click Print Check to display the Print Checks screen.
5. On the Print Checks screen, review the settings and the list of checks
the program is ready to print. More...
6. To print a test copy of a check to verify that your check forms are
aligned correctly in your printer, make sure your printer is ready, and
then click Align.
Note: Align always prints to your printer, no matter what print
destination you selected for Sage 300 ERP.
You can repeat this step as often as needed.
Tip: If you are not ready to print this check, click Close. When a
message appears warning you "Not all checks have been printed,"
click Yes to leave the Print Checks screen, cancel the check run,
and void the printed checks. (None were printed.)
7. When you are ready to print the check, click Print.
Accounts Payable asks whether the check was printed correctly.
8. Review the printed check, and it was printed correctly, click Yes.
If the check was not printed correctly:
a. Click No.
b. Reset the print status in one of the following ways:
Double-click in the Print Status column for the payment.
Click the Select Reprint Range button, and then specify the
number of the check you printed.
c. Click Print again.
Important! If you cannot reprint the check at this time, click
Close, and then click Yes when asked to confirm that you want to
cancel the print run and void the current check number. If you do

not cancel the check run, Accounts Payable sets the batch status
to Check Printing In Progress, and you cannot edit the batch until
you reset the status to Open.
9. If you are also printing a payment advice, Accounts Payable asks
whether the advice forms are in the printer.
a. Click Yes to print the advice form.
b. If the advice printed correctly, click Yes again when asked.
If the advice was not printed correctly click No, and then reset the
print status, as before.
When you accept the check and the payment advice, if you printed
one, Accounts Payable posts the check information to Bank Services,
and closes the Print Checks screen.
After printing a check

Related Topics

Home > Printing Reports > Transaction Reports > Checks > Printing Checks for a Batch of
Payments

Printing Checks for a Batch of Payments
The most common way to print checks is using the Print/Post button on
the A/P Payment Batch List screen to print checks for an entire batch,
and then immediately post the batch. More...
You can print checks while other users are printing checks, provided the
check runs are for different payment batches.

When to Print
Print all the checks in a payment batch before posting the batch.
Before you start
To print checks and post the payment information to vendor
accounts, you:
1. Open Accounts Payable > A/P Transactions > Payment Batch
List.
2. Select the batch for which you want to print checks.
3. Click Print/Post.
4. If you are posting the payments, click Yes. More...
5. On the Print Checks screen, review the settings and the list of checks
the program is ready to print. More...
6. To print a test copy of a check to verify that your check forms are
aligned correctly in your printer, click Align.
Note: You can repeat this step as often as needed when the
printing destination is Printer.
7. When you are ready to print the checks, click Print.
If you are printing checks, then advices (instead of checks only or
combined check and advices), Accounts Payable tells you to insert
the check stock in the printer before proceeding.
When printing is finished, it asks whether the checks were printed
correctly.
8. Review the checks, and then click Yes or No. Then:
If you clicked No, click Select Reprint Range, specify a range of
checks for reprinting, and then click Reprint.
If you clicked Yes and you are printing advices after the checks, the
program starts to print advices immediately. It asks you to confirm

that advices were printed correctly.
After you click Yes to accept the check run (or the advice run, if
printing advices), Accounts Payable returns you to the A/R Payment
Batch List screen and posts the payments to vendor accounts.
Important! After check data has been posted, you cannot reprint
the checks or advices.
After printing a check

Related Topics

Home > Printing Reports > Transaction Reports > Checks > Reprinting Checks Using the
Payment Batch List Screen

Reprinting Checks Using the Payment Batch List
Screen
When printing checks using the Payment Batch List screen, if the checks
do not print correctly, but you cannot reprint them immediately, you can
reject the print run, and reprint the checks later.
To reject a print run:
1. Click No when asked if the checks printed correctly.
2. If you want to void the checks, reset the status of the checks to Not
Printed on the Print Checks screen.
3. Click Close, and then confirm again that checks did not print
correctly.
If you reset the check status to Not Printed, Accounts Payable asks
whether you want to void the check numbers it issued.
If you do not want to keep any of the checks, click Yes. Accounts
Payable then:
Assigns all check numbers a Void status.
Important! Make sure you destroy all printed checks.
Retains the Ready To Post status for the batch.
Does not post the payment batch.
If you do not void all the checks, Accounts Payable:
Does not assign a Void status to check numbers at this time. It
will void only the checks that you reprint later.
Sets the batch status to Check Printing In Progress, preventing
you from opening or editing this batch unless you reset the batch
status.
Creates a restart record, so that the next time you print checks,
this batch will be processed first.

To reprint checks when you are ready:
1. Open the Payment Batch List screen.
2. Select the batch, and then click Print/Post.
If you voided the checks earlier, Accounts Payable opens the Print
Checks screen so you can proceed.
If you did not void the checks previously, Accounts Payable
displays a message stating that a restart record exists. Click OK.
Accounts Payable opens the Print Checks screen and proceeds
with the interrupted check run.
3. When the Print Checks screen appears, click Print to reprint the
checks.

Related Topics

Home > Printing Reports > Transaction Reports > Checks > Voiding Printed Checks During a
Check Run

Voiding Printed Checks During a Check Run
If you cannot reprint checks immediately and you want to edit the batch
later (for example, if you are entering and printing single checks from the
Payment Entry screen), you should void the check when you close the
Print Checks screen.
To void printed checks:
1. When asked if the checks printed correctly, click No to reject the
checks.
2. On the Print Checks screen:
a. Reset the status of the checks you printed to Not Printed, by
double-clicking the Check Status column or by using the Select
Reprint Range button.
b. Click Close.
c. When prompted to cancel the check run and void all checks, click
Yes.

Related Topics

Home > Printing Reports > Transaction Reports > Printing the G/L Transactions Report

Printing the G/L Transactions Report
The G/L Transactions report is a list of the general ledger transactions
created from all posted Accounts Payable batches, and from posted
revaluations (in multicurrency ledgers).
You can print detailed or summary versions of the report. The content of
the detailed report depends on the consolidation options selected on the
G/L Integration screen. For example, if general ledger transactions are
consolidated by account and fiscal period, the report shows a total for
each general ledger account and fiscal period. If they are not
consolidated, the report shows full details for each transaction.
For more information on the contents of this report, see A/P G/L
Transactions Report Screen.

When to Print
You should print this report:
After posting Accounts Payable batches, if you use the option to
create G/L transactions during posting.
After creating general ledger batches, if you use the option to create
G/L transactions using the Create G/L Batch icon.
If you do not use Sage 300 ERP General Ledger, print the report
before transferring the batch information to another general ledger
system.
Before using the A/P Year End screen.
You must create any outstanding general ledger batches (if you use
the option to create the batches on request) and print the G/L
Transaction report before clearing posting journals.
To print the G/L Transactions report:
1. Open Accounts Payable > A/P Transaction Reports >
G/L Transactions.
2. In the Select Batch Type field, select any or all of the Invoice,
Payment, and Adjustment batch types. If you use multicurrency
accounting, you can also select Revaluation.
3. Use the Posting SequenceFrom and To fields to specify a range of
posting sequence numbers for each batch type you selected.
The latest posting sequence numbers are displayed in the To field.
You can accept them, or enter earlier numbers.
4. Select additional options for the report using the following fields:
Report Format. Select Detail or Summary.
Sort By. If you are printing the detailed report, specify whether to
list the transactions on the report by Account Number,
Year/Period, or Batch/Entry Number.

The summary report is sorted by general ledger account number.
Currency. If you use multicurrency accounting, specify whether to
print amounts in each source currency or in the functional currency.
5. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
After printing the G/L Transactions report

Related Topics

Home > Printing Reports > Transaction Reports > G/L Transactions Report > Source Codes
Used on the G/L Transactions Report

Source Codes Used on the G/L Transactions
Report
Each type of Accounts Payable transaction is listed on the G/L
Transactions report with the source code "AP," followed by the
transaction type.
Source Codes
Transaction Type

Source Code
AP-AD

Adjustment

AP-CF

Applied Credit (from)

AP-CR

Applied Credit (to)

AP-DB

Debit Note

AP-DF

Applied Debit (from)

AP-DT

Applied Debit (to)

AP-ED

Earned Discount Taken

AP-GL

Gain or Loss (multicurrency ledgers)

AP-IN

Invoice

AP-IT

Interest Charge

AP-PI

Prepayment

AP-PY

Payment

Home > Printing Reports > Transaction Reports > Overdue Payables Report

Printing the Overdue Payables Report
The Overdue Payables report groups outstanding transactions or
balances into a current period and four aging periods by document date
or due date. Use the report to analyze your overdue payables.
For information on the contents of this report, see A/P Overdue Payables
Report Screen.

When to Print
Print the report when you need a listing of overdue payables on a given
date, such as at the end of a fiscal year or period, or when you want to
identify documents that must be paid immediately.
To print the Overdue Payables report:
1. Open Accounts Payable > A/P Transaction Reports > Aged
Payables.
2. In the Report Type field, specify Overdue Payables By Due Date or
Overdue Payables By Document Date to age balances or
documents.
3. In the Age As Of field, specify the date on which to report the
payables.
Accounts Payable uses this date to assign transactions to aging
periods. For example, if you print the report aged by due date, the
program assigns each transaction to an aging period by calculating
the number of days between its due date and the Age As Of date.
4. In the Cutoff By field, specify the type of date by which to evaluate
transactions for inclusion on the report, and then, in the Cutoff Date
field, specify the latest date a transaction can have to be included on
the report. (The report includes only transactions that have a date
that is on or before this date.) More...
5. Select from the following options:
Print Transactions In. Indicate whether to print a summary or
detailed report, and whether to print the detailed version of the
report by document date (Detail by Date) or by document number
(Detail by Document).
Sort Transactions by Transaction Type. Select this option if you
want to sort transactions by document type for each vendor on the
report.
Use Aging Periods. The aging periods defined on the A/P Options

screen appear, but you can assign different periods for this report.
Select Vendors By. Specify up to four criteria to select the vendor
accounts to list on the report. More...
Sort Vendors By. Specify up to four orders by which to sort
records for the report. More...
If you do not specify sorting criteria, the report orders the records
by vendor number.
Show Group Title. If you want to include a title for each sorted
group, select the Title check box for each group of records you are
sorting by.
Show Group Subtotal. If you want to include subtotals for each
sorted group, select the Show Group Subtotal option for groups of
records you are sorting by.
[Include] Contact/Phone/Credit. Select this option if you want to
list the vendor's contact person and phone number, and your credit
limit for the vendor.
[Include] Space for Comments. Select this option to leave blank
space at the end of each vendor record for your notes.
[Include] Vendors With A Zero Balance. Select this option to
include vendors with zero balances.
[Include] Vendors/Transactions on Hold. Select this option to
include vendors that are placed on hold in the Vendors screen, and
transactions that you have placed on hold in the Control Payments
screen.
Select Transaction Types. Select the types of transactions to
include on the report. You can include any or all of the transaction
types listed.
Applied Details. Select this option to include all the documents
such as payments and credit notes that were applied to each
reported invoice. If you do not select this option, the report shows
only the balance owing for each outstanding document.
[Show] Fully Paid Transactions. Select this option to list
documents that are fully paid, but not yet cleared from Accounts

Payable.
[Show] Aged Retainage. Select this option to include retainage
documents with taxes on the report.
This option is not available if you are aging documents by
document date.
Print Amounts In. Use this option to select the currency for the
report. You can list transaction amounts in the vendor currency or
the functional currency.
Note: If you list transactions in the functional currency, and you
have performed a revaluation, the report shows the new functional
amounts.
6. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Transaction Reports > Posting Errors Report

Printing the Posting Errors Report
The Posting Errors report lists incorrect entries that were placed into error
batches during posting and explains why the entries could not be posted.
For information on the contents of this report, see A/P Posting Errors
Report Screen.

When to Print
Print the report after posting a batch, if the program warns you that an
error batch has been created.
To print the Posting Errors report:
1. Open Accounts Payable > A/P Transaction Reports > Posting
Errors.
2. Select the type of error report to print (Invoice, Payment, or
Adjustment).
Note: If you are printing this report for an Intercompany
Transactions company, the Payment Error and Adjustment Error
reports are not available.
3. Use the From Posting Sequence and To Posting Sequence fields
to specify the range of posting sequences for which to print the
report.
4. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
After printing the G/L Transactions report

Related Topics

Home > Printing Reports > Transaction Reports > Posting Journals

Printing Posting Journals
Posting journals list all the transactions in a group of batches that were
posted together, as well as the general ledger transactions that were
created from the batches.
The journals provide audit trail reports of all uncleared posted details.
For information about the contents of this report, see A/P Posting
Journals Screen.

When to Print
You should print posting journals after each posting run, and then file
them with your other audit trail records.
You must print all outstanding posting journals before you can use the
A/P Clear History screen to clear them, or use the Year End screen to do
year-end processing.
If you use multicurrency accounting, you also print posting journals after
revaluing transactions at new exchange rates.
To print posting journals:
1. Open Accounts Payable > A/P Transaction Reports > Posting
Journals.
2. Specify the following report options:
Select Posting Journal. Select the type of journal to print
(Invoice, Payment, or Adjustment).
The invoice posting journal includes credit note, debit note, and
interest transactions, as well as invoices.
If you use multicurrency accounting, you can also select
Revaluation or Provisional Revaluation.
Note: If you are printing a posting journal for an Intercompany
Transactions company, you can select Invoice, only.
From Posting Sequence and To Posting Sequence. Type the
lowest and highest numbers in the range of posting sequences for
which you want to print journals.
A unique posting sequence number is assigned each time you post
batches. These fields display the lowest and highest posting
sequence numbers in your Accounts Payable system for the type of
journal you select.
Reprint Previously Printed Journals. Select this option if you

want to print additional copies of journals you printed before.
Note: Do not select the option if you want to print only the journals
you have not already printed from the specified range of posting
sequence numbers.
Include Job Details. Select this option to include job‑related
information, such as the contract, project, and category, with each
transaction printed.
Note: This option is available only if you use Sage 300 ERP
Project and Job Costing. It is not available for an ICT company.
Include Optional Fields. Select this option to include optional field
information for each printed transaction. (The option is available
only if you use optional fields.)
Include G/L Ref./Desc. Select this option to print the G/L reference
and description with each transaction.
Sort By. Specify the order in which to list transactions on the
posting journal:
Batch/Entry. This option lists transactions in order by the batch
and entry numbers they were assigned when you entered them.
Vendor Number. lists transactions in order by their vendor
numbers.
Document Date. This option lists transactions in order by the
dates that you entered when you created the transactions.The
name of this choice varies with the type of journal you want to
print.
Note: You select Adjustment Date when you print adjustment
posting journals.
Document Number. This option lists invoices, credit notes, debit
notes, and interest charges by their document numbers.
Check Number. This option lists payment transactions by the
check or payment number you entered with each transaction or

by the numbers that are assigned by Accounts Payable to
transactions entered without numbers.
Adjustment Number. This option lists adjustment transactions by
the adjustment number that Accounts Payable assigns to the
transactions when you create them.
It also lists transactions in the same order as sorting by batch and
entry number, unless you create transaction batches in a nonsequential order. For example, if one person opens an adjustment
batch but does not enter the adjustments until after a second
person has opened a second batch and entered transactions, the
transactions in the second batch are listed first.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Transaction Reports > Pre-Check Payment Register

Printing the Pre-Check Payment Register
The Payment Register report shows the payments that will be made if
you generate checks using the selection and exclusion criteria you
specify in the Create Payment Batch screen. The report can also provide
a list of transactions or vendor accounts that have been placed on hold.
For information about the contents of this report, see A/P Pre-Check
(Payment) Register Screen.

When to Print
Print the report before generating a check run, to verify the payment
batch you are creating.
Before you start
To print a pre-check payment register
1. Open Accounts Payable > A/P Transactions > Create Payment
Batch.
2. Select options on the Bank and Currency Selection Criteria tab
and the Vendor And Date Selection Criteria tab.
3. On the Exclusion tab, enter the list of vendors to exclude from the
batch.
4. Click the Register button.
After printing the Pre-Check Payment Register

Related Topics

Home > Printing Reports > Transaction Reports > Revaluation Posting Journal

Printing the Revaluation Posting Journal
A revaluation posting journal is the printed record of the transactions that
are created for the general ledger exchange gain and loss accounts
when you revalue multicurrency documents at new exchange rates.
If you perform a provisional revaluation, you can print the provisional
revaluation journal to check the transactions that will be created when
you post the revaluation.
For information on the contents of the revaluation posting journal, see
A/P Posting Journals Screen.

When to Print
You should print the posting journals after revaluing transactions at new
exchange rates, then file them with your other audit trail records.
Note: You must print all outstanding posting journals before you can
use the A/P Clear History screen to clear them, or use the Year End
screen to do year-end processing.
Before you start
To print the Revaluation Posting Journal:
1. Open Accounts Payable > A/P Transaction Reports > Posting
Journals.
2. Specify the following report options:
Select Posting Journal. Select Revaluation or Provisional
Revaluation.
From Posting Sequence and To Posting Sequence. If you are
printing a revaluation posting journal, type the lowest and highest
numbers in the range of posting sequences for which you want to
print journals.
You do not see this option if you are printing a provisional
revaluation journal.
Reprint Previously Printed Journals. Select this option if you
want to print additional copies of journals you printed before. You
see this option only if you are printing a Revaluation Posting
Journal.
Note: Do not select the option if you want to print only journals
you have not already printed from the specified range of posting
sequence numbers.
3. Click Print.

If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Transaction Reports > Vendor Transactions Report

Printing the Vendor Transactions Report
The Vendor Transactions report lists transactions that were posted to
vendor accounts during the period you specify when you print the report.
You can order the transactions by document date, by document number,
or by fiscal year and period.
For information on the contents of this report, see A/P Vendor
Transactions Report Screen.

When to Print
Print the report when you want to see the current status of your vendor
accounts.
Before you start
To print the Vendor Transactions report:
1. Open Accounts Payable > A/P Transaction Reports > Vendor
Transactions.
2. In the Report Type field, specify whether to print transactions by
document date, by document number, or by fiscal year and period.
3. If you are printing transactions by document date or by document
number, use the From Document Date and To fields to specify the
range of dates for which to include transactions.
If you are printing transactions by fiscal year and period, use the
From Year/Period and To fields to specify the fiscal year and period
range for which you want to print transactions.
4. Use the Select Vendors By fields to specify up to four criteria to
select the vendor accounts to list on the report. More...
Note: If you do not specify selection criteria, the report includes all
vendor records that meet the other criteria you specify. (For
example, the report does not include vendor records with a zero
balance unless you select the Print Vendors With A Zero Balance
option.)
5. Use the Sort Vendors By fields to specify up to four orders by which
to sort records for the report. More...
Note: If you do not specify sorting criteria, the report orders the
records by vendor number.
6. Specify whether to include group titles and/or group subtotals for
each sorted group. More...

7. Specify additional options for the report, as needed:
Select Transaction Types. Select one or more transaction types to
include on the report. The choices are Invoice, Debit Note, Credit
Note, Interest, Prepayment, and Payment.
Sort Transactions by Transaction Type. Select this option to sort
transactions by document type for each vendor on the report.
[Include] Contact/Phone/Credit. Select this option to list the
vendor's contact person and phone number, and your credit limit for
the vendor.
[Include] Space For Comments. Select this option to leave blank
space at the end of each vendor record for your notes.
[Include] Vendors With A Zero Balance. Select this option to
include accounts with a zero balance, for example, to find out which
vendor accounts are dormant. Note that an account could have
outstanding transactions even with a zero balance, for example, an
offsetting invoice and credit note.
[Include] Totals By Transaction Type. Select this option to list a
total for each transaction type after the listing for each vendor.
[Show] Applied Details. Select this option to include all the
documents such as payments and credit notes that were applied to
each reported invoice.
Note: If you do not select this option, the report shows only the
balance owing for each document.
[Show] Fully Paid Transactions. Select this option to list
documents that are fully paid, but not yet cleared from Accounts
Payable.
Print Amounts In. If you use multicurrency accounting, select the
currency for the report. You can list transaction amounts in the
vendor currency or the functional currency.
If you list transactions in the functional currency and you have
performed a revaluation, the report shows the new functional
amounts.

8. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Printing Vendor Reports

Printing Vendor Reports
Use the screens in the A/P Vendor Reports folder to print lists of vendors,
vendor groups, remit-to locations, and recurring payables in your
Accounts Payable system, as well as letters and labels for vendors.
Note: If the User 1099/CPRS Reporting option is selected on the
A/P Options screen, you can print 1099/1096 and T5018 (CPRS)
amounts in the required formats.
You can also print statistics reports for vendor groups and vendors.
1099/1096 Forms
5018 (CPRS) Forms
Letters and Labels
Recurring Payables Report
Remit-To Locations Report
Vendor Activity Statistics Reports
Vendor Group List
Vendor Period Statistics Report
Vendor Group Period Statistics Report
Vendors List

Home > Printing Reports > Vendor Reports > 1099/1096 Forms

Printing 1099/1096 Forms
The 1099 Amounts report lists the 1099-MISC amount for each vendor in
your Accounts Payable system.
The 1096 Amounts report prints the summary for the 1099-MISC forms.
For more information, see A/P Print 1099/1096 Forms Screen.

When to Print
Print 1099 or 1096 forms at the end of each calendar year, after you have
entered all transactions for the calendar year.
To print the report:
1. Open Accounts Payable > A/P Vendor Reports > Print 1099/1096
Forms.
If you are printing 1096 forms, select the check boxes for the
following options, as necessary:
Preaddressed Form. Select this option if you are using preprinted
forms that already include the address, so that the program does
not print the address.
Final Filing. Select this option if you are not required to file Forms
1099, 1098, 5498 or W-2G in the future.
2. Select the following options:
Form. Select the type of report you want to print. You can choose
1099 or 1096.
For Tax Year. Select the year for which you want to report 1099 data.
Use Form. Select the name of the 1099 form or 1096 form to use.
Vendor Number. Select a range of vendor numbers.
3. Enter payer information, including the name, address, telephone
number, and tax number of your company.
If you are printing 1096 forms:
From the Type field, select the type of tax number you are using
(your employer ID number or social security number).
Enter an optional contract name and e-mail address.
If your company is not in the U.S., select the Foreign Entity check
box.

4. To print a test copy of a 1099 or 1096 form to check the alignment of
the forms in your printer, click the Align button.
You can repeat this step as often as needed when the printing
destination is set to Printer.
5. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.
6. If you want to use the same settings the next time you print these
forms, click Settings > Save Settings As Defaults.

Related Topics

Home > Printing Reports > Vendor Reports > 5018 (CPRS) Forms

Printing T5018 (CPRS) Forms
You can use Accounts Payable to track payments to vendors who are
subject to CPRS reporting, and print the data on official CPRS forms.
For information on the contents of the forms, see A/P Print T5018
(CPRS) Forms Screen.

When to Print
Print CPRS reports at the end of each calendar year, after you have
entered all transactions for the calendar year.
To print the report:
1. Open Accounts Payable > A/P Vendor Reports > Print T5018
(CPRS) Forms.
2. Select report options as follows:
For Tax Year. Select the year for which you want to report CPRS
data.
Use Form. Select the name of the CPRS form to use.
If you are not sure of the name of the form, click Browse (or press
Alt+B ), and then select the form from the list that appears.
Business Number. Enter your business number.
Vendor Number. Select a range of vendor numbers.
CPRS Code. Select the range of CPRS codes to report on.
3. To print a test copy of a CPRS form to check the alignment of the
forms in your printer, click the Align button.
You can repeat this step as often as needed when the printing
destination is set to Printer.
4. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the

report attached.

Related Topics

Home > Printing Reports > Vendor Reports > Letters and Labels

Printing Letters and Labels
You can print letters and mailing labels for the vendors in your Accounts
Payable system.
Sage 300 ERP Accounts Payable comes with a sample covering letter
and a sample mailing label form, formatted for laser printers, that you can
use or change to suit your company's requirements.
Note: The sample labels are approximately 6.5 cm by 2.5 cm, and are
designed to fit a tab of 30 labels arranged in 3 columns.
For information on the contents of letters and labels, see A/P Letters and
Labels Screen.

When to Print
Print letters and labels whenever you need them for mailing to vendors.
For example, you might want to send covering letters to your vendors
with your payments.
If you are sending letters to accompany payment checks, you may find it
simpler to print checks, then advices, specifying the letter you are
sending with the checks as the advice form. This method ensures that
you print a letter for each payment check.
To print letters or labels
1. Open Accounts Payable > A/P Vendor Reports > Letters /
Labels.
2. Fill in the fields on the screen, as follows:
Letter/Label. Select the option for the type of form you are printing.
Use Letter/Label. Select the name of the letter or label form to use.
If you are not sure of the name of the form, click Browse (or press
Alt+B ), and then select the form from the list that appears.
Run Date. This is the date that appears on the forms.
Delivery Method. Specify how you want to send the letters to your
vendors, as follows:
Print Destination Select this option to send the statements to the
default print destination you selected on the company desktop.
VendorSelect this option to send the letters via the method
specified in your vendor records for each vendor.
Message ID. This field appears when you select Vendor for the
Delivery Method. Select the code for the message you want to send
with e-mailed letters.
Select By. Specify up to four selection criteria to select the vendor
accounts for which to print letters or labels. More...
Sort By. Specify up to four orders by which to list (sort) records for

the letters or labels. More...
Include Vendors with a Zero Balance. Select this option if you
want to print letters or labels for vendor accounts with zero
balances (as of the cutoff date).
3. To print a test letter or sheet of labels to check the alignment of the
letterhead or labels in your printer, click the Align button.
You can repeat this step as often as you need to when the printing
destination is Printer.
4. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Vendor Reports > Recurring Payables Report

Printing the Recurring Payables Report
The Recurring Payables report is a list of the recurring payables that you
have set up. It can also show the processing schedule attached to each
recurring payable record.
For information on the contents of this report, see A/P Recurring
Payables Report Screen.

When to Print
Print this report prior to creating a recurring payable batch to ensure that
the information is up to date.
To print the report:
1. Open Accounts Payable > A/P Vendor Reports > Recurring
Payables.
2. In the Recurring Payable Code From and To fields, enter the range
of codes you want to list in the report.
3. In the Vendor Number From and To fields, enter the range of
vendors you want to include in the report.
4. Select the Show Schedules option if you want to include the
schedules for the recurring payables codes that you are listing.
5. Select Optional Fields to include optional field information for each
recurring payable.
6. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Vendor Reports > Remit-To Locations Report

Printing the Remit-To Locations Report
The Remit-To Locations report lists the remit-to locations (addresses to
which you send checks) used by your vendors.
For information on the contents of this report, see A/P Remit-To
Locations Report Screen.

When to Print
Print the report when you add, change, or delete remit-to locations.
To print the report:
1. Open Accounts Payable > A/P Vendor Reports > Remit-To
Locations.
2. Select:
Whether to include address information (address, contact name,
and check language) or optional field information for the remit-to
locations. You must select at least one of these options to print the
report.
A range of vendor numbers.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Vendor Reports > Vendor Activity Statistics Reports

Printing Vendor Activity Statistics Reports
The Vendor Activity Statistics report lists information about the purchases
and payment history for the current year to date and previous fiscal year
for the vendor records in your Accounts Payable system. Most of the
information on this report is also available on the Vendor Activity tab of
the Vendors screen.
For information on the contents of this report, see A/P Vendor Activity
Statistics Report Screen.

When to Print
Print the report when you need to check on vendor account activity such
as the last time you made a purchase from the vendor, the date and
amount of your last payment to the vendor, the average number of days it
takes you to pay the vendor, or the date a vendor's balance was last
revalued (if you use a multicurrency Accounts Payable system).
To print the Vendor Activity Statistics report:
1. Open Accounts Payable > A/P Vendor Reports > Vendors.
2. Select Vendor Activity Statistics as the report type.
3. Specify whether to print amounts in the vendor currency or the
functional currency (if you use a multicurrency Accounts Payable
ledger).
4. Select up to four selection and sorting criteria. If you do not specify
selection criteria the report includes all vendor records. If you do not
specify sorting criteria the report orders the vendor records by vendor
number.
5. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Vendor Reports > Vendor Group List

Printing the Vendor Group List
The Vendor Group List reports the information entered for each vendor
group in your Accounts Payable system, and the vendors assigned to
each group.
For information on the contents of this report, see A/P Vendor Group List
Screen.

When to Print
Print the report when you add, change, or delete vendor groups.
To print the report:
1. Open Accounts Payable > A/P Vendor Reports > Vendor Groups.
2. Make your selections in the following fields:
Report Type. Select Vendor Group List.
Include. Specify whether to include profile information, group
members, or optional fields. You must select at least one of these
options to print the report.
From Group/To. Specify a range of vendor groups. If you are using
only one group, enter the group code in both the From and To
fields.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Vendor Reports > Vendor Period Statistics Report

Printing the Vendor Period Statistics Report
This report lists the total amount of amount of invoices, payments,
discounts taken, discounts lost, credit and debit notes, and adjustments
you have recorded for a given vendor during the period covered by the
report, as well as the total number of invoices paid during that period.
Note: The reports list statistics for the type of year and period specified
on the A/P Options screen.

When to Print
Print the report when you need a summary of vendor statistics (for
example, at the end of each period).
You can print the period statistics reports for vendors or for vendor
groups.
To print the Vendor Period Statistics report:
1.
2.
3.
4.

Open Accounts Payable > A/P Vendor Reports > Vendors.
Select Vendor Period Statistics as the report type.
Select the currency (if you use multicurrency accounting).
Specify whether to include the number of documents that make up
the total amount for each type of transaction listed on the report.
5. Specify the years and periods for which to include transactions, and
up to four selection and sorting criteria
6. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Vendor Reports > Vendor Group Period Statistics Report

Printing the Vendor Group Period Statistics
Report
This report lists the total amount of amount of invoices, payments,
discounts taken, discounts lost, credit and debit notes, and adjustments
you have recorded for a given vendor group during the period covered by
the report, as well as the total number of invoices paid during that period.
Note: The reports list statistics for the type of year and period specified
on the A/P Options screen.

When to Print
Print the report when you need a summary of vendor statistics (for
example, at the end of each period).
You can print the period statistics reports for vendors or for vendor
groups.
To print the Vendor Period Statistics report:
1. Open Accounts Payable > A/P Vendor Reports > or Vendor
Groups.
2. Select Vendor Group Statistics as the report type.
3. Specify whether to include the number of documents that make up
the total amount for each type of transaction listed on the report.
4. Select the ranges of groups, years, and periods to include on the
report.
5. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Home > Printing Reports > Vendor Reports > Vendors List

Printing the Vendors List
The Vendors report lists the information entered for the vendor records in
your Accounts Payable system.
For information on the contents of this report, see A/P Vendors Screen.

When to Print
Print the report when you add, change, or delete vendor records.
To print the report:
1. Open Accounts Payable > A/P Vendor Reports > Vendors.
2. Make selections in the following fields:
Report Type. Select Vendors.
Include. Specify whether to include the vendors' addresses, profile
information, comments, optional fields, or recurring payables.
Note: You must select at least one of these options to print the
report.
Follow-up Date From and To. If you are printing comments from
the vendor records, enter a range of follow-up dates for which to
include comments.
Select By. Specify up to four selection criteria for the report. Your
choices for the first selection criterion are: Vendor Number, Vendor
Group, or Short Name.
Your choices for the remaining three selection criteria include the
above and Account Set, Vendor Balance, Vendor Equivalent
Balance (multicurrency ledgers only), Vendor Name, Currency
Code (multicurrency ledgers only), and Start Date.
Note: If you do not specify selection criteria, the report includes all
vendor records.
Sort By. You can choose up to four orders by which to list (sort)
records for the report. You can sort by Vendor Group, Account Set,
Vendor Balance, Vendor Equivalent Balance (multicurrency ledgers
only), Vendor Name, Short Name, and Currency Code
(multicurrency ledgers only).

Note: If you do not specify sorting criteria, the report orders the
records by vendor number.
3. Click Print.
If you are printing to a printer, the Print window appears. Confirm
your printer selection and the number of copies to print, and then
click OK. Otherwise, click Cancel or Setup.
If you are printing to a file, the Export Report window appears.
Specify a name and location for the file, and then click Save.
If you are printing to the screen (Preview), the report appears in a
new window. You can print the report or export it to a file.
If you are printing to e-mail, an e-mail message appears with the
report attached.

Related Topics

Accounts Payable Screen Guides
Periodic Processing
Setup
Setup Reports
Transactions
Transaction Reports
Vendors
Vendor Reports

Home > Screen Guides > Periodic Processing Screens

Periodic Processing Screens
Use Accounts Payable Periodic Processing screens to perform tasks that
are part of your regular period-end procedures, such as clearing history,
creating general ledger batches, and deleting inactive records.
Clear History
Clear Statistics
Create G/L Batch
Create Recurring Payable Batch
Create Retainage Batch
Delete Inactive Records
Integrity Checker
Revaluation
Year End
1099 Electronic Filing
T5018 Electronic Filing

Home > Screen Guides > Periodic Processing > Clear History

A/P Clear History Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Clear History screen to remove obsolete data from your
Accounts Payable system, including:
Fully paid documents.
Vendor comments.
1099/CPRS amounts.
Printed posting journals.
Posting errors.
Deleted and posted batches.

Related Topics

Home > Screen Guides > Periodic Processing > Clear Statistics

A/P Clear Statistics Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Clear Statistics screen to remove obsolete vendor period
statistics and vendor group period statistics data from your Accounts
Payable system.
Note: This screen allows you to clear only period statistics. To clear
activity statistics, use the A/P Year End screen. For more information,
see A/P Year End Screen.

Related Topics

Home > Screen Guides > Periodic Processing > Create G/L Batch

A/P Create G/L Batch Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Create G/L Batch screen to create general ledger
transactions:
From outstanding posted invoice, payment, and adjustment batches.
When you revalue accounts at new exchange rates in multicurrency
ledgers.
Note: You use this screen to create general ledger batches only if you
did not select the Create G/L Transactions During Posting option on
the Integration tab of the A/P G/L Integration screen.

Related Topics

Home > Screen Guides > Periodic Processing > Create Recurring Payable Batch

A/P Create Recurring Payable Batch Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Create Recurring Payable Batch screen to create a batch of
recurring-payable invoices for selected vendors and recurring payables.
The batch appears in the Batch List screen as a Recurring batch, using
the next available invoice batch number.
Note: If you want to edit a recurring-payable batch, you use the A/P
Invoice Entry screen.
You post the generated invoices, then process the payments and print
checks as you would for any other type of invoice.
If the terms specified for a recurring payable include a multiple payment
schedule, Accounts Payable calculates the schedule when it processes
the payable.
Accounts Payable warns you when it creates the last invoice before a
recurring payable expires. You can update the recurring payable if you
want to continue using it.
Accounts Payable does not create an invoice for a recurring payable if:
It encounters an error while processing a recurring payables batch
(for example, if the terms code used in a recurring payable record is
invalid). The program displays an error message when it finishes
processing the batch.
Posting the invoice would cause the amount invoiced to date to
exceed the maximum amount for the recurring-payable.
The invoice would exceed the maximum number of invoices
permitted for the recurring-payable.
The invoice date is after the expiration date specified for the
recurring-payable.
The vendor is inactive or on hold.
The recurring payable is inactive.
If the program does not create an invoice for a recurring payable, it does

not update the Last Posted Invoice fields in the recurring payable record.
Note: When you delete a vendor record, Accounts Payable
automatically deletes all recurring payables for the vendor.

Related Topics

Home > Screen Guides > Periodic Processing > Create Retainage Batch

A/P Create Retainage Batch Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Create Retainage Batch screen periodically to create a
batch of retainage invoices, retainage debit notes, and retainage credit
notes for the vendors, documents, or vendor groups you select.
If you assigned a schedule (on the Retainage tab of the A/P Options
screen) that uses a reminder to users, Accounts Payable can remind
users to process retainage transactions when they are due. Users can
then process the retainage transactions directly from the Reminder List in
Common Services, rather than from the A/P Create Retainage Batch
screen. For more information about using schedules and reminders, see
the System Manager Help.
Accounts Payable assigns the next available invoice, credit note, or debit
note batch number to the retainage batch. It assigns the next retainage
invoice, retainage debit note, or retainage credit note number specified
on the Retainage tab on the A/P Options screen.

Related Topics

Home > Screen Guides > Periodic Processing > Delete Inactive Records

A/P Delete Inactive Records Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Delete Inactive Records screen to remove obsolete vendor,
vendor group, remit-to location, and recurring payable records.
Note: This screen removes records only if they currently have Inactive
status, and were set inactive within the range of dates you specify.

Related Topics

Home > Screen Guides > Periodic Processing > Integrity Checker

A/P Integrity Checker Screen
To open this screen
Fields and controls

Overview
Use the A/P Integrity Checker screen to limit the scope of Accounts
Payable integrity checks to fit the time available. You can specify:
The type of data to check.
A range of vendor records for which to check data.
Whether to fix minor errors during the check.
Whether to check for or delete orphan records.

Home > Screen Guides > Periodic Processing > Revaluation

A/P Revaluation Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Revaluation screen to:
Revalue multicurrency transactions at new exchange rates, to
determine the current value of payables on specific dates (in
multicurrency ledgers only).
Process a provisional revaluation (select the Provisional
Revaluation option) to determine the transactions that would be
created for the general ledger exchange gain and loss accounts if
you revalued the accounts at the specified rates.
Create revaluation transactions for the general ledger exchange gain
and loss accounts.
Open a separate screen to view historical revaluations for a selected
currency, and select revaluations that you need to redo.
When exchange rates fluctuate, you may need to revalue outstanding
documents denominated in other currencies to reflect their present value
in your own (functional) currency at a particular time, such as a financial
statement date. When you revalue a transaction, Accounts Payable
recalculates its functional equivalent value at a new exchange rate.
Gains and losses due to fluctuating exchange rates are treated as
permanent or temporary, depending on the exchange Gain/Loss
Accounting Method specified for your Sage 300 ERP system on the
Company Profile screen in Common Services. For more information
about this method, see the System Manager Help.

Related Topics

Home > Screen Guides > Periodic Processing > Year End

A/P Year End Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Year End screen to:
Reset batch numbers, so that the next batch you create of each type
will use number 1.
Move vendor activity statistics for the current year into the previous
year, and zero the totals for the new year.
Clear year-to-date statistics from recurring payable records.
Reset to 0 (zero) the Total Invoices Paid, Number Of Payments, and
the Total Days To Pay fields on the Activity and Statistics tabs on the
Vendors screen.
Note: Activity statistics are kept only for the current year to date and the
previous year. When you clear activity statistics, the current-year
statistics become the previous-year statistics.

Related Topics

Home > Screen Guides > Periodic Processing > 1099 Electronic Filing

A/P 1099 Electronic Filing Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P 1099 Electronic Filing screen to create an electronic file to
submit 1099 forms through the IRS FIRE (Filing Information Returns
Electronically) System using a modem or by mailing them on magnetic
tape or diskettes.
When you finish filing, Accounts Payable automatically prints a summary
report of the information you filed, which you can keep with your records.
Note: You should refer to IRS documentation for information on
electronic filing requirements before you submit 1099s electronically.
For example, the IRS does not accept compressed files. If the resulting
IRSTAX file is larger than 1.4 megabytes, you will have to submit a file
that spans two or more diskettes.

Related Topics

Home > Screen Guides > Periodic Processing > T5018 Electronic Filing

A/P T5018 (CPRS) Electronic Filing Screen
To open this screen
Fields and controls
Related tasks

Overview
Important! If you file more than 50 T5018 slips for a calendar year, you
must use CRA's Internet File Transfer application to file original or
amended T5018 returns.
Use the A/P T5018 (CPRS) Electronic Filing screen to create your T5018
information return in the required XML format. You can then submit the
generated file to the CRA through their website or on electronic media
acceptable to the CRA (DVD, CD, or diskette).
If your company operates in Canada and your primary source of business
income is construction, you must report amounts paid or credited for
construction services to the Canada Revenue Agency (CRA) by filing a
T5018 information return, which consists of a T5018 Summary and
related T5018 slips.
Note: The CRA does not process files that span more than one diskette
or CD. Be sure to choose a media type that can accommodate the
entire information return.

Related Topics

Home > Screen Guides > Setup Screens

Setup Screens
Use Accounts Payable Setup screens to set up records and options that
determine how Accounts Payable:
Processes transactions.
Interacts with General Ledger and other Sage 300 ERP modules.
Account Sets
Distribution Sets
E-mail Messages
G/L Integration
Options
Optional Fields
Payment Codes
Payment Selection Codes
1099/CPRS Codes
Terms
Distribution Codes

Home > Screen Guides > Setup > Account Sets

A/P Account Sets Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Account Sets screen to create groups of general ledger
account numbers that you can use to:
Categorize vendor transactions by accounts to which they are posted
in general ledger. These general ledger accounts are:
Payables Control.
Purchase Discounts.
Prepayment.
Use separate account sets to designate different types of payables,
or vendors in different geographical areas.

Related Topics

Home > Screen Guides > Setup > Distribution Sets

A/P Distribution Sets Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Distribution Sets screen to create sets of distribution codes
to represent the standard groups of distributions to general ledger
accounts that you make when entering vendor transactions. You can also
enter General Ledger accounts directly in distribution sets.
Note: You do not have to create distribution sets. If you prefer, you can
assign the general ledger account numbers or distribution codes you
need to invoice details as you enter them.
If you add distribution sets, you can assign them to vendor records.
Accounts Payable automatically displays the corresponding distribution
codes assigned to a distribution set when you enter transactions for the
vendor, but you can make any changes you need.
You must define distribution codes before you can use them in
distribution sets.
For each vendor account, you choose whether to distribute transactions
for the vendor by general ledger account numbers, distribution codes, or
distribution sets, and you enter the default set, code or account number.
(You can override the default during data entry.)

Related Topics

Home > Screen Guides > Setup > E-mail Messages

A/P E-mail Messages Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P E-mail Messages screen to:
Create messages to send with e-mailed letters.
Use variables (field names) from your company database so that emailed messages will include vendor- or company-specific
information. For more information, see E-mail Message Variables.
When printing letters using the Letters/Labels screen, select Vendor as
the delivery method. You can then select the message ID for the
message you want to send with the letter.

Related Topics

Home > Screen Guides > Setup > G/L Integration

A/P G/L Integration Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P G/L Integration screen to:
Specify how Accounts Payable produces and maintains information
from posted transactions for General Ledger.
Define the source codes used to identify different types of Accounts
Payable transactions created for General Ledger.
View the last posting sequence number for each type of batch posted
to General Ledger.
Specify what data to include in the G/L Entry Description, G/L Detail
Reference, G/L Detail Description, and G/L Detail Comment fields in
general ledger transactions.
Sage 300 ERP Accounts Payable produces general ledger transactions
from all batches you post. Each general ledger transaction includes all
the information you need to update Payables data accurately in your
general ledger.
If you use Sage 300 ERP General Ledger, Accounts Payable creates:
Batches of payables transactions right in General Ledger, where you
can edit and post them.
Separate General Ledger batches from posted invoice, payment, and
adjustment batches, as well as from revaluation (in multicurrency
ledgers).
If you use another general ledger system or your Sage 300 ERP General
Ledger system is at another location, Accounts Payable creates batches
you can import into another application, or print, then enter manually into
your general ledger.

Changing Settings
You can change any settings on the A/P G/L Integration screen at any
time.
Note: Changes to settings are applied only to general ledger

transactions created after the change, and do not affect pre-existing
general ledger batches.
Tip: If you use the Create G/L Batch screen to produce general ledger
batches and want to change to producing them during posting, we
recommend that you first run Create G/L Batch to create any
outstanding transactions.

Integration Tab
Use this tab to:
Specify whether to add general ledger transactions to the G/L batch
each time you post, or to create the transactions at a later date.
Choose whether to add new transactions to the existing G/L batch, or
create a separate G/L batch each time you post. You can also choose
to post new batches automatically.
Note: This option applies only if you use Sage 300 ERP General
Ledger with Accounts Payable at the same location.
Choose whether to consolidate the G/L batch when you post, or
always enter full transaction details in the batch.
Define the source codes used to identify different types of Accounts
Payable transactions created for General Ledger.
Look up the posting sequence number to be assigned the next time
you post invoices, payments, or adjustments, or the next time you
revalue transactions, if you use multicurrency accounting.
Before changing the Create G/L Transaction option to create transactions
during posting (if it was set to create transactions using the Create G/L
Batch icon), print an up-to-date copy of the G/L Transactions report, then
create any outstanding transactions.
Any change to your selections for the Consolidate G/L Batch option or
the data to include in the transaction description, detail reference, detail
description, and detail comment fields for general ledger transactions
applies only to transactions posted after the change, and has no effect on
transactions already in a general ledger batch.

Transactions Tab
Use this tab to specify the type of information to use in the G/L Entry
Description, G/L Detail Reference, G/L Detail Description, and G/L Detail
Comment fields in general ledger transactions.
This information also appears on Accounts Payable posting journals and
on General Ledger’s Journal Entry screen and reports.
You can assign one or more pieces of information (segments) to each
field, provided that the combined length of the segments and separators
does not exceed 60 characters. Fields exceeding this limit will be
truncated when you post general ledger transactions.
The segments you can select depend on the type of transaction to which
you are assigning information and whether the information is for the
transaction header or the details. This ensures that the information
passed to General Ledger is relevant for each type of transaction. For
example, you can assign the remit-to information from invoice details to
any of the General Ledger fields.
When you create general ledger transactions, if no data exists in the
source transaction field, the field will be blank in the general ledger
transaction. For example, if you assigned the original transaction
description to the G/L Entry Description field, but there is no description
for a particular entry, the field will be blank in the G/L transaction.

Related Topics

Home > Screen Guides > Setup > Options

A/P Options Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Options screen to select processing options and enter
general information about your Accounts Payable ledger.

Changing Settings
Important! Before changing any of the settings or other information on
the A/P Options screen, make sure you understand the impact the
options have on processing within Accounts Payable.
You can change the settings for most Accounts Payable options at any
time, provided that no other Accounts Payable screens are open and no
one else is currently using the Accounts Payable database.
Notes:
The only option you cannot change is the Multicurrency option.
Although you can select this option at any time, you cannot turn it
off again once you have selected it and saved the change.
You cannot save most changes on the A/P Options screen if any
other Accounts Payable screens are open.

Company Tab
Use this tab to change the contact name, telephone number, and fax
number for Accounts Payable.
To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use the
Company Profile screen in Common Services.

Numbering Tab
Use this tab to:
Choose the prefixes and next numbers to assign when you save
recurring payables, payments, prepayments, and adjustment
transactions, or you can allow Accounts Payable to assign them
automatically.
These numbers include a prefix (up to 6 letters) followed by a
sequence number. The prefix you assign must be unique and cannot
be used for any other type of Accounts Payable document.
You can change these prefixes and next numbers at any time.
Restrict the length of the number to be assigned to recurring
payables, payments, prepayments, and adjustment transactions. You
can use a maximum length of 22 characters, including prefixes.
This tab also displays the numbers that will be assigned to the next
invoice, payment, adjustment, and revaluation posting sequences, and
the next invoice, payment, and adjustment batches.

Processing Tab
Use this tab to specify:
Whether your Accounts Payable system uses multicurrency
accounting. For more information, see Setting Up Accounts Payable
to Use Multicurrency Accounting.
Note: Once you turn on the Multicurrency option, you cannot turn
it off again.
Whether to force listing of batches before posting.
Whether imported and external batches can be edited.
Whether Accounts Payable accumulates and reports vendor and
vendor group statistics.
If statistics are accumulated, the type of year and period for which
they are to be kept, whether tax is included in the statistics, and
whether statistics can be edited.
Aging periods by which you group outstanding and overdue
transactions on reports, and whether you age unapplied credit notes,
debit notes, and prepayments in the current period or the period
associated with their document dates.
The default number of days you keep comments in vendor records,
and whether you require batch listings (before posting).

Retainage Tab
Note: This tab appears when you select the Retainage Accounting
option on the Processing tab.
Use this tab to specify default settings for retainage when you add new
vendor records.
Accounts Payable uses the retainage settings from vendor records as
defaults when you enter invoices, credit notes, or debit notes, although
you can change settings for particular vendors—and for individual
documents.

Transactions Tab
This tab lets you:
Specify the following options for invoice, credit note, and debit note
transactions:
Whether you report 1099/CPRS payments, and whether you permit
1099/CPRS amounts to be edited.
The default method for calculating tax on invoices (automatic or
manual tax calculation).
Whether to use document totals as default amounts subject to
1099/CPRS reporting on invoices, debit notes, and credit notes.
Set options for payment transactions, including:
The default bank code for your company.
The order in which to list documents when applying payments and
credit notes in the Payment Entry screen. For more information,
see About Displaying Open Documents in Payment Entry.
Whether you enter adjustment transactions in payment batches.
Whether you permit editing of system-generated batches (of
payments).
Set the default sort order when printing checks, which include:
by Vendor Number.
by Payee Name.
by Payee Country.
by Payee Postal Code.
by Transaction Number.
You can change your choices for these options at any time, provided no
other Accounts Payable screens are in use.

Related Topics

Home > Screen Guides > Setup > Optional Fields

A/P Optional Fields Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Note: Optional fields are available if you use Sage Transaction Analysis
and Optional Field Creator.
Use the A/P Optional Fields screen to set up optional fields to use with
Accounts Payable vendor records and transactions.

Related Topics

Home > Screen Guides > Setup > Payment Codes

A/P Payment Codes Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Payment Codes screen to:
Display on the A/P Payment Entry screen fields that are appropriate
for the type of payment you are making.
Group vendor payments by the type of payment (cash, check, credit
card, and other).
Tip: You can create custom reports that take advantage of this
information. (For information about creating custom reports, see the
documentation that comes with Crystal Reports, available
separately.)
Important! Payment codes are different from payment selection codes,
which are used as criteria for generating payments from Accounts
Payable.

Related Topics

Home > Screen Guides > Setup > Payment Selection Codes

A/P Payment Selection Codes Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Payment Selection Codes screen to add payment selection
codes.
Payment selection codes define the criteria for selecting outstanding
invoices and generating transactions to pay them. You must create at
least one payment selection code if you want Accounts Payable to
generate payments for invoices automatically.
Note: You use the Create Payment Batch screen to generate the
payment transactions.

Criteria Tab
Use this tab to:
Choose the method for selecting documents for payment (by due
date, discount date, or both due date and discount date).
Select all documents meeting the criteria or forced documents only.
Set ranges of vendor groups, vendors, account sets, and vendor
amounts.

Exclusion Tab
Use this tab to list all vendors that you want to exclude from payment
batches you create using this code.

Optional Fields Tab
Note: This tab appears only if you use Transaction Analysis and
Optional Field Creator.
Use this tab to specify optional fields and values to be assigned as
defaults when you create a payment batch.
When you enter a new payment selection code, the tab initially displays
payment optional fields that are marked for automatic insertion, along
with their default values.
You can add or delete optional fields, and change the default values.
Note that you can add only optional fields that are defined for payments
in the Optional Fields setup screen.
If you delete an automatically inserted optional field for a payment
selection code, when you create batches using the code, the program will
reinsert the optional field using the default value from the optional field
setup record.

Select Tab
Use this tab to specify:
Whether the payment selection code is active.
The bank account from which to draw the checks.
The bank currency (check currency) and the vendor currency
(multicurrency ledgers only) and exchange rate information.
This tab also shows the date when the payment selection code was last
edited and saved.

Related Topics

Home > Screen Guides > Setup > 1099/CPRS Codes

A/P 1099/CPRS Codes Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P 1099/CPRS Codes screen to add codes to assign to
vendors that are subject to 1099/CPRS reporting.
You must enter a 1099/CPRS code in the Vendors screen for each
vendor you mark as subject to 1099/CPRS reporting.
For a list of the 1099/CPRS codes created by Accounts Payable, see List
of 1099 / CPRS Codes.

Related Topics

Home > Screen Guides > Setup > Terms

A/P Terms Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Terms screen to:
Define the payment terms by which your vendors calculate invoice
due dates.
Specify the method used to calculate discount periods and discount
amounts on invoices from vendors who offer discounts for early
payment.
Important! You must add at least one terms code before you can enter
Accounts Payable transactions.

Related Topics

Home > Screen Guides > Setup > Distribution Codes

A/P Distribution Codes Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Distribution Codes screen to:
Define codes to identify the general ledger account numbers to use
when distributing purchases to general ledger accounts.
Specify a description (name) for each distribution code.
Specify whether the distribution code is active or inactive.
Specify a Discountable status for the distribution code.

Related Topics

Home > Screen Guides > Setup Reports Screens

Setup Reports Screens
Use the screens in the A/P Setup Reports folder to print reports of:
The options you selected, data you entered, and records you added
to set up your Accounts Payable system.
Records you revised.
Vendor and vendor group statistics.
Account Sets
Distribution Codes
Distribution Sets
E-mail Messages
G/L Integration
Optional Fields
Options
Payment Codes
Payment Selection Codes
Terms
1099/CPRS Codes

Home > Screen Guides > Setup Reports > Account Sets

A/P Account Sets Report Screen
To open this screen
Related tasks

Overview
This report lists the descriptions and numbers of the general ledger
accounts used in the account sets in your Accounts Payable system.

When to Print
Print the report when you add, change, or delete account sets.

Information Printed on This Report
For each account set, the report lists:
The account numbers for your general ledger Payables Control,
Purchase Discounts, and Prepayment accounts.
The range of account sets printed.
If you use multicurrency accounting, the report also lists:
The currency code that identifies the currency used by the vendors
assigned to this account set.
The exchange gain and loss general ledger accounts (if the account
set is in a currency other than the functional currency). Exchange
gains and losses occur when you revalue Accounts Payable
transactions, or when you settle a document (such as paying an
invoice) at a different rate of exchange than the invoice rate.
The exchange rounding account to which to post differences that
arise during currency conversion.

Related Topics

Home > Screen Guides > Setup Reports > Distribution Codes

A/P Distribution Codes Report Screen
To open this screen
Related tasks

Overview
The Distribution Codes report lists the descriptions and numbers of the
general ledger accounts used in the distribution codes in your Accounts
Payable system.

When to Print
Print the report when you add, change, or delete distribution codes.

Information Printed on This Report
For each distribution code listed, the report shows:
The description and general ledger account number assigned.
Whether distributions using the code are discountable.
The date the record was last edited.
For inactive distribution codes, the date on which a code was made
inactive.

Related Topics

Home > Screen Guides > Setup Reports > Distribution Sets

A/P Distribution Sets Report Screen
To open this screen
Related tasks

Overview
The Distribution Sets report lists the distribution methods and distribution
codes specified for the distribution sets you use to allocate purchase
amounts in your Accounts Payable system.

When to Print
Print the report when you add, change, or delete distribution sets.

Information Printed on This Report
The number and description of the general ledger account assigned
to the distribution code.
The Distribution Percentage column contains information only when
the distribution method is Fixed Percentage.

Related Topics

Home > Screen Guides > Setup Reports > E-mail Messages

A/R E-mail Messages Report Screen
To open this screen
Related tasks

Overview
The E-mail Messages report lists the messages you send to vendors with
e‑mailed letters.

When to Print
Print the report when you add, change, or delete e‑mail messages.

Information Printed on This Report
Each e-mail message is printed, along with its message ID, description,
and subject line.

Related Topics

Home > Screen Guides > Setup Reports > G/L Integration

A/P G/L Integration Report Screen
To open this screen
Related tasks

Overview
The G/L Integration report lists the integration options and other
information specified on the G/L Integration screen that determine how
your Accounts Payable system interacts with General Ledger.

When to Print
Print the report when you change G/L Integration settings for Accounts
Payable.

Information Printed on This Report
The options selected on the G/L Integration screen.
The posting sequences through which you have created general
ledger transactions.
The segments and separators to be used for the reference,
description, and comment fields for each type of transaction created
for general ledger (specified on the Transactions tab of the G/L
Integration screen).

Related Topics

Home > Screen Guides > Setup Reports > Optional Fields

A/P Optional Fields Report Screen
To open this screen
Related tasks

Overview
This report lists the optional fields you have defined for Accounts
Payable.

When to Print
Print the report when you add, change, or delete optional fields.

Information Printed on This Report
For each type of optional field, the report shows the optional field codes,
descriptions, default values, and whether an optional field is set for
automatic insertion in new records.

Related Topics

Home > Screen Guides > Setup Reports > Options

A/P Options Report Screen
To open this screen
Related tasks

Overview
The A/P Options report lists the options selected and other information
entered on the A/P Options screen to specify how your Accounts Payable
system operates.

When to Print
Print the report when you change your selections for Accounts Payable
options.

Information Printed on This Report
The options on the A/P Options screen, and the selection for each.
The prefix and next number to assign to prepayments.
The numbers that will be assigned to the next invoice, payment, and
adjustment batch you create, and the next posting sequence for each
batch type.
The posting sequences through which you have created general
ledger transactions.

Related Topics

Home > Screen Guides > Setup Reports > Payment Codes

A/P Payment Codes Report Screen
To open this screen
Related tasks

Overview
The Payment Codes report lists the codes, descriptions, and methods of
payment used in your Accounts Payable system.

When to Print
Print the report when you add, change, or delete payment codes.

Information Printed on This Report
For each payment code, the report lists:
The name of the payment code that appears in payment code fields
in Accounts Payable (such as CASH, CHECK, WIRE, or the name of
a credit card).
The description.
The payment type (such as Cash, Check, Credit Card, or Other).
The date the payment code record was last edited.
For inactive payment codes, the date on which Inactive status was
selected.

Related Topics

Home > Screen Guides > Setup Reports > Payment Selection Codes

A/P Payment Selection Codes Report Screen
To open this screen
Related tasks

Overview
The Payment Selection Codes report lists the bank and currency codes,
selection criteria, and exclusion criteria defined for the payment selection
codes you use to create payment batches in your Accounts Payable
system.

When to Print
Print the report when you add, change, or delete payment selection
codes.

Information Printed on This Report
The bank code associated with each payment selection code.
The selection criteria assigned to the code, including the method of
selecting documents and the ranges of vendor groups, vendor
numbers, account sets, and amounts from which to select.
The list of vendors, if any, who are excluded from the accounts that
can be selected by the payment selection code.

Related Topics

Home > Screen Guides > Setup Reports > Terms

A/P Terms Report Screen
To open this screen
Related tasks

Overview
The Terms report lists the information entered for each terms code to
specify how to calculate due dates, discount amounts, and discount
periods on invoices that use the code.

When to Print
Print the report after you add, change, or delete terms codes.

Information Printed on This Report
The range of terms codes you chose to print on the report.
The terms code and description, and date the terms record was last
edited.
The method used to determine the due dates for invoices assigned to
the terms code. You can calculate due dates using a number of days
from the invoice date, the end of the next month, a day of the next
month, a number of days from a day of the next month, or a due date
table.
Discount information, including the method used to determine the
discount period, whether to include tax in the base for discount
calculations, and the discount percentage.
If the terms code uses a table to calculate due dates or discount
dates, the report lists the information in the table.
For multiple payment schedules, the report shows the percentage
due, the method of calculating the due date, and discount information
for each payment.
Note: This information appears only if you select the Include
Multiple Payment Schedules option.

Related Topics

Home > Screen Guides > Setup Reports > 1099/CPRS Codes

A/P 1099/CPRS Codes Report Screen
To open this screen
Related tasks

Overview
The 1099/CPRS Codes report lists the code and description for each
1099/CPRS code entered in your Accounts Payable system. The code
numbers correspond to the box numbers on the US 1099-MISC form.
For CPRS reporting in Canada, we recommend that you use code 3,
Other, to track payments to Vendors subject to CPRS reporting.
Note: Only standard 1099-MISC codes are printed on the stock
1099/CPRS Amounts report. If you add any non-standard 1099/CPRS
codes, you must modify the 1099/CPRS Amounts report screen to print
the non-standard codes.

When to Print
Print 1099 and CPRS Codes reports whenever you update 1099/CPRS
codes to verify that they are correct and complete. Then file the report.

Information Printed on This Report
The sample 1099 form includes the following information:
A list of the 1099/CPRS codes in your Accounts Payable system.
For each 1099/CPRS code listed:
A description.
The minimum amount to report.
The dates that the code was last edited and/or made inactive.

Related Topics

Home > Screen Guides > A/P Transactions Screens

A/P Transactions Screens
Use Accounts Payable transaction entry screens to record, edit, post,
and inquire on the following types of transactions:
Invoices, debit notes, credit notes
Payments
Adjustments
Adjustment Batch List
Adjustment Entry
A/P Control Payments Screen
Create Payment Batch
Invoice Batch List
Invoice Entry
Payment Batch List
Payment Entry
A/P Payment Inquiry Screen
Post Batches

Home > Screen Guides > Transactions > Adjustment Batch List

A/P Adjustment Batch List Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Adjustment Batch List screen to:
Display a list of posted and unposted adjustment batches, beginning
with the batch number you specify. More...
Create a new adjustment batch.
Select an existing batch to edit, delete, or post.
To view the transactions in an unposted batch, either open the batch
you want to view, or print the batch listing report (or preview it on your
screen).
Tip: If you try to post a batch for which you have not selected the
Ready To Post option, you see a message that lets you select the
option from the Adjustment Batch List screen.
Post individual adjustment batches.
Print batch listings, batch status reports, posting journals, and posting
error reports:
To print the Batch Status report, you click File > Print Batch
Status.
To print the posting errors report, you double-click in the Number
Of Errors column for the error batch.
To print the posting journal, you double-click in the Posting
Sequence Number column.
Notes:
You cannot edit a batch for which you have selected the Ready To
Post option.
You can view, but you cannot edit, posted batches. However, to
view a posted batch, you must not have cleared the batch using the
Clear Deleted And Posted Batches option (on the A/P Clear
History screen ).

You cannot open deleted batches.

Related Topics

Home > Screen Guides > Transactions > Adjustment Entry

A/P Adjustment Entry Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Adjustment Entry screen to:
Adjust open and fully paid documents in vendor accounts.
Note: You can use this screen to adjust fully paid documents only if
you have not yet cleared the documents from Accounts Payable.
Edit batches of adjustments created during posting (when adjustment
batches contain errors) and imported from other accounting
programs.
Print a batch listing report for the selected batch.
Tip: If the Allow Adjustments In Payment Batch option is selected on
the A/P Options screen, you can adjust documents when you apply
payments to them using the Payment Entry screen. You also use the
Payment Entry screen to edit this type of adjustment.

Document Tab
Use the Document tab to:
Specify the vendor number.
Specify the document number and the payment number for the
document you want to adjust.
Open a Finder that lets you select a particular detail for adjustment.
Click the Select Detail button to open the Open Document Details
Finder that lets you select an existing detail used on the document.
Use the detail table to add details that did not exist on the original
document, or to enter debit or credit amounts to modify existing
details.

Optional Fields Tab
Note: The Optional Fields tab appears on the Adjustment Entry screen
only if you use Sage 300 ERP Transaction Analysis and Optional Field
Creator.
If you marked any adjustment optional fields for automatic insertion, they
appear on the tab, along with their default values, when you add a new
adjustment entry.
You can add any other optional fields that are defined for adjustments,
and you can delete any that are assigned automatically, except Required
fields.
Default values for the optional fields appear, as follows:
If an optional field assigned to the current adjustment was also used
on the document you are adjusting, the program displays the values
from the original document.
If an optional field assigned to the current adjustment was not used
on the original document, but it is assigned to the vendor record,
Accounts Payable displays the default value from the vendor record.
If an optional field assigned to the current adjustment was neither
used on the original document nor assigned to the vendor, the
program uses the default value from the optional field record.
You can change the default values, as follows:
If the optional field is validated, you must specify a value that is
defined for the optional field in Common Services. If the optional field
allows blanks, you can leave the value field blank.
If the optional field is not validated, you can select a predefined
value, or you can enter any value that is consistent with the type of
field (amount, text, yes or no, and so on), providing your entry does
not exceed the length permitted for the field.

Rates Tab
Note: This tab appears only in multicurrency Accounts Payable systems
when you enter an adjustment for a vendor that does not use your
functional currency.
Use this tab to edit the rate type, rate date, and exchange rate for a
selected adjustment.
You can also use the tab to check the exchange rate that was used on
the document you are adjusting.
You enter adjustments in the vendor’s currency. The exchange rate
shows the rate for conversion to the functional currency.
Accounts Payable automatically displays the exchange rate that is
entered in Common Services for the rate type assigned to the vendor
record and the rate date that corresponds to the adjustment date.
You should check the rate for the original document before you add
adjustments.
Important! Use the same exchange rate as the original document if
you do not want to register a gain or loss on exchange with this
adjustment.

Retainage Tab
Note: The Retainage tab appears if you use retainage accounting in
your Accounts Payable system.
Use this tab to enter retainage terms and (if you use multicurrency) the
retainage exchange rate for a selected adjustment.

Related Topics

Home > Screen Guides > Transactions > A/P Control Payments Screen

A/P Control Payments Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Control Payments screen to:
View or change the due date, discount date and percent, prepayment
activation date (if applicable), discount amount, and document status
of individual transactions.
Set a payment limit for an invoice, or clear all payment limits for
invoices in a range.
Change the status of groups of selected transactions, for ranges of
vendors.

Single Document Tab
Use this tab to:
Select single documents for a specific vendor.
Change the status of individual documents, as well as the due date,
discount date, discount percent, and discount amount.
Change the prepayment activation date for prepayments.
Set a payment limit for a selected document.
For background information on setting payment controls for a specific
document, see About Applying Payments Controls to a Single Document.

Range Of Documents Tab
Use this tab to:
Change the status of groups of selected transactions.
Clear payment limits set for invoices in the range of documents.
For background information on setting payment controls for a range of
vendors, see About Applying Payment Controls for a Range of Vendors.

Related Topics

Home > Screen Guides > Transactions > A/P Create Payment Batch Screen

A/P Create Payment Batch Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Create Payment Batch screen to:
Create batches of checks to pay vendor invoices that are due or have
a discount available for early payment.
Note: You can have only one system-generated batch open at one
time.
You use the A/P Payment Entry screen to edit batches you create
using the Create Payment Batch screen, if the Allow Edit Of System
Generated Batches option is selected on the A/P Options screen.
Print a report (payment register) of the payment transactions to be
created by the current payment criteria when you generate a
payment batch.
Tip: We recommend that you always print and review the payment
register, so you do not get unexpected results when you generate
the batch.
The Create Payment Batch screen generates payments for vendors
according to their payment code. For vendors with no specific payment
code, Accounts Payable creates checks only if a check-type payment
code is specified as the default for Accounts Payable on the AP Options
screen.
For background information on creating payment batches, see About
Creating Payment Batches Automatically.

Criteria Tab
Use this tab to specify payment selection criteria:
Specify whether to select documents for payment by due date or
discount date.
Set the selection due date and/or range of dates for available
discounts.
Specify whether to select all documents that meet the criteria or only
forced documents.
Set ranges of vendors, vendor groups, account sets, and payment
amounts.

Exclusion Tab
Use this tab to list all vendors that you want to exclude from the payment
batch.

Optional Fields Tab
Note: This tab appears if you use Sage 300 ERP Transaction Analysis
and Optional Field Creator.
Accounts Payable automatically inserts the payment optional fields and
default values assigned to the payment selection code you specify for the
payment batch.
You can add or delete payment optional fields for the batch you are
creating, and you can accept or change the default values that appear on
this tab.
When you create the batch, the program includes with each payment:
All payment optional fields that are marked for automatic insertion.
Note: If you delete an automatically inserted optional field on this
tab, the program reinserts it when you create the batch.
Any additional payment optional fields that you specified for the
payment batch.

Rates Tab
You use this tab to change the exchange rates for the payment batch.
The default bank rate for the check currency and the vendor currency
comes from Common Services, and is based on the rate type and the
session date.
Note: These rates are for converting the bank currency and/or the
vendor currency to your functional currency. If either of these currencies
is the functional currency, the exchange rate for that currency will be
1.0000000.
The rates you specify on this tab apply to the whole batch. If you need to
change the rate for a few transactions, you can edit them using the
Payment Entry screen.

Select Tab
You use this tab to specify:
The batch date and the date that will appear on checks.
The bank account from which the checks will be drawn.
The bank currency (check currency) and the vendor currency
(multicurrency ledgers only).
Whether the Pre-Check Register will list payables that were
bypassed due to the selection criteria.
The tab also provides the date that the Pre-Check Register, was last
printed, the date that the last manually entered check was printed, and
the date that the last system check was printed, and it shows whether
there are any unposted payment batches.

Related Topics

Home > Screen Guides > Transaction Reports > A/P Pre-Check (Payment) Register Screen

A/P Pre-Check (Payment) Register Screen
To open this screen
Related tasks

Overview
The Payment Register report shows the payments that will be made if
you generate checks using the selection and exclusion criteria specified
on the Create Payment Batch screen.
You can also print a list of transactions or vendor accounts that have
been placed on hold.

When to Print
Print the report before generating a check run to verify the payment batch
you are creating.

Information Printed on This Report
The report includes the following information:
Codes that show why transactions are selected or why the payment
amount differs from the net (current) payable:
S. The discount amount was changed for the transaction.
F. The invoice will be paid whether or not it meets the criteria set for
the check run (unless the check is outside the specified range of
check amounts).
D. The transaction has been included in the proposed check run
because it is eligible for a discount.
A summary of the total amount of checks that will be paid in the
check run, the total amount of checks that will be withheld.
The Listing Of Payables Withheld summary. This tab appears only if
you select the Include Bypassed Payables On Register option in
the Create Payment Batch screen. Four additional codes explain why
transactions have been withheld:
A. The payment is outside the specified range of check amounts.
V. The vendor has been placed on hold.
H. The transaction has been placed on hold (using the Control
Payments screen).
P. A payment check has already been issued for the invoice, or an
adjustment to the invoice has been made but the payment or
adjustment is in an unposted batch.

Related Topics

Home > Screen Guides > Transactions > Invoice Batch List

A/P Invoice Batch List Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Invoice Batch List screen to:
Display a list of posted and unposted invoice batches, beginning with
the batch number you specify. More...
Create a new invoice batch.
Select an existing batch to edit, post, or delete.
If you try to post a batch for which you have not selected the Ready
To Post option, you see a message that lets you select the option for
the batch from the Invoice Batch List screen.
Post individual batches.
Print batch listings, batch status, posting journals, and posting error
reports.

Related Topics

Home > Screen Guides > Transactions > Invoice Entry

A/P Invoice Entry Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Invoice Entry screen to:
Enter vendor invoices, credit notes, debit notes, and individual
interest charges.
Enter prepayments with invoices.
Edit invoices, credit notes, debit notes, and invoices in batches
created in Accounts Payable or imported from other accounting
programs.
Add a new vendor or a new remit-to location during invoice entry or
when editing an existing invoice.
Enter job‑related details that will update contracts and projects in
Project and Job Costing.
Enter intercompany transaction details, if you use the Sage 300 ERP
Intercompany Transactions (ICT) program to send transactions
between companies.
The following ICT fields appear only for ICT companies: Originator,
Destination, and Route No.
Print a batch listing report for a selected batch. (Click File > Print
Batch Listing Report > Print.)
Note: You can use the Quick Mode option on the Settings menu to copy
many of the fields from the previous transaction or detail to a new
transaction or detail, so you don't have to re-enter them. For more
information, see Menu Commands.

Document Tab
Use this tab to:
Enter header information for the document.
Indicate that the transaction is related to a project you maintain in
Sage 300 ERP and Job Costing, and enter job‑related information for
each document detail.
Enter account distribution information for the document.
Edit or delete existing distributions.
Add a new vendor or a new remit-to location during invoice entry or
when editing an existing invoice.
Indicate that the transaction is an intercompany transaction by
selecting the originating company for the transaction (the originator),
the destination company, and the route number of the transaction.
For more information about intercompany transactions, see the
Intercompany Transactions help.
Note: Posting an ICT batch creates an A/P batch in the originating
company's Accounts Payable ledger (for posting to vendor
accounts), and creates an ICT G/L batch in the ICT company.

Optional Fields Tab
Note: This tab appears only if you use Sage 300 ERP Transaction
Analysis and Optional Field Creator and you have defined optional
fields for Accounts Payable invoices.
Use this tab to:
Check the optional fields used on a document.
Accounts Payable displays the optional fields that you set up for
automatic insertion on invoices, but you can change them or add
other optional fields defined for Accounts Payable invoices.
Assign different optional fields to a document.
Check or change optional field values.
Default values appear for optional fields, as follows:
If you assigned exactly the same optional fields to the vendor and
remit-to location records as you defined for invoices, the optional
field values for the remit-to location appear on the Optional Fields
tab.
If the remit-to location record and the vendor record use different
optional fields, the optional field values from the vendor record
appear as defaults for the invoice.
If an optional field is defined for invoices, but is not assigned either
to the vendor or the remit-to location, the program displays the
value specified for the optional field in the Optional Fields record.
Automatically inserted invoice optional fields appear on the Invoice Entry
Optional Fields tab when you add new documents.
Automatically inserted invoice details optional fields are associated with
each detail line. The Optional Fields indicator field on the detail table and
on the Detail Accounts/Taxes screen shows whether optional fields are
used with a particular detail.
To add, edit, or delete invoice detail optional fields, select the detail, then

click the Optional Fields Zoom button to open a separate Optional
Fields screen that lets you change the optional field information for the
detail.
If an optional field uses validation, you can select only entries that are
defined for the optional field in Common Services.
For more information about entering invoice detail optional fields on
invoices, see About Entering Optional Fields on Invoices.

Rates Tab
Note: This tab appears only if you use multicurrency accounting, and
you are entering a document for a vendor that does not use the
functional currency.
Use this tab to change the rate type, rate date, and exchange rate for
converting the document amount from the vendor's currency to the
functional currency.

Retainage Tab
Note: This tab appears if you select the Retainage option on the
Document tab.
Use this tab to specify how to process retainage for this invoice, debit
note, or credit note.
The program displays the retainage percentage, retainage rate, and the
retainage terms from the vendor record. Unless the document is
job‑related , you can change these retainage factors for a particular
document.
If the document is job‑related , you can change only the retainage rate
and retainage terms on this tab. You enter job‑related retainage amounts,
retention periods, and retainage due dates with each job detail.
Accounts Payable calculates and displays the retainage amount and
retainage due date for the selected document. You can change these
fields, whether or not the document is job‑related .
For more information about processing retainage, see About Processing
Retainage in Accounts Payable.

Taxes Tab
Use this tab to:
Change the tax class and tax included settings for the specified tax
group.
If you want to enter taxes manually, edit the tax base and tax amount
fields.
Notes:
To change the tax authorities listed on this tab, you must select a
different tax group on the Document tab.
To change the tax rates, you must use the Tax screens in Common
Services.

Terms Tab
Use this tab to:
Specify the terms for the invoice, if they are different from those
specified in the vendor record.
Edit multiple payment schedules that are calculated for invoices.
Override the discount base or discount amount calculated for an
invoice.
A payment schedule is created only if the invoice terms code uses the
Multiple Payment Schedule option.

Multiple Payment Schedules
Accounts Payable adds a Payment Schedule to the Terms tab if you
assign a terms code that uses a multiple payment schedule (for a number
of payments over a period of time such as six monthly payments).
The payment schedule divides the invoice total into the number of
payments specified by the terms code. Each payment has its own due
date, payment amount, and discount period, which is displayed on the
Terms tab of the Invoice Entry screen. If you want, you can change any
dates on the schedule, as well as decrease the number of payments (by
making later payments blank).
You can use multiple payment schedules with Intercompany
Transactions.
You can print payment schedules on batch listings if you select the Show
Schedules option when printing listings of invoice batches from the
Batch Listing screen.

Totals Tab
Use this tab to see the amount of recoverable tax, separately expensed
tax, and allocated tax, and to see why an invoice has an undistributed
amount.
The Totals tab displays the total tax amount on the invoice for each taxing
authority, as well as current totals for the document in two summaries: an
invoice summary and a tax summary.

Recoverable and Separately Expensed Taxes
The tax authority record in Tax Services specifies whether a particular tax
is recoverable or expensed separately. For example, the GST in Canada
and VAT in many other countries are recoverable taxes and are not
distributed with invoice totals.
When you click the Dist. Taxes button, Accounts Payable:
Removes (deducts) any recoverable portion of the tax from the tax
distribution amount and assigns it to the tax recoverable account.
Removes (deducts) any portion of the tax which is expensed
separately and assigns it to the tax expense account.

Related Topics

Home > Screen Guides > Transactions > A/P Payment Batch List Screen

A/P Payment Batch List Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Payment Batch List screen to:
Display a list of open, posted and deleted payment batches,
beginning with the batch number you specify. More...
Create a new payment batch.
Select an existing batch to edit, print checks for and post, or delete.
Print batch listings, batch status reports, posting journals, and posting
error reports.
Note: You must use this screen to post payment batches. Accounts
Payable does not have a Post Payment Batch screen.
To view the transactions in an unposted batch, either open the batch you
want to view, or print the batch listing or preview it on your screen. You
cannot view deleted batches, and you cannot edit batches for which you
have selected the Ready To Post option.

Related Topics

Home > Screen Guides > Transaction Reports > A/P Print Checks Screen

A/P Print Checks Screen
To open this screen
Related tasks

Overview
You can print checks for the payments you enter in Accounts Payable on
check forms that include an advice slip listing the details of the payment,
or you can print the checks and advices separately on different forms, or
you can print checks or advices only.
Sage 300 ERP Accounts Payable comes with four sample formats for
checks, with attached advice slips. You can use the sample formats or
change them to suit your company's requirements (for example, to adapt
the formats if you use separate pre-printed check and advice forms).

Printing Checks
You can print checks in one of three ways from the Accounts Payable
program:
Open the Payment Entry screen, add a payment or open an existing
one, and then click the Print Check button to print the check for the
payment.
Open the Invoice Entry screen, add a prepayment with an invoice,
select the Print Check option on the Invoice Entry Prepayment
screen, and then click the Print Check button to print the check for
the prepayment.
Open the Payment Batch List screen, select a payment batch, and
then click the Print/Post button to print checks for all the payments in
a batch.
The Print/Post button also posts the payment batch to vendor
accounts after printing the checks.
Note: You can print checks while other users are printing checks, as
long as the check runs are all for different payment batches.

When to Print
Print a check when you finish entering it, or print all the checks in a batch.

Information Printed on This Report
The sample combined check and advice slip that comes with Accounts
Payable contains the following:
Information about the transaction(s) being paid by the check.
The check number on the preprinted form. You specify the first check
number to use when you print the check, so that Accounts Payable
assigns check numbers to the payments that match the check
numbers on your forms.
The numeric check amount. It is preceded by asterisks (and the
textual check amount is followed by asterisks) to prevent alteration.
The name of the payee. It is positioned on the sample check to be
visible in form envelopes. You can change the position of this and
any other information printed on the check forms.

Related Topics

Home > Screen Guides > Transactions > Payment Entry

A/P Payment Entry Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Payment Entry screen to:
Start new payment entries and enter the general information for a
check—such as the type of payment entry, the vendor number, the
name on the check, the check date, and whether you are recording
information for a check that is already issued or printing it from
Accounts Payable.
Note: The fields that appear on the Document tab of the Payment
Entry screen depend on the type of transaction you are entering.
Record payments to vendors who are not defined in your Accounts
Payable system, such as payments of C.O.D. charges.
Apply payments to projects you maintain in Sage 300 ERP Project
and Job Costing, and allocate partial payments to different contracts
and projects listed on the invoice.
Enter and optionally print checks for vendors to pay outstanding
invoices or cash invoices, or to prepay vendors.
Enter and optionally print miscellaneous checks.
Apply previously posted prepayments or credit notes to posted
invoices and debit notes.
Import payment batches from non-Sage 300 ERP programs.
Edit system-generated payment batches (generated by the Create
Payment Batch screen).
Enter adjustments to invoices you are paying in the Payment Entry
screen, instead of using the Adjustment Entry screen.
Print a batch listing report for a selected batch.

Related Topics

Home > Screen Guides > Transactions > A/P Payment Inquiry Screen

A/P Payment Inquiry Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Payment Inquiry screen to:
Look up payments by bank range, vendor range, check status,
transaction type, date range, year and period range, and check
number range.
For example, you can look up all the payments from a selected bank,
or you can display information for a payment for which you have only
the payment number.
You are not limited to viewing payments for one vendor at a time, as
when using the Vendor Activity screen.
Open a separate Payment Information screen that displays detailed
information for a selected payment. (Select the payment on the table,
and then click Open.)
Drill down from a selected line on the list to view the original payment
in the Payment Entry screen. (Select the payment on the table, and
then click Document.)

Related Topics

Home > Screen Guides > Transactions > Post Batches

Post Batches Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Post Batches screen to post batches of payments, invoices,
or adjustments to vendor accounts.
Note:
You can post only one type of batch at a time. However, you can
post a single batch, a range of batches, or all unposted batches of
the chosen type.
Important! Batches are posted only if they are marked Ready To
Post on the respective Batch List screen.
You do not specify a batch type for an ICT company because you
can post only invoice batches in Intercompany Transactions.
You can post all batches that are marked Ready To Post, or a range
of batches that you specify.

Related Topics

Home > Screen Guides > Transactions Reports Screens

Transactions Reports Screens
Use the screens in the A/P Transaction Reports folder to print a variety of
transaction reports to maintain your audit trail and to analyze Accounts
Payable data.
Aged Cash Requirements
Aged Payables
Aged Retainage
Batch Listing
Batch Status
Check Register
G/L Transactions
Overdue Payables Report Screen
Posting Errors
Posting Journal
Pre-Check (Payment) Register
Print Checks
Vendor Transactions

Home > Screen Guides > Transaction Reports > Aged Cash Requirements

A/P Aged Cash Requirements Report Screen
To open this screen
Related tasks

Overview
The Aged Cash Requirements report highlights the cash amounts
required to meet obligations as they become due, including the amount
needed to pay invoices that are overdue, current, and due in each of four
future periods you define.
Use the report for cash flow analysis and projections.
You can print a detailed report or a summary report:
The detailed report lists all outstanding documents for each vendor.
The summary report prints one line for each vendor number,
including the overdue and current balance in the vendor's account,
and the balance that will come due in each of four periods.

When to Print
Print the Aged Cash Requirements report when you need to see the
amounts owed and when they are due to help you with cash‐flow
management, short‐term planning, and budgeting.

Information Printed on This Report
The Due Date/Applied Number/Applied Type column lists the due
date for documents at the left, and the document number and type of
applied details at the right.
The Current column contains documents that are not yet due.
Credit notes, debit notes, and prepayments appear in this column if
you select As Current for the Age Credit Notes And Debit Notes
and Age Prepayments options on the A/P Options screen.
The vendor contact and phone number, and your company's credit
limit with the vendor are listed if you select the Contact/
Phone/Credit option.
Subtotals (for a single currency company) or subtotals by currency
(for a multicurrency company), if you select Vendor Group or
Account Set as the primary sort order.
Subtotals appear on both the summary and the detail report.
Extra space appears between each vendor record if you select the
Space For Comments option.
Miscellaneous payments appear as "MC" in the Document Type or
Applied Type fields.
Reports aged by due date have an option to display aged retainage
for each vendor. (This option is not available for reports aged by
document date.)

Related Topics

Home > Screen Guides > Transaction Reports > Aged Payables

A/P Aged Payables Report Screen
To open this screen
Related tasks

Overview
The Aged Payables report groups outstanding transactions into a current
period and four aging periods by document date or due date.
Use the report to analyze your payables.
You can print detailed or summary reports;
The detailed report lists all outstanding documents for each vendor.
The summary report prints one line for each vendor number,
including the current balance and the balance in each aging period.
Note: You also print the Overdue Payables By Due Date and the
Overdue Payables By Document Date reports using the Aged Payables
Report screen.

When to Print
Print the Aged Payables report when you need a listing of the status of
your payables on a given date, such as at the end of a fiscal year or
period, or when you want to identify documents or balances you may
need to write off.

Information Printed on This Report
The Due Date/Applied Number/Applied Type column lists the due
date for documents at the left, and the document number and type of
applied details at the right.
The Current column contains documents that are not yet due. Credit
notes, debit notes, and prepayments appear in this column if you
select As Current for the Age Credit Notes And Debit Notes and
Age Prepayments options in the A/P Options screen. (You can
choose whether to include prepayments when printing the report.)
The vendor contact and phone number, and your company's credit
limit with the vendor are listed if you select the Contact/
Phone/Credit option.
Subtotals (for a single currency company), or subtotals by currency
(for a multicurrency company), if you select Vendor Group or
Account Set as the primary sort order. Subtotals appear on both the
summary and the detail report.
Extra space appears between each vendor record if you select the
Space For Comments option.
Miscellaneous payments appear as "MC" in the Document Type or
Applied Type column.
Reports aged by due date can display aged retainage for each
vendor. (This option is not available if the report is aged by document
date.)
The summary version of the report includes one line for each vendor
number, listing the current balance in the vendor's account and the
balance in each of four periods.

Related Topics

Home > Screen Guides > Transaction Reports > Aged Retainage

A/P Aged Retainage Report Screen
To open this screen
Related tasks

Overview
The Aged Retainage report lets you print reports of outstanding retainage
amounts owed to vendors.
You can print detailed or summary reports:
The detailed report lists all outstanding retainage amounts for each
vendor.
The summary report prints one line for each vendor number,
including the outstanding retainage amounts in each aging period.

When to Print
Print the report whenever you need a list of retainage amounts that are
overdue or outstanding.

Information Printed on This Report
The Aged Retainage By Due Date report includes six aging periods:
the five aging periods you specify for the report, including the current
period, plus a Future period.
For job‑related documents, each detail has its own outstanding
retainage amount and its own retainage due date. Therefore, the
retainage amount printed on the report for a job‐related document
may be broken out across several aging periods, depending on the
retainage due dates of the document details.
The Overdue Retainage By Due Date report may also include an
amount in the Future aging period, if a job‑related retainage amount
for a document detail is due in a future period.
If you select Vendor Group or Account Set as the primary sort
order, subtotals (for a single currency company), or subtotals by
currency (for a multicurrency company) appear on both the summary
and the detail report.

Related Topics

Home > Screen Guides > Transaction Reports > Batch Listing

A/P Batch Listing Screen
To open this screen
Related tasks

Overview
A batch listing is the printed record of the transactions in a batch.
You can print batch listings for invoice, payment, and adjustment batches
that have been entered, imported, generated, or posted. The invoice
batch listing includes debit notes and credit notes, as well as interest
invoices.
Tip: To enforce a strict audit trail, turn on the Force Listing Of All
Batches option on the A/P Options screen. This option prevents you
from posting batches that are unlisted.

When to Print
You should print batch listings after entering, importing, generating, or
editing batches—at any time before the batches are posted—and then
file them with your other audit trail records.
If you use the Force Listing Of Batches option, you must print all batch
listings before you can post the batches.

Information Printed on This Report
The following information is printed on the report:
The batch entry number assigned to each transaction in the Invoice
Entry, Payment Entry, or Adjustment Entry screen. This number is a
permanent part of the information stored for an entry, and appears on
the posting journals and on the unconsolidated G/L Transactions
report. Use this number to select an unposted transaction for editing,
and to trace the history of posted transactions.
The Type (Ty.) column lists the transaction type for the entry. More...
Payment terms and due date for invoices.
Note: This information appears only on invoice batch listings.
The following codes may appear:
A "T", indicating that the payment terms have been edited, as noted
on the final tab of the report.
For multicurrency ledgers, an "R" appears if the exchange rate has
been edited.
An "E" appears on payment batch listings if an entry has been
edited.
Note: The "R" and "T" codes appear only on invoice batch listings.
Optional field information.
Payment schedules are printed on invoice batch listings if you select
the Show Schedules option.
Summary pages include information, as follows:
The invoice batch listing includes a summary page that lists batch
totals for the invoices, credit notes, debit notes, and interest
charges entered, and a total for the batch.
The payment batch listing summary page lists totals for
adjustments entered in the batch, discounts taken, and payments

(amounts), and a total for the batch.
The adjustment batch listing summary page lists the total debits
and credits for the batch.
The final page lists the descriptions of symbols that appear on the
report (for invoice and payment batch listings only), and the number
of entries and batches printed.
The payment batch listing final page also lists the general ledger
account debits and credits for adjustments entered in the batch.

Related Topics

Home > Screen Guides > Transaction Reports > Batch Status

A/P Batch Status Report Screen
To open this screen
Related tasks

Overview
The Batch Status report describes all unposted invoice, payment, or
adjustment batches, and posted or deleted batches for which the
information has not yet been cleared from Accounts Payable. The report
is a valuable management tool for tracking batches, particularly when
several operators are entering batches on a multi-user system.

When to Print
Print the report as part of the transaction-entry cycle, to discover batches
for which you need to print or reprint listings before posting, and batches
that contain errors.

Information Printed on This Report
The report includes a summary that lists the number of entries, number of
batches, and total amount for each type of batch and each batch status.

Related Topics

Home > Screen Guides > Transaction Reports > Check Register

A/P Check Register Screen
To open this screen
Related tasks

Overview
The Check Register report lists details of checks that are produced and
posted to vendor accounts during a check run. It can also list the general
ledger distributions that result.
Note: Checks that are used for alignment or leading, as well as checks
that are voided before posting, are not included on this report because
they do not result in the creation of general ledger distributions or
changes to vendor account balances. These checks are listed on the
Check Status report in Bank Services.

When to Print
Print the report after posting a check run, as part of your audit trail of
payments made during the check run.

Information Printed on This Report
The report lists the checks issued to vendors, in vendor number order.
Miscellaneous payments are listed first. Information includes:
Sequence numbers that count the number of checks that will be
printed for the batch. (These numbers are not posting sequence
numbers or check numbers.)
The type of payment (PI for prepayments; PY for payments).
The number of the document paid by the check, followed by the
payment schedule number. The payment schedule number is always
1 unless the document has a multiple payment schedule.
Discounts taken or adjustments made at the time the payment was
entered. You can make adjustments during payment entry only if you
select the Allow Adjustments In Payment Batch option on the
A/P Options screen.
Any miscellaneous payments. Miscellaneous payments, which are
not assigned to vendor records, are listed under "MISC," with the
name (or other information) you entered in the Remit-To field on the
A/P Payment Entry screen.
Entries that were edited after they were added are marked with an
asterisk.

Related Topics

Home > Screen Guides > Transaction Reports > G/L Transactions

A/P G/L Transactions Report Screen
To open this screen
Related tasks

Overview
The G/L Transactions report is a list of the general ledger transactions
created from all posted Accounts Payable batches, and from posted
revaluations (in multicurrency ledgers). You can print detailed or
summary versions of the report.
Sage 300 ERP creates the general ledger batch in a CSV (Comma
Separated Values) file, tailored to the Sage 300 ERP General Ledger
format. You can send the file to a remote location that uses Sage 300
ERP General Ledger, or modify the information in the file to suit another
general ledger program.

When to Print
Print the report when you add, change, or delete distribution sets.

Information Printed on This Report
The summary report lists one total for each account number.
The level of detail for transactions on the detailed report depends on your
choices on the Integration tab of the G/L Integration screen. For example,
if the Consolidate By Account And Fiscal Period option is selected,
the report shows a total for each general ledger account and fiscal
period. If the Do Not Consolidate option selected, the report shows full
details for each transaction.
The detailed report includes:
The batch and entry number. The entry number is assigned when the
transaction is added to a batch, and is a permanent part of the record
of the transaction.
The source code assigned during posting to identify the transaction
type.More....
The reference and description information selected on the
GL Integration screen.
Total by sorting option.
The summary version of the report includes a single line for each
account number, with the total debits and credits posted to the
account.
Total debits and credits for the report.

Related Topics

Home > Screen Guides > Transaction Reports > Overdue Payables Report Screen

A/P Overdue Payables Report Screen
To open this screen
Related tasks

Overview
The Overdue Payables report groups outstanding transactions or
balances into a current period and four aging periods by document date
or due date. Use the report to analyze your overdue payables.
You can print the report with transactions listed by due date or by
document date, in detail or summary form.
Note: You can also print the Aged Payables By Due Date and the Aged
Payables By Document Date reports using the Aged Payables Report
screen.

When to Print
Print the Overdue Payables report when you need a listing of overdue
payables on a given date, such as at the end of a fiscal year or period, or
when you want to identify documents that must be paid immediately.

Information Printed on This Report
Depending on the options you select for the Overdue Payables report,
the report can include:
The telephone number and contact at the vendor's location, and the
credit limit allowed by the vendor (if you select the Contact/
Phone/Credit option for the report).
Detailed information about individual transactions, included to give
you a complete picture of your overdue payables.
Space between each vendor record (if you select the Space For
Comments option).
Applied details (if you select the Include Applied Details option).
If you do not select this option, the report lists the net amounts owing
on invoices.

Related Topics

Home > Screen Guides > Transaction Reports > Posting Errors

A/P Posting Errors Report Screen
To open this screen
Related tasks

Overview
Accounts Payable creates the Posting Errors report when you post
batches that contain errors. The report lists the incorrect entries and
explains why they could not be posted. You can print the report for
invoice, payment, and adjustment batch posting errors.
Note: The Payment and Adjustment Error reports are not available for
an Intercompany Transactions company.

When to Print
Print the report after posting a batch, if the program warns you that an
error batch has been created.

Information Printed on This Report
The report includes the following information:
The incorrect entries, listed in order by the posting sequence
numbers assigned to their original batches, then by their original
batch and entry numbers.
An explanation of the error in each entry.

Related Topics

Home > Screen Guides > Transaction Reports > Posting Journal

A/P Posting Journals Screen
To open this screen
Related tasks

Overview
A posting journal is the printed record of the transactions in a group of
batches that were posted together. It provides an audit trail of all
uncleared details that have been posted.
You can print posting journals for invoice, payment, and adjustment
batches. In multicurrency ledgers, you can also print posting journals of
the transactions that are created when you revalue documents at new
exchange rates.
You use the A/P Clear History screen to clear the data for the journals
after printing.

When to Print
You should print posting journals after each posting run, then file them
with your other audit trail records.
Note: You must print all outstanding posting journals before you can
use the A/P Clear History screen to clear them or use the Year End
screen to do year‑end processing.

Information Printed on This Report
The report can include the following information:
The original batch and entry number for each transaction. Use these
numbers to trace transactions back to their batch listings.
If you do not consolidate general ledger transactions (using the
Consolidate G/L Batch option on the A/P Options screen), you can
use these numbers to identify the transactions on the G/L
Transactions report.
Tax information appears only on the Invoice Posting Journal, showing
the total tax for each tax authority on each invoice, credit note, or
debit note.
Optional information that you can choose to include on the report
(such as optional fields, if you use them), job‑related information (if
you use Project and Job Costing), or the General Ledger detail
reference and description used with transactions.
The Payment Posting Journal includes an Adjustment and a Discount
column, listing any adjustments made to documents in the Payment
Entry screens and discounts taken when payments were applied to
documents.
You can make adjustments during payment entry if the Allow
Adjustments In Payment Batch option is selected on the
A/P Options screen.
The Adjustment Posting Journal includes a Debit and a Credit
column, listing the general ledger account number or distribution
code to which each debit or credit was posted.
A summary page.
The Invoice Posting Journal includes a summary tab that lists
separate totals for invoices, debit notes, credit notes, and interest
invoices.
The Payment Posting Journal summary tab lists totals for
adjustments, discounts taken, and payments.

The Adjustment Posting Journal summary tab lists the totals of debits
and credits.
A General Ledger Summary lists the total amounts of the
transactions that were created for each general ledger account used
in the posted batches. These transactions are placed in the general
ledger batches Accounts Payable creates in Sage 300 ERP General
Ledger, if you use it, or in the batches that are produced for you to
transfer to another general ledger system.
If you use multicurrency accounting, the posting journals also include the
following additional information:
The currency, exchange rate, and rate date for each transaction.
The Payment Posting Journal shows exchange rates for vendors and
banks that do not use the functional currency.
The total for the transaction (and the total tax, for invoice posting
journals) in the functional currency as well as the source currency.
A Summary tab which lists totals for each source currency used in
the report, as well as the equivalent totals in the functional currency.
The amounts on the General Ledger Summary tab are shown in their
source currencies, with the corresponding equivalent amounts in the
functional currency.
A Revaluation Posting Journal includes the transactions that are
created for the general ledger exchange gain and loss accounts
when you revalue multicurrency documents at new exchange rates.
This report groups transactions by posting sequence, and for each
posting sequence they are grouped and totaled by account set.
Note: If you do a provisional revaluation, you can also print the
Provisional Revaluation Listing, to check the transactions that will
be created when you post the revaluation. (Posting sequence
numbers do not appear on the Provisional Revaluation Listing
because no transactions are posted when you revalue
provisionally.)

Related Topics

Home > Screen Guides > Transaction Reports > Vendor Transactions

A/P Vendor Transactions Report Screen
To open this screen
Related tasks

Overview
The Vendor Transactions report lists transactions that were posted to
vendor accounts during the period you specify when you print the report.
You can sort the transactions by document date, by document number, or
by fiscal year and period.

When to Print
Print the report when you want to see the current status of your vendor
accounts.

Information Printed on This Report
The transaction type. More...
Order number and 1099/CPRS information. If you do not enter a
1099/CPRS tax number in the record for a vendor who is subject to
1099/CPRS reporting, the total for the vendor is marked with an
asterisk to indicate that the tax identification number is missing.
The applied type. More...
The number of days that the transaction is overdue on the date you
print the report. This information shows your payment habits with
each vendor and highlights seriously overdue transactions that may
require immediate payment.
Vendor contact, phone, and credit limit (if you select the
Contact/Phone/Credit option for the report).
Totals by vendor of outstanding invoices, credit notes, debit notes,
interest charges, and prepayments (if you select the Include Applied
Details option).
Miscellaneous payments appear as "MC" in the Document Type or
Applied Type column.
Space between each vendor record (if you select the Space For
Comments option).

Related Topics

Home > Screen Guides > Vendor Screens

Vendor Screens
Use the screens in the A/R Vendors folder to add vendor records and
other related records.
1099/CPRS Inquiry
Recurring Payables
Remit-To Locations
Vendor Activity
Vendor Groups
Vendors

Home > Screen Guides > Vendors > 1099/CPRS Inquiry

A/P 1099/CPRS Inquiry Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P 1099/CPRS Inquiry screen to:
Look up the history of 1099/CPRS payments made to vendors that
are subject to 1099/CPRS reporting.
Add, modify, or delete 1099 or CPRS amounts, if your Accounts
Payable system allows you to edit these amounts.
Note: Before you can add, modify, or delete a 1099 or CPRS amount,
the Allow Edit of 1099/CPRS Amounts option must be selected on the
Transactions tab of the A/P Options screen.

Related Topics

Home > Screen Guides > Vendors > Recurring Payables

A/P Recurring Payables Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Recurring Payables screen to:
Create records for standard invoices you receive from your vendors.
A recurring payable can be for a single item such as rent, or for a
standing order or service that is almost identical from month to
month. Recurring payables are identified by code as well as by
vendor number, so you can generate a batch of a single invoice type.
View statistics for invoices created for the recurring payable.
Manually create an invoice for a recurring payable, if necessary.
You can also include recurring payables in the Reminder List, so that
System Manager can remind a specific user, or all users, to process the
payables when they become due. For more information about reminders,
see the System Manager help.

Detail Tab
The Detail distribution tab on the Recurring Payable setup screen lets
you:
Enter the details of the recurring payable.
Open a separate Detail Accounts/Taxes screen to enter distribution
and tax information for the detail.
To open the detail Accounts/Taxes screen, highlight the detail line,
and then click the Acct/Tax button.
Lets you view estimated tax amounts for each payable detail (if you
selected Calculate or Distribute as the tax entry method for the Tax
Amount and Tax Base fields on the Tax/Totals tab).
You assign a distribution code or general ledger payable account, and
enter a description and amount for each detail line in the recurring
payable record.

Invoice Tab
This tab lets you specify the following information for the recurring
payable:
The starting date.
The expiration type, and, depending on the type you specify:
The expiration date, if there is one.
The Create Recurring Payable Batch screen does not create
invoices for payables unless the creation date is between the start
date and the expiration date.
A maximum amount that you will pay for the recurring payable, if
there is a maximum.
A maximum number of invoices. (If an invoice would cause the
amount invoiced to date to exceed the maximum, Accounts
Payable does not create the invoice.)
Assign a schedule to set the frequency of payable invoices.
Select a remit-to location for the payable, if needed.
Assign payment terms and tax information for the payable.
Enter a description and the purchase order number, if any.

Optional Fields Tab
Note: This tab appears only if you use Sage 300 ERP Transaction
Analysis and Optional Field Creator and you have defined invoice
optional fields.
Use the Optional Fields tab to assign optional fields to a document.
Recurring payables use the same optional fields as invoices.
Accounts Payable displays any optional fields set up for automatic
insertion on invoices. It also displays default values for the invoice
optional fields, as follows:
If you assigned exactly the same optional fields to the vendor and
remit-to location records as you defined for invoices, the program
displays the optional field values from the remit-to location on the
Optional Fields tab.
If the optional fields in the remit-to location record and the vendor
record are different from each other, the optional field values from the
vendor record appear as defaults for the invoice.
If an optional field is defined for invoices, but is not assigned either to
the vendor or the remit-to location, the program displays the value
specified for the optional field in the Optional Fields record.
You can change the values that appear, or add other optional fields
defined for Accounts Payable invoices. If an optional field is validated,
you must specify a value that is defined for the optional field in Common
Services. If the optional field is not validated, you can select a value from
Common Services or you can enter another value that is consistent with
the type of optional field.

Statistics Tab
Use the Statistics tab to:
View the number and amount of posted and unposted invoices
created for the recurring payable. You can edit these fields to include
historical amounts.
View the year-to-date number and amount of invoices created for the
recurring payable. Accounts Payable updates these amounts when
you post the invoices, and you cannot change them.
View information about the last invoice posted for the recurring
payable, including the date, amount, invoice and entry numbers, as
well as the batch number and posting sequence of the batch that
contained the last invoice.

Tax/Totals Tab
Tax/Totals tab displays for the recurring payable:
The tax group and tax authorities. The tax group assigned in the
vendor record appears as the default for the recurring payable, but
you can change it, if necessary.
The vendor tax class. The vendor tax class is also assigned in the
vendor record. However, for many tax authorities, the tax class varies
depending on the purpose of the goods or services being purchased.
You can change the tax class, if necessary.
Estimated tax amounts, if tax is calculated for the recurring payable.
You specify how tax is to be calculated for the recurring payable
using the Tax Amount and Tax Base fields.
Whether tax is included in the total for this document.
You can change the Tax Included option only if the Allow Tax in
Price option is selected for the tax authority in Tax Services.
Note: There is no exchange rate information tab on this tab because
the exchange rates are unknown for the recurring invoice. The only rate
information you enter is the rate type on the Invoice tab.

Related Topics

Home > Screen Guides > Vendors > Remit-To Locations

A/P Remit-To Locations Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Remit-To Locations screen to:
Add, edit, and delete remit-to locations—additional addresses to
which you send payments and other correspondence to vendors.
Note: You use this code in the Invoice Entry screen to assign a
remit-to location to a document you enter for the vendor.
Look up the remit-to locations assigned to a vendor.
Assign a primary remit-to location displayed as the default for vendor
invoices and printed on checks to the vendor.
Specify the check language to use for each location.
Note: You can change the language in which the amounts are
printed on checks. If you want to change the language for other
items on the check or advice form, you must change the check
report.
Provide default entries for remit-to location optional fields. If you use
the location when entering invoices, the optional entries from the
remit-to location record override the entries provided by the vendor
record.
Tip: If you want to view all locations for a vendor, or delete a remit-to
location, you can do so directly from the initial screen that opens when
you double-click the Remit-To Locations icon.
You can change all the information in a remit-to location except the remitto code. If you need to change the code, you must add another record
using the new code, then delete the record you no longer need.

Address Tab
Use this tab to:
Change the check language, address, contact name, telephone
number, and fax number for remit-to locations.
Select primary remit-to locations for vendors.
Assign Inactive status to remit-to locations you want to suspend
temporarily or delete at year end.

Contact Tab
Use this tab to enter the name, telephone number, fax number, and email address for a contact person at the remit-to location.

Optional Fields Tab
Note: This tab appears only if you use Sage 300 ERP Transaction
Analysis and Optional Field Creator.
You use the Optional Fields tab to assign optional fields for particular
remit-to locations.
If you set any optional fields for automatic insertion in remit-to location
records, they appear on the tab, along with their default values.
Note: If you defined the same optional fields for remit-to locations as for
vendors and vendor groups, the program uses the values from the
vendor record as default values for the optional fields in the remit-to
location record.
You can accept or change the optional field values. If an optional field
requires validation, you can select only a value that is assigned to the
optional field in Common Services or, if the optional field allows it, you
can leave the default value field blank.
Tip: If you use exactly the same optional fields for invoices, vendors,
and remit-to locations, when you specify a remit-to location on the
Invoice Entry screen, Accounts Payable uses the optional field values
from the remit-to location for the invoice, debit note, or credit note.

Related Topics

Home > Screen Guides > Vendors > Vendor Activity

A/P Vendor Activity Screen
To open this screen
Fields and controls
Pop-up screens
Related tasks

Overview
Use the A/P Vendor Activity screen to view a variety of information about
the current status of your vendor accounts.

Activity Tab
This tab displays summary information about the current status of the
account for a selected vendor, and shows the most recently posted
transactions.

Aging Tab
This tab displays your company's account balance with the vendor in
each of the aging periods used in your Accounts Payable system,
selected by the aging and cutoff dates you specify. Use it to:
Display the vendor's outstanding transaction balances aged into the
periods you specify. More...
Specify the date as of which you want to age transaction balances
(such as by today's date).
You can choose whether to age transactions by their due dates or
their document dates for each type of report.
Specify a cutoff date, so you can include or exclude transactions that
are more recent than the Age As Of date.

Payments Tab
Use this tab to view a list of payments made to a selected vendor. For
each payment, the tab displays the:
Bank code.
Check number and check date.
Check amount in the functional currency or vendor currency (if you
have a multicurrency ledger).
Check status (outstanding, cleared, or reversed).
Payment batch number and entry number.
Payee (name on the check).

Transactions Tab
Use this tab to:
View summary and detailed information about the transactions
(invoices, debit notes, credit notes, and payments) currently posted
to vendor accounts.
Accounts Payable displays a single line of summary information for
each invoice, credit note, debit note, prepayment, and payment that
has been posted to the vendor's account.
You can choose the types of documents to display, the order of their
appearance, and the starting document number. You can include
pending amounts in the display, if you want.
View completed (fully paid) documents that you have not yet cleared
from Accounts Payable. You choose whether to include or exclude
fully paid transactions.
View information about pending transactions, including pending
document balances.
Open a separate screen to view detailed history for each displayed
document.
In multicurrency ledgers, you can view amounts in the functional currency
or the vendor's currency.

Related Topics

Home > Screen Guides > Vendors > Vendor Groups

A/P Vendor Groups Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Vendor Groups screen to create vendor groups to which you
can assign vendors.
You use vendor groups to:
Classify vendor records by common characteristics.
Set default entries to speed up the task of adding records for
vendors.
Select records for processing.
For more information about vendor groups, see About Vendor Groups.

Group Tab
Use this tab to:
Assign the account set, terms code, and bank code to use for new
vendors you add to the group.
In multicurrency ledgers, specify the default rate type to assign for
vendors who do not use the functional currency.

Invoicing Tab
Use this tab to:
Specify the default distribution method to assign to vendor records
you add to the group.
Select the default tax group and tax classes to which your company
belongs when invoiced by vendors in this group.
Select options to specify how to identify duplicate invoices for this
vendor group and whether to print separate check for each invoice or
pay several invoices with a single check to a vendor.
Specify whether vendors in the group are normally subject to
1099/CPRS reporting and enter the 1099/CPRS code for the group.
You can change your choices for these options at any time.

Optional Fields Tab
Note: This tab is available only if you use Sage 300 ERP Transaction
Analysis and Optional Field Creator.
You use this tab to specify default optional field values for vendor records
you assign to the vendor group. You can:
Accept the default optional fields that appear on the tab, or delete
them.
When you add a new vendor group record, the tab displays optional
fields that are set up for automatic insertion in vendor group and
vendor records, along with their default values.
Assign different optional fields that are set up for vendors and vendor
groups.
Accept or change any default values that appear.
Note: If an optional field requires validation, you can select only a
value that is assigned to the optional field in Common Services. (If
the optional field allows blanks, you can leave the default value field
blank.)
The values you assign to the vendor group appear on new vendor
records you add to the group, if you assign the same optional fields
to the vendor records.
For more information about optional fields and how they are used in
Accounts Payable, see About Accounts Payable Optional Fields.

Statistics Tab
The Statistics tab:
Lists the number and amount of all transactions processed for the
vendor group in the year and period you select.
Lists the total days to pay figure and displays the average days to
pay figure for the group and period.
Lets you change statistical information (if the Allow Edit Of (vendor)
Statistics option is selected on the Processing tab of the
A/P Options screen).

Related Topics

Home > Screen Guides > Vendors > Vendors

A/P Vendors Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Vendors screen to:
Add new vendor records.
Change or delete existing records.
Note: You cannot delete a vendor that is used in an unposted
document.
Review period and activity statistics.
For more information about vendor records, see About Setting Up Vendor
Records.

Activity Tab
Use the Activity tab to:
View current-year and previous-year account activity for the selected
vendor.
Account activity includes the current balance of your account with the
vendor and the current number of open documents, the number and
amount of outstanding prepayments, and the amount and date of the
highest and lowest balances and largest invoices for the current and
previous years, as well as the amount and date of the last posted
invoice, payment, credit note, debit note, adjustment, and discount
posted for the vendor.
Edit activity statistics when setting up vendor accounts.

Address Tab
Use the Address tab to change the vendor's group, short name, site
address, telephone number, fax number, start date and company e-mail
address.
You cannot change the vendor number, but you can change all other
information on this tab with a few restrictions. For more information on
these restrictions, see About Editing Vendor Records

Comments Tab
Use the Comments tab to:
Add any number of comments to the vendor record, along with
follow-up and expiration dates for each comment.
Make changes to existing comments.
For more information on vendor comments, see About Vendor
Comments.

Contact Tab
Use the Contact tab to enter the name of a contact person for the vendor,
and an e-mail address and telephone and fax numbers for the contact.

Invoicing Tab
Use the Invoicing tab to:
Specify the default method by which you distribute the vendor's
invoices to general ledger accounts.
Select options to specify how to identify duplicate invoices you enter
from the vendor and whether you print a separate check for each
invoice from the vendor, or pay several invoices with a single check.
Select the tax group and tax classes to which your company belongs
when invoiced by this vendor.
Enter your company's tax registration or tax exemption number, if
any, for each tax class.
Specify whether the vendor is subject to 1099, CPRS, or no tax
reporting, and enter the 1099 or CPRS tax number, type, and code
for vendors that use 1099 or CPRS reporting.
You can change your choices for these options at any time.

Optional Fields Tab
Note: This tab is available only if you use Sage 300 ERP Transaction
Analysis and Optional Field Creator.
On this tab, you can:
Accept the default optional fields that appear on the tab, or delete
them.
When you add a new vendor record, the tab displays optional fields
that are set up for automatic insertion in vendor group and vendor
records, along with their default values.
Assign different optional fields that are set up for vendors and vendor
groups.
If you assign the same optional fields to the vendor as you assigned
to the vendor group, values from the vendor group record appear as
defaults. Otherwise, the default values from the optional field record
appear.
Accept or change any default values that appear.
Note: If an optional field requires validation, you can select only a
value that is assigned to the optional field in Common Services. (If
the optional field allows blanks, you can leave the default value field
blank.)
For more information about optional fields and how they are used in
Accounts Payable, see About Accounts Payable Optional Fields.

Processing Tab
Use the Processing tab to:
Select the vendors account set, which identifies the general ledger
accounts to which to post transactions for the vendor.
In multicurrency ledgers, the account set also determines the
vendor's currency.
Select the terms code to enter with invoices from the vendor.
Select the bank code from which you usually issue checks to the
vendor.
Specify whether to generate separate checks for each invoice, or
create a single check to cover all outstanding invoices, when you
create payments automatically for the vendor.
Enter the credit limit the vendor allows your company.
Select the rate type to use for converting transactions for the vendor
to the functional currency (in multicurrency ledgers).

Statistics Tab
Use the Statistics tab to:
List the number and amount of all transactions processed for the
vendor in the year and period selected.
List the total days to pay figure and displays the average days to pay
figure for the account and period.
Change statistical information (if the Allow Edit Of (vendor)
Statistics option is selected on the Processing tab of the
A/P Options screen).

Related Topics

Home > Screen Guides > Vendor Reports Screens

Vendor Reports Screens
Use the screens in the A/P Vendor Reports folder to print lists of vendors,
vendor groups, remit-to locations, and recurring payables in your
Accounts Payable system, as well as letters and labels for vendors.
Note: If the User 1099/CPRS Reporting option is selected on the
A/P Options screen, you can print 1099/1096 and T5018 (CPRS)
amounts in the required formats.
You can also print statistics reports for vendor groups and vendors.
1099/1096 Amounts
T5018 (CPRS) Forms
Letters/Labels
Recurring Payables
Remit-To Locations
Vendor Activity Statistics
Vendor Period Statistics
Vendor Group Period Statistics
Vendor Group List
Vendor List

Home > Screen Guides > Vendor Reports > 1099/1096 Amounts

A/P Print 1099/1096 Forms Screen
To open this screen
Related tasks

Overview
If the Use 1099/CPRS Reporting option is selected on the A/P Options
screen, you can use Accounts Payable to track payments to vendors who
are subject to 1099 reporting.
You can print this data on official 1099 MISC/1096 forms for vendors for
which 1099 is selected for the Tax Reporting option in the vendor
record.
Sage 300 ERP Accounts Payable comes with sample 1099 (AP1099.rpt)
and 1096 (AP1096.rpt) formats, designed for laser printers. The formats
were valid at the time this program was released. If the forms change,
you can update the report formats using Crystal Reports.
Note: Only standard 1099-MISC codes are printed on the stock
1099/1096 Amounts report.

Printing Alignment Copies
To print a test copy of a 1099 or 1096 form to check the alignment of the
forms in your printer, click the Align button. You can repeat this step as
often as needed when the printing destination is set to Printer.

When to Print
Print 1099 and 1096 forms at the end of each calendar year, after you
have entered all transactions for the calendar year.

Information Printed on This Report
The sample 1099 form includes the following information:
Your company name, address, and identification number.
The vendor name, address, and identification number.
The 1099 payments to the vendor in the calendar year.
A summary that contains the information you need to complete Form
1096 (required when filing 1099‐MISC forms).

Related Topics

Home > Screen Guides > Vendor Reports > T5018 (CPRS) Forms

A/P Print T5018 (CPRS) Forms Screen
To open this screen
Related tasks

Overview
If the Use 1099/CPRS Reporting option is selected on the A/P Options
screen, you can use Accounts Payable to track payments to vendors who
are subject to CPRS reporting.
You can print this data on official CPRS forms for vendors if you select
CPRS for the Tax Reporting option in the vendor record.
Sage 300 ERP Accounts Payable comes with a sample T5018
(APCPRS.rpt) format, designed for laser printers. (The format was valid
at the time this program was released. If the form changes, you can
update the report formats using Crystal Reports.)

When to Print
Print T5018 (CPRS) forms at the end of each calendar year, after you
have entered all transactions for the calendar year.

Information Printed on This Report
The sample T5018 (CPRS) form includes the following information:
Your company name, address, and tax number (TIN/SSN).
The vendor name, address, and tax number (TIN/SSN)..
The CPRS payments you made to the vendor in the calendar year.
Only standard codes are printed on the stock T5018 (CPRS)
Amounts report.

Related Topics

Home > Screen Guides > Vendor Reports > Letters/Labels

A/P Letters and Labels Screen
To open this screen
Related tasks

Overview
Letters and labels contain the information you specify for them in the
report format you choose to print. You can print letters and labels for the
individual vendors in your Accounts Payable system.
If you use optional fields as selection criteria when printing the report, you
can specify the ranges of values from which to select records for printing.
The report then includes only vendors that use the specified optional
fields, whose values fall within the specified range.
If you select Vendor as the delivery method when printing letters,
Accounts Payable prints the letters according to the delivery method
specified in the individual vendor records. You can then specify the code
for the message to send with e-mailed letters.

When to Print
Print letters and labels for your vendors whenever you need to
communicate formally with them. For example, you might want to send
covering letters to your vendors with your payments.

Information Printed on This Report
Letters and labels can include the following types of information:
Your company's name, address, telephone numbers, and contact
person.
The vendor's name and address, from the vendor account or at the
remit-to location.
You can use Crystal Reports (available separately) to adapt the report
format that comes with Accounts Payable to suit your own needs.

Related Topics

Home > Screen Guides > Vendor Reports > Recurring Payables

A/P Recurring Payables Report Screen
To open this screen
Related tasks

Overview
The Recurring Payables Report lists your recurring payable records by
recurring payable code.

When to Print
Print the Recurring Payables report whenever you need a listing of the
recurring payables set up in Accounts Payable.

Information Printed on This Report
Information is printed for each recurring payable record included in the
report, as follows:
Details from the Document tab, including: the vendor, schedule code,
start date, expiration type, expiration date or maximum amount or
number of invoices, the next invoice date, the date the recurring
payable became inactive (if the record is inactive), the date the
record was last changed (maintained), the maximum amount, the
vendor’s currency and the rate type, remit-to location, description of
the recurring payable, the vendor’s tax group, the method of tax
calculation, as well as the purchase order and (sales) order number.
It also shows the distribution code, description, general ledger
account and description, the amount of each detail, as well as tax
amounts (if entered manually), and the invoice total.
If you select the Show Schedules option for the report, the schedule
code, the date the schedule was last processed, the recurring period,
and the frequency.
If you select the Optional Fields option for the report, any optional
fields assigned to the recurring payable, along with the optional field
values.

Related Topics

Home > Screen Guides > Vendor Reports > Remit-To Locations

A/P Remit-To Locations Report Screen
To open this screen
Related tasks

Overview
The Remit-To Locations report lists the remit-to locations (alternate
addresses) used by your vendors.
The report also identifies primary remit-to locations.

When to Print
Print the report when you add, change, or delete remit‐to locations.

Information Printed on This Report
Information printed for each vendor listed on this report includes:
If you select the Address option for the report, the vendor name,
address, telephone and fax numbers, check language, and contact.
If you select the Optional Fields option for the report, any optional
fields assigned to the location.

Related Topics

Home > Screen Guides > Vendor Reports > Vendor Activity Statistics

A/P Vendor Activity Statistics Report Screen
To open this screen
Related tasks

Overview
The Vendor Activity Statistics report lists information about the purchases
and payment history for the current year to date and previous fiscal year
for the vendor records in your Accounts Payable system.
Note: Most of the information on this report is also available on the
Vendor Activity tab of the Vendors screen.

When to Print
Print the report when you need to check on vendor account activity, such
as the last time you made a purchase from the vendor, the date and
amount of your last payment to the vendor, the average number of days it
takes you to pay the vendor, or the date a vendor’s balance was last
revalued (if you have a multicurrency Accounts Payable system).

Information Printed on This Report
Information included on this report includes:
Outstanding balance, number of invoices in the system, number of
paid invoices, the total days to pay invoices, and the average number
of days to pay.
Last posting date.
The date and amount of the last invoice, credit note, debit note,
payment, discount, and adjustment posted to the account.
The amount and date of the largest invoice and balance in the
account in the current year and previous year.
In multicurrency ledgers, you can print report amounts in the functional
currency or the vendor's currency.

Related Topics

Home > Screen Guides > Vendor Reports > Vendor Period Statistics

A/P Vendor Period Statistics Report Screen
To open this screen
Related tasks

Overview
This report lists the total amount of amount of invoices, payments,
discounts taken, discounts lost, credit and debit notes, and adjustments
you have recorded for a given vendor during the period covered by the
report, as well as the total number of invoices paid during that period.
Note: The reports list statistics for the type of year and period specified
on the A/P Options screen.
The information on this report is also available on the Vendor Statistics
tab of the Vendors screen.

When to Print
Print the report when you need a summary of vendor statistics (for
example, at the end of each period).

Information Printed on This Report
The totals for each type of transaction in the years and periods
selected for the report.
If selected for the report, the number of each type of transaction
(document) posted in the selected years and periods.
Totals for all periods by vendor.

Related Topics

Home > Screen Guides > Vendor Reports > Vendor Group Period Statistics

A/P Vendor Group Statistics Report Screen
To open this screen
Related tasks

Overview
This report lists the total amount of invoices, payments, discounts taken,
discounts lost, credit and debit notes, and adjustments you have
recorded for a given vendor group during the period covered by the
report, as well as the total number of invoices paid during that period.
Note: The information on this report is also available on the Group
Statistics tab of the Vendor Groups screen.
The reports list statistics for the type of year and period specified on the
A/P Options screen.

When to Print
Print the report when you need a summary of statistics, such as at the
end of each reporting period.

Information Printed on This Report
The report includes the following information:
The totals for each type of transaction in the years and periods
selected for the report.
If selected for the report, the number of each type of transaction
(document) posted in the selected years and periods.
Totals for all periods by vendor group.

Related Topics

Home > Screen Guides > Vendor Reports > Vendor Group List

A/P Vendor Group List Screen
To open this screen
Related tasks

Overview
The Vendor Group List reports the information entered for each vendor
group used in your Accounts Payable system. The report can also
include a list of the vendors who are assigned to each group.

When to Print
Print the report when you add, change, or delete vendor groups.

Information Printed on This Report
If you select the Profile option for the report, the report lists for each
vendor group on the report:
The group's account set and bank code.
The code or account number specified for the Distribute By option
in the vendor group record (distribution code, distribution set, or G/L
account).
The tax group and related tax authorities and tax classes.
Selections for the Duplicate Invoice Checking and Generate
Separate Payment For Each Invoice options in the vendor group
record.
If you select the Optional Fields option for the report, the optional
fields used in each vendor group record (if any).
The group's currency code (in multicurrency ledgers).
If you select the Group Members option for the report, the report
includes the vendor number, name, telephone number, and contact
person for each of the member vendors, for quick reference.

Related Topics

Home > Screen Guides > Vendor Reports > Vendor List

A/P Vendors Screen
To open this screen
Related tasks

Overview
The Vendors report lists the information entered for the vendor records in
your Accounts Payable system.

When to Print
Print the report when you add, change, or delete vendor records.

Information Printed on This Report
If you select the Address option for the report, the vendor's address,
short name, telephone and fax numbers, and contact.
If you select the Profile option for the report:
The vendor's group, account set, terms code, bank code, credit
limit, check language, and start date.
The primary remit-to location, if any.
The code or account number specified for the Distribute By option
in the vendor record (distribution code, distribution set, or G/L
account).
The tax group and related tax authorities, classes, and registration
numbers.
The selections for the Duplicate Invoice Checking and Generate
Separate Payment For Each Invoice options in the vendor record.
The vendor's currency code (in multicurrency ledgers).
If you select the Comments option, any comments and dates
entered in the vendor record (for comments entered with follow-up
dates in the specified range).
If you select the Optional Fields option, any optional fields used in
the vendor records.

Related Topics
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#
1099 Form

A
A/R Invoice Type
Account Description
Account Groups
Account Number Segment Overrides
Account Number Segments
Account Number Structures
Account Segment
Account Set
Account Status
Account Types
Accounting Equation
Accounting Method
Accounting Period
Accounts Payable
Accrual
Accrual Carry-Over Date
Accrual Method
Accrual-Basis Accounting Method
Accrued Expenses
Activating taxes
Activation
Active Order
Actual Fiscal Sets
Adjustment Period

Adjustments
Advance
Allocated Tips
Allocation Account
Annual Maximum
Annualization
Assets
Audit Trail
Authentication Method
Automatic Reversal

B
Backdated Document
Bad Debts
Balance Sheet
Base Account
Base Deductions
Base Earnings
Base Hours
Base Taxes
Base Wage Multiplier
Basic Account Information
Basic Project style
Batches
Benefit
Billing Type
Billings And Costs Accounting Method
Budget Fiscal Sets

C
Calculation Base
Calculation Methods
Calculator
Capture
Cardholder
Carrying Over Vacation, Sick, and Compensatory Time Accruals
Carry-Over
Cash Advance
Cash Benefit
Cash Flow Statement
Cash Method
Category (Payroll)
Category Percentage Complete Accounting Method
Ceiling
Chart of Accounts
Class Codes
Classified Statements
Clearing Exchange Gain or Loss
Close to Segment / Account
Closing Account
Closing Period
Closing the Books
Common Stock
Company Database

Company Desktop
Company Profile
Compensatory Time
Completed Project Accounting Method
Consolidated Batch
Control Account
Corporation
Cost Accounting
Cost Center Overrides
Cost Center Segments
Cost of Goods Manufactured
Cost of Goods Sold
Cost Plus project
CPRS
Credit
Currencies
Currency Rate Type
Currency Rates
Currency Table
Current Assets
Current Liabilities
Custom (and Local) Taxes
Customization Directory
CVC
CVV

D
Database
Database ID
Date Matching
Debit
Decimal Places
Deduction
Default Closing Account
Default Currency
Default Hours
Default Rate Type
Default Source Code
Delimiter Character
Depreciation
Detail and Consolidated Posting Options
Detailed Batch
Details
Direct Labor Costs
Distribution Accounts
Distribution Code
Distribution Set
Dividend
Drilldown

E
Earning/Deduction
Earning/Deduction Frequencies
Earning/Deduction Type
Earnings
Effective Date
Employee History
Employee Level Security
Employee Selection List
EMU
Equity
Euro Conversion Rates
Euro Currency
Euro Option
Exchange Gain or Loss
Exchange Rate
Expense Reimbursement
Expenses
Expiration Date
Exporting

F
Factory Overhead
Federal and State Taxes
Financial Statements
Finder
Fiscal Calendar
Fiscal Periods
Fiscal Sets
Fiscal Year
Fixed Assets
Fixed Price project
FOB Point
Foreign-Currency Bank
Functional Currency
Functional Currency Code
Functional-Currency Equivalent
Future Order

G
G/L Batch
General Ledger Account
GIFI
Gross Pay
Gross Profit on Sales

H
History

I
Importing
Income
Income Statement
Integration Access Pack
Integrity Check
Intercompany Transactions Company
Inventory
Invoice Type

J
Journal
Journal Entry

K
L
Labor Hours Percentage Complete Accounting Method
LanPak
Ledger
Level
Liabilities
Local and Other Custom Taxes
Long-Term Liabilities

M
Macro
Maintain Quantities
Manual Check
Matching Concept
Merchant
Merchant ID
Miscellaneous Charge
Multicurrency Accounting
Multicurrency Bank
Multicurrency Fiscal Sets
Multicurrency G/L Account

N
Net Pay
Normal (Account) Balance
Number of Fiscal Periods

O
Optional Fields
Original Invoice
Override Segments (Payroll)
Overtime Rate Multiplier
Overtime Schedule
Owner Equity

P
Partnership
Pay Factors
Payroll Class Codes
Payroll Distribution Accounts
PCI
Period Minimum and Period Maximum
Periods Per Year
Picking Slip
Posting
Posting to Previous Years
Pre-authorization
Preferred Stock
Prepaid Expenses
Price List
Processing Code
Profile ID
Profit
Profit and Loss Statement
Profit Center
Project Percentage Complete Accounting Method
Project Type
Provisional Fiscal Sets
Provisional Posting
Provisional Posting Journal

Q
Quantities in G/L Accounts
Quantity Fiscal Sets
Quarter With 4 Periods
Quote

R
Rate Type
Rate Operation
Rates
Realization
Realized Exchange Gain or Loss
Reallocation Account
Recognized Exchange Gain or Loss
Reconcile (Bank)
Record
Record of Employment
Recurring Transaction
Refund
Remit-to Location
Repayment Deduction
Reported Tips
Reporting Currency
Restart Record
Retainage Accounting
Retainage Invoice
Retained Earnings
Revaluation
Revaluation Codes
Revenues
Reversed Unrealized Exchange Gain or Loss

Rollup Account

S
Sage Virtual Terminal
Salary and Wages
Salary and Wages Payable Account
Sale
Sales
Sales Table
Sample Account Segments
Schedule Code
Schedule Reports
Schedule Transactions
Script
Security Group
Segment Codes Validation
Selection List
Service Years
Services
Session Date
Settlement
Settlement Rate
Settling Transactions
Shareholders
Shareholders' Equity
Shift Differential Rate
Shift Differential Schedule

Ship-Via Code
Sick Time
Sole Trader
Source Codes
Source Currency
Source Document
Source Journal
Source Journal Profiles
Source Journals and Consolidated Transactions
Specific User
Spread
Standard Project style
Standing Order
Statement of Retained Earnings
Status
Stock
Subsidiary Ledger
Surtax Multiplier
Suspense Account
System Database

T
Tax Authorities
Tax Classes
Tax Groups
Tax Tables
Template (employee setup)
Time And Materials projects
Timecards
Tip Disbursement
Total Cost Percentage Complete Accounting Method
Transaction Fee
Transaction Rate Type
Trial Balance

U
UI Profile ID
Unrealized Exchange Gain or Loss
User Authorization
User Record

V
Vacation Time
Void

W
Wage Bracket Table
Wage Garnishment
Web Desktop
Withdrawal
Workers' Compensation Code
Worksheet

X
Y
Years of Fiscal Sets
Years of Transaction Detail

Changes in Accounts Payable 2012
Accounts Payable 2012 includes the following new features and
improvements:
US tax forms updated. The 1099 and 1096 forms have been
updated to meet the following changed IRS specifications for 2011:
The alignment and positioning of some information has been
changed so that it prints in the correct place on these forms.
For 1099/CPRS code 14 (gross proceeds paid to an attorney), the
minimum to report is now $600.

Upgrading from an Earlier Version?
If you are upgrading from version 5.6, see Changes in Accounts
Payable 6.0.
If you are upgrading from version 5.5, see Changes in Accounts
Payable 5.6.
If you are upgrading from version 5.4, see Changes in Accounts
Payable 5.5.
If you are upgrading from version 5.3, see Changes in Accounts
Payable 5.4.

Changes in Accounts Payable 6.0
Accounts Payable 6.0 includes the following new features and
improvements:

In Product Update 1
A new T5018 (CPRS) Electronic Filing screen is available in Periodic
Processing.
If you file more than 50 T5018 slips for a calendar year, the Canada
Revenue Agency (CRA) requires you to file original and amended
T5018 information returns over the Internet. You use the new T5018
(CPRS) Electronic Filing screen to create your T5018 information
return in the required XML format. You can then submit the generated
file using the CRA's Internet File Transfer application.
If you are filing fewer than 50 slips, you can submit the file to the CRA
on electronic media.

In the 6.0 Release
Changes in Processing to Respect New Fiscal Period Locks
Accounts Payable supports changes to Common Services' Fiscal
Calendar.
Fiscal periods are now locked separately for each Sage 300 ERP
program. Although this change does not affect the way you enter
transactions in Accounts Payable, you should note the following
points:
The system checks the status of a fiscal period for Accounts
Payable when you enter certain dates in Accounts Payable
transactions. It also checks the status of the fiscal period for Bank
Services when you print a payment check.
If the period is locked for Accounts Payable, you receive a warning,
an error message, or no message, depending on the setting for the
Locked Fiscal Period option on the Company Profile’s Options tab.
If the period is locked for Bank Services and the Locked Fiscal
Period option is set to Error, you receive an error message when
you add a receipt or print a refund cheque. (Otherwise, no warning
or error appears.)
Generally, you should lock a period for Accounts Receivable, Bank
Services, and Accounts Payable at the same time, to avoid this
situation.
If a fiscal period is locked for General Ledger but not for Accounts
Payable, you can create batches for General Ledger during posting
or using the Create G/L Batch icon (depending on Accounts
Payable's G/L Integration settings). When you try to post
transactions to a locked period in General Ledger, however, the
transactions will be placed in an error batch. You can avoid this
situation if you create and post General Ledger batches for
outstanding Accounts Payable transactions before locking a period
for General Ledger.
New Portal-Related Security Authorizations

Two new authorizations—Aged Payables Snapshot and Days
Payable Outstanding Snapshot—allow users to view and
configure the Aged Payables snapshot and the Days Payable
Outstanding snapshot, respectively, in the new Sage 300 ERP
Portal.
The new Sage 300 ERP Inquiry authorization allows users to
query Accounts Payable data in the new Sage 300 ERP Portal. If
they also have Export Processing authorization for Accounts
Payable, they can print or export the results of these queries.
A new Vendor Developer Inquiry authorization supports the new
portal's Inquiry feature. Developers of third-party programs,
including macros, should incorporate this resource in their security
structures.
Upgrading from an Earlier Version?
If you are upgrading from version 5.5, see Changes in Accounts
Payable 5.6.
If you are upgrading from version 5.4, see Changes in Accounts
Payable 5.5.
If you are upgrading from version 5.3, see Changes in Accounts
Payable 5.4.

Changes in Accounts Payable 5.6
Features added to Account Payable 5.6 include report changes, new
check sorting options, improved prepayment functionality, and a new
T5018 (CPRS) Electronic Filing screen.

Report Changes
Sage 300 ERP version 5.6 includes global enhancements to all reports
that allow you to save parameters easily and export reports into Microsoft
Excel.
The Aged Cash Requirements and Aged Payables reports now have
better visibility for adjustments as they can be reported as regular
documents as well as in applied details. These reports can now be sorted
by transaction type and have an easier way to identify miscellaneous
payments. Both the Aged Cash Requirements report and Aged Payables
report include an option to show Aged Retainage on the report.

Check Sorting
Accounts Payable now allows you to sort checks during print runs. Using
the Sort Checks by list on the Transactions tab of the A/P Options
screen, you can sort by:
Vendor Number
Payee Name
Payee Country
Payee Postal Code
Transaction Entry Number
The selection becomes the default sort order when printing checks.

T5018 (CPRS) Electronic Filing
A new T5018 (CPRS) Electronic Filing screen is now available in the
Periodic Processing folder.
If you file more than 50 T5018 slips for a calendar year, the Canada
Revenue Agency (CRA) requires you to file original and amended T5018
information returns over the Internet. You use the new T5018 (CPRS)
Electronic Filing screen to create your T5018 information return in the
required XML format. You can then submit the generated file using the
CRA's Internet File Transfer application. If you are filing fewer than 50
slips, you can submit the file to the CRA on electronic media.

Prepayments
You can apply payments to existing Purchase Orders when you prepay a
vendor. The previous functionality required a manual entry of the PO
number if the Purchase Order was posted but not invoiced.
Upgrading from an Earlier Version?
If you are upgrading from version 5.4, see Changes in Accounts
Payable 5.5.
If you are upgrading from version 5.3, see Changes in Accounts
Payable 5.4.

Changes in Accounts Payable 5.5
Here is a summary of the changes and new features in Accounts Payable
5.5.
We introduce the most sophisticated treatment of currency
revaluation on the market.
New accounts accommodate changes to revaluation.
You can process advance credits in Payment Entry in all series of
Sage 300 ERP.
There is a new posting date field for transactions.
You can specify source codes for transactions.
You can specify different accounts when entering transactions.
You can apply credit notes to fully paid documents. (Previously, the
document had to be unpaid.) You can also apply a debit note to a
fully applied credit note.
You can specify particular accounts for distribution sets.
We have improved integration with Project and Job Costing.
Keeping history is now automatic in Accounts Payable.
Batch entry counts and batch totals appear on all transaction entry
screens.
A new option lets you set the default tax class to 1 (instead of the
vendor's tax class) for document details.
There are a number of enhancements to recurring payables.
You can now list documents in ascending order or descending
order in the Vendor Activity screen.
When you print voided checks, the printed check includes ***VOID***
above the payee.
The Aged Payables and Aged Cash Requirements reports are
available only in letter format. (Previously, a legal-size report that
contained the same information was also available.)
You can include group subtotals when you use sorting criteria to print

the Aged Payables, Overdue Payables, Aged Cash Requirements,
Vendor Transactions, and Aged Retainage reports.
The new Print 1099/1096 Forms icon, available in the A/P Vendor
Reports folder, lets you print 1099 and 1096 forms for reporting
amounts paid to vendors in the U.S. The Print T5018 (CPRS) Forms
icon lets you print CPRS amounts on the T5018 required for
Canadian filing. (Previously, you used the 1099/CPRS Forms icon to
print these forms for both jurisdictions.)
The 1099/CPRS Amounts screen has been renamed 1099/CPRS
Inquiry. Also, you can now print a report with the same information
that is displayed on the inquiry screen.
When you reverse a miscellaneous payment, the associated invoice
is reversed automatically, too.
You can post batches at the same time others are posting batches,
but you cannot post batches that others are using.
You assign separate security authorization to post batches and to
enter them (as required under Sarbanes-Oxley legislation), if you use
security with your system. (Previously, having authorization to post a
certain type of batch also gave you authorization to view and enter
and edit transactions in that type of batch.)
Accounts Payable now integrates with Sage Fixed Assets.
Note: You cannot convert from ACCPAC Plus for DOS to this version of
Sage 300 ERP.
Upgrading from an Earlier Version?
If you are upgrading from version 5.3, see Changes in Accounts
Payable 5.4.

Changes in Accounts Payable 5.4
Accounts Payable version 5.4 introduced a number of exciting changes
and new features!
Click the name of an Accounts Payable screen or the type of change,
below, to see a summary description of the changes.

Account Sets
Adjustment Entry
Aged Cash Requirements Report
Aged Payables Report
Check Printing
Checking Data Integrity
Control Payments
Create Payment Batch
Delete Inactive Records
Distribution Sets
E-Mail Messages / Letters/Labels
G/L Integration
Invoice Entry
Optional Fields

Options
Overdue Payables Report
Payment Batches
Payment Codes
Payment Entry
Payment Selection Codes
Project and Job Costing
Recurring Payables
Remit-To Locations
Terms
Transaction Batches
Vendors and Vendor Groups
Vendor Activity
1099 Electronic Filing
1099/CPRS Amounts

A/P Rate Override Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Rate Override screen to change the exchange rate for the
current payment—for example, to one that was previously agreed on for
the invoice.
The screen shows the rates for converting the bank currency and the
vendor currency to your functional currency. If either of these currencies
is the functional currency, the exchange rate for that currency is
1.0000000, and you cannot change it.
Note: This screen is available only in multicurrency ledgers. Also, if the
bank currency and the vendor currency are the same as the functional
currency, you cannot open this screen.

Related Topics

A/P Project and Job Costing Apply Details
Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Project and Job Costing Apply Details screen to:
Select a different apply method for a particular invoice.
You can use one of two apply methods to allocate partial payments to
job‑related details.
Select particular details for payment.
Manually enter the amounts to pay for each invoice detail.
When you make a partial payment (an amount that is less than the
current balance) for a job‑related invoice, you need to specify the amount
you are paying for each detail, so that Accounts Payable can update the
correct contracts, projects, and categories in Project and Job Costing.

Related Topics

A/P Batch Information Screen (Payment Entry)
To open this screen
Fields and controls

Overview
Use the A/P Batch Information screen to view or specify information
about the batch, including:
Batch date and description.
Date the batch was last edited.
Batch type and status.
Number of entries in the batch and their total amount.
Whether the batch listing and checks have been printed.
In a multicurrency ledger, the currency, rate type, rate date, and
exchange rate for payments you add to the batch.
Bank.

Related Topics

A/P Document Taxes Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Document Taxes screen to:
Assign the tax group for the document.
Check the tax authorities, vendor tax class, tax base, and tax amount
for the document.
Change the tax class for the document.
Recalculate the tax amount when you change the tax class for the
document.
Recalculate the tax reporting amounts when you change the tax
group for the document.

Related Topics

A/P Detail Accounts/Taxes Screen
(Miscellaneous Payments)
To open this screen
Fields and controls
Related tasks

Overview
The A/P Detail Accounts/Taxes screen displays information for a selected
detail in a separate screen, so that you do not have to scroll to see all the
fields. In addition, this screen displays tax information for the detail.
Use this screen to:
Add distribution details to the miscellaneous payment (or "cash
invoice") you are entering.
Check or change the accounts to which you are distributing a
selected detail.
Change tax classes and (if the tax authority allows it) the Tax
Included In Price field for a particular detail.
On documents for which you are entering taxes manually, enter the
tax base and the tax amount for the detail.
Note: You must use the Document Taxes screen to view or edit taxes
for the document. For more information, see A/P Document Taxes
Screen.

Related Topics

A/P Revaluation History Screen
To open this screen
Fields and controls

Overview
Use the A/P Revaluation History screen to:
View historical revaluations for a selected currency. All revaluations
are listed, even if no adjusting entries were generated.
Print the Revaluation posting journal. (Highlight a line on the table,
then click the Print Posting Journal button.)
Select a historical revaluation for display on the Revaluation screen,
if you need to redo the revaluation to correct an error (for example, if
the original revaluation used wrong exchange rate) or to include a
backdated document. (Highlight a line on the table, then click the
Select button.)

Related Topics

A/P G/L Integration Detail Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P G/L Integration Detail screen to assign Accounts Payable
information to G/L transaction fields.

Related Topics

A/P Settings Screen
To open this screen
Related tasks

Overview
Note: The A/P Settings screen is available only for optional fields you
set up for transactions and transactions details.
You can - and should - restrict the flow of information that is passed to
General Ledger when you post transactions that use optional fields.
Use the A/P Settings screen to specify the General Ledger accounts for
which to send optional field information when you create general ledger
transactions. (The optional fields used in a transaction must also match
the transaction details optional fields used for an account in order to be
passed to General Ledger.)
Select from the list all the account groups for which you want to pass
values to General Ledger when you post transactions that include the
optional field.
Note: While all account groups are initially selected for new optional
fields, you need to consider carefully the purpose of the optional field
you are defining. You should send values to General Ledger only for
optional fields that require financial analysis, and only to accounts
where they are required. For example, you might want to send optional
fields that contain vendor numbers or sales territories only to revenue
accounts.
You do not need to send optional field information for analysis that is
performed only in Accounts Payable. If you routinely send all the optional
fields you use in Accounts Payable transactions, your General Ledger
may become unwieldy, and you may also considerably slow down
processing.
If you use Project and Job Costing, you can also specify whether optional
field information for job‑related transactions will be passed to Project and
Job Costing, if the optional fields match those used for billings in that
program.

Related Topics

A/P Batch Information Screen (Adjustment
Entry)
To open this screen
Fields and controls

Overview
Use the A/P Batch Information screen to view or specify information
about the batch, including:
Batch date and description.
Date the batch was last edited.
Batch type and status.
Number of entries in the batch and their total amount.
Source application, showing whether the batch was added directly
through Accounts Payable or was generated by another program
(such as Purchase Orders).

Related Topics

A/P Batch Information Screen (Invoice Entry)
To open this screen
Fields and controls

Overview
Use the A/P Batch Information screen to view information about the
batch, including:
Batch date and description.
Date the batch was last edited.
Whether the batch listing has been printed.
Source application, showing whether the batch was added directly
through Accounts Payable or was generated by another program
(such as Purchase Orders).

Related Topics

A/P Batch Information Screen (Prepayments)
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Batch Information screen to view or specify information
about the batch, including:
Batch date and description.
Date the batch was last edited.
Batch type and status.
Number of entries in the batch and their total amount.
Whether the batch listing and checks have been printed.
In a multicurrency ledger, the currency, rate type, rate date, and
exchange rate for payments you add to the batch.
Bank.

Related Topics

A/P Detail Accounts/Taxes Screen (Invoices)
To open this screen
Fields and controls
Related tasks

Overview
The A/P Detail Accounts/Taxes screen displays information for a selected
detail in a separate screen, so that you do not have to scroll to see all the
fields. In addition, this screen displays tax information for the detail.
Use this screen to:
Add details to the invoice, debit note, credit note, or interest invoice
you are entering.
Check or change the accounts to which you are distributing a
selected detail.
Change the tax class or tax-included setting for a single distribution
line before you calculate tax for the invoice.
If you know the tax amounts for each distribution, edit the taxes
manually for each detail line.
On invoices to which retainage applies, enter the retainage
percentage (or retainage amount) and the retention period (or
retainage due date) for the detail.
Indicate whether a discount can be taken for the detail.

Related Topics

A/P Prepayments Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Prepayments screen to enter a prepayment for an invoice
when you enter the invoice.
Note: You can enter only one prepayment per invoice.

Related Topics

A/P Remit-To Location Information Screen
(Invoice Entry)
To open this screen

Overview
Use the A/P Remit-To Location Information screen to:
Check the name, address, and telephone number for a remit-to
location specified for an invoice. The remit-to location is the name
and address to which you are going to send invoice payments.
If the vendor has a primary remit-to location, the information for the
primary location appears automatically when you enter the vendor
number.
Select a different remit-to location.
Note: If you need to change information for the remit-to location,
use the Remit-To Locations setup screen.

Related Topics

A/P Vendor Information Screen
To open this screen

Overview
Use the A/P Vendor Information screen to check the address and
telephone information from the vendor's record to ensure that it is correct
for the document you are entering.
Tip: If the vendor wants payments sent to a different location, specify
the remit-to location in the Remit To field on the Document tab on the
A/P invoice Entry screen. If the vendor has a primary remit-to location,
the information for the primary location appears automatically when you
enter the vendor number.

Related Topics

A/P Document History Screen
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Document History screen to view all transactions that have
been applied to a document you selected on the A/P Payment Entry
screen when applying payments or previously posted documents.
Tip: You can also use the A/P Vendor Activity screen to view document
history and check information.

Related Topics

A/P Miscellaneous Adjustment Entry Screen
To open this screen
Fields and controls
Related tasks

Overview
Note: The Allow Adjustments In Payment Batch option must be
selected on the A/P Options screen before you can use this screen.
Use the A/P Miscellaneous Adjustment Entry screen to account for small
differences between the amount you are paying to a vendor and the
amount that your records show you owe.
You can adjust a document only if you have applied a payment to it by
entering a Payment transaction.

Related Topics

A/P Remit-To Location Information Screen
(Payment Entry)
To open this screen

Overview
Use the A/P Remit-To Location Information screen to:
Check the name and address for a remit-to location.
If a primary remit-to location is specified for the selected vendor, the
information for this location appears automatically when you enter the
vendor number.
Select a different remit-to location.
Note: If you need to change information for the remit-to location,
use the Remit-To Locations setup screen.

Related Topics

A/P Payment Information Screen
To open this screen
Fields and controls

Overview
Use the Payment Information screen to view all the documents and
payments to which a check was applied, and see the amount of each
application, the date, the number of the reference document (if applied to
a prepayment), the type of check (prepayment or payment), and whether
the check was reversed.
Summary details displayed for a payment include:
Document and payment number to which the check was applied, or
prepayment number if a prepayment.
Check amount and currency (if you have a multicurrency ledger).
Transaction type and description.
Applied date.
Reference document number (if applied to a prepayment).
Tip: Before you start, print and post any outstanding checks and
payment batches.

Related Topics

A/P Detail Accounts/Taxes Screen (Recurring
Payables)
To open this screen
Fields and controls
Related tasks

Overview
Use the A/P Detail Accounts/Taxes screen to:
Check or change the General Ledger account to which you are
distributing the currently selected detail. If you change the account,
the program updates the G/L Account field on the detail line.
Enter a comment with the detail.
Check or change the tax class for each tax authority, and indicate
whether tax is included or excluded in the detail you are entering.
Specify the tax amount for each tax authority and detail, if you enter
taxes manually.
Important! If you enter taxes manually, make sure that the sum of
the taxes for all the distribution lines matches the total you specify
on the Tax/Totals tab for each tax authority.

Related Topics

A/P Remit-To Location Information Screen
(Recurring Payables)
To open this screen

Overview
Use the A/P Remit-To Location Information screen to check the address,
contact, telephone for the vendor at the location where you send your
payments.
If the vendor wants you to send your payment to another address, specify
a different remit-to location in the Remit-To field (on the Recurring
Payables screen).

Related Topics

A/P Vendor Information Screen (Recurring
Payables)
To open this screen

Overview
Use this Vendor Information screen to check the address, contact, and
telephone numbers for the vendor to ensure that you are entering the
recurring payable for the correct vendor.

Related Topics

A/P Payment Information Screen
To open this screen

Overview
Use the Payment Information screen to view all the documents and
payments to which a check was applied, and to see the amount of each
application, the date, the number of the reference document (if applied to
a prepayment), the type of check (prepayment or payment), and whether
the check was reversed.
Summary details listed for a selected payment include:
Document and payment number to which the check was applied, or
prepayment number if a prepayment.
Check amount and currency (if you have a multicurrency ledger).
Transaction type and description.
Applied date.
Reference Document number (if applied to a prepayment).
Tip: To ensure that you view the most up-to-date payment information,
print and post any outstanding checks and payment batches before
using this screen.

Related Topics

A/P Document Information Screen
To open this screen

Overview
Use the Document Information screen to review the history of a selected
transaction. The information displayed on this screen includes:
Summary information about the transaction (document number, type,
description, date, payment number, original amount, discount
amount, applied amount, and current balance).
A list of the documents that were applied to the selected transaction,
including information such as the document type, check or reference
number, date, applied amount, and description.
Tips:
To scroll through the columns, click an arrow at one of the lower
corners of the screen or press the Tab key to move from column to
column.
As with most Accounts Payable lists, you can change the order of
columns by dragging the column title to the right or left in the line.
To return to the Vendor Activity screen, click Close.

Related Topics

